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How to get Help
This chapter explains how to get help for Nortel products and services.

Getting help from the Nortel web site
The best way to get technical support for Nortel products is from the Nortel 
Technical Support web site:

www.nortel.com/support

This site provides quick access to software, documentation, bulletins, and 
tools to address issues with Nortel products. From this site, you can:

• download software, documentation, and product bulletins

• search the Technical Support Web site and the Nortel Knowledge Base 
for answers to technical issues

• sign up for automatic notification of new software and documentation for 
Nortel equipment

• open and manage technical support cases

Getting help over the phone from a Nortel Solutions Center
If you do not find the information you require on the Nortel Technical 
Support web site, and you have a Nortel support contract, you can also get 
help over the telephone from a Nortel Solutions Center.

In North America, call 1-800-4NORTEL (1-800-466-7835).
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Outside North America, go to the following web site to obtain the telephone 
number for your region:

www.nortel.com/callus

Getting help from a specialist by using an Express Routing 
Code

To access some Nortel Technical Solutions Centers, you can use an Express 
Routing Code (ERC) to quickly route your call to a specialist in your Nortel 
product or service. To locate the ERC for your product or service, go to:

www.nortel.com/erc

Getting help through a Nortel distributor or reseller 
If you purchased a service contract for your Nortel product from a distributor 
or authorized reseller, contact the technical support staff for that distributor 
or reseller.

http://www.nortel.com/callus
http://www.nortel.com/erc
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About this document
This document is a global document. Contact your system supplier or your 
Nortel representative to verify that the hardware and software described is 
supported in your area.

Subject
This document contains description, installation, and administration 
information for the following: 

• Nortel IP Audio Conference Phone 2033

• Nortel IP Phone 2001, IP Phone 2002, IP Phone 2004, and IP Phone 2007

• Nortel IP Phone Key Expansion Module (KEM)

• Nortel IP Softphone 2050 

• Nortel Mobile Voice Client 2050 for Personal Digital Assistants (PDAs)

• Nortel IP Phone 1120E

• Nortel IP Phone 1140E

Note on legacy products and releases

This NTP contains information about systems, components, and features that 
are compatible with Nortel Communication Server 1000 Release 4.5 
software. For more information on legacy products and releases, click the 
Technical Documentation link under Support on the Nortel home page:

http://www.nortel.com

http://www.nortelnetworks.com/
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Applicable systems
This document applies to the following systems:

• Communication Server 1000S (CS 1000S)

• Communication Server 1000M Chassis (CS 1000M Chassis)

• Communication Server 1000M Cabinet (CS 1000M Cabinet)

• Communication Server 1000M Half Group (CS 1000M HG)

• Communication Server 1000M Single Group (CS 1000M SG)

• Communication Server 1000M Multi Group (CS 1000M MG)

• Communication Server 1000E (CS 1000E)

• Meridian 1 PBX 11C Chassis

• Meridian 1 PBX 11C Cabinet

• Meridian 1 PBX 51C

• Meridian 1 PBX 61C

• Meridian 1 PBX 81

• Meridian 1 PBX 81C

Note: When upgrading software, memory upgrades may be required on 
the Signaling Server, the Call Server, or both.

System migration

When particular Meridian 1 systems are upgraded to run CS 1000 
Release 4.5 software and configured to include a Signaling Server, they 
become CS 1000M systems. Table 1 lists each Meridian 1 system that 
supports an upgrade path to a CS 1000M system.

Table 1
Meridian 1 systems to CS 1000M systems (Part 1 of 2)

This Meridian 1 system... Maps to this CS 1000M system

Meridian 1 PBX 11C Chassis CS 1000M Chassis

Meridian 1 PBX 11C Cabinet CS 1000M Cabinet
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For more information, see one or more of the following NTPs:

• Communication Server 1000M and Meridian 1: Small System Upgrade 
Procedures (553-3011-258)

• Communication Server 1000M and Meridian 1: Large System Upgrade 
Procedures (553-3021-258)

• Communication Server 1000S: Upgrade Procedures (553-3031-258)

Intended audience
This document is intended for individuals responsible for maintaining 
Internet Enabled systems.

Conventions

Terminology

In this document, the following systems are referred to generically as 
“system”:

• Communication Server 1000S (CS 1000S)

• Communication Server 1000M (CS 1000M)

• Communication Server 1000E (CS 1000E)

• Meridian 1

Meridian 1 PBX 51C CS 1000M Half Group

Meridian 1 PBX 61C CS 1000M Single Group

Meridian 1 PBX 81 CS 1000M Multi Group

Meridian 1 PBX 81C CS 1000M Multi Group

Table 1
Meridian 1 systems to CS 1000M systems (Part 2 of 2)

This Meridian 1 system... Maps to this CS 1000M system
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The following systems are referred to generically as “Small System”:

• Communication Server 1000M Chassis (CS 1000M Chassis)

• Communication Server 1000M Cabinet (CS 1000M Cabinet)

• Meridian 1 PBX 11C Chassis

• Meridian 1 PBX 11C Cabinet 

The following systems are referred to generically as “Large System”:

• Communication Server 1000M Half Group (CS 1000M HG)

• Communication Server 1000M Single Group (CS 1000M SG)

• Communication Server 1000M Multi Group (CS 1000M MG)

• Meridian 1 PBX 51C

• Meridian 1 PBX 61C

• Meridian 1 PBX 81

• Meridian 1 PBX 81C

Related information
This section lists information sources that relate to this document.

NTPs

The following NTPs and documents are referenced in this document:

• IP Phone 2001 User Guide

• IP Phone 2002 User Guide

• IP Phone 2004 User Guide

• IP Phone 2007 User Guide

• IP Audio Conference Phone 2033 User Guide

• IP Phone 1120E User Guide

• IP Phone 1140E User Guide

• IP Phone Key Expansion Module User Guide
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• WLAN IP Telephony: Installation and Configuration (553-3001-304)

• Mobile Voice Client 2050 User Guide

• Converging the Data Network with VoIP (553-3001-160)

• IP Peer Networking: Installation and Configuration (553-3001-213)

• Features and Services (553-3001-306)

• Software Input/Output: Administration (553-3001-311)

• IP Line: Description, Installation, and Operation  (553-3001-365)

• Software Input/Output: Maintenance (553-3001-511)

Online

To access Nortel documentation online, click the Technical Documentation 
link under Support on the Nortel home page:

http://www.nortel.com

CD-ROM

To obtain Nortel documentation on CD-ROM, contact your Nortel  customer 
representative.

http://www.nortelnetworks.com/
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Nortel IP Phone 2001

Contents
This section contains information on the following topics:

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Description  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Supported features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Features not currently supported . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Display characteristics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Key number assignments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

Package components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Before you begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

First-time installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Start-up sequence  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Full Duplex mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Gratuitous Address Resolution Protocol Protection . . . . . . . . . . . . . . . 63

Replacing an IP Phone 2001 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Removing an IP Phone 2001 from service . . . . . . . . . . . . . . . . . . . . . . 65

Introduction
This section explains how to install and maintain the IP Phone 2001. For 
information on using the IP Phone 2001, see the IP Phone 2001 User Guide.
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This section contains the following procedures:

• Procedure 1, “Pre-installation checklist” on page 47.

• Procedure 2, “Installing an IP Phone 2001 for the first time using manual 
configuration” on page 49.

• Procedure 3, “Installing an IP Phone 2001 for the first time using DHCP” 
on page 55.

• Procedure 4, “Disabling Auto Negotiate and enabling Full Duplex 
mode” on page 62.

• Procedure 5, “Checking Ethernet Statistics” on page 62.

• Procedure 6, “Changing the TN of an existing IP Phone 2001” on 
page 64.

• Procedure 7, “Replacing an IP Phone 2001” on page 65.

• Procedure 8, “Removing an IP Phone 2001 from service” on page 65.

Note: After an IP Phone has been installed and configured, if power to 
the phone is interrupted, re-entry of the IP parameters, Node Number, 
TN, or re-acquisition of firmware is not required. 

Description
The IP Phone 2001 brings voice and data to the desktop environment. It 
connects directly to the LAN through the Ethernet connection. 

The IP Phone 2001 components are shown in Figure 1 on page 37 and 
described in Table 2 on page 37. 
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Figure 1
IP Phone 2001 

Table 2
IP Phone 2001 components and functions (Part 1 of 3)

Component Function

Speaker Press the Dial/Line key to activate 
the speaker for on-hook dialing and 
listening.

Message Waiting/
Incoming Call Indicator

The Message Waiting lamp turns ON 
to indicate that a message has been 
left for the user. This lamp also 
flashes when the set ringer is ON.
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Volume control bar Use the volume control bar to adjust 
the volume of the Handset, Ringer, 
and On-hook Dialing/Listen tones.

Press the right side of the rocker bar 
to increase volume; press the left side 
to decrease volume.

Navigation keys Use the navigation keys to scroll 
through menus and lists in the display 
area.

Dial/Line key Use the Dial/Line key to access the 
single line and activate on-hook 
dialing. No status icon or LED is 
provided.

Hold key Press the Hold key to put an active 
call on hold. Press the Dial/Line key 
to return to the caller on hold.

Soft keys (self-labeled) Soft keys (self-labeled) are located 
below the display area. The LCD 
label above the key changes, based 
on the active feature.

Note: A triangle before a key label 
indicates that the key is active.

Message key Press the Message key to access 
your voicemail box.

Table 2
IP Phone 2001 components and functions (Part 2 of 3)

Component Function
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Goodbye key Press the Goodbye key to terminate 
an active call.

Services key Press the Services key to access the 
following items:

• Telephone Options (see Notes 1 
and 2):

— Volume adjustment

— Contrast adjustment

— Language

— Date/Time

— Local DialPad Tone

— Set Information

— Ring type

• Password Admin:

— Station Control Password

• Virtual Office Login and Virtual 
Office Logout (if Virtual Office is 
configured)

Press the Services key to exit from 
any menu or menu item.

Note 1: If a call is presented while the user is manipulating information, the phone rings. 
However, the screen display is not updated with Caller ID and the programming text is not 
disturbed.

Note 2: The user can originate a call using Autodial or Last Number Redial while manipulating 
an option. However, the display is not updated with the dialed digits or Caller ID, and Autodial 
and Last Number Redial intercept the dialpad.

Table 2
IP Phone 2001 components and functions (Part 3 of 3)

Component Function
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Supported features
The IP Phone 2001 supports the following additional features:

• 802.1Q VLAN and 802.1P priority support, industry standards for 
managing bandwidth usage

• 802.1x Port-based network access control, industry standard for passing 
Extensible Authentication Protocol (EAP) over a LAN 

• 802.1ab Link Layer Discovery 

• Extensible Authentication Protocol (EAP) 

• Gratuitous Address Resolution Protocol Protection (GARP) 

• VLAN filtering 

• Virtual office

• Branch Office

• Both the registered and configured TNs are displayed in the Set Info 
menu.

• Basic IP User License — for more information, see IP Line: Description, 
Installation, and Operation  (553-3001-365)

• language support: English, French, Swedish, Danish, Norwegian, 
German, Dutch, Portuguese, Czech, Finnish, Hungarian, Italian, Polish, 
Spanish, Japanese, Russian, Latvian, Turkish

Features not currently supported
The following features are not supported on the IP Phone 2001:

• External three-port switch to support sharing LAN access with a PC or 
other data device is not provided. However, the IP Phone 2001 does 
provide 100 Mbps full-duplex support.

• Integrated switch

• Personal Directory, Call Log and Redial List are not supported. 
However, if the primary DN on an IP Phone 2001 is an MADN of an IP 
Phone 2002, IP Phone 2004, or IP Softphone 2050, Preferred Name 
Match and Idle Set Display (new call indication) are supported.
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• Corporate Directory

• Automatic Call Distribution

• IP Key Expansion Modules

• Support of accessory modules

• Live Dialpad

• Group Listening

• Set-to-Set messaging

• Context-sensitive soft keys

• Handsfree operation

• Headset support

• External Applications Server

Display characteristics
An IP Phone 2001 has two display areas: 

• information line display

• soft key label display

Figure 2 on page 42 shows these two display areas.
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Cleaning the IP Phone display screen

Gently wipe the IP Phone display screen with a soft, dry cloth.

Information Line display

An IP Phone 2001 has a one-line information display area with the following 
information:

• Caller Number

• Caller Name

• Feature prompt strings

Figure 2
IP Phone 2001 display areas

CAUTION
Do not use any liquids or powders on the IP Phone 2001. 
Using anything other than a soft, dry cloth can 
contaminate IP Phone components and cause premature 
failure.
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• User-entered digits

• Date and time information (if the IP Phone is in an idle state) 

• Set information

The information area changes, according to call processing state and active 
features.

Soft key label display

A maximum of ten functions can be assigned to the soft keys. Your system 
administrator assigns functions to the soft keys in layers.

Use the More.. soft key to navigate through the layers of functions. If there 
are only four functions assigned to the soft keys, the More.. key does not 
appear and all four functions are displayed.

The soft key label has a maximum six characters. Each soft key includes the 
soft key label and an icon. When a soft key is in use, a flashing icon displays 
at the beginning of the soft key label, and the label shifts one character to the 
right. (If the label is six characters long, the last or rightmost character is 
truncated.) If a feature is enabled, the icon state turns to On. It remains in the 
on state until the feature key is pressed again. This cancels the enabled feature 
and turns the icon off, returning the soft key label to its original state. 

Key number assignments
The IP Phone 2001 has four soft-labeled, predefined soft keys that are used to 
provide up to ten features. Because they are predefined, the user cannot 
change the key number assignment.

The Message key is numbered 16. Key numbers 17 to 31 are the four soft key 
labels below the display area. See Figure 1 on page 37.

Key numbers 17 to 31 support the features A03, A06, CFW, CHG, CPN, 
PRK, PRS, RGA, RNP, SCC, SCU, SSC, SSU and TRN, as listed in Table 3 
on page 44.
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Key number assignments at the Call Server are aligned with that of the 
IP Phone 2002. The mappings between IP Phone 2001 soft key numbers and 
PBX CPU key numbers are the same as on the IP Phone 2002 and IP Phone 
2004.

Table 3 describes the IP Phone assignment functions for each of the soft keys. 
Use LD 11 to program keys 16 to 26 on the IP Phone 2001.

Note: If you attempt to configure anything other than the permitted 
response, the system generates an error code. 

Table 3
IP Phone 2001 soft keys

Key Number  Response Description

Key 16 MWK Message Waiting key

Key 17 TRN Call Transfer key

Key 18 A06 Six-party conference key

Alternate: A03 (3-party conference)

Key 19 CFW Call Forward key

Key 20 RGA Ring Again key

Key 21 PRK Call Park key

Key 22 RNP Ringing Number Pickup key

Key 23 Reserved for speed dial Speed dial includes SCU, SCC, SSU, 
SSC

Key 24 PRS Privacy Release key

Key 25 CHG Charge Account key

Key 26 CPN Calling Party Number key

Keys 27 - 31 Reserved



 Nortel IP Phone 2001  Page 45 of 508

IP Phones Description, Installation, and Operation

Package components
The following information applies to Phase II IP Phones. Product codes for 
Phase II IP Phones are different from previous sets. 

See the product code on the back of the phone to confirm whether it is a Phase 
II IP Phone. The product code for Phase II IP Phones appears as “IP Phone 
200x”. The product code for previous versions of the IP Phones appears with 
an “i” in front of the model number; example, “i200x”. 

The AC power adapter must be ordered separately if local power using the 
AC adapter is required, because Phase II IP Phones include integrated support 
for a number of power over LAN options, including support for IEEE 802.3af 
standard power.

Table 4 lists the IP Phone 2001 package components and product codes.  

Table 4
IP Phone 2001 components list (Part 1 of 2)

IP Phone 2001 package contents include:

• IP Phone 2001 

• Handset

• Handset cord

• Footstand

• 7 ft. Cat5 Ethernet cable

• Getting Started card

IP Phone 2001(Ethergray) with Icon keycaps NTDU90AA16/A0533387

IP Phone 2001 (Ethergray) with English text label keycaps NTDU90BA16/A0533388

IP Phone 2001 (Charcoal) with Icon keycaps NTDU90AA70/A0053389

IP Phone 2001 (Charcoal) with English text label keycaps NTDU90BA70/A0533390

Replacement parts

7 ft. Cat5 Ethernet Cable A0648375
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For more information, and for information about previous versions of the IP 
Phone, contact your Nortel representative. 

Before you begin
The following section provides a step-by-step guide through the 
IP Phone 2001 installation process. Before installing the IP Phone 2001, 
complete the following pre-installation checklist.

Handset, Ethergray A0788874

Handset, Charcoal A0758634

Handset cord, Ethergray; for IP Phone 2004 and IP Phone 2001 A088682

Handset cord, Charcoal; for IP Phone 2004 and IP Phone 2001 N0000764

IP Phone 2001/2002/2004 Power Adapters

Power transformer (117/120 VAC 50/60 Hz) (North America) A0619627

Power transformer 3 prong AC to AC, direct plug-in, 8W, 240 
VAC, 50Hz to 16 VAC at 500 mA (Ireland and UK)

A0656598

Power transformer AC to AC, direct plug-in, 8W, 230 VAC, 50/60 
Hz, to 16 VAC at 500 mA (Europe)

A0619635

Power transformer 2 prong wall plug direct plug-in AC to AC, 8W, 
240 VAC, 50 Hz, to 16 VAC at 500 mA (Australia and New 
Zealand)

A0647042

Power transformer AC to AC, direct plug-in, 8W, 100 VAC, 50 
Hz, to 16 VAC at 500 mA

A0828858

Table 4
IP Phone 2001 components list (Part 2 of 2)
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Procedure 1
Pre-installation checklist

1 Ensure there is one IP Phone 2001 boxed package for each IP Phone 
2001 being installed. The package contains:

• IP Phone 2001

• Handset

• Handset cord

• Footstand

• 2.3 m (7 foot) Cat5 Ethernet cable

• Getting Started card

2 To install and configure an IP Phone 2001, the host system must be 
installed with the Voice Gateway Media Card.

3 If an AC power adapter is required, ensure the correct AC power 
transformer is used. The voltage rating of the transformer must match the 
wall outlet voltage. Refer to Table 4 on page 45.

4 Understand the three configuration modes that you can choose as you 
proceed through the installation of the IP Phone 2001. The three 
configuration modes are:

• Static IP address – see “Static IP address assignment” on page 48.

• Dynamic Partial DHCP – see “Dynamic IP address assignment — 
Partial DHCP” on page 48.

• Dynamic Full DHCP – see “Dynamic IP address assignment — Full 
DHCP” on page 49.

5 Make sure that a DHCP server and DHCP relay agents, if required, are 
installed, configured, and running.

End of Procedure
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First-time installation

IP address assignments

During the first-time installation, there are IP address parameters that are 
entered either manually or automatically depending on the installation 
configuration. As well, you are prompted to enable or disable 802.1Q. For 
more information, see “802.1Q VLAN description” on page 407.

There are three configuration modes you can choose from to obtain the IP 
parameters. Review the following sections for more information on the 
configuration mode that you are using.

Static IP address assignment

During the installation, the IP Phone 2001 parameters are entered manually 
using the key pad.

Your system administrator provides the following information: IP address, 
subnet mask, and default Media Gateway.

You must also enter the Connect Server parameters including: IP address, 
port number, action, and retry count.

Go to Procedure 2, “Installing an IP Phone 2001 for the first time using 
manual configuration” on page 49.

Dynamic IP address assignment — Partial DHCP

For a partial DHCP installation, you must provide, through the IP Phone 2001 
key pad, the Connect Server parameters including: IP address, port number, 
action, and retry count. Other parameters (IP Phone IP address, subnet mask, 
and default Gateway) are retrieved from the DHCP server.

CAUTION — Damage to Equipment

Do not plug your IP Phone 2001 into an ISDN 
connection. Severe damage can result. Consult your 
system administrator to ensure that you are plugging 
your IP Phone into a 10/100BaseT Ethernet jack.
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The IP Phone 2001 password, node ID and TN must be entered manually 
from the key pad.

For more information about DHCP servers, see Converging the Data 
Network with VoIP (553-3001-160).

Go to Procedure 3, “Installing an IP Phone 2001 for the first time using 
DHCP” on page 55.

Dynamic IP address assignment — Full DHCP

For a full DHCP installation, all parameters (IP Phone IP address, subnet 
mask, default Gateway, Connect Server IP address, port number, action, and 
retry count) are retrieved from the DHCP server to recognize the IP Phone 
2001.

The IP Phone 2001 password, node ID, and TN must be entered manually 
from the key pad.

For more information on how to set up DHCP servers for use with the 
IP Phones, refer to Converging the Data Network with VoIP (553-3001-160).

Go to Procedure 3, “Installing an IP Phone 2001 for the first time using 
DHCP” on page 55.

Procedure 2
Installing an IP Phone 2001 for the first time using 
manual configuration

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Phone 2001 on the system using LD 11.

For more information, see Software Input/Output: Administration 
(553-3001-311).

3 Connect the IP Phone 2001 components:

a. Connect one end of the handset cord to the handset jack on the back 
of the IP Phone identified with a handset icon.

b. Connect the other end of the handset cord to the handset.
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4 Connect one end of the CAT5 Ethernet cable to the network interface 
located on the back of the IP Phone (identified with a LAN icon, see 
Figure 3). The other end of the CAT5 Ethernet cable plugs into the IP 
network.

Figure 3
IP Phone 2001 rear view
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5 Power the IP Phone 2001 using either the Power over Ethernet or an AC 
power transformer (local power). 

If local power is used, plug the AC power transformer into the nearest 
power outlet. Make sure you use the correct AC power transformer is 
used. The voltage rating of the transformer must match the wall outlet 
voltage. Refer to Table 4 on page 45. Connect the transformer to the 
AC power jack shown in Figure 3 on page 50. Be sure to thread the 
cord around the retaining hook to provide strain relief for a secure 
power connection.

6 When the Nortel logo appears in the middle of the display, immediately 
press the four feature keys at the bottom of the display in sequence from 
left to right.

7 At the prompt EAP enable?, select Yes. Enter DeviceID and Password. 
For more information on EAP, refer to Appendix C: “802.1x Port-based 
network access control” on page 415.

Note: If you select No, you will not be prompted to enter Device ID and 
Password.

8 At the prompt DHCP Yes/No?, select No.

9 Enter the following information provided by your system administrator:

IMPORTANT!

Timing information
There are only four seconds between plugging in the IP Phone 2001 
power transformer and the appearance of the Nortel logo in the middle 
of the display. When you see the logo, you have one second to respond 
by pressing the four feature keys at the bottom of the display in 
sequence from left to right. If you miss the one-second response time, 
the IP Phone 2001 attempts to locate the connect server. Wait until it is 
finished, and then begin the power-up sequence again.

Screen prompt Description

set IP A valid IP Phone 2001 IP address
net msk A subnet mask

def gw The default Gateway for the IP Phone 2001 on 
the LAN segment to which it is connected
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10 Enter the information for the primary Connect Server (S1) and the 
secondary Connect Server (S2):  
Screen prompt Description

S1 IP The node IP address of the IP line 
node

S1 Port This is a fixed value: 4100

S1 action This is a fixed value: 1

S1 retry The number of times the IP Phone 
2001 attempts to connect to the 
server. Enter 10.

S2 IP Same as S1 in most cases (see 
note below)

S2 Port Same as S1

S2 action Same as S1
S2 retry Same as S1

Cfg XAS? (0-No,1-Yes) Enter 0 (for No)

External Application Server (XAS) 
is not supported on the IP Phone 
2001. This prompt exists to support 
future implementation of XAS.

VLAN? (0-No, 1-Ma, 2-Au) Default 0 (for No)
802.1Q VLAN remains off and 
initialization continues.

For more information about VLAN 
configuration, refer to Converging 
the Data Network with VoIP 
(553-3001-160).
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1-Ma
Enter a Voice VLAN ID, then press 
OK.

The following Voice VLAN ID 
displays:
Manual Cfg

VOICE VLAN ID: 1234

Note: The Voice VLAN ID is 
entered as an integer. The Voice 
VLAN ID is a 12-bit value between 
1 and 4095.

The IP Phone 2001 is configured 
with 802.1Q enabled, the VOICE 
VLAN ID is configured to the 
entered value, and the VOICE 
VLAN priority = 6.
2-Au
Automatically enter VLAN ID using 
DHCP. DHCP auto discovers the 
VLAN ID.

) VLANFiLTER (0-No, 1-Yes)
Default 0 (for No)

You will not be prompted for 
VLANFILTER if VLAN? is not 
enabled.

Data VLAN? (0-No, 1-Yes) After the value is entered, the DATA 
VLAN configuration option appears 
on the display.

Select 0-No, since DATA VLAN is 
not supported on the IP Phone 
2001.

Duplex (0-Auto, 1-Full) Default 0 (for Auto)

GARP Ignore? (0-No,1-Yes) Default 0 (for No)
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11 The IP Phone 2001 can support primary (S1) and secondary (S2) connect 
server. If you require IP Phones to register on multiple nodes, refer to 
“Enhanced Redundancy for IP Line Nodes” in IP Line: Description, 
Installation, and Operation  (553-3001-365).

The IP Phone 2001 searches for the connect server. When the 
connection is complete, proceed with step 12.

12 Enter the following information provided by your system administrator:

The IP Phone 2001 registers with the Terminal Proxy Server (TPS) and, 
if needed, begins the firmware download. This takes several minutes. 
When the download is complete, the IP Phone 2001 resets.

Note: The Enhanced UNIStim Firmware Download feature for IP Phones 
provides an improved method of delivering new firmware to IP Phones. 
For further information on Enhanced UNIStim Firmware Download, refer 
to IP Line: Description, Installation, and Operation  (553-3001-365).

The current system date and time appear on the top line of the display 
when the configuration is complete. Self-labeling keys also appear.

13 Check for dial tone and the correct DN above the display.

14 Secure the IP Phone footstand to the base of the IP Phone. Use the angle 
adjustment grip on the top back of the IP Phone to adjust the position.

15 (Optional) Customize the feature keys as required. For more information, 
see IP Phone 2001 User Guide.

End of Procedure

Screen prompt Description

Password IP Phone Installer Password

You are not prompted to enter the IP Phone 
Installer Password if it has not been configured 
in your system.

Node The node ID.

TN The TN or VTN.
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Procedure 3
Installing an IP Phone 2001 for the first time 
using DHCP

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Phone 2001 on the system using LD 11.

For more information, see Software Input/Output: Administration 
(553-3001-311).

3 Connect the IP Phone 2001 components:

a. Connect one end of the handset cord to the handset jack on the back 
of the IP Phone identified with a handset icon.

b. Connect the other end of the handset cord to the handset.

4 Connect one end of the CAT5 Ethernet cable to the network interface 
located on the back of the IP Phone (identified with a LAN icon, see 
Figure 3 on page 50). The other end of the CAT5 Ethernet cable plugs 
into the IP network.
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5 Power the IP Phone 2001 using either the Power over Ethernet or an AC 
power transformer (local power).

To use local power, plug the AC power transformer into the nearest 
power outlet. Ensure the correct AC power transformer is used. The 
voltage rating of the transformer must match the wall outlet voltage. 
Refer to Table 4 on page 45. Connect the transformer to the AC power 
jack shown in Figure 3 on page 50. Be sure to thread the cord around 
the retaining hook to provide strain relief for a secure power 
connection.

6 When the Nortel logo appears in the middle of the display area, 
immediately press the four feature keys at the bottom of the display in 
sequence from left to right.

7 At the prompt EAP enable?, select Yes. Enter DeviceID and Password. 
For more information on EAP, refer to Appendix C: “802.1x Port-based 
network access control” on page 415.

Note: If you select No, you will not be prompted to enter Device ID and 
Password.

8 At the prompt DHCP Yes/No?, select Yes.

9 Select Partial or Full DHCP.

a. If you select Full DHCP, then the following parameters are retrieved 
from the DHCP server:

— a valid IP Phone 2001 IP address

— a subnet mask

IMPORTANT!

Timing information
There are only four seconds between plugging in the IP Phone 2001 
power transformer and the appearance of the Nortel logo in the middle 
of the display area. When you see the logo, you have one second to 
respond by pressing the four feature keys at the bottom of the display in 
sequence from left to right. If you miss the one-second response time, 
the IP Phone 2001 attempts to locate the connect server. Wait until it is 
finished, and then begin the power-up sequence again.
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— the default Media Gateway for the IP Phone 2001 on the LAN 
segment to which it is connected

— the S1 node IP address of the IP line node

— the S1 action

— the S1 retry count. This is the number of times the 
IP Phone 2001 attempts to connect to the server

— the S2 node IP address of the IP line node

— the S2 action

— the S2 retry count

b. If you select Partial DHCP, then you must enter the following 
parameters:

Screen prompt Description

S1 IP the node IP address of the IP line 
node

S1 Port this is a fixed value: 4100

S1 action this is a fixed value: 1

S1 retry the number of times the IP Phone 
2001 attempts to connect to the 
server; enter 10

S2 IP same as S1 in most cases (see note 
below)

S2 Port same as S1

S2 action same as S1
S2 retry same as S1

Cfg XAS? (0-No,1-Yes) Enter 0 (for No), since External 
Application Server is not supported 
on the IP Phone 2001.

This prompt exists to support future 
implementation of External 
Application Server.
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VLAN? (0-No, 1-Ma, 2-Au) Default 0 (for No)
802.1Q remains off and initialization 
continues.

For more information about VLAN 
configuration, refer to Converging the 
Data Network with VoIP 
(553-3001-160).

1-Ma
Enter a VLAN ID manually, then 
press OK.
The following VLAN ID displays:
Manual Cfg

VOICE VLAN ID: 1234

Note: The VOICE VLAN ID is 
entered as a decimal. The VOICE 
VLAN ID is a 12-bit value between 0 
and 4095.

The IP Phone 2001 is configured 
with 802.1Q enabled, VOICE VLAN 
priority = 6, and the VOICE VLAN ID 
set to the entered value.
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Note: The IP Phone 2001 can support a primary (S1) and secondary 
(S2) connect server. If you require IP Phones to register on multiple 
nodes, refer to “Enhanced Redundancy for IP Line Nodes” in IP Line: 
Description, Installation, and Operation  (553-3001-365).

The IP Phone 2001 searches for the connect server. When the 
connection is complete, proceed to step 10.

10 Enter the following information provided by your system administrator.

2-Au
Automatically enter a VLAN ID 
using DHCP.
DHCP auto discovers the 
VLAN ID.

VLANFILTER (0-No, 1-Yes)
Default 0 (for No)

You will not be prompted for 
VLANFILTER if VLAN? is not 
enabled.

Data VLAN? (0-No, 1-Yes) After the value is entered, the 
DATA VLAN configuration option 
appears on the display.

Select 0 (for No), since DATA 
VLAN is not supported on the IP 
Phone 2001.

Duplex (0-Auto, 1-Full) Default 0 (for Auto).

GARP Ignore? (0-No,1-Yes) Default 0 (for No)

Screen prompt Description

Password IP Phone Installer Password

You are not prompted to enter the IP Phone 
Installer Password if it has not been 
configured in your system.
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The IP Phone 2001 registers with the TPS and, if needed, begins the 
firmware download. This takes several minutes. When the download is 
complete, the IP Phone 2001 resets.

Note: The Enhanced UNIStim Firmware Download feature for IP Phones 
provides an improved method of delivering new firmware to IP Phones. 
For further information on Enhanced UNIStim Firmware Download, refer 
to IP Line: Description, Installation, and Operation  (553-3001-365).

The current system date and time appear on the top line of the display 
when the configuration is complete. Self-labeling keys also appear.

11 Check for dial tone and the correct DN above the display.

12 Secure the IP Phone footstand to the base of the IP Phone. Use the angle 
adjustment grip on the top back of the IP Phone to adjust the position. 

13 (Optional) Customize the feature keys as required. For more information, 
see IP Phone 2001 User Guide.

End of Procedure

Start-up sequence
When an IP Phone 2001 is connected to the network, it must perform a startup 
sequence. The elements of the startup sequence include:

• obtaining the IP parameters

• finding a default Gateway server

• authenticating the user

See Table 5 on page 61 for a summary of the IP parameters and how they are 
obtained.

Node The node ID

TN The TN or VTN
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Note: For all static IP address assignments, your system administrator 
provides the network information.

Full Duplex mode
In the Configuration menu, Auto Negotiate mode is the default setting for 
initial startup. Typically, the IP Phone 2001 is connected to a network that 
supports Auto Negotiate, and it selects the best speed and duplex mode 
available. There is no intervention required under normal operation.

If the IP Phone is connected to a network configured for Full Duplex mode 
only, it is not able to automatically negotiate the proper configuration. 
Therefore, in this instance, to allow the IP Phone to work at the optimum 
speed and duplex mode, Auto Negotiate must be disabled. Use the following 
procedure to disable Auto Negotiate and enable Full Duplex mode.

Table 5
IP Phone 2001 IP parameters

Parameter Method of Acquisition

IP Address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Net Mask Manually entered or automatically retrieved through 
Partial or Full DHCP.

Default Address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Connect Server (IP address, port, 
action and retry count — primary 
and secondary)

Manually entered or automatically retrieved through Full 
DHCP.

User ID (Node ID, Node Password 
and TN)

Manually entered for first-time configuration. Retrieved 
from local storage on subsequent power cycles.

Provided by your system administrator.
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Procedure 4
Disabling Auto Negotiate and enabling Full Duplex 
mode

1 Reset the phone by disconnecting and re-connecting power.

2 When the Nortel logo appears, press each of the soft keys in sequence. 
See Procedure 3 on page 55.

3 If no other configuration changes are required, press OK repeatedly until 
the Duplex network option appears.

4 Select 1 to enable Full Duplex mode.

5 When the Speed option appears, select one of the following:

• 0 for 10 Mbps

• 1 for 100 Mbps (default)

6 Select OK to confirm the change.

7 Restart the IP Phone 2001. The firmware reads the new setting, and the 
IP Phone operates in Full Duplex mode.

End of Procedure

When the IP Phone is restarted, the firmware reads the setting for Full 
Duplex mode and sets port 0, the network interface port, accordingly.

Use the following procedure to confirm activation of Full Duplex mode.

Procedure 5
Checking Ethernet Statistics

1 Double-click the Services key. The Network Diagnostics menu appears.

2 Select Ethernet Statistics.

• If Full Duplex mode is active, the following is displayed:

— Link: UP

— Duplex: Full

— Speed: 10 (Mb) or 100(Mb)
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— Auto-Nego Capability: N

— Auto-Nego Completed: N

End of Procedure

Gratuitous Address Resolution Protocol Protection
Gratuitous Address Resolution Protocol Protection (GARP) prevents the 
IP Phone 2001 from GARP Spoof attacks on the network. In a GARP Spoof 
attack, a malicious device on the network takes over an IP address (usually 
the default gateway) by sending unsolicited (or Gratuitous) ARP messages, 
thus manipulating the ARP table of the victim’s machine. This allows the 
malicious device to launch a variety of attacks on the network, resulting in 
undesired traffic routing. For example, a GARP attack can convince the 
victim machine that the malicious device is the default gateway. In this 
scenario, all traffic from the victim’s machine flows through the malicious 
device.

To enable GARP Protection during configuration, refer to Procedure 2, 
“Installing an IP Phone 2001 for the first time using manual configuration” 
on page 49 or Procedure 2, “Installing an IP Phone 2001 for the first time 
using DHCP” on page 55.

Extensible Authentication Protocol 
Extensible Authentication Protocol (EAP) is a general protocol that fulfills 
the protocol requirements defined by 802.1x. For further information on 
802.1x, refer to Appendix C: “802.1x Port-based network access control” on 
page 415.

Reinstalling an IP Phone 2001
You can reinstall an existing previously configured IP Phone 2001 on the 
same system. For example, the IP Phone 2001 can be assigned to a new user 
(new TN) or to an existing user who moved to a new subnet by changing the 
TN of the IP Phone 2001.
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Procedure 6
Changing the TN of an existing IP Phone 2001

1 Repower the IP Phone 2001.

Note: During the reboot sequence of a previously configured Internet 
Telephone, the IP Phone 2001 displays the existing node number for 
approximately five seconds.

2 If node password is enabled and NULL, choose one of the following:

a. Disable password.

b. Set password as non-NULL.

3 Press OK when the node number displays.

4 Enter password at the password screen, and press OK.

A TN screen displays.

5 Select the Clear soft key to clear the existing TN. 

End of Procedure

If Then

node password is enabled and is 
not NULL

a password screen displays. Go to 
step 4.

node password is disabled a TN screen displays. Go to 
step 5.
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Replacing an IP Phone 2001 

Procedure 7
Replacing an IP Phone 2001 

1 Disconnect the IP Phone 2001 that you want to replace.

2 Follow either Procedure 2 on page 49 (static IP assignment) or 
Procedure 3 on page 55 (dynamic IP assignment) to install and configure 
the IP Phone 2001.

3 Enter the same TN and Node Number as the IP Phone 2001 you 
replaced. The system associates the new IP Phone 2001 with the existing 
TN.

End of Procedure

Removing an IP Phone 2001 from service

Procedure 8
Removing an IP Phone 2001 from service

1 Disconnect the IP Phone 2001 from the network or turn off the power.

Note: The service to the PC is disconnected as well if the PC is 
connected to the IP Phone 2001.

If the IP Phone 2001 was automatically configured, the DHCP lease 
expires and the IP address returns to the available pool.

2 In LD 11, OUT the TN.

End of Procedure

IMPORTANT!

Two IP Phones cannot share the same TN. You must remove the 
IP Phone 2001 that is currently using the TN.



Page 66 of 508  Nortel IP Phone 2001

553-3001-368 Standard 12.00 March 2006



Page 67 of 508

IP Phones Description, Installation, and Operation

100

Nortel IP Phone 2002

Contents
This section contains information on the following topics:

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Description  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Supported features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Features not currently supported . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Display characteristics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Key number assignments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Package components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Before you begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

First-time installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

Startup sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

Full Duplex mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

Reinstalling an IP Phone 2002  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

Replacing an IP Phone 2002 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

Removing an IP Phone 2002 from service . . . . . . . . . . . . . . . . . . . . . . 100



Page 68 of 508  Nortel IP Phone 2002

553-3001-368 Standard 12.00 March 2006

Introduction
This section explains how to install and maintain the IP Phone 2002. For 
information on using the IP Phone 2002, see the IP Phone 2002 User Guide.

This section contains the following procedures:

• Procedure 9, “Pre-installation checklist” on page 80.

• Procedure 10, “Installing an IP Phone 2002 for the first time using 
manual configuration” on page 83.

• Procedure 11, “Installing an IP Phone 2002 for the first time using 
DHCP” on page 88.

• Procedure 12, “Disabling Auto Negotiate and enabling Full Duplex 
mode” on page 97.

• Procedure 13, “Checking Ethernet Statistics” on page 97.

• Procedure 14, “Changing the TN of an existing IP Phone 2002” on 
page 98.

• Procedure 15, “Replacing an IP Phone 2002” on page 99.

• Procedure 16, “Removing an IP Phone 2002 from service” on page 100.

Note: After an IP Phone has been installed and configured, if power is 
to the phone is interrupted, re-entry of the IP parameters, Node Number, 
TN, or re-acquisition of firmware is not required. 

Description
The IP Phone 2002 brings voice and data to the desktop environment. It 
connects directly to the LAN through the Ethernet connection. 

The IP Phone 2002 components are shown in Figure 4 on page 69.
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Figure 4
IP Phone 2002
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Table 6
IP Phone 2002 components and functions (Part 1 of 4)

Component Function

Speaker Press the Handsfree key to activate the 
speaker.

Programmable Line DN/
feature keys
(self-labeled)

Four programmable line (DN)/feature keys 
(self-labeled) are configured for various 
features on the IP Phone. One must be the 
prime DN key.

A steady LCD light beside a line (DN) key 
indicates the feature or line is active. A 
flashing LCD indicates the line is on hold or 
the feature is being programmed.

Message Waiting light/
Incoming Call Indicator

The Message Waiting light turns ON to 
indicate that a message has been left for the 
user. This light also flashes when the set 
ringer is ON.

Soft keys (self-labeled) Soft keys (self-labeled) are located below the 
display area. The LCD label above the key 
changes, based on the active feature.

Note: A triangle before a key label indicates 
that the key is active.

Navigation keys Use the navigation keys to scroll through 
menus and lists in the display area.

Inbox (Message) Press the Inbox (Message) key to access 
your voicemail box.

Outbox/Shift The Outbox/Shift key is a fixed key that is 
reserved for future feature development.

Directory Press the Directory key to access Directory 
services.
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Services Press the Services key to access the 
following items:

• Telephone Options (see Notes 1 and 2):

— Volume Adjustment

— Contrast Adjustment

— Language

— Date/Time Format

— Display diagnostics

— Local Dialpad Tone

— Ring type

— OnHook Default Path

— Change Feature key label

— Set Information

• Virtual Office Login and Virtual Office 
Logout (if Virtual Office is configured)

• Test Local Mode and Resume Local Mode 
(if Branch Office is configured)

Quit Press the Quit key to end an active 
application. 

Pressing the Quit key does not affect the 
status of the calls currently on your IP Phone.

Expand to PC The Expand to PC key is used to access 
external server applications such as External 
Application Server (XAS).

Goodbye Press the Goodbye key to terminate an active 
call.

Table 6
IP Phone 2002 components and functions (Part 2 of 4)

Component Function
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Hold Press the Hold key to put an active call on 
hold. Press the line (DN) key beside the 
flashing LCD to return to the caller on hold.

Headset Press the Headset key to answer a call using 
the headset or to switch a call from the 
handset or Handsfree to the headset.

Mute Press the Mute key to listen to the receiving 
party without transmitting.

Press the Mute key again to return to a 
two-way conversation.

The Mute key applies to Handsfree, Handset, 
and Headset microphones. 

The Mute LED flashes when the Mute option 
is in use.

Volume control bar Use the volume control bar to adjust the 
volume of the handset, headset, speaker, 
ringer, and, Handsfree feature. 

Press the right side of the rocker bar to 
increase volume; press the left side to 
decrease volume.

Table 6
IP Phone 2002 components and functions (Part 3 of 4)

Component Function
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Supported features
The IP Phone 2002 supports the following additional features:

• 802.1Q VLAN and 802.1P priority support, industry standards for 
managing bandwidth usage — full VLAN capability, including a 
manageable integrated switch in the IP Phone for VLAN and priority 
tagging for PC and IP Phone traffic

• 802.1x Port-based network access control, industry standard for passing 
Extensible Authentication Protocol (EAP) over a LAN

• integrated hardware to support power over Ethernet, for IEEE 802.3af 
standard power; also including support for PowerDsine Power over LAN 
Hub powering, and Cisco proprietary powering as tested with specific 
Cisco Ethernet switch equipment

• Extensible Authentication Protocol (EAP) 

• Gratuitous Address Resolution Protocol Protection (GARP) 

• VLAN filtering 

• ability to change the feature key labels

Handsfree key Press the Handsfree key to activate the 
Handsfree feature.

The LED lights to indicate when handsfree is 
active.

Note 1: If a call is presented while the user is manipulating an option, the 
IP Phone 2002 rings and the DN key flashes. However, the screen display 
is not updated with Caller ID information and programming text is not 
disturbed.

Note 2: The user can originate a call using Autodial or Last Number 
Redial while manipulating an option. However, the display is not updated 
with the dialed digits or the Caller ID information, and Autodial and Last 
Number Redial intercept the dialpad.

Table 6
IP Phone 2002 components and functions (Part 4 of 4)

Component Function
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• Corporate Directory

• Personal Directory

• Redial List

• Callers List

• Password Administration

• Virtual office

• Branch Office

• switch to support sharing LAN access with a PC or other data device

• 10/100 Mbps Full Duplex mode

• Both the registered and configured TNs are displayed in the Set Info 
menu.

• language support: English, French, Swedish, Danish, Norwegian, 
German, Dutch, Portuguese, Czech, Finnish, Hungarian, Italian, Polish, 
Spanish, Japanese, Russian, Latvian, Turkish

• IP Key Expansion modules

• External Application Server (XAS)

Features not currently supported
The following features are not supported on the IP Phone 2002:

• Live Dialpad

• Group Listening

• Set-to-Set messaging

• Context-sensitive soft keys

The three-port switch that is internal to the IP Phone 2002 is an unmanaged 
switch. It passes the packets (unmodified) and does not interpret the 802.1Q 
header. The three-port switch provides priority based on the port. The IP 
Phone port traffic takes priority over the Ethernet.
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Display characteristics
An IP Phone 2002 has three major display areas: 

• programmable line (DN) feature key label

• soft key label

• information line

Figure 5 on page 75 shows these three display areas.

Figure 5
IP Phone 2002 display areas
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Cleaning the IP Phone display screen

Gently wipe the IP Phone display screen with a soft, dry cloth.

Programmable line (DN)/feature key label display

The feature key label area displays a ten-character string for each of the four 
feature keys. Each feature key includes the key label and an icon. The icon 
state can be on, off, or flashing. Key labels are left-aligned for keys on the left 
side of the screen, and right-aligned for keys on the right side of the screen.

Note: If a label is longer than ten characters, the last ten characters are 
displayed and the excess characters are deleted from the beginning of the 
string.

Soft key label display

A maximum of ten functions can be assigned to the soft keys. Your system 
administrator assigns functions to the soft keys in layers.

Use the More.. soft key to navigate through the layers of functions. If there 
are only four functions assigned to the soft keys, the More.. key does not 
appear and all four functions are displayed.

The soft key label has a maximum six characters. Each soft key includes the 
soft key label and an icon. When a soft key is in use, a flashing icon displays 
at the beginning of the soft key label, and the label shifts one character to the 
right. (If the label is six characters long, the last or rightmost character is 
truncated.) If a feature is enabled, the icon state turns to On. It remains in the 
on state until the feature key is pressed again. This cancels the enabled feature 
and turns the icon off, returning the soft key label to its original state. 

CAUTION
Do not use any liquids or powders on the IP Phone. 
Using anything other than a soft, dry cloth can 
contaminate IP Phone components and cause premature 
failure.
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Information line display

An IP Phone 2002 has a one-line information display area with the following 
information: 

• Caller number

• Caller name

• Feature prompt strings

• User-entered digits

• Date and time information (if the IP Phone is in an idle state) 

The information in the display area changes, according to the call processing 
state and active features.

Key number assignments
The IP Phone 2002 has four soft-labeled, predefined soft keys that are used to 
provide up to ten features. Because they are pre-defined, the user cannot 
change the key number assignment. 

The Message key is numbered 16. Key numbers 17 to 31 are the four soft key 
labels below the display area. See Figure 4 on page 69.

Key numbers 17 to 31 support the features A03, A06, CFW, CHG, CPN, 
PRK, PRS, RGA, RNP, SCC, SCU, SSC, SSU and TRN, as listed in Table 7 
on page 78.

Key number assignments at the Call Server are aligned with that of the 
IP Phone 2004. The mappings between IP Phone 2002 soft key numbers and 
PBX CPU key numbers are the same as on the IP Phone 2004. 

Table 7 describes the IP Phone assignment functions for each of the dedicated 
keys. Use LD 11 to program keys 16 to 26 on the IP Phone 2002.
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Note: If you attempt to configure anything other than the permitted 
response, the system generates an error code. 

Package components
The following information applies to Phase II IP Phones. Product codes for 
Phase II IP Phones are different from previous sets. 

See the product code on the back of the phone to confirm whether it is a Phase 
II IP Phone. The product code for Phase II IP Phones appears as 

Table 7
IP Phone 2002 soft keys

Key Number  Response Description

Key 16 MWK Message Waiting key

Key 17 TRN Call Transfer key

Key 18 A06 Six-party conference key

Alternate: A03 (3-party conference)

Key 19 CFW Call Forward key

Key 20 RGA Ring Again key

Key 21 PRK Call Park key

Key 22 RNP Ringing Number Pickup key

Key 23 Reserved for speed dial Speed dial includes SCU, SCC, SSU, 
SSC

Key 24 PRS Privacy Release key

Key 25 CHG Charge Account key

Key 26 CPN Calling Party Number key

Keys 27 - 31 Reserved
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“IP Phone 200x”. The product code for previous versions of the IP Phone 
appears with an “i” in front of the model number (for example, “i200x”). 

The AC power adapter must be ordered separately if local power using the 
AC adapter is required, because Phase II IP Phones include integrated support 
for a number of power over LAN options, including support for IEEE 802.3af 
standard power.

Table 8 lists the IP Phone 2002 package components and product codes.

Table 8
IP Phone 2002 components list (Part 1 of 2)

IP Phone 2002 package contents include:

• IP Phone 2002 

• Handset

• Handset cord

• Footstand

• 7ft Cat5 Ethernet cable

• Getting Started card 

IP Phone 2002 (Ethergray) with Icon keycaps NTDU91AA16/A0533404

IP Phone 2002 (Ethergray) with English text label keycaps NTDU91BA16/A0533405

IP Phone 2002 (Charcoal) with Icon keycaps NTDU91AA70/A0533406

IP Phone 2002 (Charcoal) with English text label keycaps NTDU91BA70/A0533407

Replacement parts

7 ft. Cat5 Ethernet cable A0648375

Handset, Ethergray A0788874

Handset, Charcoal A0758634

Handset cord, Ethergray A0897725

Handset cord, Charcoal N0000763

Footstand, Charcoal (used for Ethergray and Charcoal models) A0891619
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For more information, and for information about previous versions of the IP 
Phone, contact Nortel. 

Before you begin
The following section provides a step-by-step guide through the IP Phone 
2002 installation process. Before installing the IP Phone 2002, complete the 
following pre-installation checklist.

Procedure 9
Pre-installation checklist

1 Ensure there is one IP Phone 2002 boxed package for each IP Phone 
2002 being installed. The package contains:

• IP Phone 2002 

• Handset

• Handset cord

• Footstand

• 2.3 m (7’) Cat5 Ethernet cable

• Getting Started card

IP Phone 2001/2002/2004 Power Adaptors

Power transformer (117/120 VAC 50/60 Hz) (North America) A0619627

Power transformer 3 prong AC to AC, direct plug-in, 8W, 240 
VAC, 50Hz to 16 VAC at 500 mA (Ireland and UK)

A0656598

Power transformer AC to AC, direct plug-in, 8W, 230 VAC, 50/60 
Hz, to 16 VAC at 500 mA (Europe)

A0619635

Power transformer 2 prong wall plug direct plug-in AC to AC, 8W, 
240 VAC, 50 Hz, to 16 VAC at 500 mA (Australia and New 
Zealand)

A0647042

Power transformer AC to AC, direct plug-in, 8W, 100 VAC, 50 
Hz, to 16 VAC at 500 mA

A0828858

Table 8
IP Phone 2002 components list (Part 2 of 2)
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2 To install and configure an IP Phone 2002, the host system must be 
installed with the Voice Gateway Media Card.

3 If an AC power adapter is required, ensure the correct AC power 
transformer is used. The voltage rating of the transformer must match the 
wall outlet voltage. Refer to Table 8 on page 79.

4 Understand the three configuration modes that you can choose as you 
proceed through the installation of the IP Phone 2002. The three 
configuration modes are:

• Static IP address (see “Static IP address assignment” on page 81)

• Dynamic Partial DHCP (see “Dynamic IP address assignment — 
Partial DHCP” on page 82)

• Dynamic Full DHCP (see “Dynamic IP address assignment — Full 
DHCP” on page 82)

5 A DHCP server and DHCP relay agents, if required, must also be 
installed, configured, and running.

End of Procedure

First-time installation

IP address assignments

During the first-time installation, there are IP address parameters that are 
entered either manually or automatically depending on the installation 
configuration. As well, you are prompted to enable or disable 802.1Q. For 
more information, see “802.1Q VLAN description” on page 407.

There are three configuration modes you can choose from to obtain the IP 
parameters. Review the following sections for more information on the 
configuration mode that you are using.

Static IP address assignment

During the installation, the IP Phone 2002 parameters are entered manually 
using the key pad.
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Your system administrator provides the following information: IP address, 
subnet mask, and the default Gateway.

You must also enter the Connect Server parameters including: IP address, 
port number, action, and retry count.

Go to Procedure 10, “Installing an IP Phone 2002 for the first time using 
manual configuration” on page 83.

Dynamic IP address assignment — Partial DHCP

For a partial DHCP installation, you must provide, through the IP Phone 2002 
key pad, the Connect Server parameters including: IP address, port number, 
action, and retry count. Other parameters (IP Phone IP address, subnet mask 
and default Gateway) are retrieved from the DHCP server.

The IP Phone 2002 password, node ID and TN must be entered manually 
from the key pad.

For more information about DHCP servers, see Converging the Data 
Network with VoIP (553-3001-160).

Go to Procedure 11, “Installing an IP Phone 2002 for the first time using 
DHCP” on page 88.

Dynamic IP address assignment — Full DHCP

For a full DHCP installation, all parameters (IP Phone IP address, subnet 
mask, default Gateway, Connect Server IP address, port number, action, and 
retry count) are retrieved from the DHCP server to recognize the IP Phone 
2002.

The IP Phone 2002 password, node ID, and TN must be entered manually 
from the key pad.

For more information on how to set up DHCP servers for use with the IP 
Phones, refer to Converging the Data Network with VoIP (553-3001-160).

Go to Procedure 11, “Installing an IP Phone 2002 for the first time using 
DHCP” on page 88.
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Procedure 10
Installing an IP Phone 2002 for the first time using 
manual configuration

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Phone 2002 on the system using LD 11.

For more information, see Software Input/Output: Administration 
(553-3001-311).

3 Connect the IP Phone 2002 components:

a. Connect one end of the handset cord to the handset jack on the back 
of the IP Phone (identified with a handset icon).

b. Connect the other end of the handset cord to the handset.

4 Choose one of the following connections:

• For an IP Phone not sharing LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the network interface 
located on the back of the IP Phone (identified with a LAN icon, see 
Figure 6). The other end of the CAT5 Ethernet cable plugs into the IP 
network.

• For an IP Phone sharing LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the network interface 
located on the back of the IP Phone (identified with a LAN icon, see 
Figure 6) and the other end to the IP network. Insert on end of a 
second CAT5 Ethernet cable into the PC network interface located on 
the back of the IP Phone (identified with a PC icon, see Figure 6) and 
the other end into the computer.

CAUTION
Damage to Equipment
Do not plug your IP Phone 2002 into any other port 
but the PC Ethernet port. Severe damage can result. 
Consult your system administrator to ensure that you 
plug your IP Phone into the PC Ethernet port.
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5 Power the IP Phone 2002 using either the Power over Ethernet or an AC 
power transformer (local power).

To use local power, plug the AC power transformer into the nearest 
power outlet. 

Figure 6
IP Phone 2002 Ethernet network interface connections

IMPORTANT!

Timing information
There are only four seconds between plugging in the IP Phone 2002 
power transformer and the appearance of the Nortel logo in the middle 
of the display. When you see the logo, you have one second to respond 
by pressing the four feature keys at the bottom of the display in 
sequence from left to right. If you miss the one-second response time, 
the IP Phone 2002 attempts to locate the connect server. Wait until it is 
finished, and then begin the power-up sequence again.

Network
Ethernet

PC
Ethernet
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Ensure the correct AC power transformer is used. The voltage rating of 
the transformer must match the wall outlet voltage. Refer to Table 8 on 
page 79. Connect the power jack as shown in Figure 6 on page 84. Be 
sure to thread the cord around the retaining hook to provide strain relief 
for a secure power connection.

6 When the Nortel logo appears in the middle of the display, immediately 
press the four feature keys at the bottom of the display in sequence from 
left to right.

7 At the prompt EAP enable?, select Yes. Enter DeviceID and Password. 
For more information on EAP, refer to Appendix C: “802.1x Port-based 
network access control” on page 415.

Note: If you select No, you will not be prompted to enter Device ID and 
Password.

8 At the prompt DHCP Yes/No?, select No.

9 Enter the following information provided by your system administrator:

10 Enter the information for the primary Connect Server (S1) and the 
secondary Connect Server (S2): 

Screen prompt Description

set IP A valid IP Phone 2002 IP address.

net msk A subnet mask.
def gw The default Gateway for the IP Phone 2002 on 

the LAN segment to which it is connected.

Screen prompt Description

S1 IP The node IP address of the IP line node.

S1 Port This is a fixed value: 4100

S1 action This is a fixed value: 1
S1 retry The number of times the IP Phone 2002 

attempts to connect to the server. Enter 
10.

S2 IP Same as S1 in most cases (see note 
below).

S2 Port Same as S1
S2 action Same as S1

S2 retry Same as S1
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Cfg XAS? (0-No,1-Yes) Default 1 (for Yes).

Note: If there is no External Application 
Server (XAS), enter 0 (for No). You will 
not be prompted to enter the XAS IP 
address.

XAS IP: Enter the IP address of the XAS server.

VLAN? (0-No, 1-Ma, 2-Au) Default 0 (for No)
802.1Q VLAN remains off until 
initialization continues.

For more information about VLAN 
configuration, refer to Converging the 
Data Network with VoIP 
(553-3001-160).

1-Ma
Enter a Voice VLAN ID, then press OK.

The following Voice VLAN ID displays:
Manual Cfg

VOICE VLAN ID: 1234

Note: The Voice VLAN ID is entered as 
an integer. The Voice VLAN ID is a 
12-bit value between 1 and 4095.

The IP Phone 2002 is configured with 
802.1Q enabled, the VOICE VLAN ID is 
configured to the entered value, and the 
VOICE VLAN priority = 6.

2-Au
Automatically enter a VLAN ID using 
DHCP. DHCP auto discovers the VLAN 
ID.
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Note 1: The IP Phone 2002 can support a primary (S1) and secondary 
(S2) connect server. If you require IP Phones to register on multiple 
nodes, refer to “Enhanced Redundancy for IP Line Nodes” in IP Line: 
Description, Installation, and Operation  (553-3001-365).

The IP Phone 2002 searches for the connect server. When the 
connection is complete, proceed with step 11.

VLANFILTER (0-No, 1-Yes)
Default 0 (for No)

You will not be prompted for 
VLANFILTER if VLAN? is not enabled.

Data VLAN?
(0 for No, 1 for Yes)

After the value is entered, the DATA 
VLAN configuration option appears on 
the display.

Enter 0 (for No)
Data VLAN is not present.

Enter 1 (for Yes)
Enter DATA VLAN to set the DATA VLAN 
ID, then press OK.
The following DATA VLAN ID displays:
DATA VLAN ID: 1234

Note: The DATA VLAN ID is entered as 
an integer. The DATA VLAN ID is a 
12-bit value between 0 and 4095, and 
should be different from the VOICE 
VLAN ID.

The IP Phone 2002 is configured with 
802.1Q enabled, the DATA VLAN ID is 
configured to the entered value, and the 
DATA VLAN priority = 0.

Duplex (0-Auto, 1-Full) Default 0 (for Auto)

GARP Ignore? (0-No,1-Yes) Default 0 (for No)
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11 Enter the following information provided by your system administrator:

The IP Phone 2002 registers with the Terminal Proxy Server (TPS) and, 
if needed, begins the firmware download. This takes several minutes. 
When download is complete, the IP Phone 2002 resets.

Note: The Enhanced UNIStim Firmware Download feature for IP Phones 
provides an improved method of delivering new firmware to IP Phones. 
For further information on Enhanced UNIStim Firmware Download, refer 
to IP Line: Description, Installation, and Operation  (553-3001-365).

The current system date and time appear on the top line of the display 
when the configuration is complete. Self-labeling keys also appear.

12 Check for dial tone and the correct DN above the display.

13 Secure the IP Phone footstand to the base of the IP Phone. Use the angle 
adjustment grip on the top back of the IP Phone to adjust the position.

14 (Optional) Customize the feature keys as required. For more information, 
see IP Phone 2002 User Guide.

End of Procedure

Procedure 11
Installing an IP Phone 2002 for the first time 
using DHCP

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Phone 2002 on the system using LD 11.

For more information, see Software Input/Output: Administration 
(553-3001-311).

Screen prompt Description

Password IP Phone Installer Password

You are not prompted to enter the IP Phone 
Installer Password if it has not been configured 
in your system.

Node The node ID.

TN The TN or VTN.
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3 Connect the IP Phone 2002 components:

a. Connect one end of the handset cord to the handset jack on the back 
of the IP Phone (identified with a handset icon).

b. Connect the other end of the handset cord to the handset.

4 Choose one of the following connections:

• For an IP Phone not sharing LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the network interface 
located on the back of the IP Phone (identified with a LAN icon, see 
Figure 7 on page 90). The other end of the CAT5 Ethernet cable 
plugs into the IP network.

• For an IP Phone sharing LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the network interface 
located on the back of the IP Phone (identified with a LAN icon, see 
Figure 7 on page 90) and the other end to the IP network. 

Insert one end of a second CAT5 Ethernet cable into the PC network 
interface located on the back of the IP Phone (identified with a PC 
icon, see Figure 7 on page 90) and the other end into the computer.
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5 Power the IP Phone 2002 using either the Power over Ethernet or an AC 
power transformer (local power).

Figure 7
IP Phone 2002 Ethernet network interface connections

IMPORTANT!

Timing information
There are only four seconds between plugging in the IP Phone 2002 
power transformer and the appearance of the Nortel logo in the middle 
of the display. When you see the logo, you have one second to respond 
by pressing the four feature keys at the bottom of the display in 
sequence from left to right. If you miss the one-second response time, 
the IP Phone 2002 attempts to locate the connect server. Wait until it is 
finished, and then begin the power-up sequence again.

Network
Ethernet

PC
Ethernet
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a. To use local power, plug the AC power transformer into the nearest 
power outlet. 

b. Ensure the correct AC power transformer is used. The voltage rating 
of the transformer must match the wall outlet voltage. Refer to Table 
8 on page 79. Connect the power jack as shown in Figure 6 on 
page 84. Be sure to thread the cord around the retaining hook to 
provide strain relief for a secure power connection.

6 When the Nortel logo appears in the middle of the display, immediately 
press the four feature keys at the bottom of the display in sequence from 
left to right.

7 At the prompt EAP enable?, select Yes. Enter DeviceID and Password. 
For more information on EAP, refer to Appendix C: “802.1x Port-based 
network access control” on page 415.

Note: If you select No, you will not be prompted to enter Device ID and 
Password.

8 At the prompt DHCP Yes/No?, select Yes.

9 Select Partial or Full DHCP.

a. If you select Full DHCP, then the following parameters are retrieved 
from the DHCP server:

— a valid IP Phone 2002 IP address

— a subnet mask

— the default Gateway for the IP Phone 2002 on the LAN segment 
to which it is connected

— the S1 node IP address of the IP line node

— the S1 action

— the S1 retry count (This is the number of times the IP Phone 
attempts to connect to the server.)

— the S2 node IP address of the IP line node

— the S2 action

— the S2 retry count

— the External Application Server (XAS) IP address
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b. If you select Partial DHCP, then you must enter the following 
parameters:

Screen prompt Description

S1 IP the node IP address of the IP line node
S1 Port this is a fixed value: 4100

S1 action this is a fixed value: 1

S1 retry the number of times the IP Phone 2002 
attempts to connect to the server; enter 
10

S2 IP same as S1 in most cases (see note 
below)

S2 Port same as S1

S2 action same as S1
S2 retry same as S1

Cfg XAS? (0-No,1-Yes) Default 1 (for Yes).

Note: If there is no External Application 
Server (XAS), enter 0 (for No). You will 
not be prompted to enter the XAS IP 
address.

XAS IP: Enter the IP address of the XAS server.

VLAN? (0-No, 1-Ma, 2-Au) Default 0 (for No)
802.1Q VLAN remains off until 
initialization continues.

For more information about VLAN 
configuration, refer to Converging the 
Data Network with VoIP (553-3001-160).



 Nortel IP Phone 2002  Page 93 of 508

IP Phones Description, Installation, and Operation

1-Ma
Enter a Voice VLAN ID, then press OK.

The following Voice VLAN ID displays:
Manual Cfg

VOICE VLAN ID: 1234

Note: The Voice VLAN ID is entered as 
an integer. The Voice VLAN ID is a 12-bit 
value between 1 and 4095.

The IP Phone 2002 is configured with 
802.1Q enabled, the VOICE VLAN ID is 
configured to the entered value, and the 
VOICE VLAN priority = 6.

2-Au
Automatically enter a VLAN ID using 
DHCP. DHCP auto discovers the VLAN 
ID.

VLANFILTER (0-No, 1-Yes)
Default 0 (for No)

You will not be prompted for 
VLANFILTER if VLAN? is not enabled.
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Note 1: The IP Phone 2002 can support a primary (S1) and secondary 
(S2) connect server. If you require IP Phones to register on multiple 
nodes, refer to “Enhanced Redundancy for IP Line Nodes” in IP Line: 
Description, Installation, and Operation  (553-3001-365).

The IP Phone 2002 searches for the connect server. When the 
connection is complete, proceed to step 10.

10 Enter the following information provided by your system administrator.

Data VLAN?
(0 for No, 1 for Yes)

After the value is entered, the DATA 
VLAN configuration option appears on 
the display.

Enter 0 (for No)
Data VLAN is not present.

Enter 1 (for Yes)
Enter DATA VLAN to set the DATA VLAN 
ID, then press OK.
The following DATA VLAN ID displays:
DATA VLAN ID: 1234

Note: The DATA VLAN ID is entered as 
an integer. The DATA VLAN ID is a 12-bit 
value between 0 and 4095, and should 
be different from the VOICE VLAN ID.

The IP Phone 2002 is configured with 
802.1Q enabled, the DATA VLAN ID is 
configured to the entered value, and the 
DATA VLAN priority = 0.

Duplex (0-Auto, 1-Full) Default 0 (for Auto)

GARP Ignore?(0-No,1-Yes) Default 0 (for No)

Screen prompt Description

Password IP Phone Installer Password

You are not prompted to enter the IP Phone 
Installer Password if it has not been 
configured in your system.
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The IP Phone 2002 registers with the TPS and, if needed, begins the 
firmware download. This takes several minutes. When complete, the 
IP Phone 2002 resets.

Note: The Enhanced UNIStim Firmware Download feature for IP Phones 
provides an improved method of delivering new firmware to IP Phones. 
For further information on Enhanced UNIStim Firmware Download, refer 
to IP Line: Description, Installation, and Operation  (553-3001-365).

The current system date and time appear on the top line of the display 
when the configuration is complete. Self-labeling keys also appear.

11 Check for dial tone and the correct DN above the display.

12 Secure the IP Phone footstand to the base of the IP Phone. Use the angle 
adjustment grip on the top back of the IP Phone to adjust the position. 

13 (Optional) Customize the feature keys as required. For more information, 
see IP Phone 2002 User Guide.

End of Procedure

Startup sequence
When an IP Phone 2002 is connected to the network, it must perform a startup 
sequence. The elements of the startup sequence include:

• obtaining the IP parameters

• finding a default Gateway server

• authenticating the user

See Table 9 for a summary of the IP parameters and how they are obtained.

Node the node ID

TN the TN or VTN
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Note: Your system administrator provides the network information for 
all static IP address assignments,.

Full Duplex mode
In the Configuration menu, Auto Negotiate mode is the default setting for 
initial startup. Typically, the IP Phone is connected to a network that supports 
Auto Negotiate, and it selects the best speed and duplex mode available. 
There is no intervention required under normal operation.

If the IP Phone is connected to a network configured for Full Duplex mode 
only, it is not able to automatically negotiate the proper configuration. 
Therefore, in this instance, to allow the IP Phone to work at the optimum 
speed and duplex mode, Auto Negotiate must be disabled. Use the following 
procedure to disable Auto Negotiate and enable Full Duplex mode.

Table 9
IP Phone 2002 IP parameters

Parameter Method of acquisition

IP Address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Net Mask Manually entered or automatically retrieved through 
Partial or Full DHCP.

Default Address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Connect Server (IP address, port, 
action and retry count — primary 
and secondary)

Manually entered or automatically retrieved through Full 
DHCP.

User ID (Node ID, Node Password 
and TN)

Manually entered for first-time configuration. Retrieved 
from local storage on subsequent power cycles.

Provided by your system administrator.
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Procedure 12
Disabling Auto Negotiate and enabling Full Duplex 
mode

1 Reset the phone by disconnecting and reconnecting power.

2 When the Nortel logo appears in the middle of the display, press each of 
the soft keys in sequence. See Procedure 10 on page 83.

3 If no other configuration changes are required, press the OK soft key 
repeatedly until the Duplex network option appears.

4 Select 1 to enable Full Duplex mode.

5 When the Speed option appears, select one of the following:

• 0 for 10 Mbps

• 1 for 100 Mbps (default)

6 Select OK to confirm the change.

7 Restart the IP Phone. The firmware reads the new setting, and the 
IP Phone operates in Full Duplex mode.

When the IP Phone is restarted, the firmware reads the setting for Full 
Duplex mode and sets both port 0, network interface port, and port 1, PC 
interface port, accordingly.

Use the following procedure to confirm activation of Full Duplex mode.

Procedure 13
Checking Ethernet Statistics

1 Double-click the Services key. The Network Diagnostics menu appears.

2 Select Ethernet Statistics.

• If Full Duplex mode is active, the following is displayed:

— Link: UP

— Duplex: Full

— Speed: 10 (Mb) or 100(Mb)

— Auto-Nego Capability: N

— Auto-Nego Completed: N

End of Procedure
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Gratuitous Address Resolution Protocol Protection
Gratuitous Address Resolution Protocol Protection (GARP) prevents the 
IP Phone 2002 from GARP Spoof attacks on the network. In a GARP Spoof 
attack, a malicious device on the network takes over an IP address (usually 
the default gateway) by sending unsolicited (or Gratuitous) ARP messages, 
thus manipulating the ARP table of the victim’s machine. This allows the 
malicious device to launch a variety of attacks on the network, resulting in 
undesired traffic routing. For example, a GARP attack can convince the 
victim machine that the malicious device is the default gateway. In this 
scenario, all traffic from the victim’s machine flows through the malicious 
device.

To enable GARP Protection during configuration, refer to Procedure 10, 
“Installing an IP Phone 2002 for the first time using manual configuration” 
on page 83 or Procedure 10, “Installing an IP Phone 2002 for the first time 
using DHCP” on page 88.

Extensible Authentication Protocol 
Extensible Authentication Protocol (EAP) is a general protocol that fulfills 
the protocol requirements defined by 802.1x. For further information on 
802.1x, refer to Appendix C: “802.1x Port-based network access control” on 
page 415.

Reinstalling an IP Phone 2002
You can reinstall an existing previously configured IP Phone 2002 on the 
same system. For example, the IP Phone 2002 can be assigned to a new user 
(new TN) or to an existing user who moved to a new subnet by changing the 
TN of the IP Phone 2002.

Procedure 14
Changing the TN of an existing IP Phone 2002

1 Repower the IP Phone 2002.

Note: During the reboot sequence of a previously configured IP Phone, 
the IP Phone 2002 displays the existing node number for approximately 5 
seconds.
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2 If node password is enabled and NULL, choose one of the following:

a. Disable password.

b. Set password as non-NULL.

3 Press OK when the node number displays.

4 Enter password at the password screen and press OK.

A TN screen displays.

5 Select the Clear soft key to clear the existing TN. 

End of Procedure

Replacing an IP Phone 2002 

Procedure 15
Replacing an IP Phone 2002 

1 Disconnect the IP Phone 2002 that you want to replace.

2 Follow either Procedure 10 on page 83 (static IP assignment) or 
Procedure 11 on page 88 (dynamic IP assignment) to install and 
configure the IP Phone 2002.

If Then

node password is enabled and is 
not NULL

a password screen displays. Go to 
step 4.

node password is disabled a TN screen displays. Go to 
step 5.

IMPORTANT!

Two IP Phones cannot share the same TN. You must remove the 
IP Phone 2002 that is currently using the TN.
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3 Enter the same TN and Node Number as the IP Phone 2002 you 
replaced. The system associates the new IP Phone 2002 with the existing 
TN.

End of Procedure

Removing an IP Phone 2002 from service

Procedure 16
Removing an IP Phone 2002 from service

1 Disconnect the IP Phone 2002 from the network or turn off the power.

Note: The service to the PC is disconnected as well if the PC is 
connected to the IP Phone 2002.

If the IP Phone 2002 was automatically configured, the DHCP lease 
expires and the IP address returns to the available pool.

2 In LD 11, OUT the TN.

End of Procedure
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Introduction
This section explains how to install and maintain the IP Phone 2004. For 
information on using the IP Phone 2004, see the IP Phone 2004 User Guide.

This section contains the following procedures:

• Procedure 17, “Pre-installation checklist” on page 115.

• Procedure 18, “Installing an IP Phone 2004 for the first time using 
manual configuration” on page 118.

• Procedure 19, “Installing an IP Phone 2004 for the first time using 
DHCP” on page 124.

• Table 20,”'Disabling Auto Negotiate and enabling Full Duplex mode” on 
page 132.

• Table 21, “Checking Ethernet Statistics” on page 132.

• Procedure 22, “Changing the TN of an existing IP Phone 2004” on 
page 133.

• Procedure 23, “Replacing an IP Phone 2004” on page 134.

• Procedure 24, “Removing an IP Phone 2004 from service” on page 135.

Note: After an IP Phone has been installed and configured, if power is 
to the phone is interrupted, re-entry of the IP parameters, Node Number, 
TN, or re-acquisition of firmware is not required. 

Description
The IP Phone 2004  brings voice and data to the desktop environment. It 
connects directly to the LAN through the Ethernet connection. 

The IP Phone 2004  translates voice into data packets for transport using 
Internet Protocol. A Dynamic Host Configuration Protocol (DHCP) server 
can be used to provide information that enables the IP Phone 2004  network 
connection, and connection to the Voice Gateway Media Card. The IP Phone 
2004  uses the customer’s IP network to communicate with the Call Server. 
The IP Phone 2004  components are shown in Figure 8 and described in 
Table 10 on page 103.
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Figure 8
IP Phone 2004 

Table 10
IP Phone 2004 components and functions (Part 1 of 5)

Component Function

Hold Press the Hold key to put an active call on 
hold. Press the line (DN) key beside the 
flashing LCD to return to the caller on hold.

Goodbye Press the Goodbye key to terminate an active 
call.
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Message Waiting Light/
Incoming Call Indicator

The Message Waiting Indicator turns ON to 
indicate that a message has been left for the 
user. This indicator also flashes when the set 
ringer is ON.

Programmable line DN/
feature keys
(self-labeled)

Programmable line (DN)/feature keys 
(self-labeled) are configured for various 
features on the IP Phones.

A steady LCD light beside a line (DN) key 
indicates the feature or line is active. A 
flashing LCD indicates the line is on hold or 
the feature is being programmed.

Soft keys (self-labeled) Soft keys (self-labeled) are located below the 
display area. The LCD label above the key 
changes, based on the active feature.

Note: A triangle before a key label indicates 
that the key is active.

Fixed feature keys Use these keys to access non-programmable 
standard features.

Expand to PC The Expand to PC key is used to access 
external server applications such as External 
Application Server.

Copy A fixed key reserved for future feature 
development. An audible non-working tone is 
generated along with a display message.

Table 10
IP Phone 2004 components and functions (Part 2 of 5)

Component Function



 Nortel IP Phone 2004  Page 105 of 508

IP Phones Description, Installation, and Operation

Services Press the Services key to access the 
following items:

• Telephone Options (see Notes 1 and 2):

— Volume Adjustment

— Contrast Adjustment

— Language

— Date/Time Format

— Display diagnostics

— Local Dialpad Tone

— Ring type

— Call timer

— OnHook Default Path

— Change Feature key Label

— Set Information

• Virtual Office Login and Virtual Office 
Logout (if Virtual Office is configured)

• Test Local Mode and Resume Local Mode 
(if Branch Office is configured)

Navigation keys Use the navigation keys to scroll through 
menus and lists in the display area.

Shift Press the Shift key to toggle between two 
feature key pages and access an additional six 
lines/features.

Inbox (Message) Press the Inbox (Message) key to access 
your voice mailbox.

Table 10
IP Phone 2004 components and functions (Part 3 of 5)

Component Function
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Quit Press the Quit key to end an active 
application. 

Pressing the Quit key does not affect the 
status of the calls currently on your IP Phone.

Directory Press the Directory key to access Directory 
services.

Mute Press the Mute key to listen to the receiving 
party without transmitting.

Press the Mute key again to return to a two 
way conversation.

The Mute key applies to Handsfree, Handset, 
and Headset microphones. 

The Mute LED flashes when the Mute option 
is in use.

Headset Press the Headset key to answer a call using 
the headset or to switch a call from the 
handset or Handsfree to the headset.

Volume control bar Use the Volume control bar to adjust the 
volume of the handset, headset, speaker, 
ringer, and Handsfree feature. 

Press the right side of the rocker bar to 
increase volume, the left side to decrease 
volume.

Table 10
IP Phone 2004 components and functions (Part 4 of 5)

Component Function
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Supported features
The IP Phone 2004  supports the following additional features:

• 802.1Q VLAN and 802.1P priority support, industry standards for 
managing bandwidth usage — full VLAN capability, including a 
manageable integrated switch in the IP Phone for VLAN and priority 
tagging for PC and IP Phone traffic

• 802.1x Port-based network access control, industry standard for passing 
Extensible Authentication Protocol (EAP) over a LAN

• integrated hardware to support power over Ethernet, for IEEE 802.3af 
standard power; also including support for PowerDsine Power over LAN 
Hub powering, and Cisco proprietary powering as tested with specific 
Cisco Ethernet switch equipment

• Extensible Authentication Protocol (EAP) 

• Gratuitous Address Resolution Protocol Protection (GARP) 

• VLAN filtering

• ability to change the feature key labels

Handsfree key Press the Handsfree key to activate 
handsfree.

The LED lights to indicate when the handsfree 
feature is active.

Note 1: If a call is presented while the user is manipulating an option, the 
IP Phone 2004 rings and the DN key flashes. However, the screen display 
is not updated with Caller ID information. The programming text is not 
disturbed.

Note 2: The user can originate a call using Autodial or Last Number 
Redial while manipulating an option. However, the display is not updated 
with the dialed digits or the Caller ID, and Autodial and Last Number 
Redial intercept the dialpad.

Table 10
IP Phone 2004 components and functions (Part 5 of 5)

Component Function
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• Corporate Directory

• Personal Directory

• Redial List

• Callers List

• Password Administration

• Virtual office

• Branch Office

• switch to support sharing LAN access with a PC or other data device

• 10/100 Mbps Full Duplex mode

• External Application Server (XAS)

• Both the registered and configured TNs are displayed in the Set Info 
menu.

• language support: English, French, Swedish, Danish, Norwegian, 
German, Dutch, Portuguese, Czech, Finnish, Hungarian, Italian, Polish, 
Spanish, Japanese, Russian, Latvian, and Turkish

• IP Key Expansion modules

Features not currently supported
The following features are not supported on the IP Phone 2004 :

• Live Dialpad

• Group Listening

• Set-to-Set messaging

• Context-sensitive soft keys

The three-port switch that is internal/external to the IP Phone 2004  is an 
unmanaged switch. It passes the packets (unmodified) and does not interpret 
the 802.1Q header. The three-port switch provides priority based on the port 
(that is, the IP Phone port traffic takes priority over the Ethernet).
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Display characteristics
An IP Phone 2004  has three major display areas: 

• programmable line (DN)/feature key label

• soft key label

• information line

Figure 9 on page 109 shows these three display areas.

Figure 9
IP Phone 2004  display areas
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Cleaning the IP Phone display screen

Gently wipe the IP Phone display screen with a soft, dry cloth.

Programmable line (DN)/feature key label display

The feature key label area displays a ten-character string for each of the four 
feature keys. Each feature key includes the key label and an icon. The icon 
state can be on, off, or flashing. Key labels are left-aligned for keys on the left 
side of the screen, and right-aligned for keys on the right side of the screen.

Note: If a label is longer than ten characters, the last ten characters are 
displayed, and the excess characters are deleted from the beginning of the 
string.

Soft key label display

A maximum of ten functions can be assigned to the soft keys. Your system 
administrator assigns functions to the soft keys in layers.

Use the More.. soft key to navigate through the layers of functions. If there 
are only four functions assigned to the soft keys, the More.. key does not 
appear and all four functions are displayed.

The soft key label has a maximum six characters. Each soft key includes the 
soft key label and an icon. When a soft key is in use, a flashing icon displays 
at the beginning of the soft key label, and the label shifts one character to the 
right. (If the label is six characters long, the last or rightmost character is 
truncated.) If a feature is enabled, the icon state turns to On. It remains in the 
on state until the feature key is pressed again. This cancels the enabled feature 
and turns the icon off, returning the soft key label to its original state. 

CAUTION
Do not use any liquids or powders on the IP Phone. 
Using anything other than a soft, dry cloth can 
contaminate IP Phone components and cause premature 
failure.
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Information line display

An IP Phone 2004  has a three-line information display area with the 
following information: 

• caller number

• caller name

• feature prompt strings

• user-entered digits

• date and time information (if the IP Phone is in an idle state) 

The information in the display area changes, according to the call processing 
state and active features.

Key number assignments
The IP Phone 2004  has four soft-labeled, predefined soft keys that are used 
to provide up to 10 features. Because they are predefined, the user cannot 
change the key number assignment. 

The Message key is numbered 16. Key numbers 17 to 31 are the four soft-key 
labels below the display area. See Figure 8 on page 103.

Key numbers 17 to 31 support the features A03, A06, CFW, CHG, CPN, 
PRK, PRS, RGA, RNP, SCC, SCU, SSC, SSU and TRN, as listed in Table 11 
on page 112.

Table 11 describes the IP Phone assignment functions for each of the 
dedicated keys. Use LD 11 to program keys 16 to 26 on the IP Phone 2004 .



Page 112 of 508  Nortel IP Phone 2004

553-3001-368 Standard 12.00 March 2006

Note: If you attempt to configure anything other than the permitted 
response, the system generates an error code.  

Table 11
IP Phone 2004  soft keys (Part 1 of 2)

Key number  Response Description

Key 16 MWK

NUL

Message Waiting key

Removes function or feature from key

Key 17 TRN

NUL

Call Transfer key

Removes function or feature from key

Key 18 A03

A06

NUL

Three-party conference key

Six-party conference key

Removes function or feature from key

Key 19 CFW

NUL

Call Forward key

Removes function or feature from key

Key 20 RGA

NUL

Ring Again key

Removes function or feature from key

Key 21 PRK

NUL

Call Park key

Removes function or feature from key

Key 22 RNP

NUL

Ringing Number Pickup key

Removes function or feature from key

Key 23 SCU

SSU

SCC

SSC

NUL

Speed Call User

System Speed Call User

Speed Call Controller

System Speed Call Controller

Removes function or feature from key
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Package components
The following information applies to Phase II IP Phones. Product codes for 
Phase II IP Phones are different from previous sets.

See the product code on the back of the phone to confirm whether it is a 
Phase II IP Phone. The product code for Phase II IP Phones appears as 
“IP Phone 200x”. The product code for previous versions of the IP Phone 
appears with an “i” in front of the model number (for example, “i200x”). 

The AC power adapter must be ordered separately if local power using the 
AC adapter is required, because Phase II IP Phones include integrated support 
for a number of power over LAN options, including support for IEEE 802.3af 
standard power.

Key 24 PRS

NUL

Privacy Release key

Removes function or feature from key

Key 25 CHG

NUL

Charge Account key

Removes function or feature from key

Key 26 CPN

NUL

Calling Party Number key

Removes function or feature from key

Table 11
IP Phone 2004  soft keys (Part 2 of 2)

Key number  Response Description
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Table 12 lists the IP Phone 2004  package components and product codes.

Table 12
IP Phone 2004  component list (Part 1 of 2)

IP Phone 2004 package contents includes

• IP Phone 2004 

• Handset

• Handset cord

• Footstand

• 7 ft. Ethernet cable

• Getting Started card

IP Phone 2004 (Ethergray) with Icon keycaps NTDU92AA16/
A0533408

IP Phone 2004 (Ethergray) with English text label keycaps NTDU92BA16/
A0533409

IP Phone 2004 (Charcoal) with Icon keycaps NTDU92AA70/
A0533410

IP Phone 2004 (Charcoal) with English text label keycaps NTDU92BA70/
A0533411

IP Phone 2004 wall mount kit (Charcoal), used with Ethergray and 
Charcoal models

NTMN15BA70/
A0503076

Replacement parts

7 ft. Ethernet Cat5 cable A0648375

Handset (Ethergray) A0788874

Handset (Charcoal) A0758634

Handset cord (Ethergray) A0788682

Handset cord (Charcoal) N0000764

Footstand (Charcoal), used for Ethergray and Charcoal models A0538587

IP Phone 2004 Power Adaptors
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For more information, and for information about previous versions of the IP 
Phone, contact Nortel. 

Before you begin
The following section provides a step-by-step guide through the 
IP Phone 2004 installation process. Before installing the IP Phone 2004, 
complete the following pre-installation checklist.

Procedure 17
Pre-installation checklist

1 Ensure there is one IP Phone 2004  boxed package for each IP Phone 
2004  being installed. The package contains:

• IP Phone 2004 

• Handset

• Handset cord

• Footstand

• 2.3 m (7 foot) Ethernet cable, Category 5

• Getting Started card

2 To install and configure an IP Phone 2004 , the host system must be 
installed with the Voice Gateway Media Card.

Power transformer (117/120 VAC 50/60 Hz) (North America) A0619627

Power transformer 3 prong AC to AC, direct plug-in, 8W, 240 VAC, 
50Hz to 16 VAC at 500 mA (Ireland and UK)

A0656598

Power transformer AC to AC, direct plug-in, 8W, 230 VAC, 50/60 Hz, 
to 16 VAC at 500 mA (Europe)

A0619635

Power transformer 2 prong wall plug direct plug-in AC to AC, 8W, 
240 VAC, 50 Hz, to 16 VAC at 500 mA (Australia and New Zealand)

A0647042

Power transformer AC to AC, direct plug-in, 8W, 100 VAC, 50 Hz, to 
16 VAC at 500 mA

A0828858

Table 12
IP Phone 2004  component list (Part 2 of 2)
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3 If an AC power adapter is required, make sure you use the correct AC 
power transformer. The voltage rating of the transformer must match the 
wall outlet voltage. Refer to Table 12 on page 114.

4 Understand the three configuration modes that you can choose from as 
you proceed through the installation of the IP Phone 2004 . The three 
configuration modes are:

• Static IP address – see “Static IP address assignment” on page 117.

• Dynamic Partial DHCP – see “Dynamic IP address assignment — 
Partial DHCP” on page 117.

• Dynamic Full DHCP – see “Dynamic IP address assignment — Full 
DHCP” on page 117.

5 A DHCP server and DHCP relay agents, if required, must also be 
installed, configured, and running.

End of Procedure

First-time installation
To install and configure an IP Phone 2004 , you must first install a Voice 
Gateway Media Card in the system.

IP address assignments

During the first-time installation, there are IP address parameters that are 
entered either manually or automatically depending on the installation 
configuration. As well, you are prompted to enable or disable 802.1Q. For 
more information, see “802.1Q VLAN description” on page 407.

The three configuration modes for the IP Phone 2004  are described below.

CAUTION
Damage to Equipment
Do not plug your IP Phone 2004  into an ISDN 
connection. Severe damage can result. Consult your 
system administrator to ensure that you are plugging 
your IP Phone into a 10/100BaseT Ethernet jack.
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Static IP address assignment

During the installation, the IP Phone 2004  parameters are entered manually 
using the key pad.

Your system administrator provides the following information: IP address, 
subnet mask, and default Gateway.

You must also enter the Connect Server parameters including: IP address, 
port number, action, and retry count.

Go to Procedure 18, “Installing an IP Phone 2004 for the first time using 
manual configuration” on page 118.

Dynamic IP address assignment — Partial DHCP

For a partial DHCP installation, you must provide, through the IP Phone’s 
key pad, the Connect Server parameters including: IP address, port number, 
action, and retry count. Other parameters (IP Phone IP address, subnet mask, 
and default Gateway) are retrieved from the DHCP server.

The IP Phone password, node ID and TN must be entered manually from the 
key pad.

For more information about DHCP servers, see Converging the Data 
Network with VoIP (553-3001-160).

Go to Procedure 19, “Installing an IP Phone 2004 for the first time using 
DHCP” on page 124.

Dynamic IP address assignment — Full DHCP

For a full DHCP installation, all parameters (IP Phone IP address, subnet 
mask, default Gateway, Connect Server IP address, port number, action, and 
retry count) are retrieved from the DHCP server to recognize the 
IP Phone 2004.

The IP Phone 2004  password, node ID and TN must be entered manually 
from the key pad.
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Go to Procedure 19, “Installing an IP Phone 2004 for the first time using 
DHCP” on page 124.

Procedure 18
Installing an IP Phone 2004 for the first time using 
manual configuration 

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Phone 2004 on the system using LD 11.

For more information, see Software Input/Output: Administration 
(553-3001-311).

3 Connect the IP Phone 2004 components:

a. Connect one end of the handset cord to the handset jack on the back 
of the IP Phone (identified with a handset icon).

b. Connect the other end of the handset cord to the handset.

4 Choose one of the following connections:

• For an IP Phone not sharing a LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the LAN Ethernet 
port located on the back of the IP Phone 2004 (identified with a LAN 
icon). The other end of the CAT5 Ethernet cable plugs into the IP 
network.

• For an IP Phone sharing a LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the LAN Ethernet 
port located on the back of the IP Phone (identified with a LAN icon, 
see Figure 10 on page 119) and the other end to the IP network. 
Insert one end of a second CAT5 Ethernet cable into the PC Ethernet 
port located on the back of the IP Phone (identified with a PC icon, 
see Figure 10 on page 119) and the other end into the computer.
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Figure 10
IP Phone 2004 Ethernet network connections 

CAUTION
Damage to Equipment
Do not plug your IP Phone 2004 into any port but the 
PC Ethernet port. Severe damage can result. Consult 
your system administrator to ensure that you are 
plugging your IP Phone into the PC Ethernet port.
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5 Power the IP Phone 2004 using either the Power over Ethernet or an AC 
power transformer (local power).

a. To use local power, plug the AC power transformer into the nearest 
power outlet. 

b. Ensure the correct AC power transformer is used. The voltage rating 
of the transformer must match the wall outlet voltage. Refer to Table 
12 on page 114. Connect the AC power transformer to the power 
adapter jack (see Figure 10 on page 119).

6 When the Nortel logo appears in the middle of the display, immediately 
press the four feature keys at the bottom of the display in sequence from 
left to right.

7 At the prompt EAP enable?, select Yes. Enter DeviceID and Password. 
For more information on EAP, refer to Appendix C: “802.1x Port-based 
network access control” on page 415.

Note: If you select No, you will not be prompted to enter Device ID and 
Password.

8 At the prompt DHCP Yes/No?, select No.

9 Enter the following information provided by your system administrator:

IMPORTANT!

Timing information
There are only four seconds between plugging in the IP Phone 2004  
power transformer and the appearance of the Nortel logo in the middle 
of the display. When you see the logo, you have one second to respond 
by pressing the four feature keys at the bottom of the display in 
sequence from left to right. If you miss the one-second response time, 
the IP Phone 2004 attempts to locate the connect server. Wait until it is 
finished, and then begin the power-up sequence again.

Screen prompt Description

set IP a valid IP Phone 2004 IP address

net msk a subnet mask

def gw the default Gateway for the IP Phone 2004 on 
the LAN segment to which it is connected
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10 Enter the information for the primary Connect Server (S1) and the 
secondary Connect Server (S2): 

Screen prompt Description

S1 IP the node IP address of the IP line node
S1 Port this is a fixed value: 4100

S1 action this is a fixed value: 1

S1 retry the number of times the IP Phone 2004  
attempts to connect to the server (Enter 
10)

S2 IP same as S1 in most cases (see note 
below)

S2 Port same as S1

S2 action same as S1
S2 retry same as S1

Cfg XAS? (0-No,1-Yes) Default 1 (for Yes).

Note: If there is no External 
Application Server (XAS), enter 0 (for 
No). You will not be prompted to enter 
the XAS IP address.

XAS IP: Enter the IP address of the XAS server.

VLAN? (0-No, 1-Ma, 2-Au) Default 0 (for No)
802.1Q VLAN remains off until 
initialization continues.

For more information about VLAN 
configuration, refer to Converging the 
Data Network with VoIP 
(553-3001-160).
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1-Ma
Enter a Voice VLAN ID, then press OK.

The following Voice VLAN ID displays:
Manual Cfg

VOICE VLAN ID: 1234

Note: The Voice VLAN ID is entered as 
an integer. The Voice VLAN ID is a 
12-bit value between 1 and 4095.

The IP Phone 2004  is configured with 
802.1Q enabled, the VOICE VLAN ID is 
configured to the entered value, and the 
VOICE VLAN priority = 6.

2-Au
Automatically enter a VLAN ID using 
DHCP. DHCP auto discovers the VLAN 
ID.

VLANFILTER (0-No, 1-Yes)
Default 0 (for No)

You will not be prompted for 
VLANFILTER if VLAN? is not enabled.
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Note 1: The IP Phone 2004  can support a primary (S1) and secondary 
(S2) connect server. If you require IP Phones to register on multiple 
nodes, refer to “Enhanced Redundancy for IP Line Nodes” in IP Line: 
Description, Installation, and Operation  (553-3001-365).

The IP Phone 2004  searches for the connect server. When the 
connection is complete, proceed with step 11.

Data VLAN? (0-No, 1-Yes) After the value is entered, the DATA 
VLAN configuration option appears on 
the display.

Enter 0 (for No)
Data VLAN is not present.

Enter 1 (for Yes)
Enter DATA VLAN to set the DATA 
VLAN ID, then press OK.
The following DATA VLAN ID displays:
DATA VLAN ID: 1234

Note: The DATA VLAN ID is entered as 
an integer. The DATA VLAN ID is a 
12-bit value between 0 and 4095, and 
should be different from the VOICE 
VLAN ID.

The IP Phone 2004  is configured with 
802.1Q enabled, the DATA VLAN ID is 
configured to the entered value, and the 
DATA VLAN priority = 0.

Duplex (0-Auto, 1-Full) Default 0 (for Auto)

GARP Ignore? (0-No,1-Yes) Default 0 (for No)
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11 Enter the following information provided by your system administrator:

12 The IP Phone 2004 registers with the TPS and, if needed, begins the 
firmware download. This takes several minutes. When registration is 
complete, the IP Phone 2004 resets.

Note: The Enhanced UNIStim Firmware Download feature for IP Phones 
provides an improved method of delivering new firmware to IP Phones. 
For further information on Enhanced UNIStim Firmware Download, refer 
to IP Line: Description, Installation, and Operation  (553-3001-365).

The current system date and time appear on the top line of the display 
when the configuration is complete. Self-labeling keys also appear.

13 Check for dial tone and the correct DN above the display.

14 Secure the IP Phone footstand to the base of the IP Phone. Use the angle 
adjustment grip on the top back of the IP Phone to adjust the position.

15 (Optional) Customize the feature keys as required. For more information, 
see IP Phone 2004 User Guide.

End of Procedure

Procedure 19
Installing an IP Phone 2004 for the first time 
using DHCP

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Phone 2004 on the system using LD 11.

For more information, see Software Input/Output: Administration 
(553-3001-311).

Screen prompt Description

Password  IP Phone Installer Password

You are not prompted to enter the IP Phone 
Installer Password if it has not been configured 
in your system.

Node The node ID.

TN The TN or VTN.
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3 Connect the IP Phone 2004 components:

a. Connect one end of the handset cord to the handset jack on the back 
of the IP Phone (identified with a handset icon).

b. Connect the other end of the handset cord to the handset.

4 Choose one of the following connections:

a. For an IP Phone not sharing a LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the LAN ethernet 
port located on the back of the IP Phone (identified with a LAN icon). 
The other end of the CAT5 Ethernet cable plugs into the IP network.

b. For an IP Phone sharing a LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the LAN Ethernet 
port located on the back of the IP Phone (identified with a LAN icon, 
see Figure 10 on page 119) and the other end to the IP network. 
Insert one end of a second CAT5 Ethernet cable into the PC Ethernet 
port located on the back of the IP Phone (identified with a PC icon, 
see Figure 10 on page 119) and the other end into the computer.

CAUTION
Damage to Equipment
Do not plug your IP Phone 2004 into any port but the 
PC Ethernet port. Severe damage can result. Consult 
your system administrator to ensure that you are 
plugging your IP Phone into the PC Ethernet port.

IMPORTANT!

Timing information
There are only four seconds between plugging in the IP Phone 2004  
power transformer and the appearance of the Nortel logo in the middle 
of the display. When you see the logo, you have one-second to respond 
by pressing the four feature keys at the bottom of the display in 
sequence from left to right. If you miss the one second response time, 
the IP Phone 2004 attempts to locate the connect server. Wait until it is 
finished, and then begin the power-up sequence again.
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5 Power the IP Phone 2004 using either the Power over Ethernet or an AC 
power transformer (local power).

a. To use local power, plug the AC power transformer into the nearest 
power outlet. 

b. Ensure the correct AC power transformer is used. The voltage rating 
of the transformer must match the wall outlet voltage. Refer to 
Table 12 on page 114. Connect the AC power transformer to the 
power adapter jack (see Figure 10 on page 119).

6 When the Nortel logo appears in the middle of the display, immediately 
press the four feature keys at the bottom of the display in sequence from 
left to right.

7 At the prompt EAP enable?, select Yes. Enter DeviceID and Password. 
For more information on EAP, refer to Appendix C: “802.1x Port-based 
network access control” on page 415.

Note: If you select No, you will not be prompted to enter Device ID and 
Password.

8 At the prompt DHCP Yes/No?, select Yes.

9 Select Partial or Full DHCP.

a. If you select Full DHCP, then the following parameters are retrieved 
from the DHCP server:

— a valid IP Phone 2004 IP address

— a subnet mask

— the default Gateway for the IP Phone 2004 on the LAN segment 
to which it is connected

— the S1 node IP address of the IP line node

— the S1 Action

— the S1 retry count. This is the number of times the IP Phone 
attempts to connect to the server

— the S2 node IP address of the IP line node

— the S2 Action

— the S2 retry count

— the External Application Server (XAS) IP address
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b. If you select Partial DHCP, then you must enter the following 
parameters: 

Screen prompt Description

S1 IP The node IP address of the IP line 
node.

S1 Port This is a fixed value: 4100

S1 action This is a fixed value: 1

S1 retry The number of times the IP Phone 
2004  attempts to connect to the 
server. Enter 10.

S2 IP Same as S1 in most cases (see 
note below)

S2 Port Same as S1

S2 action Same as S1
S2 retry Same as S1

Cfg XAS? (0-No,1-Yes) Default 1 (for Yes).

Note: If there is no External 
Application Server (XAS), enter 0 
(for No). You will not be prompted 
to enter the XAS IP address.

XAS IP: Enter the IP address of the XAS 
server.

VLAN? (0-No, 1-Ma, 2-Au) Default 0 (for No)
802.1Q VLAN remains off until 
initialization continues.

For more information about VLAN 
configuration, refer to Converging 
the Data Network with VoIP 
(553-3001-160).
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1-Ma
Enter a Voice VLAN ID, then press 
OK.

The following Voice VLAN ID 
displays:
Manual Cfg

VOICE VLAN ID: 1234

Note: The Voice VLAN ID is 
entered as an integer. The Voice 
VLAN ID is a 12-bit value between 
1 and 4095.

The IP Phone 2004 is configured 
with 802.1Q enabled, the VOICE 
VLAN ID is configured to the 
entered value, and the VOICE 
VLAN priority = 6.

2-Au
Automatically enter a VLAN ID 
using DHCP. DHCP auto 
discovers the VLAN ID.

VLANFILTER (0-No, 1-Yes)
Default 0 (for No)

You will not be prompted for 
VLANFILTER if VLAN? is not 
enabled.
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Note 1: The IP Phone 2004 can support a primary (S1) and secondary 
(S2) connect server. If you require IP Phones to register on multiple 
nodes, refer to “Enhanced Redundancy for IP Line Nodes” in IP Line: 
Description, Installation, and Operation  (553-3001-365).

The IP Phone 2004 searches for the connect server. When the 
connection is complete, proceed to step 10.

Data VLAN? (0 for No, 1 for Yes) After the value is entered, the 
DATA VLAN configuration option 
appears on the display.

Enter 0 (for No)
Data VLAN is not present.

Enter 1 (for Yes)
Enter DATA VLAN to set the DATA 
VLAN ID, then press OK.
The following DATA VLAN ID 
displays:
DATA VLAN ID: 1234

Note: The DATA VLAN ID is 
entered as an integer. The DATA 
VLAN ID is a 12-bit value between 
0 and 4095, and should be 
different from the VOICE VLAN ID.

The IP Phone 2004 is configured 
with 802.1Q enabled, the DATA 
VLAN ID is configured to the 
entered value, and the DATA 
VLAN priority = 0.

Duplex (0-Auto, 1-Full) Default 0 (for Auto)

GARP Ignore? (0-No,1-Yes) Default 0 (for No)
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10 Enter the following information provided by your system administrator.

The IP Phone 2004 registers with the TPS and, if needed, will begin the 
firmware download. This takes several minutes. When the download is 
complete, the IP Phone 2004 resets.

Note: The Enhanced UNIStim Firmware Download feature for IP Phones 
provides an improved method of delivering new firmware to IP Phones. 
For further information on Enhanced UNIStim Firmware Download, refer 
to IP Line: Description, Installation, and Operation  (553-3001-365).

The current system date and time appear on the top line of the display 
when the configuration is complete. Self-labeling keys also appear.

11 Check for dial tone and the correct DN above the display.

12 Secure the IP Phone footstand to the base of the IP Phone. Use the angle 
adjustment grip on the top back of the IP Phone to adjust the position. 

13 (Optional) Customize the feature keys as required. For more information, 
see IP Phone 2004 User Guide.

End of Procedure

Startup sequence
When an IP Phone 2004 is connected to the network, it must perform a startup 
sequence. The elements of the startup sequence include:

• obtaining the IP parameters

• finding a default Gateway server

• authenticating the user

Screen prompt Description

Password IP Phone Installer Password

You are not prompted to enter the IP Phone 
Installer Password if it has not been 
configured in your system.

Node The node ID

TN The TN or VTN
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See Table 13 on page 131 for a summary of the IP parameters and how they 
are obtained.

Note: For all IP static assignments, your system administrator provides 
the network information.

Full Duplex mode
In the Configuration menu, Auto Negotiate mode is the default setting for 
initial startup. Typically, the IP Phone is connected to a network that supports 
Auto Negotiate, and it selects the best speed and duplex mode available. 
There is no intervention required under normal operation.

If the IP Phone 2004 is connected to a network configured for Full Duplex 
mode only, it is not able to automatically negotiate the proper configuration. 
Therefore, in this instance, to allow the IP Phone 2004 to work at the optimum 
speed and duplex mode, Auto Negotiate must be disabled. Use the following 
procedure to disable Auto Negotiate and enable Full Duplex mode.

Table 13
IP Phone 2004 IP parameters

Parameter Method of Acquisition

IP Address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Net Mask Manually entered or automatically retrieved through 
Partial or Full DHCP.

Default Address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Connect Server (IP address, port, 
action and retry count — primary 
and secondary)

Manually entered or automatically retrieved through Full 
DHCP.

User ID (Node ID, Node Password 
and TN)

Manually entered for first-time configuration. Retrieved 
from local storage on subsequent power cycles.

Provided by your system administrator.
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Procedure 20
Disabling Auto Negotiate and enabling Full Duplex 
mode

1 Reset the IP Phone 2004 by disconnecting and reconnecting power.

2 When the Nortel logo appears in the middle of the display, press each of 
the soft keys in sequence. See Procedure 19 on page 124.

3 If no other configuration changes are required, press OK repeatedly until 
the Duplex network option appears.

4 Select 1 to enable Full Duplex mode.

5 When the Speed option appears, select one of the following:

• 0 for 10 Mbps

• 1 for 100 Mbps (default)

6 Select OK to confirm the change.

7 Restart the IP Phone 2004. The firmware reads the new setting, and the 
IP Phone operates in Full Duplex mode.

When the IP Phone 2004 is restarted, the firmware reads the setting for 
Full Duplex mode and sets both port 0, network interface port, and port 1, 
PC interface port, accordingly.

Use the following procedure to confirm activation of Full Duplex mode.

Procedure 21
Checking Ethernet Statistics

1 Double-click the Services key. The Network Diagnostics menu appears.

2 Select Ethernet Statistics.

• If Full Duplex mode is active, the following is displayed:

— Link: UP

— Duplex: Full

— Speed: 10 (Mb) or 100(Mb)

— Auto-Nego Capability: N

— Auto-Nego Completed: N

End of Procedure
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Gratuitous Address Resolution Protocol Protection
Gratuitous Address Resolution Protocol Protection (GARP) prevents the 
IP Phone 2004 from GARP Spoof attacks on the network. In a GARP Spoof 
attack, a malicious device on the network takes over an IP address (usually 
the default gateway) by sending unsolicited (or Gratuitous) ARP messages, 
thus manipulating the ARP table of the victim’s machine. This allows the 
malicious device to launch a variety of attacks on the network, resulting in 
undesired traffic routing. For example, a GARP attack can convince the 
victim machine that the malicious device is the default gateway. In this 
scenario, all traffic from the victim’s machine flows through the malicious 
device.

To enable GARP Protection during configuration, refer to Procedure 18, 
“Installing an IP Phone 2004 for the first time using manual configuration” 
on page 118 or Procedure 18, “Installing an IP Phone 2004 for the first time 
using DHCP” on page 124.

Extensible Authentication Protocol 
Extensible Authentication Protocol (EAP) is a general protocol that fulfills 
the protocol requirements defined by 802.1x. For further information on 
802.1x, refer to Appendix C: “802.1x Port-based network access control” on 
page 415.

Reinstalling an IP Phone 2004 
You can reinstall an existing previously configured IP Phone 2004 on the 
same system. For example, the IP Phone 2004 can be assigned to a new user 
(new TN) or to an existing user who moved to a new subnet by changing the 
TN of the IP Phone 2004.

Procedure 22
Changing the TN of an existing IP Phone 2004 

1 Repower the IP Phone 2004.

Note: During the reboot sequence of a previously configured IP Phone, 
the IP Phone 2004 displays the existing node number for approximately 
five seconds.



Page 134 of 508  Nortel IP Phone 2004

553-3001-368 Standard 12.00 March 2006

2 If node password is enabled and NULL, choose one of the following:

a. Disable password.

b. Set password as non-NULL.

3 Press OK when the node number displays.

4 Enter password at the password screen, and press OK.

A TN screen displays.

5 Select the Clear soft key to clear the existing TN. 

End of Procedure

Replacing an IP Phone 2004 

Procedure 23
Replacing an IP Phone 2004 

1 Disconnect the IP Phone 2004 that you want to replace.

2 Follow Procedure 18 on page 118 (static IP assignment) or Procedure 19 
on page 124 (dynamic IP assignment) to install and configure the 
IP Phone 2004.

If Then

node password is enabled and is 
not NULL

a password screen displays. Go to 
step 4.

node password is disabled a TN screen displays. Go to 
step 5.

IMPORTANT!

Two IP Phones cannot share the same TN. You must remove the 
IP Phone 2004 that is currently using the TN.
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3 Enter the same TN and Node Number as the IP Phone 2004 you 
replaced. The system associates the new IP Phone 2004 with the existing 
TN.

End of Procedure

Removing an IP Phone 2004 from service

Procedure 24
Removing an IP Phone 2004 from service

1 Disconnect the IP Phone 2004 from the network or turn the power off.

Note: The service to the PC is disconnected as well if the PC is 
connected to the IP Phone 2004.

If the IP Phone 2004 was automatically configured, the DHCP lease 
expires and the IP address returns to the available pool.

2 In LD 11, OUT the TN.

End of Procedure
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Introduction
This section explains how to install and maintain the IP Phone 2007. For 
information on using the IP Phone 2007, see the IP Phone 2007 User Guide.

This section contains the following procedures:

• Procedure 25, “Pre-installation checklist” on page 157.

• Procedure 26, “Installing an IP Phone 2007 for the first time using 
manual configuration” on page 159.

• Procedure 27, “Installing an IP Phone 2007 for the first time using 
DHCP” on page 166.

• Table 28,”'Disabling Auto Negotiate and enabling Full Duplex mode” on 
page 175.

• Table 29, “Checking Ethernet Statistics” on page 175.

• Procedure 30, “Changing the TN of an existing IP Phone 2007” on 
page 177.

• Procedure 31, “Replacing an IP Phone 2007” on page 178.

• Procedure 32, “Removing an IP Phone 2007 from service” on page 178.

Note: After an IP Phone has been installed and configured, if power to 
the phone is interrupted, re-entry of the IP parameters, Node Number, 
TN, or re-acquisition of firmware is not required. 

Description
The IP Phone 2007 brings voice and data to the desktop environment. It 
connects directly to the LAN through the Ethernet connection. 

The IP Phone 2007 translates voice into data packets for transport using 
Internet Protocol. A Dynamic Host Configuration Protocol (DHCP) server 
can be used to provide information that enables the IP Phone 2007 network 
connection, and connection to the Voice Gateway Media Card. The 
IP Phone 2007 uses the customer’s IP network to communicate with the Call 
Server.
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The IP Phone 2007 supports the following features:

• 12 programmable feature soft keys

• four soft keys (self-labeled) providing access to a maximum of ten 
features

• speaker for on-hook dialing or on-hook listening

• volume control bar for adjusting ringer, speaker, handset, and headset 
volume

• four call processing fixed keys: 

— Hold

— Goodbye

— Handsfree

— Mute

• shared LAN access with a PC

• headset jack with On/Off key

• automatic network configuration

• hearing-aid compatibility

• remote firmware download

• TFTP Server based firmware upgrades

• Enhanced UNIStim firmware upgrades

• USB mouse and keyboard support

• USB port support

• large, color touch panel display screen

• web-based applications support

• Password protection
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The IP Phone 2007 supports the following additional features:

• 802.1Q VLAN and Layer 2 priority bit support, an industry standard for 
managing bandwidth usage — full VLAN capability, including a 
manageable integrated switch in the IP Phone for VLAN and priority 
tagging for PC and IP Phone traffic

• integrated hardware to support power over Ethernet, for IEEE 802.3af 
standard power; also including support for PowerDsine Power over LAN 
Hub powering, and Cisco proprietary powering as tested with specific 
Cisco Ethernet switch equipment

• Gratuitous Address Resolution Protocol Protection (GARP) 

• ability to change the feature key labels

Note: Feature keys will support English characters only.

• language support: English, French, Swedish, Danish, Norwegian, 
German, Dutch, Portuguese, Czech, Finnish, Hungarian, Italian, Polish, 
Spanish, Japanese, Russian, Latvian, and Turkish

The IP Phone 2007 provides a large, color touch panel display that supports 
color XML/HTML content through an external application server.

Touch panel

You perform point and click operations on your IP Phone 2007 using the 
touch panel. The touch panel is used with the graphical user interface (GUI) 
to present soft keys directly on the display. You can activate all Line/DN keys 
and feature soft keys by using the touch panel.

Calibrate the touch panel

Calibrate the touch panel through the Tools menu, which enables you to fine- 
tune the touch panel. You are prompted to use the stylus to tap three targets. 
For further information, see Procedure 26, “Installing an IP Phone 2007 for 
the first time using manual configuration” on page 159 or Procedure 27, 
“Installing an IP Phone 2007 for the first time using DHCP” on page 166.

Stylus

Operate the touch panel using a stylus or your finger. However, use of a stylus 
is recommended to avoid damage to the touch panel.
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Cleaning the IP Phone display screen

Press the Goodbye key and the gently wipe the IP Phone display screen with 
a soft, dry cloth.

Figure 11
IP Phone 2007

CAUTION
Do not use any liquids or powders on the IP Phone. 
Using anything other than a soft, dry cloth can 
contaminate IP Phone components and cause premature 
failure.
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Table 14
IP Phone 2007 components and functions (Part 1 of 3)

Component Function

Hold Press the Hold key to put an active call on hold. Tap the 
flashing line (DN) soft key to return to the caller on hold.

Goodbye Press the Goodbye key to terminate an active call.

Handsfree Press the Handsfree key to activate handsfree.

The LED lights to indicate when the handsfree feature is 
active.

Headset Press the Headset key to answer a call using the headset or 
to switch a call from the handset or handsfree to the 
headset.

Mute Press the Mute key to listen to the receiving party without 
transmitting. Press the Mute key again to return to a two 
way conversation. The Mute key applies to handsfree, 
handset, and headset microphones. 

The Mute LED flashes when the Mute option is in use.

Volume control bar Use the Volume control bar to adjust the volume of the 
ringer, handset, headset, speaker, and the Handsfree 
feature. 

Press the right side of the rocker bar to increase volume, the 
left side to decrease volume.

Message waiting light/
incoming call indicator

The Message waiting indicator turns ON to indicate that a 
message has been left for the user. This indicator also 
flashes when the set ringer is ON.

Programmable line DN/
feature keys
(self-labeled)

Programmable line (DN)/feature keys (self-labeled) are 
located on the touch panel display. Line (DN)/feature keys 
are configured for various features on the IP Phones. 

A steady LCD light beside a line (DN)/feature key indicates 
the feature or line is active. A flashing LCD indicates the line 
is on hold or the feature is being programmed.
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Soft keys (self-labeled) Soft keys (self-labeled) are located on the touch panel 
display. The soft key label changes, based on the active 
feature.

Tap the More.. soft key to access the next layer of soft key 
functions.

Navigation keys Use the navigation keys to scroll through menus and lists on 
the LCD display screen. The key rocks for up, down, left, and 
right movement.

Context-sensitive keys The soft key labels are enabled for the keys on either side of 
the navigation cluster. The labels are context sensitive. 
When in an edit box, the soft key labels will show as Clear 
and Backspace. This allows numeric editing without using 
the soft keyboard. In normal use the soft key labels show 
Quit and Copy.

Table 14
IP Phone 2007 components and functions (Part 2 of 3)

Component Function



Page 144 of 508  Nortel IP Phone 2007

553-3001-368 Standard 12.00 March 2006

Services Tap the Services key to access the following items:

• Telephone Option menu

— Volume adjustment…

— Contrast adjustment

— Language…

— Date/Time

— Display diagnostics

— Local DialPad Tone

— Set Info

— Diagnostics

— Call Log Options

— Ring type…

— Call timer

— On hook default path

— Change Feature key label

— Name Display Format

• Virtual Office Login and Virtual Office Logout (if Virtual 
Office is configured)

• Test Local Mode and Resume Local Mode (if Branch 
Office is configured)

• Password Admin (if configured)

Note 1: When an option has a sublist, an ellipsis (…) 
appears after the option.

Note 2: For ease of use, Nortel recommends the use of the 
external USB keyboard.

Table 14
IP Phone 2007 components and functions (Part 3 of 3)

Component Function
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Features not currently supported

The following features are not supported on the IP Phone 2007:

• Live Dialpad

• Group Listening

• Set-to-Set messaging

The three-port switch that is internal to the IP Phone 2007 is an unmanaged 
switch. It passes the packets (unmodified) and does not interpret the 802.1Q 
VLAN header. The three-port switch provides priority based on the port (that 
is, the IP Phone port traffic takes priority over the Ethernet).

Display characteristics

The IP Phone 2007 window-based user interface has two display areas:

• Application area

• Tools/Navigation area

Figure 12 on page 146 shows these two display areas.
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Figure 12
IP Phone 2007 display areas

Note: The display may differ from the above example.

To extend the life of the LCD panel, the panel will go dark (“sleep”) after a 
configured period of time. For further information, refer to the IP Phone 2007 
User Guide.

Application area

The Application area provides:

• line and feature key status

• information line display

— caller number

— caller name
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— feature prompt strings

— user-entered digits

— date and time information

— set information

• feature keys

• soft keys

Figure 13 shows the Application area.

Figure 13
IP Phone 2007 Application area

Programmable line (DN)/feature key label display

The feature key label area displays a ten-character string for each of the 
twelve programmable line (DN)/feature keys. Each key includes the key label 
and an icon. The icon state can be on, off, or flashing. Key labels are 
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left-aligned for keys on the left side of the screen, and right-aligned for keys 
on the right side of the screen.

If a label is longer than ten characters, the last ten characters are displayed, 
and the excess characters are deleted from the beginning of the string.

Soft key label display

A maximum of ten functions can be assigned to the soft keys.Your system 
administrator assigns functions to the soft keys in layers. 

Note: Soft key labels support different languages.

Use the More.. key to navigate through the layers of functions. If there are 
only four functions assigned to the soft keys, the More.. key does not appear 
and all four functions are displayed.

The soft key label has a maximum of six characters. Each soft key includes 
the soft key label and an icon. When a soft key is in use, a flashing icon 
displays at the beginning of the soft key label, and the label shifts one 
character to the right. (If the label is six characters long, the last or rightmost 
character is truncated.) If a soft key is enabled, the icon state changes to on. 
It remains in the on state until the soft key is pressed again. This cancels the 
enabled soft key and turns the icon off, returning the soft key label to its 
original state. 

Feature key label display

The soft key labels may show either text or icons. The text labels are 
displayed by default and are changed using the Tools menu. For further 
information about the soft keys and their icon equivalents, refer to the 
IP Phone 2007 User Guide.
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Tools/Navigation area

The Tools/Navigation area provides controls for navigating between features 
and selecting tools. 

The following five main elements are presented as touchable keys:

• Tools

• Primary application

• Applications

• Telephone

• Keyboard

Password Protection

Password protection is enabled during Full DHCP configuration through 
SECUREMENU parameter. The Full DHCP configuration mode is required to 
enable the password protection. If the SECUREMENU item is not present at the 
end of the S4 part of the Full DHCP string, password protection is not 
enabled. You can still enable password protection by setting the S4 IP address 
to 0.0.0.0 and the other fields, such as ActionByte and RetryCount, to another 
setting. Nortel recommends you use 0 as the setting for ActionByte and 
RetryCount.

The following examples show how to configure password protection through 
the DHCP string:

• Menu protection on, GraphicalXAS configured:

Nortel-i2004-A,xxx.xxx.xxx.xxx:pppppp,aaa,rrr;
xxx.xxx.xxx.xxx:pppppp,aaa,rrr;xxx.xxx.xxx.xxx:
pppppp,aaa,rrr,SECUREMENU

Nortel-i2004-A,147.19.11.70:4100,1,10; 
147.19.11.70:4100,1,5;37.165.238.90:44443,1,5,
SECUREMENU
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• Menu protection off, GraphicalXAS configured:

Nortel-i2004-A,xxx.xxx.xxx.xxx:pppppp,aaa.rrr;
xxx.xxx.xxx.xxx:pppppp,aaa,rrr;xxx.xxx.xxx.xxx:
pppppp,aaa

Nortel-i2004-A,147.19.11.70:4100,1,10;147.19.11.7:
4100,1,5;37.165.238.90:4443,1

• Menu protection off, no XAS configured:

Nortel-i2004-A,147.19.11.70:4100,1,10;147.19.11.7:
4100,1,5;0.0.0.0:0,0,0,SECUREMENU

For further information on configuring Full DHCP, refer to Converging the 
Data Network with VoIP (553-3001-160).

When Password protection is enabled, a password is required to access the 
Tools menu. When the Tools icon is pressed, a password prompt window 
appears. Use the dialpad and enter the password 26567*738 (color*set) to 
access the Tools menu. 

The Tools menu remains active for five minutes. You can freely navigate, exit 
and reenter the Tools menu without being prompted to reenter the password. 
To reset the timer before the five minute time expires, press the Tools icon. 

When time expires, the Tools menu and any open submenus are closed. 
Alternatively, you can select Lock Menu item from the Tools menu. The 
Lock Menu item immediately closes and locks the Tools menu. You must 
reenter your password to reaccess the Tools menu. 

If you enter an incorrect password, press the Tools icon to reopen the 
password prompt window. Only three incorrect password entries are allowed. 
Any entry after the three attempts is ignored for five minutes. The password 
prompt window is visible and you can reenter the password, but the password 
is not processed until the five minute time expires.

IMPORTANT!

In Full DHCP mode, the server must be configured to respond to the 
request for vendor-specific encapsulated options.
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For further information about the Tools/Navigation area, refer to the 
IP Phone 2007 User Guide.

Figure 14 shows the Tools/Navigation area.

Figure 14: IP Phone 2007 Tools/Navigation area
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Table 15: IP Phone 2007 Tools Menu (Part 1 of 2)

Component Description

Network Configuration Displays the information that was configured when the IP 
Phone 2007 was installed:

— DHCP status

— Telephone Set IP mask

— Network Mask

— Gateway IP address

— Server 1 and Server 2 IP address, Port, Action, Retry, 
and PK numbers

— Voice VLAN and Data VLAN

— Duplex setting

— XAS (S4) IP address, Port, Action, Retry

— GraphicalXAS IP address

Local Diagnostics Displays the Local Diagnostics menu containing the following 
items:

— Network Diagnostic Tools

— Ethernet Statistics

— IP Network Statistics

— IP Set&DHCP Information

Touch Panel Setup Use the Touch Panel Setup tool to calibrate the touch panel 
and stylus.

Contrast and Brightness Use Contrast Brightness tools to alter the display’s physical 
settings.

USB Devices Use USB Devices menu to control the Universal Serial Bus 
(USB) device plugged into the USB port in the back of the 
IP Phone.
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For further information on configuring Local Options on the IP Phone 2007, 
refer to “IP Phone diagnostic utilities” on page 421.

Key number assignments
The IP Phone 2007 has four soft-labeled, predefined keys that are used to 
provide up to ten features. Because they are predefined, the user cannot 
change the key number assignment. 

The Message key is numbered 16. Key numbers 17 to 31 are the four soft key 
labels below the display area. See Figure 11 on page 141.

Key numbers 17 to 31 support the features A03, A06, CFW, CHG, CPN, 
PRK, PRS, RGA, RNP, SCC, SCU, SSC, SSU and TRN, as listed in Table 16 
on page 154.

Table 16 describes the IP Phone assignment functions for each of the soft 
keys. Use LD 11 to program keys 16 to 26 on the IP Phone 2007.

TFTP Upgrade Use TFTP Upgrade menu to upgrade the firmware in the 
IP Phone.

Preferences Use the Preferences menu to configure individual user 
preferences. 

Table 15: IP Phone 2007 Tools Menu (Part 2 of 2)

Component Description
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Note: If you attempt to configure anything other than the permitted 
response, the system generates an error code.  

Table 16
IP Phone 2007 soft keys (Part 1 of 2)

Key number  Response Description

Key 16 MWK

NUL

Message waiting key

Removes function or feature from key

Key 17 TRN

NUL

Call Transfer key

Removes function or feature from key

Key 18 A03

A06

NUL

Three-party conference key

Six-party conference key

Removes function or feature from key

Key 19 CFW

NUL

Call Forward key

Removes function or feature from key

Key 20 RGA

NUL

Ring Again key

Removes function or feature from key

Key 21 PRK

NUL

Call Park key

Removes function or feature from key

Key 22 RNP

NUL

Ringing Number Pickup key

Removes function or feature from key

Key 23 SCU

SSU

SCC

SSC

NUL

Speed Call User

System Speed Call User

Speed Call Controller

System Speed Call Controller

Removes function or feature from key
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Package components
The IP Phone 2007 includes integrated support for a number of LAN options, 
including support for IEEE 802.3af standard power. The Global power 
adapter must be ordered separately if local power is required.

Table 17 lists the IP Phone 2007 package components and product codes. 
Contact Nortel for further information.

Key 24 PRS

NUL

Privacy Release key

Removes function or feature from key

Key 25 CHG

NUL

Charge Account key

Removes function or feature from key

Key 26 CPN

NUL

Calling Party Number key

Removes function or feature from key

Table 17
IP Phone 2007 component list (Part 1 of 2)

IP Phone 2007 package contents includes

• IP Phone 2007 (charcoal with metallic bezel)

• Handset

• Handset cord

• Footstand

• 7 ft. (2.3 m) CAT5 Ethernet cable

• Getting Started card

NTDU96AB70

Replacement parts

7 ft. CAT5 Ethernet cable A0648375

Table 16
IP Phone 2007 soft keys (Part 2 of 2)

Key number  Response Description
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Before you begin
The following section provides a step-by-step guide through the IP Phone 
2007 installation process. Before installing the IP Phone 2007, complete the 
following pre-installation checklist.

Handset (charcoal) A0758634

Handset cord (charcoal) N0000764

Footstand (charcoal) A0538587

IP Phone 2007 power adapter

Global power adapter N0014020

IP Phone 2007 power cords

Cord 9.9 ft. NA Power, NEMA, 125Vac 13a 

NA, M.East, Taiwan, Indonesia, Philippines, Korea, Thailand, 
Vietnam, Japan

NTTK14AB

Cord 8 ft., ANA Power AS-3, 240Vac 10A
Australia, New Zealand, PRC

NTTK15AA

Option 11C Standard European Power Cord 250Vac
Other EMEA, Kenya

NTTK16AB

Option 11C Swiss Power Cord, 9.9 ft. 125Vac
Switzerland

NTTK17AB

Option 11C UK Power Cord 240Vac
Hong Kong, Ireland, UK, Singapore, Malaysia, India, Bangladesh,
Pakistan, Brunei, Sri Lanka

NTTK18AB

Option 11C Denmark Power Cord Kit, 9.9 ft. 125Vac
Denmark

NTTK22AB

Table 17
IP Phone 2007 component list (Part 2 of 2)
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Procedure 25
Pre-installation checklist

1 Ensure there is one IP Phone 2007 boxed package for each IP Phone 
2007 being installed. The package contains:

• IP Phone 2007

• Handset

• Handset cord

• Footstand

• 7 ft. (2.3 m) CAT5 Ethernet cable

• Getting Started card

2 To install and configure an IP Phone 2007, the host system must be 
installed with the Voice Gateway Media Card.

3 If you are not using Power over Ethernet (PoE) you must use the Global 
power adapter or your phone will fail to operate. Refer to Table 17 on 
page 155.

4 Understand the three configuration modes that you can choose from as 
you proceed through the installation of the IP Phone 2007. The three 
configuration modes are:

• Static IP address – see “Static IP address assignment” on page 158.

• Dynamic Partial DHCP – see “Dynamic IP address assignment — 
Partial DHCP” on page 159.

• Dynamic Full DHCP – see “Dynamic IP address assignment — Full 
DHCP” on page 159.

5 A DHCP server and DHCP relay agents, if required, must also be 
installed, configured, and running.

End of Procedure

WARNING
If you are using local power, you must use the Global 
power adapter or your phone will fail to operate. 
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First-time installation
To install and configure an IP Phone 2007, you must first install a Voice 
Gateway Media Card in the system.

IP address assignments

During the first-time installation, there are IP address parameters that are 
entered either manually or automatically depending on the installation 
configuration. As well, you are prompted to enable or disable 802.1Q VLAN. 
For more information, see “802.1Q VLAN description” on page 407.

There are three configuration modes which you can choose from to obtain the 
IP parameters. Review the following sections for more information on the 
configuration mode you are using.

Static IP address assignment

During the installation, the IP Phone 2007 parameters are entered manually 
using the dialpad.

Your system administrator provides the following information: IP address, 
subnet mask, and default Gateway.

You must also enter the Connect Server parameters including: IP address, 
port number, action, and retry count. 

Go to Procedure 26, “Installing an IP Phone 2007 for the first time using 
manual configuration” on page 159.

CAUTION
Damage to Equipment
Do not plug your IP Phone 2007 into an ISDN 
connection. Severe damage can result. Consult your 
system administrator to ensure that you are plugging 
your IP Phone into a 10/100BaseT Ethernet jack.
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Dynamic IP address assignment — Partial DHCP

For a partial DHCP installation, you must provide, through the IP Phone 2007 
dialpad, the Connect Server parameters including: IP address, port number, 
action, and retry count. Other parameters (IP Phone IP address, subnet mask, 
and default Gateway) are retrieved from the DHCP server.

The IP Phone 2007 password, node ID and TN must be entered manually 
from the dialpad.

For more information about DHCP servers, see Converging the Data 
Network with VoIP (553-3001-160).

Go to Procedure 27, “Installing an IP Phone 2007 for the first time using 
DHCP” on page 166.

Dynamic IP address assignment — Full DHCP

For a full DHCP installation, all parameters (IP Phone IP address, subnet 
mask, default Gateway, Connect Server IP address, port number, action, and 
retry count) are retrieved from the DHCP server to recognize the 
IP Phone 2007.

The IP Phone 2007 password, node ID and TN must be entered manually 
from the dialpad.

For more information on how to set up DHCP servers for use with the 
IP Phone 2007, refer to Converging the Data Network with VoIP 
(553-3001-160).

Go to Procedure 27, “Installing an IP Phone 2007 for the first time using 
DHCP” on page 166.

Procedure 26
Installing an IP Phone 2007 for the first time using 
manual configuration

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Phone 2007 on the system using LD 11.
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For more information, see Software Input/Output: Administration 
(553-3001-311).

3 Connect the IP Phone 2007 components:

a. Connect one end of the handset cord to the handset jack on the back 
of the IP Phone (identified with a handset icon).

b. Connect the other end of the handset cord to the handset.

4 Choose one of the following connections:

• For an IP Phone not sharing a LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the LAN Ethernet 
port located on the back of the IP Phone (identified with a LAN icon). 
Plug the other end of the CAT5 Ethernet cable into the IP network.

• For an IP Phone sharing a LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the LAN Ethernet 
port located on the back of the IP Phone (identified with a LAN icon, 
see Figure 15 on page 161) and the other end to the IP network. 
Insert one end of a second CAT5 Ethernet cable into the PC Ethernet 
port located on the back of the IP Phone (identified with a PC icon, 
see Figure 15 on page 161) and the other end into the computer’s 

Ethernet port. 

CAUTION
Damage to Equipment
Do not plug your IP Phone 2007 into any port but the 
PC Ethernet port. Severe damage can result. Consult 
your system administrator to ensure that you are 
plugging your IP Phone into the PC Ethernet port.
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Figure 15
IP Phone 2007 connections

5 Power the IP Phone 2007 using either the Power over Ethernet or the 
Global power adapter (local power).

WARNING
If you are using local power, you must use the Global 
power adapter or your phone will fail to operate. 

IMPORTANT!

Timing information
There are only four seconds between plugging in the IP Phone 2007 
power adapter and the appearance of Nortel on the display. When Nortel 
appears in the middle of the screen, you have one second to respond by 
pressing 0, 0, 7, *. If you miss the one-second response time, the IP 
Phone 2007 attempts to locate the connect server. Wait until it is 
finished, and then begin the power-up sequence again.
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a. To use local power, plug the Global power adapter into the nearest 
power outlet. Refer to Table 17 on page 155.

b. Connect the power jack as shown in Figure 15 on page 161. 

You will hear a tone shortly before the IP Phone is ready to start the Nortel 
IP telephone application. 

6 Once the application has loaded and started, Nortel will appear in the 
middle of the screen. Immediately press the following keys in sequence:

a. 0

b. 0

c. 7

d. star (*)

Note: If you miss part of the configuration, unplug the phone from the 
power for a few seconds and redo this step.

7 At the prompt DHCP Yes/No?, select No.

8 Enter the following information provided by your system administrator:

Note: When entering the IP addresses and subnet mask, use the star (*) 
key on the dialpad to represent the dot (.).

Screen prompt Description

set IP a valid IP Phone 2007 IP address
net msk a subnet mask

def gw the default Gateway for the IP Phone 2007 
on the LAN segment to which it is connected
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9 Enter the information for the primary Connect Server (S1) and the 
secondary Connect Server (S2):

Screen prompt Description

S1 IP the node IP address of the IP line 
node

S1 Port this is a fixed value: 4100

S1 action this is a fixed value: 1

S1 retry the number of times the IP Phone 
2007 attempts to connect to the 
server (Enter 10)

S2 IP same as S1 in most cases (see 
Note 1)

S2 Port same as S1

S2 action same as S1
S2 retry same as S1

Cfg XAS? (0-No,1-Yes) Default 0 (for No).

Note: If there is no XAS or 
GraphicalXAS server, enter 0 (for No). 
You are not prompted for the XAS IP 
address or the GraphicalXAS IP 
address if they are not configured on 
your system.

When prompted, enter the following:

• XAS IP: 

• GXAS
Default 1 (for Yes)

Note: You will only be prompted for 
XAS Port if GXAS is 1 (for Yes).

• XAS Port 
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Voice VLAN? (0-No, 1-Yes) Default 0 (for No) 
802.1Q VLAN remains off and 
initialization continues.

For more information about VLAN 
configuration, refer to Converging the 
Data Network with VoIP 
(553-3001-160).

When prompted, enter the following:

• Voice VLAN ID:

Note: The Voice VLAN ID is entered 
as an integer. The Voice VLAN ID is a 
12-bit value between 1 and 4095.

The IP Phone 2007 is configured with 
802.1Q enabled, the VOICE VLAN ID 
is configured to the entered value, and 
the VOICE VLAN priority = 6.

Data VLAN? (0-No, 1-Yes) Default 0 (for No) 
Data VLAN is not present.

When prompted, enter the following:

• DATA VLAN ID:

Note: The DATA VLAN ID is entered 
as an integer. The DATA VLAN ID is a 
12-bit value between 0 and 4095, and 
should be different from the VOICE 
VLAN ID.

The IP Phone 2007 is configured with 
802.1Q enabled, the DATA VLAN ID 
is configured to the entered value, and 
the DATA VLAN priority = 0.

Duplex (0-Auto, 1-Full) Default 0 (for Auto)

GARP Ignore? (0-No,1-Yes) Default 0 (for No)
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Note 1: The IP Phone 2007 can support a primary (S1) and secondary 
(S2) connect server. If you require IP Phones to register on multiple 
nodes, refer to “Enhanced Redundancy for IP Line Nodes” in IP Line: 
Description, Installation, and Operation  (553-3001-365).

The IP Phone 2007 searches for the connect server. When the 
connection is complete, proceed with Step 10.

10 Enter the following information provided by your system administrator:

The IP Phone 2007 registers with the TPS and, if needed, begins the 
firmware download. This takes several minutes. When the download is 
complete, the IP Phone 2007 resets.

Note: The Enhanced UNIStim Firmware Download feature for IP Phones 
provides an improved method of delivering new firmware to IP Phones. 
For further information on Enhanced UNIStim Firmware Download, refer 
to IP Line: Description, Installation, and Operation  (553-3001-365).

11 Check for dial tone and the correct DN above the display.

12 Secure the IP Phone footstand to the base of the IP Phone. Use the angle 
adjustment grip on the top back of the IP Phone to adjust the position.

13 (Optional) Customize the feature keys as required. For more information, 
see the IP Phone 2007 User Guide.

14 Tap the Tools icon to calibrate the touch panel and stylus. 

15 Tap the Touch Panel Setup soft key.

The screen displays a calibration map, the Cancel soft key is displayed, 
and the following system prompt is displayed:

Touch the center of the red ball.

16 Use the stylus and tap each of the red dots, in order, starting with the 
lower left portion of the screen, and following the sequence as prompted.

Screen prompt Description

Password  IP Phone Installer Password

You are not prompted to enter the IP Phone 
Installer Password if it has not been configured 
in your system.

Node the node ID

TN the TN or VTN
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After the third dot is tapped, the display changes to indicate the result of 
calibration. 

— If the calibration is successful, the telephone displays the following 
report:

Data calibration is CORRECT.
Save Data calibration?

YES and NO soft keys and calibration statistics are displayed on the 
screen. 

Tap the YES soft key to save the calibration settings and exit to the 
main display or tap the NO soft key to abandon the calibration 
settings and exit to the main display.

— If the calibration is unsuccessful, the telephone displays the 
following report:

Data calibration is WRONG.
Repeat calibration?

YES and NO soft keys and calibration statistics are displayed on the 
screen. 

Tap the YES soft key to retry the calibration. Return to step 15 on 
page 173 to follow the calibration procedure or tap the NO soft key to 
abandon the calibration and return to the main display.

End of Procedure

Procedure 27
Installing an IP Phone 2007 for the first time 
using DHCP

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Phone 2007 on the system using LD 11.

For more information, see Software Input/Output: Administration 
(553-3001-311).

3 Connect the IP Phone 2007 components:
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a. Connect one end of the handset cord to the handset jack on the back 
of the IP Phone (identified with a handset icon).

b. Connect the other end of the handset cord to the handset.

4 Choose one of the following connections:

• For an IP Phone not sharing a LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the LAN Ethernet 
port located on the back of the IP Phone (identified with a LAN icon). 
Plug the other end of the CAT5 Ethernet cable into the IP network.

• For an IP Phone sharing a LAN access with a PC:

Connect one end of the CAT5 Ethernet cable to the LAN Ethernet 
port located on the back of the IP Phone (identified with a LAN icon, 
see Figure 15 on page 161) and the other end to the IP network. 
Insert one end of a second CAT5 Ethernet cable into the PC Ethernet 
port located on the back of the IP Phone (identified with a PC icon, 
see Figure 15 on page 161) and the other end into the PC Ethernet 

port.

5 Power the IP Phone 2007 using either the Power over Ethernet or the 
Global power adapter (local power).

CAUTION
Damage to Equipment
Do not plug your IP Phone 2007 into any port but the 
PC Ethernet port. Severe damage can result. Consult 
your system administrator to ensure that you plug 
your IP Phone into the PC Ethernet port.

IMPORTANT!

Timing information
There are only four seconds between plugging in the IP Phone 2007’s 
power adapter and the appearance of Nortel on the display. When Nortel 
appears in the middle of the screen, you have one second to respond by 
pressing 0, 0, 7, *. If you miss the one-second response time, the IP 
Phone 2007 attempts to locate the connect server. Wait until it is 
finished, and then begin the power-up sequence again.
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a. To use local power, plug the Global power adapter into the nearest 
power outlet.

b. Connect the power jack as shown in Figure 15 on page 161. 

You will hear a tone shortly before the IP Phone is ready to start the Nortel 
IP telephone application. 

6 Once the application has loaded and started, Nortel will appear on the 
screen. Immediately press the following keys in sequence:

a. 0

b. 0

c. 7

d. star (*)

Note: If you miss part of the configuration, unplug the phone from the 
power for a few seconds and redo this step.

7 At the prompt DHCP Yes/No?, select Yes.

8 Select Partial or Full DHCP.

a. If you select Full DHCP, then the following parameters are retrieved 
from the DHCP server:

— a valid IP Phone 2007 IP address

— a subnet mask

— the default Gateway for the IP Phone 2007 on the LAN segment 
to which it is connected

— the S1 node IP address of the IP line node

— the S1 Action

— the S1 Retry Count (This is the number of times the IP Phone 
attempts to connect to the server.)

WARNING

If you are using local power, you must use the Global 
power adapter or your phone will fail to operate. 
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— S1 Port

— the S2 node IP address of the IP line node

— the S2 Action

— the S2 Retry Count

— S2 Port

— the External Application Server (XAS) IP address 
(S4 IP address)

— XAS Port (S4 Port)

— XAS Action (S4 Action)

— XAS Retry Count (S4 Retry Count)

— Duplex

b. If you select Partial DHCP, then you must enter the following 
parameters:

Screen prompt Description

S1 IP The node IP address of the IP line node.

S1 Port This is a fixed value: 4100

S1 action This is a fixed value: 1
S1 retry The number of times the IP Phone 2007 

attempts to connect to the server. 
Enter 10.

S2 IP Same as S1 in most cases (see note 
below)

S2 Port Same as S1
S2 action Same as S1

S2 retry Same as S1
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Cfg XAS? (0-No,1-Yes) Default 0 (for No).

Note: If there is no XAS or 
GraphicalXAS server, enter 0 (for 
No). You are not prompted for the 
XAS IP address or the 
GraphicalXAS IP address if they 
are not configured on your system.

When prompted, enter the 
following:

• XAS IP: 

• GXAS
Default 1 (for Yes)

Note: You will only be prompted 
for XAS Port if GXAS is 1 (for Yes).

• XAS Port 

Voice VLAN? (0-No, 1-Yes) Default 0 (for No)
802.1Q VLAN remains off and 
initialization continues.

For more information about VLAN 
configuration, refer to Converging 
the Data Network with VoIP 
(553-3001-160).
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When prompted, enter the 
following:

• VLAN Cfg? (0-Auto, 1-Man):
Default 1 (for Man)

Note: You are only prompted for 
VLAN Cfg? if Full DHCP is 
selected.

• Voice VLAN ID:

Note: The Voice VLAN ID is 
entered as an integer. The Voice 
VLAN ID is a 12-bit value between 
1 and 4095.

The IP Phone 2007 is configured 
with 802.1Q enabled, the VOICE 
VLAN ID is configured to the 
entered value, and the VOICE 
VLAN priority = 6.

Data VLAN? (0-No, 1-Yes) Default 0 (for No) 
Data VLAN is not present.

When prompted, enter the 
following:

• DATA VLAN ID:

Note: The DATA VLAN ID is 
entered as an integer. The DATA 
VLAN ID is a 12-bit value between 
0 and 4095, and should be 
different from the VOICE VLAN ID.

The IP Phone 2007 is configured 
with 802.1Q enabled, the DATA 
VLAN ID is configured to the 
entered value, and the DATA 
VLAN priority = 0.
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Note: The IP Phone 2007 can support a primary (S1) and secondary 
(S2) connect server. If you require IP Phones to register on multiple 
nodes, refer to “Enhanced Redundancy for IP Line Nodes” in IP Line: 
Description, Installation, and Operation  (553-3001-365).

The IP Phone 2007 searches for the connect server. When the 
connection is complete, proceed to step 9.

9 Enter the following information provided by your system administrator.

Note: When entering the IP addresses and subnet mask, use the star (*) 
key on the dialpad to represent the dot (.).

The IP Phone 2007 registers with the TPS and, if needed, begins the 
firmware download. This takes several minutes. When the download is 
complete, the IP Phone 2007 resets.

Note: The Enhanced UNIStim Firmware Download feature for IP Phones 
provides an improved method of delivering new firmware to IP Phones. 
For further information on Enhanced UNIStim Firmware Download, refer 
to IP Line: Description, Installation, and Operation  (553-3001-365).

10 Check for dial tone and the correct DN above the display.

11 Secure the IP Phone footstand to the base of the IP Phone. Use the angle 
adjustment grip on the top back of the IP Phone to adjust the position. 

12 (Optional) Customize the feature keys as required. For more information, 
see IP Phone 2007 User Guide.

13 Tap the Tools icon to calibrate the touch panel and stylus. 

14 Tap the Touch Panel Setup soft key.

Duplex (0-Auto, 1-Full):0 Default 0 (for Auto)

GARP Ignore? (0-No,1-Yes) Default 0 (for No)

Screen prompt Description

Password IP Phone Installer Password

You are not prompted to enter the IP Phone 
Installer Password if it has not been 
configured in your system.

Node the node ID

TN the TN or VTN
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The screen displays a calibration map, the Cancel soft key is displayed, 
and the following system prompt is displayed:

Touch the center of the red ball.

15 Use the stylus and tap each of the red dots, in order, starting with the 
lower left portion of the screen, and following the sequence as prompted.

After the third dot is tapped, the display changes to indicate the result of 
calibration. 

— If the calibration is successful, the telephone displays the following 
report:

Data calibration is CORRECT.
Save Data calibration?

YES and NO soft keys and calibration statistics are displayed on the 
screen. 

Tap the YES soft key to save the calibration settings and exit to the 
main display or tap the NO soft key to abandon the calibration 
settings and exit to the main display.

— If the calibration is unsuccessful, the telephone displays the 
following report:

Data calibration is WRONG.
Repeat calibration?

YES and NO soft keys and calibration statistics are displayed on the 
screen. 

Tap the YES soft key to retry the calibration. Return to step 15 on 
page 173 to follow the calibration procedure or tap the NO soft key to 
abandon the calibration and return to the main display.

End of Procedure

Startup sequence
When an IP Phone 2007 is connected to the network, it must perform a startup 
sequence. The elements of the startup sequence include:

• obtaining the IP parameters
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• finding a default Gateway server

• authenticating the user

Table 18 on page 174 lists a summary of the IP parameters and how they are 
obtained.

Note: Your system administrator provides the network information for 
all static IP address assignments.

Full Duplex mode
In the Configuration menu, Auto Negotiate mode is the default setting for 
initial startup. Typically, the IP Phone is connected to a network that supports 
Auto Negotiate, and it selects the best speed and duplex mode available. 
There is no intervention required under normal operation.

Table 18
IP Phone 2007 IP parameters

Parameter Method of Acquisition

IP Address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Net Mask Manually entered or automatically retrieved through 
Partial or Full DHCP.

Default Gateway Manually entered or automatically retrieved through 
Partial or Full DHCP.

Connect Server (IP address, port, 
action and retry count — primary 
and secondary)

Manually entered or automatically retrieved through Full 
DHCP.

User ID (Node ID, Node Password 
and TN)

Manually entered for first-time configuration. Retrieved 
from local storage on subsequent power cycles.

Note: Your system administrator provides the 
information to enter.
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If the IP Phone 2007 is connected to a network configured for Full Duplex 
mode only, it is not able to automatically negotiate the proper configuration. 
Therefore, in this instance, to allow the IP Phone to work at the optimum 
speed and duplex mode, Auto Negotiate must be disabled. Use Procedure 28 
on page 175 to disable Auto Negotiate and enable Full Duplex mode.

Procedure 28
Disabling Auto Negotiate and enabling Full Duplex 
mode

1 Reset the IP Phone by disconnecting and reconnecting power.

2 When Nortel appears on the screen, press 0, 0, 7, star (*). See 
Procedure 27 on page 166.

3 If no other configuration changes are required, press the OK soft key 
repeatedly until the Duplex network option appears.

4 Select 1 to enable Full Duplex mode.

5 When the Speed option appears, select one of the following:

• 0 for 10 Mbps

• 1 for 100 Mbps (default)

6 Select OK to confirm the change.

7 Restart the IP Phone 2007. The firmware reads the new setting, and the 
IP Phone operates in Full Duplex mode.

When the IP Phone is restarted, the firmware reads the setting for Full Duplex 
mode and sets both port 0, network interface port, and port 1, PC interface 
port, accordingly.

Note: Refer to the IP Phone 2007 User Guide for further information.

Use Procedure 29 to confirm activation of Full Duplex mode.

Procedure 29
Checking Ethernet Statistics

1 Tap the Tools icon. 

2 Tap the Local Diagnostics soft key.

3 Tap the Ethernet Statistics soft key.
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The following statistics are displayed:

— Link: Up

— Duplex: Full

— Speed: 10 (Mb) or 100 (Mb)

— Auto-Nego Capability: N

— Auto-Nego Completed: N

End of Procedure

Gratuitous Address Resolution Protocol Protection
Gratuitous Address Resolution Protocol Protection (GARP) prevents the 
IP Phone 2007 from GARP Spoof attacks on the network. In a GARP Spoof 
attack, a malicious device on the network takes over an IP address (usually 
the default gateway) by sending unsolicited (or Gratuitous) ARP messages, 
thus manipulating the ARP table of the victim’s machine. This allows the 
malicious device to launch a variety of attacks on the network, resulting in 
undesired traffic routing. For example, a GARP attack can convince the 
victim machine that the malicious device is the default gateway. In this 
scenario, all traffic from the victim’s machine flows through the malicious 
device.

To enable GARP Protection during configuration, refer to Procedure 26, 
“Installing an IP Phone 2007 for the first time using manual configuration” 
on page 159 or Procedure 26, “Installing an IP Phone 2007 for the first time 
using DHCP” on page 166.

Reinstalling an IP Phone 2007
You can reinstall an existing, previously-configured IP Phone 2007 on the 
same system. For example, the IP Phone 2007 can be assigned to a new user 
(new TN) or to an existing user who moved to a new subnet by changing the 
TN of the IP Phone 2007.
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Procedure 30
Changing the TN of an existing IP Phone 2007

1 Repower the IP Phone 2007.

Note: During the reboot sequence of a previously configured IP Phone, 
the IP Phone 2007 displays the existing node number for approximately 
five seconds.

2 If node password is enabled and NULL, choose one of the following:

a. Disable password.

b. Set password as non-NULL.

3 Press OK when the node number displays.

4 Enter password at the password screen, and press OK.

A TN screen displays.

5 Select the Clear soft key to clear the existing TN.

If Then

node password is enabled and is 
not NULL

a password screen displays. Go to 
step 4.

node password is disabled a TN screen displays. Go to 
step 5.
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Replacing an IP Phone 2007

Procedure 31
Replacing an IP Phone 2007

1 Disconnect the IP Phone 2007 that you want to replace.

2 Follow Procedure 26 on page 159 (static IP assignment) or Procedure 27 
on page 166 (dynamic IP assignment) to install and configure the IP 
Phone 2007.

Enter the same TN and Node Number as the IP Phone 2007 you 
replaced. The system associates the new IP Phone 2007 with the existing 
TN.

End of Procedure

Removing an IP Phone 2007 from service

Procedure 32
Removing an IP Phone 2007 from service

1 Disconnect the IP Phone 2007 from the network or turn the power off.

Note: The service to the PC is disconnected as well if the PC is 
connected to the IP Phone 2007.

If the IP Phone 2007 was automatically configured, the DHCP lease 
expires and the IP address returns to the available pool.

2 In LD 11, OUT the TN.

End of Procedure

IMPORTANT!

Two IP Phones cannot share the same TN. You must remove the IP 
Phone 2007 that is currently using the TN.
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Key Expansion Module (KEM)

Contents
This section contains information on the following topics.
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Description
The Nortel IP Phone Key Expansion Module (KEM) is a hardware 
component that connects to IP Phone 2002 and IP Phone 2004 and provides 
additional line appearances and feature keys (see Figure 16 on page 180).

Up to two IP Phone KEMs can be connected to an IP Phone 2002 or 
IP Phone 2004. With two IP Phone KEMs connected, the IP Phone can have 
up to 48 additional line/feature keys.
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Note: The IP Phone 2004 can also have up to 48 additional line/feature 
keys using the Shift key functionality and one IP Phone KEM. With two 
IP Phone KEMs connected, the Shift key functionality does not affect 
the IP Phone KEMs since the maximum number of line/feature keys is 
already available. The IP Phone 2002 does not support Shift key 
functionality. 

Figure 16
IP Phone 2002 with one IP Phone KEM attached

Features
The IP Phone KEM has the following features:

• 12 keys on each side of an LCD provide up to 24 additional self-labeled 
line/feature keys. Using the Shift key functionality, an IP Phone 2004 
can have up to 48 additional logical line/feature keys.
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• A desk-mount bracket and structural baseplate connect the IP Phone 
KEM to an IP Phone 2002 or IP Phone 2004, or to another 
IP Phone KEM.

• A wall-mount bracket installs the IP Phone KEM alongside a 
wall-mounted IP Phone 2002 or IP Phone 2004.

Display characteristics
The IP Phone KEM has one LCD between the two rows of 12 Line/feature 
keys (see Figure 16 on page 180). Each of the 24 physical keys on the 
IP Phone KEM has a 10-character display label. This label is set 
automatically, however, the user can edit the label using the controls on the 
IP Phone. 

To alter the display and contrast on the IP Phone KEM, use the Contrast 
Adjustment option under the Telephone Options menu on the IP Phone. 
Any contrast changes you make on the IP Phone affect the IP Phone KEM. 
The IP Phone KEM and IP Phone do not have separate contrast adjustments.

Key number assignments
Since the IP Phone 2002 and IP Phone 2004 have key number assignments 
from 0 to 31, the IP Phone KEM key number assignments begin at 32. 
Therefore, the first IP Phone KEM has key number assignments from 32 to 
55, and the second IP Phone KEM has key number assignments from 56 to 
79.

Package components
Table 19 lists the IP Phone KEM package components.

Table 19
IP Phone KEM components list (Part 1 of 2)

Components Order code

IP Phone KEM - Ethergray A0540989
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Configuration
The IP Phone KEM must be configured in LD 11 before it can be used.

IP Phone KEM - Charcoal A0540990

IP Phone KEM wall mount kit - Charcoal A0555218

LD 11 – Configure the IP Phone KEM. (Part 1 of 5)

Prompt Response Description

REQ: NEW

CHG

Add new data.

Change existing data.

TYPE: I2002

I2004

IP Phone 2002

IP Phone 2004

... ...

ZONE 0 – 255 Zone number to which the IP Phone 2002 or 
IP Phone 2004 belongs

KEM (0) – 2 Number of attached IP Phone KEMs

Note: Up to two IP Phone KEMs can be attached to an 
IP Phone. Pressing <CR> without entering a number 
leaves the value unchanged.

....

Table 19
IP Phone KEM components list (Part 2 of 2)
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KEY xx aaa yyyy (cccc or D) zz..z

Telephone function key assignments

The following key assignments determine calling options 
and features available to an IP Phone. Note that KEY is 
prompted until a carriage return <CR> is entered.

Where: 

xx = key number
aaa = key name or function
yyy = additional information required for the key
zz.z = additional information required for the key aaa.

The cccc or D entry deals specifically with the Calling 
Line Identification feature, where:

cccc = CLID table entry of (0)-N, where N = the value 
entered at the SIZE prompt in LD 15 minus 1. 

D = the character “D”. When the character “D” is 
entered, the system searches the DN keys from key 0 
and up, to find a DN key with a CLID table entry. The 
CLID associated with the found DN key will then be 
used.

Note: The position of the (cccc or D) field varies 
depending on the key name or function.

You may enter a CLID table entry if aaa = ACD, HOT d, 
HOT L, MCN, MCR, PVN, PVR, SCN, or SCR.

Type xx NUL to remove a key function or feature.

Some data ports require specific key assignments. Refer 
to the Meridian Data Services NTPs for information 
regarding these requirements.

LD 11 – Configure the IP Phone KEM. (Part 2 of 5)

Prompt Response Description
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Key number limits that can be assigned are as follows:

0-7 for Meridian Communications Adapter (MCA)
0-5 for M2006
0-7 for M2008
0-59 for M2616, varies with number of add-on 
modules
0-79 for I2002, varies with value of KEM
0-79 for I2004, varies with value of KEM

Note: The first IP Phone KEM is assigned keys 32-55, 
and the second IP Phone KEM is assigned keys 56-79.

If either the Meridian Programmable Data Adapter 
(MPDA) or the Display Module is equipped, then key 7 
on sets M2008, M2216, and M2616 and key 5 on set 
M2006 will become Program keys which cannot be used 
as function keys.

Any printout of the TN block will not show key 7 because 
it is a local function key.

On the M2616, if CLS = HFA, key 15 on the voice TN 
defaults to the Handsfree key. No other feature 
assignment is accepted.

Primary and secondary data DNs must be unique.

A station SCR, SCN, MCR, or MCN DN must be 
removed as a member from all Group Hunt lists before 
the DN can be modified.

LD 11 – Configure the IP Phone KEM. (Part 3 of 5)

Prompt Response Description



 IP Phone Key Expansion Module (KEM)  Page 185 of 508

IP Phones Description, Installation, and Operation

On the M3903, keys 4-15 are blocked. No feature 
assignment is accepted for keys 2-15.

On the M3903, M3904, and M3905, keys 29-31 are 
reserved. No feature assignment is accepted for keys 
29-31 other than NUL.

On M3904, no feature assignment is accepted for keys 
12-15.

On M3905, the craftsperson can assign NUL or a server 
application on key 5. On key 6, the craftsperson can 
assign NUL or a local application.

On M3905, the craftsperson can assign NUL or the 
program key on key 7.

On M3905, the craftsperson can assign AAG, AMG, 
ASP, DWC, EMR, MSB, or NRD on keys 8-11. Other 
features are blocked.

PAGEOFST <Page> 
<KeyOffset>

Automatically calculates the IP Phone KEM key based 
on the entered values. This prompt enables the system 
administrator to enter a Page number of 0 or 1 and a Key 
Offset number from 0-23. Once entered, the KEY 
prompt is prompted with the appropriate KEY value filled 
in.

Enter <CR> to terminate data entry.

Note 1: Applies to an IP Phone 2004 with
KEM = 1, and where <CR> was entered at the KEY 
prompt.

Note 2: Does not apply to an IP Phone 2002.

When values are entered for Page and KeyOffset, the 
KEY xx prompt displays, followed by PAGEOFST 
prompt. This loop continues until no values (<CR> only) 
are entered at the PAGEOFST prompt.

LD 11 – Configure the IP Phone KEM. (Part 4 of 5)

Prompt Response Description
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Installation
The IP Phone KEM mounts on the right side of an IP Phone 2002 or 
IP Phone 2004. The IP Phone KEM snaps into the receptacle on the back of 
the IP Phone using the desk-mount bracket and structural baseplate supplied 
with the IP Phone KEM (see Figure 17).

KEY xx Edit the IP Phone KEM key number specified by 
PAGEOFST, where:
xx = the number of the key (for example, KEY 36)

Enter <CR> to keep the current setting.

KEMOFST <KEM> 
<KeyOffset>

Automatically calculates the IP Phone KEM key based 
on the entered values. This prompt enables the system 
administrator to enter a KEM number of 1 or 2 and a Key 
Offset number from 0-23. Once entered, the KEY 
prompt is prompted with the appropriate KEY value filled 
in.

Enter <CR> to terminate data entry.

When values are entered for KEM and KeyOffset, the 
KEY xx prompt displays, followed by KEMOFST prompt. 
This loop continues until no values (<CR> only) are 
entered at the KEMOFST prompt.

Note 1: Applies to an IP Phone 2002 if <CR> was 
entered at the KEY prompt.

Note 2: Applies to an IP Phone 2004 with
KEM = 2, and where <CR> was entered at the KEY 
prompt.

KEY xx Edit the IP Phone KEM key number specified by 
KEMOFST, where:
xx = the number of the key (for example, KEY 36)

Enter <CR> to keep the current setting.

LD 11 – Configure the IP Phone KEM. (Part 5 of 5)

Prompt Response Description
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The IP Phone KEM connects to the IP Phone 2002 or IP Phone 2004 using 
the Accessory Expansion Module (AEM) port on the IP Phone.

Figure 17
IP Phone KEM attached to an IP Phone 2002

Procedure 33
Connecting the IP Phone KEM to an IP Phone 2002 or IP Phone 2004

Use the following instructions to install an IP Phone KEM:

1 Remove the IP Phone from the stand by pressing the IP Phone tilt handle, 
and pulling the IP Phone away from the stand. 

Note: For the IP Phone 2004, you can also adjust the stand angle to 
maximum, instead of removing the stand.

2 Place the connecting arm of the IP Phone KEM behind the IP Phone and 
align the IP Phone KEM connection plug to the AEM port on the back of 
the IP Phone.

Note: The IP Phones 2002 with the product codes: NTDU76AB34, 
NTDU76BB34, NTDU76AB70, and NTDU76BB70 have shorter 
connector pins than the other IP Phone 2002. Therefore, the ribbon cable 
connector of the IP Phone KEM must be detached from the retaining clip 
and pressed manually into the header connector before attaching the IP 
Phone KEM. 
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3 Press the IP Phone KEM and IP Phone firmly together until the IP Phone 
KEM locks into place.

4 If connecting a second IP Phone KEM, repeat steps 1-3.

Note: The second IP Phone KEM is attached to the right side of the first 
IP Phone KEM.

5 Attach the IP Phone stand and the IP Phone KEM stand, if removed. 
Adjust each IP Phone KEM stand to the same angle as the IP Phone.

The IP Phone KEM powers up.

Note: The IP Phone KEM uses the electrical connection of the IP Phone 
2002 or IP Phone 2004 for power. It does not have its own power source.

End of Procedure

IP Phone KEM startup initialization
Once the IP Phone KEM has been installed and powered up on your 
IP Phone 2002 or IP Phone 2004, the IP Phone KEM initializes (see 
Table 20).

Table 20
Startup initialization process for the IP Phone KEM

Phase Description

1. IP Phone KEM performs 
self-test

The self-test confirms the operation of the IP Phone KEM’s local 
memory, CPU, and other circuitry. While undergoing this 
self-test, the IP Phone KEM display lights up.

Note: If the IP Phone KEM display does not light up, or lights 
up and then goes blank, or fails to begin flashing, check that the 
IP Phone KEM is correctly installed and configured.
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When the three phases complete successfully, you are ready to use the 
additional line/feature keys on your IP Phone KEM.

Note: If you have a second IP Phone KEM installed on your IP Phone, 
the one to the immediate right of the IP Phone must be functional for the 
subsequent IP Phone KEM to work. This is because the second IP Phone 
KEM receives its power, and communicates with the IP Phone, through 
the first IP Phone KEM.

Operating parameters

General

If an IP Phone KEM is not responding, and lines or features are configured 
on keys 32–79, calls can be directed to those keys which the user cannot 
access. This means the IP Phone 2002 or IP Phone 2004 rings but the call 
cannot be answered. In such cases, the incoming call receives Call Forward 
No Answer (CFNA) treatment.

IP Phone 2002

If only one IP Phone KEM is configured in LD 11, but two IP Phone KEMs 
are detected on an IP Phone 2002, the second IP Phone KEM is ignored. An 

2. IP Phone KEM 
establishes communication 
with the IP Phone

The IP Phone KEM display flashes until it establishes 
communication with the IP Phone. 

If the IP Phone KEM display does not stop flashing, 
communication has not been established with the IP Phone. 
Check that the IP Phone KEM is correctly installed and 
configured.

3. IP Phone KEM 
downloads keymaps

The key labels download to the IP Phone KEM. During the 
download, the display is blank.

Table 20
Startup initialization process for the IP Phone KEM

Phase Description



Page 190 of 508  IP Phone Key Expansion Module (KEM)

553-3001-368 Standard 12.00 March 2006

error message displays to alert the administrator that the hardware 
configuration does not match the administered configuration.

If two IP Phone KEMs are configured in LD 11, but only one IP Phone KEM 
is responding, the keys on the second IP Phone KEM are available for call 
processing but are not accessible to the user. This means that lines and 
features on keys 56-79 can cause the IP Phone 2002 to ring, but there is no 
way to answer it. An error message displays to alert the administrator that the 
hardware configuration does not match the administered configuration.

IP Phone 2004

If only one IP Phone KEM is configured in LD 11, but two IP Phone KEMs 
are detected on an IP Phone 2004, the Terminal Proxy Server (TPS) assigns 
keys 56–79 to the second IP Phone KEM. An error message displays to alert 
the administrator that the hardware configuration does not match the 
administered configuration.

If two IP Phone KEMs are configured in LD 11 but only one IP Phone KEM 
is responding, the TPS assigns keys 32–79 to the single IP Phone KEM (using 
the Shift key functionality). An error message displays to alert the 
administrator that the hardware configuration does not match the 
administered configuration. When a second IP Phone KEM is detected, the 
TPS changes the key assignments to display across both IP Phone KEMs, as 
expected.

Virtual Office

When a Virtual Office (VO) login occurs from an IP Phone 2002 or 
IP Phone 2004 that does not have the same number of IP Phone KEMs 
responding as configured on the IP Phone used to log in, call processing may 
terminate on a key that is not physically available. In other words, the 
IP Phone rings but the call cannot be answered. 

During the VO login process, the existence of any IP Phone KEM is verified. 
If a mismatch is detected, the login proceeds normally; however, an error 
message is generated to alert the administrator of the mismatch. 
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Firmware

The IP Phone KEM firmware is not downloadable. In the event that the 
IP Phone KEM firmware must be upgraded or changed, the IP Phone KEM 
must be replaced with a new IP Phone KEM containing the updated firmware.
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Nortel IP Softphone 2050
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Introduction
This section explains how to install and maintain the IP Softphone 2050. For 
information about using the IP Softphone, see the CS 1000  
IP Softphone 2050 User Guide.
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This section contains the following procedures:

• Procedure 35, “Installing an IP Softphone 2050 for the first time” on 
page 213.

• Procedure 36, “Installing the IP Softphone 2050 on the PC (new 
installation)” on page 215.

• Procedure 37, “Upgrading the IP Softphone 2050 on your PC” on 
page 215.

• Procedure 38, “Uninstalling the IP Softphone 2050 (Version 1)” on 
page 216.

• Procedure 39, “Uninstalling the IP Softphone 2050 (Version 2)” on 
page 216.

• Procedure 42, “Changing the TN of an existing IP Softphone 2050” on 
page 219.

• Procedure 43, “Removing an IP Softphone 2050 from service” on 
page 219.

Description
The IP Softphone 2050 is a Windows-based application that provides voice 
services for Personal Computers (PC). The IP Softphone 2050 operates on 
PCs that run Windows 2000 Professional, Windows XP Pro, and Windows 
XP Home.

Designed to work with IP-based phone systems, the IP Softphone 2050 
provides Voice Over IP (VoIP) services using a telephony server and an 
enterprise Local Area Network (LAN). The VoIP application is comprised of 
the following components:

• Settings—used to configure the IP Softphone

• IP Softphone 2050—the IP Softphone user interface

• IP Softphone 2050 QoS

The IP Softphone 2050 supports the following features:

• 12 user-defined feature keys: six programmable line (DN)/feature keys 
and six lines/features accessed by pressing the Shift key
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• four soft keys providing access to a maximum of 10 features

• four-line display

• directory capabilities stored locally on the PC or linked to external 
directories, such as LDAP, Microsoft Outlook, andWindows Address 
Book Directory 

• one-click direct dialing from various windows and applications

• five specialized feature keys:

— Directory

— Inbox/Message

— Shift/Outbox

— Services

— Quit

— Copy

— Expand

• dedicated call processing keys

— Hold

— Goodbye

— Answer

— Mute

— Navigation

— Message Waiting

• user-selected ringer lets the PC speakers or the headset ring for incoming 
calls

• choice of two window skins, as well as an Accessibility Interface option 
for the visually-impaired

The Accessibility Interface operates with screen reading software, such 
as JAWS® for Windows from Freedom Scientific, which enables 
visually-impaired users to access the full range of IP Softphone 2050 
features. Visually-impaired users can follow Procedure 40 on page 216 
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to install the Accessibility Interface from the IP Softphone 2050 
CD ROM.

• programmable hot keys allow single-key access to user-definable 
features

• three input modes: Digit, Alpha, and Native

• macro functions available for programming long dialing patterns

• support for G.711, G.729A, and G.729AB codecs for operation at a 
variety of network connection speeds

Supported features
The IP Softphone 2050 supports the following additional features:

• 802.1Q VLAN support, industry standards for managing bandwidth 
usage—full VLAN capability, including a manageable integrated switch 
in the IP Phone for VLAN and priority tagging for PC and IP Phone 
traffic

• Call Duration Timer

• ability to change the feature key labels

• Corporate Directory

• Personal Directory

• Redial List

• Callers List

• Password Administration

• Virtual office

• Branch Office

• Call Recording

• language support: English, French, Swedish, Danish, Norwegian, 
German, Dutch, Portuguese, Czech, Finnish, Hungarian, Italian, Polish, 
Spanish, Japanese, Russian, Latvian, and Turkish
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Language support

The IP Softphone 2050 is affected by the following three language controls:

• Operating system language

• IP Softphone 2050 language selection—sets the language displayed in 
the help screens and in the menus (select the IP Softphone 2050 language 
from the Application menu or during installation)

• TPS language selection—sets the language in the display area (the 
language in the display areas is selected from the Language menu)

Note: In normal operation, the language chosen from the 
IP Softphone 2050 language setup matches the language chosen from the 
Language menu. Otherwise, the soft key labels and feature prompts will 
appear in a different language than the help text and menu items on the 
IP Softphone 2050 application. The user must ensure that the appropriate 
language is chosen. 

Components
The IP Softphone 2050 supports the following main components:

• Call Control window

• Local Directory window

• Settings window

• System tray icon and menu

• third-party supported applications

• i2050.exe application

Call Control window

You can use the 1140 Call Control Window (see Figure 18 on page 198), or 
the Compact skin Call Control window (see Figure 19 on page 198) to make 
and manage telephone calls. 



Page 198 of 508  Nortel IP Softphone 2050

553-3001-368 Standard 12.00 March 2006

Figure 18
1140 Call Control window 

Figure 19
Compact skin Call Control window
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Table 21 lists the elements and functions of the Call Control window.

Table 21
Call Control window elements and functions  (Part 1 of 3)

Element Function

Primary display The primary display area provides call information 
(for example, Caller ID) and instructions for using 
certain soft key features. In the idle state, only the 
date and time are displayed.

Soft keys Four additional soft-labeled keys on the IP 
Softphone 2050 support a specific subset of the 
key features.

Answer Click the Answer key to answer and make calls.

Hold Click the Hold key to place an active call on hold. 
The feature key label for the line placed on hold 
displays a flashing icon. Click the Line key to return 
to the call. 

Release Click the Release key to end an active call.

Line keys Six programmable line keys represent line 
appearances, DNs, or features. 

Volume Use the volume keys to increase or decrease the 
headset volume.

Mute Click the Mute key to listen to the receiving party 
without transmitting. Click the Mute key to return to 
a two-way conversation. The Mute key mutes the 
headset microphone.

increase

decrease
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Directory Click the Directory key to access the Network 
Directory. 

Inbox/Message Click the Inbox/Message key to access messages 
or return a call.

Shift/Outbox Press the Shift key to shift between two feature key 
pages when a second feature key page exists.

Copy Click the Copy key to copy a network service, 
feature, or folder.

Quit Click the Quit key to quit a network service or 
feature.

Navigation arrows Use the navigation arrows to scroll through menus 
and lists in the display area.

Send/Enter Press the Send/Enter key, at the center of the 
Navigation key cluster, to confirm menu selections. 

Note: The Send/Enter key is only available on the 
1140E Call Control window.

Dialpad Click numbers on the dialpad to dial a number.

Table 21
Call Control window elements and functions  (Part 2 of 3)

Element Function
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Speaker Click the Speaker key to answer and make calls 
using the handsfree speaker.

Expand The Expand key is reserved for future 
implementation.

Services Press the Services key access the following items:

• Language

• Date/Time 

• Set Info

• Call Log Options

• Ring type

• Call Timer

• Change Feature Key Label

• Name Display Format

• Virtual Office Login and Virtual Office Logout (if 
Virtual Office is configured)

• Test Local Mode and Resume Local Mode (if 
Branch Office is configured)

• Password Admin:

— Station Control Password

Table 21
Call Control window elements and functions  (Part 3 of 3)

Element Function
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Operation

Display characteristics

The IP Softphone 2050 has the following display areas:

• information display 

• soft key label display

• keypad dialing keys display

• feature keys display

Information display area

The information display area can contain four lines of text, up to a maximum 
of twenty four characters for each line. The display area consists of 2 areas: 
Info line and Info window.

Info line

The Info Line is the first (top) line of display text. The left ten-character area 
shows the Call Server type. The right part of the Info Line shows the current 
time and date.

Info window

The Info Window display area that shows prompts and information about 
calls. During a call the information area is used to display dialed digits, 
calling line ID, called party name, application-specific information, and 
various messages such as “Release and Try Again”.

When the information exceeds 3 x 24 characters, a scroll icon tells the user to 
press the scroll keys to view the second line of the display.

Soft key label display

A maximum of ten functions can be assigned to the soft keys. Functions are 
assigned to the soft keys in layers in LD 11.
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Use the More soft key to navigate through the layers of functions. If only 4 
functions are assigned to the soft keys, the More key does not appear and all 
four functions are displayed.

The soft key label has a maximum of 7 characters. Each soft key includes the 
soft key label and an icon. When a soft key is in use, a flashing icon displays 
at the beginning of the soft key label, and the label shifts one character to the 
right. (If the label is six characters long, the last, or rightmost, character is 
truncated.) If a feature is enabled, the icon state turns to ON. It remains in the 
ON state until the feature key is pressed again. This cancels the enabled 
feature and turns the icon off, returning the soft key label to its original state. 

System Tray

The System Tray provides fast access to most of the IP Softphone 2050 
functionality. The user can make, answer, and manage a call, as well as access 
macros and features from the System Tray without opening the Call Control 
window. 

Nortel USB Audio Kit

The USB Audio Kit enables the user to speak and hear callers. To ensure 
proper IP Softphone 2050 operation, use only Nortel-supported USB audio 
kits. The USB Audio Kit includes the following:

• USB Headset Adapter (desktop or mobile)

• Installation Guide 

• USB cord

The following USB adapters are supported on the IP Softphone 2050:

• Nortel Enhanced USB Adapter (desktop)

• Nortel Mobile USB Adapter (mobile)

The Algo Analog Terminal Adapter (ATA) is a USB adapter that lets you use 
analog terminals instead of headsets. With an Algo ATA users can, for 
example, use a cordless headset with their IP Softphone 2050.

The IP Softphone 2050 is compatible with the Algo ATA. For support, see 
www.algosolutions.com.
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USB Headset Adapter

The USB Headset Adapter provides a controlled high-quality audio 
environment, including:

• absolute and predictable loss and level plan implementation that is 
necessary to meet TIA-810, FCC part 68 and its international 
equivalents, as well as the ADA requirements for the hearing impaired

• compliance with version 1.1 of the USB Device Specification and 
Windows Plug & Play specifications

• simple installation using standard Windows drivers (requires no 
additional software or drivers)

• support on Windows 2000 Professional, Windows XP Pro, and 
Windows XP Home

Refer to the IP Softphone 2050 User Guide for specific operation system 
information.

• in-use lamp connector with in-use control provided by polarity 
insensitive isolated contact closure

• red Message Waiting light, located at the top of the USB Headset 
Adapter, that flashes when you have voicemail messages

• IP Softphone 2050 Smart Functions button enables the IP Softphone 
2050 Smart Functions menu that provides quick access to IP Softphone 
2050 features

• Mute light that indicates a call is on mute

The USB Headset Adapter auto-configures in the supported Windows 
operating system. No additional software is required.

Registration

When you add an IP Softphone 2050 to the network, depending on 
configuration, the IP Softphone 2050 can connect to a predefined IP address 
or can request an IP address from a DHCP server. The IP Softphone 2050 then 
contacts the Connect Server, which instructs the IP Softphone 2050 to display 
a message on its display screen requesting the customer’s node number and 
TN.
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After the customer enters this information, the IP Softphone 2050 contacts the 
Node Master, which selects a TPS with sufficient capacity to register the 
IP Softphone 2050. The IP Softphone 2050 contacts the chosen TPS and, if 
the IP Softphone 2050 is valid, registers it with the system. The registration 
information is then saved to the IP Softphone 2050.

Loss plan

The USB Headset Adapter provides the IP Softphone 2050 with a fixed loss 
plan compliant with the TIA-810A specification. If other headsets or audio 
devices are used, the loss plan is unknown and undefined. Nortel supports the 
resolution of audio problems only for the USB Headset Adapter.

Echo cancellation

Echo can be generated electrically when there is an impedance mismatch, or 
generated acoustically by feedback from a speaker or ear piece to a 
microphone. Any echo that is ultimately returned to the IP Phone is more 
noticeable to the listener because of the additional delay introduced by the IP 
connection.

The Voice Gateway Media Card has echo cancelers included as part of its 
function that cancels echo generated on the TDM side of the Media Gateway. 
When audio goes through the Voice Gateway Media Card, the echo 
cancellers are enabled.

The IP Softphone 2050 has no echo canceller, so a slight echo from acoustic 
coupling on the headset can occur in some call situations.

Clock synchronization

Buffer underruns and overruns can occur since there is no sample clock at the 
receiving end of an IP audio stream synchronized to the transmitting clock. 
The buffer overruns and underruns are corrected by two mechanisms, both of 
which apply to the IP Phones and the DSPs on the Voice Gateway Media 
Card.
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Jitter buffer

Use the default value sent from the TPS (the value configured in TM– [Nortel 
recommends that you use the default value]) to configure the IP Softphone 
2050 jitter buffer. 

The jitter buffer has a desired size and a maximum allowable size. If the jitter 
buffer exceeds its maximum allowable size, sufficient frames are discarded 
to reduce the contents of the jitter buffer to the desired setting. If the jitter 
buffer underruns, frames are held in the jitter buffer until it fills to the desired 
level. Both underrun and overrun result in a discontinuity in the audio.

For codecs that support silence suppression, the jitter buffer is resynchronized 
at the beginning of each talk spurt.

QoS

A combination of codec selection, jitter buffer and packet time, and the use 
of the DiffServ code point of the network contributes to the end-to-end QoS.

However, the IP Softphone 2050 is an application within the context of the 
PC operating system, so the operating system has an effect on the end-to-end 
QoS for the IP Softphone 2050. The DSP functionality (such as codec 
packetization) implemented in DSP hardware on the IP Softphone 2050 and 
Voice Gateway Media Card runs as part of the application code on the PC 
CPU. If the CPU is busy with other tasks, voice quality can be negatively 
affected.

The number of buffers used to buffer audio data between the application and 
PC audio hardware device driver is adjustable from the Settings > Sound 
Devices window. Using fewer buffers reduces the audio path delay but 
increases the chances of dropouts and choppy speech, depending on the speed 
and utilization of the PC CPU.

DiffSERV (DSCP)

The IP Softphone 2050 uses DSCP settings assigned by the TPS. The 
IP Softphone 2050 supports DSCP on Windows 2000 Professional, 
Windows XP Pro, and Windows XP Home.
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802.1Q

The IP Softphone 2050 uses 802.1p (priority) settings assigned by the TPS. 
The IP Softphone 2050 supports 802.1p on Windows 2000 Professional, 
Windows XP Pro, and Windows XP Home.   

The service can be installed from the CD-ROM. If you install the 
IP Softphone 2050 with Administrators access, then this service is installed 
automatically. 

Codec

The IP Softphone 2050 provides the following codecs:

• G.711 provides the highest quality (if the network facilities can handle 
the packet flow) because there is no compression.

• G.729A is ranked best; it has 8:1 compression but no voice activity 
detection.

• G.729AB is the same as G.729A but includes voice activity detection; 
while this provides the lowest average network bandwidth utilization, in 
some call environments the speech quality suffers due to clipping of the 
beginning of words.

Frame size

The IP Softphone 2050 supports the following range of frame sizes:

• G.711-64 A-law and µlaw: 10-960—10 ms increments

• G.729A: 10-960—10 ms frames

• G.729AB: 10-960—10 ms frames

Key number assignments
The IP Softphone 2050 has 6 keys that present 12 feature keys, with 6 on each 
feature key page. The keys are numbered from 0 to 11. The Shift key is used 
to change between two feature pages, 0 to 5 and 6 to 11.
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Note: If a feature requires a feature package that is not present for the 
Call Server installation, that feature does not appear within the default 
configuration for the IP Softphone 2050.

The Message key is numbered 16. If Message Waiting is not configured, then 
key16 must be NUL. 

Key numbers between 17–31 are assigned to the four soft label keys 
immediately below the display area. The supported features are: A03, A06, 
CFW, CHG, CPN, PRK, PRS, RGA, RPN, SCU, SCC, SSU, SSC, and TRN.

Table 22 describes the IP Phone feature assignment for each of the soft keys. 
Use LD 11 to program keys 16 to 26 on the IP Softphone 2050.

Note: If you attempt to configure anything other than the permitted 
response, the system generates an error code.

Table 22
IP Softphone 2050 soft keys (Part 1 of 2)

Prompt  Response Description

Key 16 MWK

NUL

Message Waiting key

Removes function or feature from key

Key 17 TRN

NUL

Call Transfer key

Removes function or feature from key

Key 18 A03

A06

NUL

three-party conference key

six-party conference key

Removes function or feature from key

Key 19 CFW

NUL

Call Forward key

Removes function or feature from key

Key 20 RGA

NUL

Ring Again key

Removes function or feature from key
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Operating parameters
The operating parameters for the IP Softphone 2050 are as follows:

• The minimum recommended system hardware for the IP Softphone 2050 
application is:

— Pentium-compatible CPU (200 megahertz [MHz] or higher)

— 128 megabytes (MB) RAM or higher for Microsoft Windows 2000

Key 21 PRK

NUL

Call Park key

Removes function or feature from key

Key 22 RNP

NUL

Ringing Number pickup key

Removes function or feature from key

Key 23 SCU

SSU

SCC

SSC

NUL

Speed Call User

System Speed Call User

Speed Call Controller

System Speed Call Controller

Removes function or feature from key

Key 24 PRS

NUL

Privacy Release key

Removes function or feature from key

Key 25 CHG

NUL

Charge Account key

Removes function or feature from key

Key 26 CPN

NUL

Calling Party Number key

Removes function or feature from key

Keys 27 - 31 Reserved

Table 22
IP Softphone 2050 soft keys (Part 2 of 2)

Prompt  Response Description
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— 256 MB RAM or higher for Windows XP

— 55 MB free hard drive space (all languages)

— 800 by 600 resolution monitor (16-bit color)

— Universal Serial Bus (USB) port (version 1.1 or 2.0)

— USB Audio Kit

For information about supported operating systems, refer to the 
IP Softphone 2050 User Guide. 

• Perform the software version upgrade for IP Softphone 2050 manually. 
The technician must do this at the PC. The Voice Gateway Media Card 
does not download any software to the IP Softphone 2050. The 
isetShow command on the Voice Gateway Media Card displays the 
current version of any registered IP Softphone 2050.

• The IP Softphone 2050 does not have an ACD Supervisor headset jack. 
Agent walkaway is supported with the Enhanced USB Keypad Adapter. 

• An IP Softphone 2050 does not register against a TN configured for any 
other type of IP Phone.

• Soundcard audio is supported only for incoming call notification. Nortel 
supports USB Headset Adapter for the speech path.

• 5 menu options available on the IP Phone 2004, not required on the IP 
Softphone 2050, are:

— Volume adjustment

— Contrast adjustment

— Display diagnostics

— Key click

— On-hook default path

System components
The IP Softphone 2050 is comprised of an external Universal Serial Bus 
headset adapter (Nortel Enhanced USB Adapter [desktop]) and a software 
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application installed on the user’s PC. The IP Softphone 2050 also supports a 
mobile adapter (Nortel Mobile USB Adapter).  

Table 23 lists the IP Softphone 2050 package components.  

Before you begin
The following section provides a step-by-step guide through the 
IP Softphone 2050 installation process. Before installing the IP Phone, 
complete the following pre-installation checklist.

IMPORTANT!

Use your IP Softphone 2050 with the approved Nortel Enhanced USB 
adapter (desktop) or Nortel Mobile USB Adapter only.

Table 23
IP Softphone 2050 package components

Component Code

Nortel Mobile USB Adapter Monaural Headset IP 
Softphone 2050 Kit includes: 

NTEX14MD

• IP Softphone 2050 application software CD/
ROM

NTDW82EA

• Nortel Mobile USB headset adapter with 
monaural headset

NTEX14MB

IP Softphone 2050 application software CD/ROM NTDW83BA

Replacement parts:

Mobility USB Audio Adapter (no headset) NTEX14MA

Mobility USB Audio Adapter kit with headset NTEX14MB
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Procedure 34
Preinstallation checklist

1 Ensure you have the IP Softphone 2050 application software CD.

2 To install and configure an IP Softphone 2050, the host system must be 
equipped with the Voice Gateway Media Card.

3 Understand the three configuration modes from which you can choose 
from as you proceed through the installation of the IP Softphone 2050. 
The 2 configuration modes are:

• Static IP address—see “Static IP address assignment”

• Partial DHCP—see “Dynamic IP address assignment—Partial 
DHCP”

4 A DHCP server and DHCP relay agents, if required, must also be 
installed, configured, and running.

First-time installation
During the first-time installation, the two IP address parameters entered either 
manually- or automatically, depending on the installation configuration. They 
are as follows:

• Static IP address assignment 

• Partial DHCP 

Static IP address assignment

During the installation, enter the IP Softphone 2050 parameters manually 
using the dialpad.

Enter the IP address, subnet mask, and default Gateway address. You must 
also enter the Connect Server parameters including IP address, port number, 
action, and retry count.

Dynamic IP address assignment—Partial DHCP

For a partial DHCP installation, you must provide, through the IP Phone 
dialpad, the Connect Server parameters including: IP address, port number, 
action, and retry count. Other parameters (IP Phone IP address, subnet mask, 
and default Gateway) are obtained from the DHCP server.
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Enter the IP Phone password, node ID, and TN manually, using the dialpad.

For more information about DHCP servers, see Converging the Data 
Network with VoIP (553-3001-160).

Use Procedure 35 to install an IP Softphone 2050 for the first time.

Procedure 35
Installing an IP Softphone 2050 for the first time

1 Install the Voice Gateway Media Card. For more information, see IP Line: 
Description, Installation, and Operation  (553-3001-365)

2 Configure a virtual loop on the Call Server, using LD 97.

For more information, see Software Input/Output: Administration (553-
3001-311).

3 Configure the IP Softphone 2050 in LD 11. At the prompt, enter the 
following:

REQ: chg
TYPE: i2050

4 Install the USB Headset Adapter. If you are using the mobile adapter, 
connect the headset to the adapter. If you are using the desktop adapter, 
you must:

a. Connect the coiled lower cord to the headset cord with the Quick 
Disconnect connector. Ensure the Quick Disconnect connector is 
securely fastened. 

b. Connect the headset cord to the RJ9 jack on the adapter.

5 Connect the USB cable to the headset adapter and to one of the USB 
jacks on the back of your PC or USB hub.

The first time the headset adapter is plugged in, a delay occurs while 
Windows configures the device and locates the appropriate driver 
software. During the installation, you are prompted to supply the original 
Windows CD-ROM so Windows can locate the required drivers.

6 Install the IP Softphone 2050.



Page 214 of 508  Nortel IP Softphone 2050

553-3001-368 Standard 12.00 March 2006

7 Configure the IP Softphone 2050 parameters. Click the Server tab in the 
Settings window and choose one of the following:

• To manually configure the IP Softphone 2050 parameters, enter the 
IP address of the Call Server, Server type, port number, and retries. 

• For DHCP, select the check box beside Automatic (DHCP). The 
IP address, Server type, port number, and retries are automatically 
retrieved from the DHCP Server. 

Note:  For more information about using partial DHCP, refer to 
Procedure 19, “Installing an IP Phone 2004 for the first time using DHCP” 
on page 124.

8 Click Apply.

End of Procedure

Installing or upgrading the IP Softphone 2050
Use the following options to obtain the latest version of the 
IP Softphone 2050:

• new installation—installing the IP Softphone 2050 for the first time

• upgrade—upgrading the IP Softphone 2050 to the latest version

IP Softphone (Version 1) and IP Softphone (Version 2) can coexist on a PC, 
although both versions cannot run at the same time.

Note: Before performing a new installation or an upgrade, check the 
version of IP Softphone 2050 software. 

Use Procedure 36 on page 215 for a new installation of the 
IP Softphone 2050. 

IMPORTANT!

Before you upgrade an IP Softphone 2050, record the information 
found in the Server window. This information may required in the 
future.
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Procedure 36
Installing the IP Softphone 2050 on the PC
(new installation)

1 Insert the CD-ROM disk into the CD-ROM drive of your PC.

Note:  Installation should proceed automatically. If it does not, then 
continue with step 2, otherwise go to step 5.

2 Double-click the My Computer icon.

3 Double-click the CD icon.

4 Double-click the Setup icon.

5 Follow the instructions on-screen to complete the installation.

6 Select Start > Programs > Nortel > IP Softphone 2050 to start the 
IP Softphone 2050 application.

7 Select Settings to assign a server address, select sound devices, and 
select a server type.

Note:  If you are installing the IP Softphone 2050 on a Windows XP or 
Windows 2000 platform, you must install the Windows QoS Packet 
Scheduler. Refer to Procedure 41 on page 217.

End of Procedure

Use Procedure 37 on page 215 to upgrade the IP Softphone 2050 on the PC. 

Procedure 37
Upgrading the IP Softphone 2050 on your PC

1 Download the IP Softphone 2050 upgrade file from the Nortel web site 
and extract all files to a working directory.

Note:  Refer to either the CS 1000 Release 4.5 Product Bulletin or the 
IP Line 4.5 Read Me First about download instructions.

2 Double-click the My Computer icon and navigate to the working 
directory.

3 Double-click the Setup icon.

4 Follow the instructions on-screen to complete the installation.

Note:  Compare the values currently in the configuration utility to the 
values recorded prior to the upgrade. These should be identical.
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5 Select Start > Programs > Nortel > IP Softphone 2050 to start the 
IP Softphone 2050 application.

6 Select Settings to assign a server address, select sound devices, and 
select a server type.

End of Procedure

Use Procedure 38 to uninstall IP Softphone 2050 (Version 1).

Procedure 38
Uninstalling the IP Softphone 2050 (Version 1)

1 Select Start > Settings > Control Panel > Add/Remove Programs.

2 Choose Nortel Networks i2050 Software Phone.

3 Select Remove. 

4 Select Yes to confirm.

End of Procedure

Procedure 39
Uninstalling the IP Softphone 2050 (Version 2)

1 Select Start > Settings > Control Panel > Add/Remove Programs.

2 Choose Nortel Sofphone 2050.

3 Select Remove.

4 Select Yes to confirm. 

End of Procedure

Visually impaired users can follow Procedure 40 to install the Accessibility 
Interface from the IP Softphone 2050 CD-ROM.

Procedure 40
Installing the Accessibility Interface

1 Press and hold Shift.

2 Insert the IP Softphone 2050 installation CD into your CD-ROM drive.
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3 Press and hold Shift for several seconds to prevent Autorun from starting.

4 If the Installation Wizard starts:

a. Wait until the Welcome to the Install Shield Wizard for the Nortel 
IP Softphone 2050 screen appears.

b. Press Tab to select Cancel.

c. Press Return.

d. Click Yes to confirm that you want to cancel the installation.

e. Click Finish.

5 From Windows Explorer, select your CD-ROM. 

6 Select Accessibility.bat.

The file Accessibility.bat executes the command line “setup /s /vqb/
vUI508=1”. This installs the application and sets the user interface to the 
Accessibility Interface.

End of Procedure

Procedure 41
Installing the Windows QoS Packet Scheduler

1 Select Start > Control Panel. 

2 Select Network Connections (Classic View or Windows XP), or 
Network and Dialup Connections (Windows 2000).

3 Right-click Local Area Connection.

4 Select Properties.

5 Click Install.

The Select Network Component Type window opens.

6 Click Add.

The Select Network Service window opens.

7 Select QoS Packet Scheduler.

8 Click OK.

End of Procedure
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Running the IP Softphone 2050 for the first time
Start the IP Softphone 2050 in one of the following ways:

• Select Start > Programs > Nortel > IP Softphone 2050.

• Click the desktop shortcut (if one was created during the installation).

• Click Automatic startup sequence.

Note: If you want the IP Softphone 2050 to start automatically when the 
PC starts, create a shortcut to the application in the Startup folder.

When an IP Softphone 2050 is started for the first time and connects to the 
network, the IP Softphone executes the following start-up sequence:

1 Obtain the IP parameters.

2 Find a Media Gateway server and authenticate the user.

As the IP Softphone 2050 registers with the Voice Gateway Media Card, one 
of the following occurs:

• If a non-null node password is enabled, you are prompted to enter the 
node number and password. Use the keyboard or numeric keypad to enter 
the prompts for a node number and password. After the password is 
verified, enter the TN of the IP Softphone 2050. Refer to IP Line: 
Description, Installation, and Operation  (553-3001-365) for further 
information about the password feature.

• If the null node password is configured and enabled, these screens are 
skipped and no option is provided to change the password.

• If the node password is disabled or not configured, it prompts for a node 
number and TN. Enter the node number and TN using the keyboard or 
numeric keypad.

The IP Softphone 2050 is now configured and can be used.

Changing the TN of an existing IP Softphone 2050
This procedure is required for a new user of the IP Softphone 2050 
application.
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Procedure 42
Changing the TN of an existing IP Softphone 2050

1 Exit the IP Softphone 2050 application.

2 Restart the IP Softphone 2050 application.

If the node password is not configured, or is configured but disabled, go 
to step 3.

If the node password is configured and enabled for the node, go to step 4.

3 During startup, the IP Softphone 2050 registers again with the TPS, and 
the IP Softphone 2050 displays the existing node number and TN for 
approximately five seconds.

4 If the password is configured and enabled for the node, the node number 
and password prompt displays for approximately 5 seconds; enter the 
correct password within this 5-second period.

If the user activates the Clear soft key during the 5-second period, the 
existing node and TN are cleared and the user is prompted for new 
parameters.

End of Procedure

Removing an IP Softphone 2050 from service

Procedure 43
Removing an IP Softphone 2050 from service

1 Exit the IP Softphone 2050 application.

2 Uninstall the IP Softphone 2050 application from the PC using the 
Windows Add/Remove Programs.

3 In LD 11, OUT the TN.

End of Procedure
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268

Nortel Mobile Voice Client 2050

Contents
This section contains information on the following topics:
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MVC 2050 installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247

MVC 2050 removal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249
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MVC 2050 and WLAN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267

Introduction
This section describes how to install, configure, and remove the Nortel 
Mobile Voice Client 2050. For information on using the MVC 2050, see the 
Mobile Voice Client 2050 User Guide.

This section contains the following procedures:

• Procedure 44, “  Starting MVC 2050” on page 246.
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• Procedure 45, “  Synchronizing a PDA with a desktop PC using 
ActiveSync” on page 247.

• Procedure 46, “  Installing MVC 2050” on page 248.

• Procedure 47, “  Removing MVC 2050 from your PDA” on page 249.

• Procedure 48, “  Enable Auto-Create” on page 255.

• Procedure 49, “  Disabling Automatic Gain Control” on page 261.

Description
Mobile Voice Client (MVC) 2050 adds wireless IP Phone services to the 
convenience of Personal Digital Assistants (PDAs). MVC 2050 functions 
like an IP Softphone 2050. However, MVC 2050 cannot be used as an Agent 
or Supervisor in Call Center Portal applications.

MVC 2050 is UNIStim-based software providing real-time voice 
communication, over a WLAN, to PDAs. 

MVC 2050 operates on PDAs running the Windows Mobile 2003 operating 
system and can use WLAN 802.11b, interworking with various enterprise 
communication servers. MVC 2050 can also interwork with WLAN Access 
Points (WAP) and can use the WSS 2250 WLAN Security Switch. MVC 
2050 can coexist with a secure Virtual Private Network (VPN) client on the 
same PDA. MVC 2050 requires access to an enterprise or public WLAN 
Access Point (WAP). 

MVC 2050 is compatible with the following communication servers:

• CS 1000S

• CS 1000M

• CS 1000E

• Meridian 1

MVC 2050 supports the following:

• IP telephony features such as Messages, Directory, Shift, Services, 
Expand, Copy, and Quit

• audible notification of connection or disconnection to the server
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• Hold, Goodbye, Answer, Volume Up, Volume Down, Mute, 
Navigation keys

• macro functions for programming lengthy dialing patterns

Note: Pause is available to build into the macro to introduce a delay 
which may be required to access some Interactive Voice Response (IVR) 
applications and voicemail systems.

• contacts application: locally stored in the PDA Contacts application or 
linked to an external application, such as Microsoft Outlook, on a 
desktop

• network access and DHCP-configurable services (automatic 
configuration of communication server location using DHCP)

• connection to end user-supplied headsets for the speech path

• online help

• six programmable line/feature keys

• four soft keys (self-labeled)

• 12-button dialpad

• multi-field display

• end user-selectable skins

System components
MVC 2050 is comprised of:

• MVC 2050 application software, including Global IP Sound NetEQ™ 
software

• end user-supplied compatible PDA

• end user-supplied headset

Compatible PDAs

MVC 2050 is compatible with the following PDAs:

• Dell® Axim® X5
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• Dell Axim X3/X3i

• Hewlett Packard® iPAQ® h5550/h5555

• Toshiba e750/e755

• Toshiba e800/e805

Note: The Dell Axim X3, 300 MHz model, is not supported for use with 
MVC 2050. Since the PDA industry evolves at a rapid pace, contact 
Nortel technical support to determine the latest PDA models tested and 
supported, and for information about any known issues.

Headsets

Headsets are end user-supplied and are an important component of audio 
quality. The iPAQ and Toshiba PDAs support stereo headphones and 
microphones like the iPAQ certified Plantronics M130 Adjustable Fit 
Headset. The Dell Axim X5 supports stereo headphones, but not a 
microphone. The Jensen JM-11 Behind-the-Neck Headphone has been tested 
with the MVC 2050. Consult the PDA manufacturer for headphone 
recommendations. 

Automatic Gain Control and feedback

Since MVC 2050 requires a headset to operate properly, disable Automatic 
Gain Control. See “Automatic Gain Control and feedback” on page 260.

CAUTION
MVC 2050 does not support the use of 
Bluetooth wireless technology headsets and 
accessories. Bluetooth wireless technology and 
the 802.11b WLAN interface operate on the 
same frequency band and use the same WLAN 
hardware on the PDA. Therefore, using 
Bluetooth wireless technology with MVC 2050 
decreases audio quality.
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Note: When the PDA is used in handsfree mode, without a headset, the 
PDA microphone picks up sounds from the speaker, creating a feedback 
loop. Automatic Gain Control is used in this instance to avoid 
feedback. 

Audio quality

MVC 2050 provides a high-quality audio environment, including:

• NetEQ software (included with the software package)

• interworking with G.711 codec providing high audio quality without 
compression; MVC 2050 supports G.711-64 A-law and U-law.

• Audio selection tab providing a user-selectable quality slider

• Advanced Audio tab for expert users

Application software
MVC 2050 is a software application that enables voice communications over 
a WLAN from a PDA.

The MVC 2050 software application is comprised of the following 
components:

• MVC 2050 software

• NetEQ software (included in MVC 2050 software)

MVC 2050 supports use of the following:

• flexible interface including:

— end user-selectable skins to provide a variety of screen appearances

— retractable Toolbar

— six programmable line/feature keys (number of features available is 
call-server dependent)

— four soft keys (self-labeled)

— 12-button dialpad

— profiles the user can customize
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— contacts list the user can customize

— programmable macro functions for lengthy dialing patterns

• run-in-background application that allows the user to close the 
MVC 2050 interface but leave it running to allow incoming calls

• 802.11b WLAN interface

• automatic configuration of communication server location using 
Dynamic Host Configuration Protocol (DHCP)

• features and services provided by the network (such as call features and 
voicemail)

• online Help

• G.711 codec for operation without compression

ClearType

MVC 2050 uses a special screen font which requires that Microsoft 
ClearType® be enabled on your PDA. ClearType software improves the 
appearance and readability of text on liquid crystal display (LCD), pocket PC 
screens, and flat panel monitors.

MVC 2050 Call Handling screen
From the Call Handling screen, the end user can access and operate most 
features available on MVC 2050 (see Figure 20 on page 227). Calls can be 
answered or dial tone obtained by selecting Answer from the Keys menu or 
using the Headset/Answer icon. (see Figure 21 on page 228).

The Call Handling screen contains the telephone dialpad. The appearance of 
the Call Handling screen differs with each available skin. See “MVC 2050 
graphical interface (skins) components” on page 236. The current skin can be 
determined using the Settings > Skin dialog box. All skins share common 
components.

Note: You can use the up, down, left, and right cursor control arrow 
keys on your PDA as navigation buttons to navigate around the skin and 
move through the menu items.
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Figure 20
Starting the MVC 2050 from the Main Application screen
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Figure 21
Call Handling screen

Display

The display is located in the central area of the skin. Messages and text are 
viewed on the display. See Figure 21.

Dialpad

The twelve-button dialpad is located on the left side of the skin. See 
Figure 21.

Display

Dialpad

Soft keys
(self-
labeled)

Program-
mable
Line/
Feature
keys

Menu keys
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Soft keys (self-labeled)

There are four soft keys (self-labeled) located in the bottom row of the 
display. The labels on these keys depend on the call server. See Figure 21 on 
page 228.

Programmable line/feature keys

There are six programmable line/feature keys located on the right side of the 
skin. They are aligned vertically and are the same color as the display. The 
number of features available depends on the call server. See Figure 21 on 
page 228.

Menus 

MVC 2050 provides the following menus:

• File

• Keys

• Help

File

The File menu provides the following items:

• Run in background

• Paste

• Contacts

• Settings

• Exit

See Figure 22 on page 230.
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Figure 22
File Menu screen

Run-in-background 

Select Run-in-background to close MVC 2050 but allow it to keep running 
in the background so that incoming calls can ring on your PDA. 

After you have completed your call, press the X in the upper right-hand 
corner of the PDA display to close the MVC 2050 application and return it to 
the background.

Paste

Select Paste to paste a telephone number into your PDA from another 
application to place a call rather than entering an existing telephone number 
through your Call Handling screen dialpad. 
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Contacts

Select Contacts to launch the Contacts dialog box. The Contacts application 
reads a list of contacts from the PDA Contacts list or from a list which you 
have synchronized onto your PDA from Outlook. 

Settings

Select Settings to provide access to the Settings submenu. The Settings 
menu provides windows for Personal settings, System settings, and 
Connections settings. See “Settings” on page 251.

The System settings window provides access to settings for memory, power, 
remove programs, screen and regional settings, iTask settings, and self 
test.

Note: A reboot of MVC 2050 is required for settings changes to 
Profiles, Hardware ID, Sounds, Servers, and Listener IP to take 
effect. 

Exit

Select Exit to close MVC 2050. Once Exit has been activated, calls cannot 
be received until the application is re-started.

Note: Selecting Exit frees up PDA-processing resources.

Keys

The Keys menu provides the following items: See Figure 23 on page 232.

• Headset

• Answer

• Goodbye

• Hold

• Features

• Macros
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Figure 23
Keys menu

Headset

Select Headset to answer an incoming call or to obtain dial tone to place a 
call (see Figure 23, "Keys menu"). You can also use the Headset/Answer 
icon located at the top, center of the screen. 

Answer

Select Answer to answer an incoming call or to obtain dial tone to place a 
call. You can also use the Headset/Answer icon on the Call Handling screen 
to answer an incoming call or obtain dial tone (see the Headset/Answer icon, 
located at the top, center of the screen. See Figure 23, "Keys menu").

Call Handling icons

Hold Headset/AnswerGoodbye
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Goodbye

Select Goodbye to end a call. You can also use the Goodbye icon located at 
the top right of the screen. See Figure 23 on page 232.

Hold

Select Hold to place a call on hold. You can also use the Hold icon located at 
the top left of the screen. See Figure 23 on page 232.

Features

Select Features from the Keys menu to access a menu of interface keys. See 
Figure 24 on page 234. 

Meridian 1, CS 1000S, CS 1000M, and CS 1000E communication servers 
provide the following default Features menu: 

• Messages

• Shift

• Directory

• Services

• Expand

• Copy

• Quit

• Redial List

• Callers List

To re-arrange items on this list, open the Settings menu and select the 
Features tab. Items on this list cannot be added or removed.
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Figure 24
Keys > Features screen

Macros

Select Macros from the Keys > Features submenu to access macros (also 
available through the Settings > Macros dialog box). Macros can be used to 
make speed-dials, access voicemail, and other routine functions faster and 
easier. For more information about macros see “Macros” on page 265.
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Help

Select Help to access the MVC 2050 PDA-specific version of Help. See 
Figure 25.

Figure 25
Help menu

The Help menu provides the following items:

• Contents

• Diagnostics

• About MVC 2050

Contents

Select the Contents menu item to access the Help system.
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Diagnostics

Diagnostics provides access to a list of methods to determine server 
connection state.

Following are the diagnostic methods provided:

• Ping

• TraceRoute

• RUDP Ping

Also see “Profiles” on page 257 for information on importing and exporting 
profiles to assist in troubleshooting.

About MVC 2050

About MVC 2050 identifies the MVC 2050 application. Select About 
MVC 2050 to view configuration information for your MVC 2050(such as 
system product name, version number, copyright indication, manufacturer’s 
name and logo, and Global IP Sound name and logo). MVC 2050 uses packet 
loss concealment provided by Global IP Sound NetEQ software.

MVC 2050 graphical interface (skins) components

MVC 2050 provides alternative graphical images known as skins. The 
dialpad, menu, and icon buttons are located on the skin. Skins come in several 
colors and arrangements. See Figures 26 to 30, starting on page 237.

All skins share the following common components. See Figure 26 on 
page 237.

• programmable line/feature keys

• soft keys (self-labeled)

• dialpad

• display

• Call Handling icons

• Toolbar icons

• Menu Bar icons
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• retractable toolbar

• Message Waiting light

• System Input Panel icon

Figure 26
Graphical image (skin), common components

 

Message
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Programmable
Line/Feature
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Soft keys
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Display
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Figure 27
Black skin

Figure 28
Blue skin 
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Figure 29
Lime skin

Figure 30
Round skin 
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Icons

The MVC 2050 Call Handling screen presents icon equivalents for menu 
items. See Figure 31: “  Call Handling screen icons (with Toolbar retracted)” 
on page 241.

Icons can be divided into three types:

• Call Handling icons

• Toolbar icons

• Menu Bar icons



 Nortel Mobile Voice Client 2050  Page 241 of 508

IP Phones Description, Installation, and Operation

Figure 31
Call Handling screen icons (with Toolbar retracted)

Call Handling icons

There are three Call Handling icons across the top of the Call Handling 
screen. See Figure 31.

The following are the Call Handling icons:

• Hold

• Headset/Answer

• Release

Menu Bar

Toolbar

Call Handling
icons

Hold Directory

Messages

Shift

Services

Expand

Copy

Release

Quit

Toolbar
icons

Menu Bar
icons

 

System Input

Toolbar toggle
Settings
Paste

Contacts

System Input
icon

Headset/Answer
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Menu Bar icons

MVC 2050 provides icons which can be used instead of text menu 
equivalents. See Figure 31 on page 241.

The following are the Menu Bar icons:

• Paste

• Contacts

• Settings

• Toolbar toggle

• System Input icon

Toolbar icons

The retractable toolbar contains icons which are not present on the remainder 
of the display. The icons are located at the bottom of the skin and are visible 
when the Toolbar is retracted. You can retract the Toolbar using the Toolbar 
Toggle icon at the bottom of the screen. See Figure 31 on page 241.

The following are the icons visible on the Toolbar:

• Mute

• Volume Down

• Volume Up

The following are the icons visible when the Toolbar is retracted:

• Mute

• Volume Down

• Volume Up

• Directory

• Messages

• Shift

• Services

• Expand
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• Copy

• Quit

System Input Panel

To access the System Input Panel from MVC 2050, tap the System Input 
Panel icon on the Menu Bar in the bottom right-hand corner of the PDA. See 
Figure 31 on page 241. Consult the PDA documentation for a description of 
the System Input Panel. 

You can use the System Input Panel to enter data for MVC 2050 and other 
applications. To enter data, use the keyboard or the transcriber. See Figure 32 
on page 244 for an example of transcriber use.

The following are the default System Input Panels:

• Block Recognizer

• Keyboard

• Letter Recognizer

• Transcriber
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Figure 32
System Input using a transcriber

Using the MVC 2050 application, the keyboard can act like a dialpad, 
interpreting the alphabetical keys as numbers. For instance, if you type a J, K, 
or L, it is interpreted as a number five (5). Keys which are not alphanumeric 
are ignored.

AAA1217.bmp
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Operating parameters
The operating parameters for MVC 2050 are as follows:

• MVC 2050 application supports English language only.

• MVC 2050 is supported on PDAs running Windows Mobile 2003.

The following are the minimum recommended PDA hardware specifications:

• CPU type Intel XScale® PXA 255, speed 400 MHz

• Memory 48 Mb ROM, 64 Mb RAM

Software requirements

MVC 2050 requires Windows Mobile 2003.

For secure Virtual Private Network (VPN) access to a network, a VPN client 
is required. The certicom™ movianVPN™ client and the Apani™ Networks 
VPN client have been tested with MVC 2050. The VPN client runs on the 
PDA and is similar to the Contivity client that runs on a PC. The VPN client 
can establish the necessary IPsec tunnel through a Contivity server.
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Operation
Use Procedure 48 to start MVC 2050.

Procedure 44
Starting MVC 2050

1 From the Main Application screen, select Programs.

2 Select Start.

3 Select Mobile Voice Client 2050. The Call Handling screen appears. 
(See “MVC 2050 Call Handling screen” on page 226).

End of Procedure
.

PDA processor speed can have adverse effects on MVC 2050 performance.

CAUTION
PDA processor models, speed, and amount of 
memory vary. To maintain audio quality, do not 
overload the processor with intensive tasks 
while using MVC 2050. For example, Nortel 
does not recommend using your PDA’s version 
of Internet Explorer while using MVC 2050.

IMPORTANT!

Set the PDA processor speed to the highest setting or to auto, which 
changes the processor speed according to system status. To set the 
PDA processor speed, select: 
Start > Setting > System > Power > Processor or CPU speed, 
depending on the type of PDA. 
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PDA battery life can affect the MVC 2050 call duration and the call volume.

MVC 2050 installation
If an older version of MCV 2050 is installed on the PDA, remove it prior to 
installing a newer version. See “MVC 2050 removal” on page 249.

To install MVC 2050 on the PDA:

1 Place the PDA in its cradle.

2 Synchronize the PDA with a desktop PC running Microsoft® 
ActiveSync® using Procedure 45.

3 Install the MVC 2050 from a Desktop using Procedure 46 on page 248.

MVC 2050 installation method

MVC 2050 supports installation from a docked PDA with a Microsoft 
ActiveSync connection to a desktop PC.

Synchronizing a PDA with a desktop PC

Use Procedure 45 to synchronize your PDA with your desktop PC.

Procedure 45
Synchronizing a PDA with a desktop PC 
using ActiveSync

1 Place the PDA in its cradle.

2 Ensure that ActiveSync is running.

IMPORTANT!

PDA vendors offer two types of rechargeable battery: standard and 
extended-life. The extended-life battery is recommended. It provides 
longer call duration and increased call volume than the standard-life 
battery.
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3 Wait for the PDA and the PC to synchronize. See Figure 33 on page 248.

End of Procedure

For details about synchronizing a PDA with a desktop PC, refer to the PDA 
Users Manual.

Figure 33
ActiveSync connected screen

Installing MVC 2050 from a Desktop PC using ActiveSync

Use the following procedure to install MVC 2050 using the product CD.

Procedure 46
Installing MVC 2050

1 Synchronize the PC and PDA. See Procedure 45 on page 247.

2 Insert the MVC 2050 CD into the CD-ROM drive of your desktop PC.

3 Go to your desktop and double-click My Computer. The PC files and 
folders menu appears.

AAA1185.bmp
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4 Select the CD Drive.

5 Select Setup.

6 Follow the instructions on the screen until the Install Wizard asks you if 
you want to modify, install, or remove MVC 2050.

7 Select Install. The Install Wizard installs MVC 2050. When installation 
finishes, a message displays on the PC:

• “attend to your device (PDA)”. 

• The PDA displays a message; “do you want to perform a soft 
restart?”.

8 Select Yes. Your PDA restarts.

End of Procedure

MVC 2050 removal
Use the following procedure to remove MVC 2050 from your PDA. See 
Figure 34 on page 250.

Procedure 47
Removing MVC 2050 from your PDA

1 Select Start. A drop-down menu appears.

2 Select Settings. A Windows folder with a number of programs, usually 
shown as icons with names and a row of tabs across the bottom, appears.

3 Select the System tab. Another Windows program folder appears.

4 Select Remove Programs. A list of programs appears.

5 Select Nortel MVC 2050.

6 Select Remove. A dialog box appears, asking you to confirm this 
decision.

7 Select Yes. There is a brief pause during removal of MVC 2050. After the 
pause, a dialog box appears asking if you want to perform a soft reset.

8 Select Yes. Your PDA restarts and MVC 2050 has been removed.

End of Procedure
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Figure 34
Removing MVC 2050

Configuration
MVC 2050 has a flexible interface which enables end users to customize 
configurations for a variety of connections.

About MVC 2050

About MVC 2050 identifies the application. Select About MVC 2050 from 
the Help menu to view configuration information for your system such as the 
MVC 2050 system product name, version number, copyright indication, 
manufacturer’s name and logo, and the Global IP Sound® name and logo. 
MVC 2050 uses packet loss concealment provided by Global IP Sound 
NetEQ software.
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Settings

Select Settings from the File menu to access the Settings submenu. Settings 
provides windows for Personal settings, System settings, and Connections 
settings to control the behavior, appearance, and connection status of your 
MVC 2050.

The System settings window provides access to settings for memory, power, 
remove programs, screen and regional settings, iTask settings, and self 
test.

Note: A reboot of MVC 2050 is required for settings changes to 
Profiles, Hardware ID, Sounds, Servers, and Listener IP to take 
effect. 

Server 

The Server tab, accessible from the Settings screen, contains all the settings 
necessary for MVC 2050 to contact a server. See Figure 35, "DHCP Setting 
on Server screen" and Figure 36 on page 253. Settings on the Server tab can 
be changed to access a different server or you can implement the profile 
containing the desired server (see “Profiles” on page 257).
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Figure 35
DHCP Setting on Server screen
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Figure 36
Assigning Server values

Connection history

Connection history writes connection and disconnection indication messages 
to the registry key “HKCU\Software\Nortel \MVC2050\Log”. This is a 
circular queue of 29 entries. Each time a connection or disconnection event 
occurs, a log entry is written. The entries contain a date and time and a 
description of the connection or disconnection event. Following are the 
descriptions of the connection and disconnection events.

Soft reset, server n

Server n indicates that the server has instructed MVC 2050 to reset and 
connect to a server ‘n’ where ‘n’ and its value is determined, and possibly 
written, by the server. This message maps directly to a UNIStim message.

Server connected

Server connected indicates that MVC 2050 has successfully connected to the 
server. It means that MVC 2050 received the “Assign TerminalID” UNIStim 
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message, which is the last message received by MVC 2050 before a normal 
session is started.

Recovering: Server unreachable

The Recovering: Server unreachable message is generated when MVC 
2050 loses connection with the server. It indicates that the UNIStim 
“watchdog timer” has expired and indicates loss of network connection.

Hard Reset

The Hard Reset message indicates that the server has instructed MVC 2050 
to reset and clear its UNIStim-related memory. This message maps directly 
to a UNIStim message.

Hardware ID

The Hardware ID screen is used to select the MAC address that MVC 2050 
reports to the communication server. The MAC address can be reset.

The Hardware ID being used by MVC 2050 can be viewed in the MVC 2050 
Settings on the Hardware ID tab. See Figure 37 on page 255.

Hardware IDs are generated by reading MAC addresses from the PDA 
Network Interface Card (NIC). When MVC 2050 is used with most server 
types, the Hardware ID it uses must be unique. Some software, such as VPN 
client software, creates artificial network interfaces with MAC addresses 
which are not unique. These may be addresses which will be common to all 
installations of a particular VPN client. 

Without a unique MAC address, an MVC 2050 may not be able to connect to 
a server, or may connect to a server and cause another device with the same 
hardware ID to be disconnected from the server. If MVC 2050 is 
disconnected from the server it automatically attempts to reconnect. The 
resulting conflicts prevent a stable connection from being made.

You can enable Auto-Create to prevent conflict with another device. 
Auto-Create fabricates a MAC address with a random value which is 
unlikely to be repeated by another device.
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Use Procedure 48 to enable Auto-Create.

Procedure 48
Enable Auto-Create

1 Select Settings.

2 Select Hardware ID.

3 Select Auto-Create.

End of Procedure

Figure 37
Hardware ID screen



Page 256 of 508  Nortel Mobile Voice Client 2050

553-3001-368 Standard 12.00 March 2006

For more information about the Hardware ID screen, see Table 24.

Dialing formats

Dialing Locations settings set the dialing rules to be applied to properly route 
a call when an end user dials a number. The dialing rules establish prefixes to 
access local and long-distance numbers using the location of the end user’s 

Table 24
Hardware ID screen

Selection Description

Hardware ID This box contains the MAC address for 
the Ethernet hardware installed in your 
device. MVC 2050 uses the MAC 
address of the Ethernet hardware as its 
hardware ID. You may have to change 
this value if there is more than one MAC 
address, or if the device is using an 
extranet client that hides the true MAC 
address. For example, the Nortel 
Contivity Extranet Switch uses a single 
MAC address for all clients. This might 
cause connection problems with your 
communication server.

Auto-create This changes the MAC address that 
appears in the Hardware ID box. If your 
device has more than one MAC address, 
tap the Auto-Create button to cycle 
through the set of MAC addresses on 
your computer. Auto-Create also makes 
up random hardware IDs in case the 
Ethernet hardware addresses are not 
unique to the communication server.

Firmware Version Shows the build number of MVC 2050 
installed on your device. This value is 
the version number of the application 
last reported by the server.
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server. To establish the dialing rules and dialing patterns, see Mobile Voice 
Client 2050 User Guide. 

Profiles

Each profile is a named file that contains a combination of servers and other 
attributes that control connection, behavior, and appearance of the 
MVC 2050. 

A number of profiles can be created and saved to allow easy switching among 
different servers, feature programming, and audio programming. 

Profiles can be created, selected, modified, or deleted. When you select a 
profile you can change the name, modify it or delete it. 

When a profile is selected, all other Settings tabs refer to the selected profile. 
The name of the selected profile is shown in the lower right corner on each 
tab. See Figure 38 on page 258.

From the Profiles screen you can:

• create profiles

• delete profiles

• modify a profile’s name

• change the profile used by the application

• export profiles

• import profiles
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Figure 38
Profiles screen

When a new profile has been created and selected, the values on all of the 
other tabs have been set to the defaults for this profile. Any value modified 
on any of the other tabs will be associated with this profile until another 
profile is selected. To change settings on other tabs for this profile, select the 
tab you wish to change. For example, go to the Server tab to modify the 
server settings.

Sounds

MVC 2050 can make sounds to indicate server connection or disconnection.

Sound files and sound settings are not saved when Profiles are saved, so the 
sounds must be programmed by the end user. Up to three sounds can be 
programmed for use with audible notification of server connection or 
disconnection.

AAA1189.bmp
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Following are descriptions of the events for which the sounds are used. See 
Figure 39 on page 259.

Server unreachable

The sound you select for this event plays when MVC 2050 loses contact with 
the server. The message “Server unreachable” displays on the PDA screen.

Server unresponsive

The sound you select for this event plays if MVC 2050 fails to connect to the 
server. The message “Server unresponsive” displays on the PDA screen.

Server connected

The sound you select for this event plays when MVC 2050 connects to a 
server.

Figure 39
Events List 
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Audio Quality

Audio quality is controlled from two screens: 

• Audio, the quality slider tab

• Advanced Audio

Audio quality slider tab

You can control audio quality using the slider tab to reduce audio delay and 
increase audio clarity. This slider controls the number of audio buffers the 
PDA uses to smooth out incoming audio streams.

If you experience audio delay, you can decrease the number of buffers and 
reduce the delay by using the slider on the Audio screen.

If you experience broken or choppy speech at either end of the call, or the dial 
tone sounds choppy, the PDA’s volume control may be the cause. To prevent 
this problem, use the volume controls on the MVC 2050 toolbar to adjust 
volume while using the MVC 2050.

If you experience reduced audio clarity in the receive audio stream, try 
increasing this setting. Increasing the Audio clarity setting increases the 
number of audio buffers used to process incoming audio. If the delay is too 
large, you can decrease this setting. 

Automatic Gain Control and feedback

Since MVC 2050 requires a headset to operate properly, disable the 
Automatic Gain Control.

Note: When the PDA is used in handsfree mode, without a headset, the 
PDA microphone picks up sounds from the speaker, creating a feedback 
loop. Automatic Gain Control is used in this instance to avoid 
feedback.
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Use the following procedure to disable the Automatic Gain Control.

Procedure 49
Disabling Automatic Gain Control

1 Select Start.

2 Select Settings.

3 Select System.

4 Select iPAQ Audio.

5 Select Automatic Gain Control.

6 Select Disable.

7 Select Yes.

End of Procedure

Advanced Audio

Global IP Sound NetEQ software provides loss concealment and 
compensation. 

NetEQ is the default setting and MVC 2050 Advanced Audio settings cannot 
be adjusted.

Figure 40 on page 262 shows the Advanced Audio screen.
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Figure 40
Advanced Audio screen
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See Table 25 for more information about the Advanced Audio screen. 

Echo cancellation

MVC 2050 can use the Voice Gateway Media Card for echo cancellation.

Table 25 
Advanced Audio screen 

Selection Description

NetEQ (Global IP Sound) NetEQ packet loss concealment 
software is the default mode of 
operation.

Jitter Buffer A Jitter Buffer is used to minimize a 
change in rate for arriving voice frames. 
The Jitter Buffer sends voice frames to 
your PDA sound system at a fixed rate. 
The rate of arrival of voice frames is 
variable. The value of “jitter” is the 
normal number of voice frames the 
application should have in its jitter 
buffer. 

Highwater Mark Highwater Mark indicates the 
maximum number of voice frames the 
application should have in its jitter 
buffer before it starts discarding 
packets. This value should be at least 
2.5 times the value of jitter. If a smaller 
value is assigned, MVC 2050 regards it 
as an error and corrects it.

Early Packet and Late Packet 
Resync

Early Packet Resync and Late Packet 
Resync indicate the points at which 
MVC 2050 discards and restarts the 
jitter buffer contents. This value should 
be at least five times the Highwater 
Mark. 
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Jitter Buffer

Global IP Sound NetEQ, bundled with MVC 2050 software, provides loss 
concealment and compensation for up to 30% packet loss. 

NetEQ is an advanced jitter buffer and packet loss concealment unit that 
delivers improvements in sound quality, while minimizing latency, for IP 
telephone systems. It is a one-sided, embedded solution that enables 
high-quality voice over networks. NetEQ reduces jitter buffer delay 30-80 ms 
and automatically provides a solution to clock drift present in VoIP hardware. 
NetEQ is codec independent.

The jitter buffer is used to minimize a change in rate for arriving voice frames. 
The jitter buffer sends voice frames to the PDA sound system at a fixed rate. 
The rate of arrival of voice frames is variable. The value of “jitter” is the 
normal number of voice frames the application should have in its jitter buffer. 

Codec

MVC 2050 supports G.711 which provides higher audio quality with no 
compression.

Frame Size

MVC 2050 supports G.711-64 A-law and U-law with 10 ms to 960 ms frame 
sizes in 10 ms increments. Optimum and recommended payload is 
established as 30 ms frame size.
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Listener IP

Use the Listener IP screen to override the port assignments when there is a 
conflicting application on the PDA.

See Table 26 for information about selections available on the Listener IP 
screen.

Macros

The Mobile Voice Client (MVC) 2050 Macros tab enables you to record and 
use macros. A macro is a recorded sequence of steps that saves you 
keystrokes. 

For example, you can create a macro that selects a particular line and then 
dials that telephone number automatically. Another example of macro use is 
programming voicemail access numbers and codes for faster access.

Macro screen

To enter a new macro name, or to select an existing macro to modify or delete, 
select the New icon to the right of the list box. See Figure 41 on page 266.

Table 26
Listener IP screen

Selection Description

Use a specific address MVC 2050 normally listens to all 
IP addresses on the device for 
communication server-to-terminal 
(UNIStim) messaging on all the 
network interface cards on the 
device. This is the default mode of 
operation. To override this 
behavior, select the check box and 
enter a specific IP address.

Use a specific port MVC 2050 listens to IP port 5000 
on the device for communication 
server-to-terminal (UNIStim) 
messaging.
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To select an existing macro, tap the down arrow in the Macro list box and 
make your selection. 

To delete a selected macro, tap the Delete icon (the button to the right of the 
list box).

Figure 41
Macro screen

Keys

Once you have selected a macro name, tap the down arrow in the Keys 
drop-down list to select a key to add to the macro. Press the Add button to 
add the key. 

The Pause key is used to insert a short pause in the macro. A pause introduces 
a delay which may be required to access some Interactive Voice Response 
(IVR) applications and the voicemail systems.



 Nortel Mobile Voice Client 2050  Page 267 of 508

IP Phones Description, Installation, and Operation

Contents

A list of the macro’s contents appears in the Contents list box. Once there are 
two or more entries in this box, the keystrokes can be moved around by using 
the up and down buttons which appear to the right of the box.

You can remove keystrokes from the Contents box by selecting a keystroke 
and pressing the Remove button.

Preview

You can preview your macro in a single view by viewing the read-only field 
under the Contents box. 

Dialpad

You can select the Keys list box and press the Add button, or you can use the 
numbers on the dialpad to enter numbers into your macro.

MVC 2050 and WLAN

802.11b wireless ethernet networking

MVC 2050 uses an 802.11b WLAN interface.

Audio quality is affected by the distance from the AP and enclosed spaces. 
Audio quality is also affected by the use of Bluetooth accessories while on a 
voice call due to interference and contention.

QoS

Due to device constraints, 802.11 p/q is not supported.

CAUTION
MVC 2050 does not support use of Bluetooth 
accessories.
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WiFi

ActiveSync of a PDA with a PC can be accomplished using Wireless Fidelity 
(WiFi).

Roaming and handover

If you experience slight gaps and pauses in transmission and reception during 
calls, MVC 2050 may be experiencing roaming/handover difficulties 
attributable to the wireless network. 

CAUTION
When you return the PDA to its cradle, if you 
want to maintain the MVC 2050 connection to 
the server, deactivate ActiveSync. Otherwise the 
connection is lost because ActiveSync uses 
Point-to-Point Protocol (PPP). This will cause 
the PDA connection to the voice network to be 
dropped and connected to the PC.
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Nortel WLAN Handset 2210, 
WLAN Handset 2211, and 
WLAN Handset 2212

For information about WLAN Handset 2210, WLAN Handset 2211, and 
WLAN Handset 2212, refer to WLAN IP Telephony: Installation and 
Configuration (553-3001-304).
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Introduction
This section explains how to install and maintain the IP Audio Conference 
Phone 2033. For information on using the IP Audio Conference Phone 2033, 
see the Nortel IP Audio Conference 2033 User Guide.

This section contains the following procedures:

• Procedure 50, “Pre-installation checklist” on page 283

• Procedure 51, “Installing an IP Audio Conference Phone 2033 for the 
first time using manual configuration” on page 285

• Procedure 52, “Installing an IP Audio Conference Phone 2033 for the 
first time using DHCP” on page 293

• Procedure 53, “Disabling Auto Negotiate and enabling Full Duplex 
mode” on page 299

• Procedure 54, “Changing the TN of an existing IP Audio Conference 
Phone 2033” on page 300

• Procedure 55, “Replacing an IP Audio Conference Phone 2033” on 
page 301

• Procedure 56, “Removing an IP Audio Conference Phone 2033 from 
service” on page 302

Description
The IP Audio Conference Phone 2033 brings voice to the audio conference 
environment by connecting directly to a Local Area Network (LAN) through 
an Ethernet connection.

The IP Audio Conference Phone 2033 components are shown in Figure 42 on 
page 273 and described in Table 27 on page 274.
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Figure 42
IP Audio Conference Phone 2033

Extension microphones
The IP Audio Conference Phone 2033 supports up to two extension 
microphones that extend the microphone range in large rooms. Each 
extension microphone has a Mute button and an LED indicator to indicate the 
current mute state.

Figure 43 on page 274 shows an extension microphone.
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Figure 43
Extension microphone

Table 27 lists the components and functions of the IP Audio Conference 
Phone 2033.

Table 27
Nortel IP Audio Conference Phone 2033 components and functions (Part 1 of 3)

Component Function

Line (DN) key Use the Line (DN) key to access the single line and activate 
on-hook dialing.

Volume control buttons Use the Volume control buttons to adjust the volume of the 
ringer and speaker.

Mute button Use the Mute button on the main unit or any extension 
microphone to mute the ringer and the speaker.

Note: Pressing the Mute button on the extension 
microphone toggles the mute state of the entire IP Phone, 
not just the microphone.

Goodbye key Use the Goodbye key to terminate an active call.
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Hold key Press the Hold key to put an active call on hold. Press the 
Line (DN) key to return to the caller on hold.

Message (Inbox) key Press the Message (Inbox) key to access your voice 
mailbox.

Navigation keys Use the Navigation keys to scroll through menus and lists 
appearing on the LCD display screen.

Arrows appear on the left side of display screen to indicate 
there is more information to be displayed. 

Soft keys Soft keys (self-labeled) are located below the LCD screen 
display. The LCD screen display above the key changes, 
based on the active feature. Refer to “Soft key label display” 
on page 279 for further information.

Press the Shift soft key labelled >> to access the second 
row of soft keys.

Note: When a triangle appears before a key label, the 
feature is active.

Table 27
Nortel IP Audio Conference Phone 2033 components and functions (Part 2 of 3)

Component Function
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Services key Press the Services key to access the following items:

• Telephone Options (see Notes 1 and 2):

— Volume adjustment

— Contrast adjustment

— Language

— Date/Time

— Local DialPad Tone

— Set Information

— Ring type

• Password Admin:

— Station Control Password

• Virtual Office Login and Virtual Office Logout (if Virtual 
Office is configured)

• Test Local Mode and Resume Local Mode (if Media 
Gateway 1000B is configured)

Note 1: Press the Services key to exit from any menu or 
menu item.

Note 2: The Password Admin menu may not be available 
on your IP Audio Conference Phone 2033. Consult your 
system administrator.

Note 1: If a call is presented while the user is manipulating information, the phone rings. 
However, the screen display is not updated with Caller ID and the programming text is not 
disturbed.

Note 2: The user can originate a call using Last Number Redial while manipulating an option.

Table 27
Nortel IP Audio Conference Phone 2033 components and functions (Part 3 of 3)

Component Function
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Diagnostic Utilities
For further information on Diagnostic Utilities, refer to Appendix D:“IP 
Phone diagnostic utilities” on page 421.

Supported features
The Nortel IP Audio Conference Phone 2033 supports the following 
additional features:

• 802.1Q VLAN and Layer 2 priority bit support, an industry standard for 
managing bandwidth usage 

• Gratuitous Address Resolution Protocol Protection (GARP) 

• VLAN filtering

• Virtual Office

• language support: English, French, Swedish, Danish, Norwegian, 
German, Dutch, Portuguese, Czech, Finnish, Hungarian, Italian, Polish, 
Spanish, Japanese, Russian, Latvian, Turkish

Display characteristics
The IP Audio Conference Phone 2033 has two display areas:

• information line display

• soft key label display

Figure 44 on page 278 shows the two display areas.
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Figure 44
IP Audio Conference Phone 2033 display areas

Cleaning the IP Phone display screen

Press the Goodbye key and gently wipe the IP Phone display screen with a 
soft, dry cloth.

Information line display

The IP Audio Conference Phone 2033 has a one-line information display area 
with the following information:

• Caller number

• Caller name

• Feature prompt strings

• User-entered digits

CAUTION
Do not use any liquids or powders on the IP Phone. 
Using anything other than a soft, dry cloth can 
contaminate IP Phone components and cause 
premature failure.
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• Date and time information (if the IP Phone is in an idle state)

• Set information

The information in the display area changes, according to the call processing 
state and active features.

Soft key label display

The IP Audio Conference Phone 2033 has three soft keys. A maximum of ten 
functions can be assigned to these soft keys.Your system administrator 
assigns functions to the soft keys in layers.

Use the Shift (>>) key to navigate through the layers of functions. If there are 
only three functions assigned to the soft keys, the Shift (>>) key does not 
appear and all three functions are displayed.

Figure 45 shows the soft keys on the display area.

Figure 45
Soft keys

The soft key label has a maximum of six characters. Each soft key includes 
the soft key label and an icon. When a soft key is in use, a flashing icon 
displays at the beginning of the soft key label, and the label shifts one 
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character to the right. (If the label is six characters long, the last or rightmost 
character is truncated.) If a soft key is enabled, the icon state changes to on. 
It remains in the on state until the soft key is pressed again. This cancels the 
enabled soft key and turns the icon off, returning the soft key label to its 
original state.

Key number assignments
The IP Audio Conference Phone 2033 has three soft-labeled, predefined soft 
keys that are used to provide up to ten features. The user cannot change the 
key number assignments.

The Message Indication key is assigned to key 16. Keys numbered 17 to 31 
are the soft keys below the display area. See Table 28 on page 280. 

Key numbers 17 to 31 support A03, A06, CFW, CHG, CPN, PRK, PRS, 
RGA, RNP, SCC, SCU, SSC, SSU and TRN, as listed in Table 28.

Table 28 describes the IP Phone assignment functions for each of the 
dedicated keys. Use LD 11 to program keys 16 to 26 on the IP Audio 
Conference Phone 2033.

Table 28
IP Audio Conference Phone 2033 soft keys (Part 1 of 2)

Key number Response Description

Key 16 MSI Message waiting indication

Key 17 TRN Call Transfer key

Key 18 A06 Six-party conference key

Alternate: A03 (3-party conference)

Key 19 CFW Call Forward key

Key 20 RGA Ring Again key

Key 21 PRK Call Park key

Key 22 RNP Ringing Number Pickup key
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Package components
Table 29 on page 282 lists the components for the IP Audio Conference 
Phone 2033. 

Key 23 Reserved for speed dial Speed dial includes SCU, SCC, SSU, 
SSC

Key 24 PRS Privacy Release key

Key 25 CHG Charge Account key

Key 26 CPN Calling Party Number key

Keys 27 - 31 Reserved

Table 28
IP Audio Conference Phone 2033 soft keys (Part 2 of 2)

Key number Response Description
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Table 29
IP Audio Conference Phone 2033 components list

IP Audio Conference Phone 2033 package contents include:

• IP Audio Conference Phone 2033 (charcoal)

• 7 ft. CAT5 Ethernet cable

• Power Interface Module (PIM) with 25 ft. console cable

• IP Audio Conference Phone 2033 Quick Reference Card

• Universal power supply

NTEX11AA70

IP Audio Conference Phone 2033 package contents include:

• IP Audio Conference Phone 2033 (charcoal)

• 7 ft. CAT5 Ethernet cable

• Power Interface Module (PIM) with 25 ft. console cable

• IP Audio Conference Phone 2033 Quick Reference Card

• 2 Extension microphones (charcoal)

• Universal power supply

NTEX11BA70

Additional Extension microphones with 7 ft. cable NTEX11DA70

Power accessory kit (PIM, Universal power supply, cabling) NTEX11CA

IP Phone IP Audio Conference Phone 2033 Power cords

NA NEMA 5-15P, 125V 13A (10ft.) NTTK14AB

Euro CEE (7) VII, 250V, 10A (2.5m) NTTK16AB

ANZ AS3112, 250V 10A (2.5m) NTTK15AA

Swiss SEV 1011, 250V 10A (8ft.) NTTK17AB

UK/Ireland BS1363, 240V 10A (8ft.) NTTK18AB

Denmark AFSNIT, 250V 10A (2.5m) NTTK22AB

Argentina IRAM 2073, 250V 10A (8ft.) A0814961
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Before you begin
The following section provides a step-by-step guide through the IP Audio 
Conference Phone 2033 installation process. Before installing the IP Audio 
Conference Phone 2033, complete Procedure 50 “Pre-installation checklist” 
on page 283. 

Procedure 50
Pre-installation checklist

1 Ensure there is one IP Audio Conference Phone 2033 boxed package for 
each IP Audio Conference Phone 2033 being installed. See Table 29 on 
page 282 for a list of package contents.

2 To install and configure an IP Audio Conference Phone 2033, the host 
system must be installed with the Voice Gateway Media Card.

3 If an AC power adapter is required, ensure the correct AC power 
transformer is used. The voltage rating of the transformer must match the 
wall outlet voltage. Refer to Table 29 on page 282.

4 Understand the three configuration modes you can choose as you 
proceed through the installation of the IP Audio Conference Phone 2033. 
The three configuration modes are:

• Static IP address – see “Static IP address assignment” on page 284.

• Dynamic Partial DHCP – see “Dynamic IP address assignment—
Partial DHCP” on page 284.

• Dynamic Full DHCP – see “Dynamic IP address assignment—Full 
DHCP” on page 285.

5 Make sure a DHCP server and DHCP relay agents, if required, are 
installed, configured, and running.

End of Procedure
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First time installation

IP address assignments

During the first-time installation, there are IP address parameters that are 
entered either manually or automatically depending on the installation 
configuration. As well, you are prompted to enable or disable 802.1Q VLAN. 
For more information, see “802.1Q VLAN description” on page 407.

There are three configuration modes which you can choose from to obtain the 
IP parameters. Review the following sections for more information on the 
configuration mode you are using.

Static IP address assignment

During the installation, the IP Audio Conference Phone 2033 parameters are 
entered manually using the dialpad.

Your system administrator provides the following information: IP address, 
subnet mask, and default Gateway.

You must also enter the Connect Server parameters, including: IP address, 
port number, action, and retry count.

Go to Procedure 51, “Installing an IP Audio Conference Phone 2033 for the 
first time using manual configuration” on page 285.

Dynamic IP address assignment—Partial DHCP

For a partial DHCP installation, you must provide, through the IP Audio 
Conference Phone 2033 dialpad, the Connect Server parameters, including: 
IP address, port number, action, and retry count. Other parameters (IP Phone 

CAUTION — Service Interruption

Do not plug your IP Audio Conference Phone 2033 into 
an ISDN connection. Severe damage can result. Consult 
your system administrator to ensure you are plugging 
your IP Phone into a 10/100BaseT Ethernet jack.
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IP address, subnet mask, default Gateway, and TFTP Server IP address) are 
retrieved from the DHCP server.

The IP Audio Conference Phone 2033 password, node ID and TN must be 
entered manually from the dialpad.

For more information about DHCP servers, see Converging the Data 
Network with VoIP (553-3001-160).

Go to Procedure 52, “Installing an IP Audio Conference Phone 2033 for the 
first time using DHCP” on page 293.

Dynamic IP address assignment—Full DHCP

For a full DHCP installation, all parameters (IP Phone IP address, subnet 
mask, default Gateway, Connect Server IP address, port number, action, and 
retry count) are retrieved from the DHCP server to recognize the IP Audio 
Conference Phone 2033.

The IP Audio Conference Phone 2033 password, node ID, and TN must be 
entered manually from the dialpad.

For more information on how to set up DHCP servers for use with the 
IP Audio Conference Phone 2033, refer to Converging the Data Network with 
VoIP (553-3001-160).

Go to Procedure 52, “Installing an IP Audio Conference Phone 2033 for the 
first time using DHCP” on page 293.

Procedure 51
Installing an IP Audio Conference Phone 2033
for the first time using manual configuration

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Audio Conference Phone 2033 on the system using 
LD 11. At the prompts, enter the following:

REQ:chg
TYPE:i2001
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TN cc uu
ECHG yes
ITEM cls hfa
ITEM

For more information, see Software Input/Output: Administration 
(553-3001-311).

3 Connect one end of the CAT5 Ethernet cable to the network interface 
located on the back of the Power Interface Module (PIM). See Figure 46. 
Plug the other end of the CAT5 Ethernet cable into your IP network 
interface. 

Figure 46 shows the Power Interface Module (PIM).

Figure 46
PIM

4 Connect one end of the AC power adapter cord to the power supply port 
located on the back of the PIM. Thread the cord through the channel on 
the bottom of the PIM and plug the other end into the AC power source. 
Ensure the correct AC power transformer is used. The voltage rating of 
the transformer must match the wall outlet voltage. Refer to Table 29 on 
page 282.
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5 The middle port of the PIM (see Figure 46 on page 286) has an attached 
CAT5 Ethernet cable. Thread the cord through the channel on the bottom 
of the IP Phone and plug it into the PIM port on the IP Phone. See 
Figure 47 on page 288.

Note: Red LEDs indicate power. Messages indicating system start up, 
such as Loading, Initializing network, and Loading boot parameters 
appear after a short delay.

Figure 47 on page 288 shows the bottom view of the IP Audio Conference 
Phone 2033.
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Figure 47
Bottom view of IP Audio Conference Phone 2033

You will hear a tone shortly before the IP Phone is ready to start the Nortel 
IP Phone application. Once the application has loaded and started, you will 
see the Nortel logo and Starting DHCP will appear at the bottom of the screen. 

6 To enter the configuration menu, press the three soft keys at the bottom 
of the display in sequence from left to right.

7 At the prompt, DHCP Yes/NO?, select No.

IMPORTANT!

Timing information
When you see the Nortel logo, you have one second to respond by 
pressing the three soft keys at the bottom of the display in sequence 
from left to right. If you miss the one-second response time, the IP Audio 
Conference Phone 2033 attempts to locate the connect server. Wait until 
it is finished, and then begin the power-up sequence again.
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8 Enter the following information provided by your system administrator:

Note: The TFTP Server is required to download the current firmware. For 
further information on TFTP Server configuration, see Appendix E:“TFTP 
Server” on page 489.

Screen prompt Description

set IP a valid IP Audio Conference Phone 2033 IP 
address

net msk a subnet mask

def gw the default Gateway for the 
IP Audio Conference Phone 2033 on the 
LAN segment to which it is connected.

Emulation Key Mapping 
(0 HS 1 HF) :0

1 for (HF)

TFTP Server IP 0.0.0.0. the TFTP Server IP address
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9 Enter the information for the primary Connect Server (S1) and the 
secondary Connect Server (S2):

Screen prompt Description

S1 IP The node IP address of the IP line 
node

S1 Port This is a fixed value: 4100

S1 action This is a fixed value: 1

S1 retry The number of times the IP Audio 
Conference Phone 2033 attempts to 
connect to the server. Enter 10.

S2 IP Same as S1 in most cases (see note 
below)

S2 Port Same as S1

S2 action Same as S1
S2 retry Same as S1

Cfg XAS? (0-No,1-Yes) Enter 0 (for No), since External 
Application Server is not supported 
on the IP Audio Conference Phone 
2033.

This prompt exists to support future 
implementation of External 
Application Server.

VLAN? (0-No, 1-Ma, 2-Au) Default 0-No 
802.1Q VLAN remains off and 
initialization continues.
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1-MA 
Enter a VLAN ID manually, then 
press OK.
The following VLAN ID displays:
Manual Cfg

VLAN: 1234

Note: The VLAN ID is entered as a 
decimal. The VLAN ID is a 12-bit 
value between 0 and 4095.

The IP Audio Conference Phone 
2033 is configured with 802.1Q 
VLAN enabled, priority = 6, and the 
VLAN ID set to the entered value.

2-Au
Enter a VLAN ID automatically. This 
prompt exists to support future 
implementation of DHCP.

VLANFILTER (0-No, 1-Yes)
Default 0 (for No)

You will not be prompted for 
VLANFILTER if VLAN? is not 
enabled.

Data VLAN? (0-No, 1-Yes) After the value is entered, the DATA 
VLAN configuration option appears 
on the display.

Select 0-No, since DATA VLAN is 
not supported on the IP Phone Audio 
Conference Phone 2033.

Duplex (0-Auto, 1-Full) :0 Default 0 (for Auto)

GARP Ignore? (0-No,1-Yes) Default 0 (for No)
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Note: The IP Audio Conference Phone 2033 can support a primary (S1) 
and secondary (S2) connect server. If you require IP Phones to register 
on multiple nodes, refer to IP Line: Description, Installation, and 
Operation  (553-3001-365).

The IP Audio Conference Phone 2033 searches for the TFTP Server for 
firmware upgrade. If the filename specified in i2033.cfg is not the same as 
the current firmware, the telephone downloads the file and upgrades the 
firmware. This takes several minutes. When the upgrade is complete, the 
IP Audio Conference Phone 2033 reboots. The current system date and 
time appear on the top line of the display when the configuration is 
complete. Self-labeling keys also appear.

Note: A TFTP Server is required to download the current version of 
firmware. For further information on TFTP Server configuration, see 
Appendix E:“TFTP Server” on page 489.

The IP Audio Conference Phone 2033 searches for the connect server. 
When the connection is complete, proceed with Step 10.

10 Enter the following information:

Note: Select the Shift soft key labeled (>>) and press Clear to edit the TN 
field. The IP Audio Conference Phone 2033 by default will place you in the 
units field of the TN. You can not use backspace to move to the loop, shelf 
or card fields.

The current system date and time appear on the top line of the display 
when the configuration is complete. Self-labeling keys also appear.

11 Check for dial tone and the correct DN above the display.

12 (Optional) Customize the soft keys as required. For more information, see 
Software Input/Output: Administration (553-3001-311) and IP Audio 
Conference Phone 2033 User Guide.

End of Procedure
.

Screen prompt Description

Password IP Phone Installer Password

You are not prompted to enter the IP Phone 
Installer Password if it has not been configured 
in your system.

Node The node ID.

TN The TN or VTN.
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Procedure 52
Installing an IP Audio Conference Phone 2033 
for the first time using DHCP

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Audio Conference Phone 2033 on the system using 
LD 11. At the prompts, enter the following:

REQ:chg
TYPE:i2001
TN cc uu
ECHG yes
ITEM cls hfa
ITEM

For more information, see Software Input/Output: Administration 
(553-3001-311).

3 Connect CAT5 Ethernet cable attached to the Power Interface Module 
(PIM). Thread the cord through the channel on the bottom of the IP Phone 
and plug it into the PIM port on the IP Phone. See Figure 46 on page 286.

4 Connect one end of the AC power adapter cord to the power supply port 
located on the back of the PIM. Thread the cord through the channel on 
the bottom of the PIM and plague the other end into the AC power source. 
Ensure the correct AC power transformer is used. The voltage rating of 
the transformer must match the wall outlet voltage. Refer to Table 29 on 
page 282.

5 Connect one end of the CAT5 Ethernet cable to the network interface 
located on the back of the PIM (see Figure 46 on page 286). Plug the 
other end of the CAT5 Ethernet cable into your IP network interface.

Note: Red LEDs indicate power. Messages indicating system start up, 
such as Loading, Initializing network, and Loading boot parameters 
appear after a short delay.
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Figure 47 on page 288 shows the bottom view of the IP Audio Conference 
Phone 2033.

You will hear a tone shortly before the IP Phone is ready to start the Nortel 
IP Phone application. Once the application has loaded and started, you will 
see the Nortel logo and Starting DHCP will appear at the bottom of the screen. 

6 To enter the configuration menu, press the three soft keys at the bottom 
of the display in sequence from left to right.

7 At the prompt DHCP Yes/No?, select Yes.

8 Select Partial or Full DHCP.

a. If you select Full DHCP, then the following parameters are retrieved 
from the DHCP server:

— a valid IP Audio Conference Phone 2033 IP address

— a subnet mask

— the default Gateway for the IP Audio Conference 
Phone 2033 on the LAN segment to which it is connected

— the S1 node IP address of the IP line node

— the S1 action

— the S1 retry count. This is the number of times the IP Audio 
Conference Phone 2033 attempts to connect to the server

— the S2 node IP address of the IP line node

— the S2 action

— the S2 retry count

IMPORTANT!

Timing information
When you see the Nortel logo, you have one second to respond by 
pressing the three soft keys at the bottom of the display in sequence 
from left to right. If you miss the one-second response time, the IP Audio 
Conference Phone 2033 attempts to locate the connect server. Wait until 
it is finished, and then begin the power-up sequence again.
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b. If you select Partial DHCP, then you must enter the following 
parameters:

Screen prompt Description

S1 IP the node IP address of the IP line node
S1 Port this is a fixed value: 4100

S1 action this is a fixed value: 1

S1 retry the number of times the IP Audio 
Conference Phone 2033 attempts to 
connect to the server; enter 10

S2 IP same as S1 in most cases (see note 
below)

S2 Port same as S1

S2 action same as S1
S2 retry same as S1

Cfg XAS? (0-No,1-Yes) Enter 0 (for No), since External 
Application Server is not supported on 
the IP Audio Conference Phone 2033.

This prompt exists to support future 
implementation of External Application 
Server.

VLAN? (0-No, 1-Ma, 2-Au) Default 0 for No 
802.1Q VLAN remains off and 
initialization continues.
1-MA 
Enter a VLAN ID manually, then press 
OK.
The following VLAN ID displays:
Manual Cfg

VLAN: 1234

Note: The VLAN ID is entered as a 
decimal. The VLAN ID is a 12-bit value 
between 0 and 4095.

The IP Audio Conference Phone 2033 is 
configured with 802.1Q VLAN enabled, 
priority = 6, and the VLAN ID set to the 
entered value.
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Note: The IP Audio Conference Phone 2033 can support a primary (S1) 
and secondary (S2) connect server. If you require IP Phones to register 
on multiple nodes, refer to “Enhanced Redundancy for IP Line Nodes” in 
IP Line: Description, Installation, and Operation  (553-3001-365).

The IP Audio Conference Phone 2033 searches for the TFTP Server for 
firmware upgrade. If the filename specified in i2033.cfg is not the same as 
the current firmware, the telephone downloads the file and upgrades the 
firmware. This takes several minutes. When the upgrade is complete, the 
IP Audio Conference Phone 2033 reboots. The current system date and 
time appear on the top line of the display when the configuration is 
complete. Self-labeling keys also appear.

Note: A TFTP Server is required to download the current version of 
firmware. For further information on TFTP Server configuration, see 
Appendix E:“TFTP Server” on page 489.

The IP Audio Conference Phone 2033 searches for the connect server. 
When the connection is complete, proceed to Step 9.

2-Au
Enter a VLAN ID automatically. This 
prompt exists to support future 
implementation of DHCP.

VLANFILTER (0-No, 1-Yes)
Default 0 (for No)

You will not be prompted for 
VLANFILTER if VLAN? is not enabled.

Data VLAN? (0-No, 1-Yes) After the value is entered, the DATA 
VLAN configuration option appears on 
the display.

Select 0-No, since DATA VLAN is not 
supported on the IP Audio Conference 
Phone 2033.

Duplex (0-Auto, 1-Full) Default 0 (for Auto)

GARP Ignore? (0-No,1-Yes) Default 0 (for No)
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9 Enter the following information:

Note: Select the Shift soft key labeled (>>) and press Clear to edit the TN 
field. The IP Audio Conference Phone 2033 by default will place you in the 
units field of the TN. You can not use backspace to move to the loop, shelf 
or card fields.

The current system date and time appear on the top line of the display 
when the configuration is complete. Self-labeling keys also appear.

10 Check for dial tone and the correct DN above the display.

11 (Optional) Customize the soft keys as required. For more information, see 
Software Input/Output: Administration (553-3001-311) and 
IP Audio Conference Phone 2033 User Guide.

End of Procedure

Startup sequence
When an IP Audio Conference Phone 2033 is connected to the network, it 
must perform a startup sequence. The elements of the startup sequence 
include:

• obtaining the IP parameters

• finding a default Gateway server

• authenticating the user

Table 30 lists a summary of the IP parameters and how they are obtained.

Screen prompt Description

Password IP Phone Installer Password

You are not prompted to enter the IP Phone 
Installer Password if it has not been 
configured in your system.

Node The node ID.

TN The TN or VTN.
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Note: For all static IP address assignments, your system administrator 
provides the network information.

Full Duplex mode
In the Configuration menu, Auto Negotiate mode is the default setting for 
initial startup. Typically, the IP Phone is connected to a network that supports 
Auto Negotiate, and it selects the best speed and duplex mode available. 
There is no intervention required under normal operation.

If the IP Phone is connected to a network configured for Full Duplex mode 
only, it is not able to automatically negotiate the proper configuration. To 
allow the IP Phones to work at the optimum speed and duplex mode, Auto 
Negotiate must be disabled. Use Procedure 53 to disable Auto Negotiate and 
enable Full Duplex mode.

Table 30
IP Audio Conference Phone 2033 IP parameters

Parameter Method of Acquisition

IP Address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Net Mask Manually entered or automatically retrieved through 
Partial or Full DHCP.

Default Gateway Manually entered or automatically retrieved through 
Partial or Full DHCP.

Connect Server (IP address, port, 
action and retry count — primary 
and secondary)

Manually entered or automatically retrieved through Full 
DHCP.

User ID (Node ID, Node Password 
and TN)

Manually entered for first-time configuration. Retrieved 
from local storage on subsequent power cycles.

Note: Your system administrator provides the 
information to enter.
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Procedure 53
Disabling Auto Negotiate and enabling 
Full Duplex mode

1 Reset the IP Phone by disconnecting and re-connecting power.

2 When the Nortel logo appears, press each of the soft keys in sequence. 
See Procedure 52 on page 293.

3 If no other configuration changes are required, press the OK soft key 
repeatedly until the Duplex network option appears.

4 Select 1 to enable Full Duplex mode.

5 When the Speed option appears, select one of the following:

• 0 for 10 Mbps

• 1 for 100 Mbps (default)

6 Select OK to confirm the change.

7 Restart the IP Phone. The firmware reads the new setting, and the IP 
Phone operates in Full Duplex mode.

End of Procedure

When the IP Phone is restarted, the firmware reads the setting for Full 
Duplex mode and sets port 0, the network interface port, accordingly.

Gratuitous Address Resolution Protocol Protection
Gratuitous Address Resolution Protocol Protection (GARP) prevents the 
IP Audio Conference Phone 2033 from GARP Spoof attacks on the network. 
In a GARP Spoof attack, a malicious device on the network takes over an 
IP address (usually the default gateway) by sending unsolicited (or 
Gratuitous) ARP messages, thus manipulating the ARP table of the victim’s 
machine. This allows the malicious device to launch a variety of attacks on 
the network, resulting in undesired traffic routing. For example, a GARP 
attack can convince the victim machine that the malicious device is the 
default gateway. In this scenario, all traffic from the victim’s machine flows 
through the malicious device.

To enable GARP Protection during configuration, refer to Procedure 51, 
“Installing an IP Audio Conference Phone 2033 for the first time using 
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manual configuration” on page 285 or Procedure 51, “Installing an IP Audio 
Conference Phone 2033 for the first time using DHCP” on page 293.

Reinstalling an IP Audio Conference Phone 2033

You can reinstall an existing previously configured IP Audio Conference 
Phone 2033 on the same system. For example, the IP Audio Conference 
Phone 2033 can be assigned to a new user (new TN) or to an existing user 
who moved to a new subnet by changing the TN of the IP Audio Conference 
Phone 2033.

Procedure 54
Changing the TN of an existing 
IP Audio Conference Phone 2033 

1 Repower the IP Audio Conference Phone 2033.

Note: During the reboot sequence of a previously configured the 
IP Audio Conference Phone 2033 displays the existing node number for 
approximately five seconds.

2 If node password is enabled and NULL, choose one of the following:

a. Disable password.

b. Set password as non-NULL.

3 Press OK when the node number displays.

4 Enter password at the password screen, and press OK.

A TN screen displays.

If Then

node password is enabled and is 
not NULL

a password screen displays. Go to 
step 4.

node password is disabled a TN screen displays. Go to 
step 5.
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5 Select the Shift soft key labeled (>>) and press Clear to edit the TN field. 
The IP Audio Conference Phone 2033 by default will place you in the units 
field of the TN. You can not use backspace to move to the loop, shelf or 
card fields.

End of Procedure

Replacing an IP Audio Conference Phone 2033 

Procedure 55
Replacing an IP Audio Conference Phone 2033 

1 Disconnect the IP Audio Conference Phone 2033 that you want to 
replace.

2 Follow either Procedure 51 on page 285 (static IP assignment) or 
Procedure 52 on page 293 (dynamic IP assignment) to install and 
configure the IP Audio Conference Phone 2033.

3 Enter the same TN and Node Number as the IP Audio Conference 
Phone 2033 you replaced. The system associates the new IP Audio 
Conference Phone 2033 with the existing TN.

End of Procedure

IMPORTANT!

Two IP Phones cannot share the same TN. You must remove the IP 
Audio Conference Phone 2033 that is currently using the TN.
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Removing an IP Audio Conference Phone 2033 from 
service

Procedure 56
Removing an IP Audio Conference Phone 2033 
from service

1 Disconnect the IP Audio Conference Phone 2033 from the network or turn 
off the power.

Note: The service to the PC is disconnected as well if the PC is 
connected to the IP Audio Conference Phone 2033.

If the IP Audio Conference Phone 2033 was automatically configured, the 
DHCP lease expires and the IP address returns to the available pool.

2 In LD 11, OUT the TN.

End of Procedure

Connecting an extension microphone 

Procedure 57
Connecting an extension microphone to the 
IP Audio Conference Phone 2033

1 Thread the microphone cord through the channels on the bottom of the 
IP Phone.

Note: A maximum of two microphone jacks are supported on the IP Audio 
Conference Phone 2033.

2 Connect the microphone cord to one of the microphone jacks on the 
bottom of the IP Phone.

End of Procedure
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Introduction
SIP is a protocol standard used for establishing, modifying, and terminating 
conference and telephony sessions in IP networks. A SIP session can be a 
simple two-way telephone call or it can be a collaborative multimedia 
conference session. SIP initiates real-time, multimedia sessions which can 
integrate voice, data, and video.

Nortel supports certified compatible third-party SIP phones. In contrast to IP 
Phones, SIP Phones use an industry standard open standards-based signaling 
protocol, whereas IP Phone signaling is UNIStim based. A Signaling Server 
is required to establish signaling for SIP Phones and SIP Phones exchange 
signaling with SIP components residing on the Signaling Server. Available 
features for SIP Phones depend on the devices themselves, and the 
communication server, and vary from manufacturer to manufacturer and 
between models. Features are delivered to IP Phones from the 
communication server.
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SIP Phones communicate with SIP-network components which reside on the 
Signaling Server. These components include the following:

• SIP Gateway — The SIP Gateway provides a direct trunking interface 
between the CS 1000 systems and a SIP domain. The SIP Gateway is 
implemented according to SIP standards. The SIP Gateway connects 
CS 1000 systems to other Nortel or third-party SIP-enabled products. 
This direct SIP interface is used to interwork with products such as the 
Multimedia Communication Server (MCS) 5100 or CS 2000.

• SIP Redirect Server — The SIP Redirect Server is used to facilitate 
centralized dialing plan management and the configuration of the 
network routing information for the SIP domain. A SIP Redirect Server 
translates telephone numbers recognized by Enterprise Business 
Network (EBN) voice systems to IP addresses in the SIP domain. As a 
result, the SIP Redirect Server interfaces with SIP-based products. The 
SIP Redirect Server has the ability to access the CS 1000 system’s 
endpoint/location database in order to direct SIP Gateways and SIP 
Phones within the networked environment. 

• SIP Registrar — The SIP Registration Server, which is also known as the 
SIP Registrar, is used for endpoint registration. Registration is one way 
that the server can learn the location of a user (SIP client). Upon 
initialization, and at periodic intervals, a user’s telephone sends 
REGISTER messages to the SIP Registrar in the same domain. The 
contact information from the REGISTER request is then made available 
to other SIP servers, such as proxies and redirect servers, within the same 
administrative domain. The registration process precedes the call setup.

SIP-based Converged Desktop Service (CDS) provides the telephony 
features of the CS 1000 systems, along with the multimedia applications of 
the MCS 5100. CDS allows a user to have an identity in the SIP domain (for 
example, a registered PC client), as well as in the CS 1000 system as a 
telephone. For further information, refer to Multimedia Communication 
Portfolio Interworking - Basics (NN10372-111), and for information about 
calls between SIP Phones and SIP Gateways, refer to IP Peer Networking: 
Installation and Configuration (553-3001-213). 
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SIP Phone features
The following is a list of features delivered through the 
Communication Server 1000:

• Calling Line Identification (CLID)

• Network Call Party Name display

• Network Call Redirection

• Message Waiting Indication

• Network Class of Service Access controls

• Network Alternate Route Selection (NARS, UDP, CDP)

• Call Detail Recording (CDR) — using Tandem CDR features

Other telephony features are available and vary, depending on the particular 
SIP Phone. 

The following list contains examples of intelligent SIP Phone-based features 
that may be supported on a SIP Phone. Please consult the particular phone 
specification for details.

• Conference calling

• Call hold

• Call waiting

• Call forwarding

• Call transfer

• Caller ID

• Call waiting caller ID

• Speed dial from phone book

• Call logs
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Installation and configuration overview
A SIP Phone must be installed and properly configured before it can be used. 
SIP Phone configuration involves configuration on the phone itself and 
configuration on the Signaling Server.

• Follow the manufacturer’s installation and configuration instructions to 
set up your SIP Phone. 

• To configure a SIP Phone on the Signaling Server, refer to IP Peer 
Networking: Installation and Configuration (553-3001-213) which 
provides the required configuration procedures for adding a SIP Phone 
user endpoint to the Signaling Server using the Network Routing Service 
(NRS) Manager.
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Introduction
This section explains how to install and maintain the IP Phone1120E. For 
information on using the IP Phone 1120E, see the IP Phone 1120E User 
Guide.

This section contains the following procedures:

• Procedure 58, “Pre-installation checklist” on page 328.

• Procedure 59, “Installing an IP Phone 1120E for the first time” on 
page 330.

• Procedure 60, “Disabling Auto Negotiate and enabling Full Duplex 
mode” on page 343.

• Procedure 61, “Checking Ethernet Statistics” on page 344.

• Procedure 62, “Changing the TN of an existing IP Phone 1120E” on 
page 345.

• Procedure 63, “Replacing an IP Phone 1120E” on page 346.

• Procedure 64, “Removing an IP Phone 1120E from service” on 
page 347.

Note: After an IP Phone has been installed and configured, if power to 
the phone is interrupted, re-entry of the IP parameters, Node Number, 
TN, or re-acquisition of firmware is not required. 

Description
The IP Phone 1120E brings voice and data to the desktop environment. It 
connects directly to the LAN through the Ethernet connection. 

The IP Phone 1120E translates voice into data packets for transport using 
Internet Protocol. A Dynamic Host Configuration Protocol (DHCP) server 
can be used to provide information that enables the IP Phone 1120E network 
connection, and connection to the Voice Gateway Media Card. The 
IP Phone 1120E uses the customer’s IP network to communicate with the 
Signaling Server.
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Figure 48
IP Phone 1120E

Supported features
The IP Phone 1120E supports the following features:

• four user-defined feature keys with labels and indicators

• four soft keys 

Note: Functions for the soft keys are configured in LD 11. 

• graphical, high-resolution LCD display, backlit, with adjustable contrast

• high quality speaker phone

Handsfree key

Handset

User-defined feature keys

High-resolution  
graphical display screen

Navigation keys

Services key
Copy key

Quit/Stop key

Message/Inbox key
Shift/Outbox key
Directory key

Hold key

Expand to PC key

Headset key

Goodbye key
Volume control

Dialpad

Soft keysSpeaker

Message waiting indicatorData message waiting indicator*

Mute key
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• volume control keys for adjusting ringer, speaker, handset, and headset 
volume

• six specialized feature keys:

— Quit

— Directory

— Message/Inbox

— Shift/Outbox

— Services

— Copy

• six call-processing fixed keys: 

— Mute

— Handsfree

— Goodbye

— Expand to PC

— Headset

— Hold

• gigabit Ethernet ports

• integrated gigabit Ethernet switch for shared PC access

• headset jack with On/Off key

• USB port, to support keyboard or mouse

Note: Powered downstream 1.1 compliant USB hubs are supported, 
including USB 2.0 hubs, if they offer USB 1.1 backwards compliancy.

• automatic network configuration

• hearing-aid compatibility
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The IP Phone 1120E supports the following additional features:

• 802.1Q VLAN and 802.1p priority support, industry standards for 
managing bandwidth usage—full VLAN capability, including a 
manageable integrated switch in the IP Phone for VLAN and priority 
tagging for PC and IP Phone traffic

• 802.1x Port-based network access control, industry standard for passing 
Extensible Authentication Protocol (EAP) over a LAN

• integrated hardware to support power over Ethernet, for IEEE 802.3af 
standard power; also including support for PowerDsine Power over LAN 
Hub powering, and Cisco proprietary powering as tested with specific 
Cisco Ethernet switch equipment 

• Gratuitous Address Resolution Protocol Protection (GARP) 

• VLAN filtering 

• Call Duration Timer 

• ability to change the feature key labels

• Corporate Directory

• Personal Directory

• Redial List

• Callers List

• Password Administration

• Virtual office

• Branch Office

• Active Call Failover

• Enhanced UNIStim Firmware Download

• 10/100/1000 Mbps Full Duplex mode

• language support: English, French, Swedish, Danish, Norwegian, 
German, Dutch, Portuguese, Czech, Finnish, Hungarian, Italian, Polish, 
Spanish, Russian, Latvian, Turkish, and Katakana
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Note: In the case of the prompts locally generated by the phone for the 
Local Tools menu and in all local features, the language is controlled 
locally by the phone. Thus there are two language selection mechanisms 
on the phone: one for local features, which is selected in the Local Tools 
menu (press the Services key twice to access the Local Tools menu), and 
another for TPS features, which is selected in the Telephone Options 
menu (press the Services key, and select Telephone Options to access the 
Telephone Options menu). Refer to the appropriate IP Phone User Guide 
for more information.

• External Application Server (XAS)

Features not currently supported
The following features are not supported on the IP Phone 1120E:

• Live Dialpad

• Group Listening

• Set-to-Set messaging

• Context-sensitive soft keys

The three-port switch that is internal to the IP Phone 1120E is an unmanaged 
switch. It passes the packets (unmodified) and does not interpret the 802.1Q 
header. The three-port switch provides priority based on the port. The IP 
Phone port traffic takes priority over the Ethernet.

The IP Phone 1120E components are shown in Table 31.

Table 31
IP Phone 1120E components and functions (Part 1 of 7)

Component Function

Hold Press the Hold key to put an active call on 
hold. Press the line (DN) key beside the 
flashing LCD to return to the caller on hold.

Goodbye Press the Goodbye key to terminate an active 
call.
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Message waiting 
indicator 

When a message is waiting, the orange 
Message waiting indicator flashes. Also, this 
indicator flashes when the ringer is set to On.

Data Message waiting 
Indicator

When a data-related message, such as an 
instant message, is received, the blue Data 
message waiting indicator flashes. Also, this 
indicator flashes when a contact has come on-
line.

Note: This function requires server support 
and, therefore, is not available on all phones.

User-defined feature key 
labels

User-defined feature key labels are configured 
for various features on the IP Phones.

A steady LCD light beside a line (DN) key 
indicates the feature or line is active. A 
flashing LCD indicates the line is on hold or 
the feature is being programmed.

Soft keys Soft keys are located below the display area. 
The LCD label above the key changes, based 
on the active feature.

Note: A triangle before a key label indicates 
that the key is active.

Fixed feature keys Use these keys to access non-programmable 
standard features.

Expand to PC The Expand to PC key is used to access 
external server applications such as External 
Application Server (XAS).

Navigation keys Use the Navigation keys to scroll through 
menus and lists appearing on the LCD display 
screen. The outer part of this key cluster rocks 
for up, down, left, and right movements.

Table 31
IP Phone 1120E components and functions (Part 2 of 7)

Component Function
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Send/Enter Press the Send/Enter key, at the center of the 
Navigation key cluster, to confirm menu 
selections. In many cases, you can use the 
Send/Enter key instead of the Select soft key.

Message/Inbox Press the Message/Inbox key to access your 
voicemail box.

Shift/Outbox The Shift/Outbox key is a fixed key that is 
reserved for future feature development.

Quit/Stop Press the Quit/Stop key to end an active 
application. 

Pressing the Quit/Stop key does not affect the 
status of the calls currently on your IP Phone.

Directory Press the Directory key to access Directory 
services.

Mute Press the Mute key to listen to the receiving 
party without transmitting.

Press the Mute key again to return to a two-
way conversation.

The Mute key applies to Handsfree, Handset, 
and Headset microphones. 

The Mute LED flashes when the Mute option 
is in use.

Headset Press the Headset key to answer a call using 
the headset or to switch a call from the 
handset or Handsfree to the headset. 

The Headset LED flashes when the Headset 
option is in use.

Table 31
IP Phone 1120E components and functions (Part 3 of 7)

Component Function
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Volume control keys Press the volume control keys to adjust the 
volume of the handset, headset, speaker, 
ringer, and, Handsfree feature. 

Press the volume key with the loudspeaker 
icon to increase volume; press the volume key 
without the loudspeaker icon to decrease 
volume.

Table 31
IP Phone 1120E components and functions (Part 4 of 7)

Component Function
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Services Press the Services key to access the 
following items:

• Telephone Options (see Notes 1 and 2):

— Volume Adjustment

— Contrast Adjustment

— Language

— Date/Time 

— Display diagnostics

— Local Dialpad Tone

— Set Info

— Diagnostics

— Call Log Options

— Ring type

— Call Timer

— OnHook Default Path

— Change Feature Key Label

— Name Display Format

• Virtual Office Login and Virtual Office 
Logout (if Virtual Office is configured)

• Test Local Mode and Resume Local Mode 
(if Branch Office is configured)

• Password Admin

• Display Network Diagnostics Utilities

Table 31
IP Phone 1120E components and functions (Part 5 of 7)

Component Function
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Press the Services key twice to access the 
Local Tools menu. The following items 
appear in the Local Tools menu:

• 1. Preferences

• 2. Local Diagnostics

• 3. Network Configuration

• 4. Lock Menu

Note: If you are prompted to enter a password 
when you double-press the Services key, 
password protection is enabled. For more 
information about password protection, see 
“Password protection of the Tools menu” on 
page 320.

To make a selection, press the number 
associated with the menu item, or use the 
navigation keys to scroll through the menu 
items. 

Press the Services key to exit from any menu 
or menu item. 

For information about configuring the 
IP Phone 1120E Local Tools menu, see 
“Configure IP Phone 1120E and IP Phone 
1140E Local Tools options” on page 463.

Copy Press the Copy Key to copy entries to your 
Personal Directory from other lists, such as 
the Caller List, Redial List and Corporate 
Directory.

Speaker Press the Handsfree key to activate the 
speaker.

Table 31
IP Phone 1120E components and functions (Part 6 of 7)

Component Function
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Display characteristics
An IP Phone 1120E has three major display areas: 

• user-defined feature key label

• soft key label

• information line

Figure 49 shows these three display areas.

Handsfree Press the Handsfree key to activate the 
Handsfree feature.

The LED lights to indicate when handsfree is 
active.

Note 1: If a call is presented while the user is manipulating an option, the 
IP Phone 1120E rings and the DN key flashes. However, the screen 
display is not updated with Caller ID information and programming text is 
not disturbed.

Note 2: The user can originate a call using Autodial or Last Number 
Redial while manipulating an option. However, the display is not updated 
with the dialed digits or the Caller ID information, and Autodial and Last 
Number Redial intercept the dialpad.

Table 31
IP Phone 1120E components and functions (Part 7 of 7)

Component Function
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Figure 49
1120E IP display area

Cleaning the IP Phone display screen

Gently wipe the IP Phone display screen with a soft, dry cloth.

User-defined feature key label display

The feature key label area displays a 10 character string for each of the four 
feature keys. Each feature key includes the key label and an icon. The icon 
state can be on, off, or flashing. Key labels are left-aligned for keys on the left 
side of the screen, and right-aligned for keys on the right side of the screen.

Note: If a label is longer than ten characters, the last ten characters are 
displayed and the excess characters are deleted from the beginning of the 
string.

CAUTION
Do not use any liquids or powders on the IP Phone. 
Using anything other than a soft, dry cloth can 
contaminate IP Phone components and cause premature 
failure.

Upper display area
User-defined  

feature key labels

Lower display area
Soft keys

Middle display area
Date/time display

Call party information
Feature status information

Options information
Directories information

42888 2348

10/30  4:30pm

AutoDial47678

Trans Conf Forward More...
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Soft key label display

A maximum of ten functions can be assigned to the soft keys. Functions are 
assigned to the soft keys in layers in LD 11.

Use the More soft key to navigate through the layers of functions. If there are 
only four functions assigned to the soft keys, the More key does not appear 
and all four functions are displayed.

The soft key label has a maximum of seven characters. Each soft key includes 
the soft key label and an icon. When a soft key is in use, a flashing icon 
displays at the beginning of the soft key label, and the label shifts one 
character to the right. (If the label is six characters long, the last or rightmost 
character is truncated.) If a feature is enabled, the icon state turns to On. It 
remains in the on state until the feature key is pressed again. This cancels the 
enabled feature and turns the icon off, returning the soft key label to its 
original state. 

Information line display

An IP Phone 1120E has a one-line information display area with the 
following information: 

• Caller number

• Caller name

• Feature prompt strings

• User-entered digits

• Date and time information (if the IP Phone is in an idle state) 

The information in the display area changes, according to the call processing 
state and active features.

Password protection of the Tools menu
When password protection is enabled, the Tools menu is locked to prevent 
accidental or unwanted changes. The fixed password is required whenever the 
Services key is double-pressed or whenever the Local Diagnostics and 
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Network Configuration sub menus are accessed. Use the dialpad to enter the 
fixed password 26567*738 (color*set). 

Password protection is enabled during Full DHCP configuration if the 
SECUREMENU parameter, or the PARTSECUREMENU parameter are present 
at the end of the S4 part of the Full DHCP string. If neither the SECUREMENU 
parameter, nor the PARTSECUREMENU parameter is present, password 
protection is not enabled. 

You can still enable password protection by setting the S4 IP address to 
0.0.0.0 and the other fields, such as ActionByte and RetryCount, to another 
setting. Nortel recommends you use 0 as the setting for ActionByte and 
RetryCount.

The following examples show how to configure password protection through 
the DHCP string:

• Menu protection on, GraphicalXAS configured:

Nortel-i2004-A,xxx.xxx.xxx.xxx:pppppp,aaa,rrr;
xxx.xxx.xxx.xxx:pppppp,aaa,rrr;xxx.xxx.xxx.xxx:
pppppp,aaa,rrr,SECUREMENU

Nortel-i2004-A,147.19.11.70:4100,1,10; 
147.19.11.70:4100,1,5;37.165.238.90:44443,1,5,
SECUREMENU

or

Nortel-i2004-A,xxx.xxx.xxx.xxx:pppppp,aaa,rrr;
xxx.xxx.xxx.xxx:pppppp,aaa,rrr;xxx.xxx.xxx.xxx:
pppppp,aaa,rrr,PARTSECUREMENU

Nortel-i2004-A,147.19.11.70:4100,1,10; 
147.19.11.70:4100,1,5;37.165.238.90:44443,1,5,
PARTSECUREMENU
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• Menu protection off, GraphicalXAS configured:

Nortel-i2004-A,xxx.xxx.xxx.xxx:pppppp,aaa.rrr;
xxx.xxx.xxx.xxx:pppppp,aaa,rrr;xxx.xxx.xxx.xxx:
pppppp,aaa

Nortel-i2004-A,147.19.11.70:4100,1,10;147.19.11.7:
4100,1,5;37.165.238.90:4443,1

• Menu protection off, no XAS configured:

Nortel-i2004-A,147.19.11.70:4100,1,10;147.19.11.7:
4100,1,5;0.0.0.0:0,0,0,SECUREMENU

or

Nortel-i2004-A,147.19.11.70:4100,1,10;147.19.11.7:

4100,1,5;0.0.0.0:0,0,0,PARTSECUREMENU

For further information on configuring Full DHCP, refer to Converging the 
Data Network with VoIP (553-3001-160).

Accessing the Tools menu

If the SECUREMENU parameter was set during Full DHCP configuration, 
you are prompted to enter the fixed password (26567*738) whenever the 
Services key is double-pressed on the IP Phone 1120E. If the PARTSECURE 
parameter was set during Full DHCP configuration, you are prompted to enter 
the fixed password whenever you access 2. Local Diagnostics or 3. Network 
Configuration menu items from the Tools menu. You are always promted to 
enter the fixed password whenever you access the Lock Menu sub menu. 

The Tools menu remains active for 5 minutes. You can freely navigate, exit 
and reenter the Tools menu without being prompted to reenter the password. 
To reset the timer before the 5 minute time expires, double-press the Services 
key. 

IMPORTANT!

In Full DHCP mode, the server must be configured to respond to the 
request for vendor-specific encapsulated options.
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You can also press the 5 key to access the Lock Now item from the Lock 
Menu. The Lock Now item immediately exits the Tools menu, closes any 
open Tools menu pages, and locks the Tools menu. Alternatively, when time 
expires, the Tools menu and any open submenus are closed. Double-press the 
Services key to open the password prompt window to reaccess the Tools 
menu.

If you enter an incorrect password, the Tools menu will not open. Double-
press the Services key to open the password prompt window. Only three 
incorrect password entries are allowed. Any entry after the three attempts is 
ignored for 5 minutes. The password prompt window is visible and you can 
reenter the password but the password is not processed until the 5 minute time 
expires.

Note: Some items appear dimmed depending on the current state of the 
menu lock and the mode of the IP Phone. The current selected mode is 
dimmed. Only configuration options which are enabled from the current 
state appear active.

For more information about configuring the Local Tools menu for the 
IP Phone 1120E, refer to “Configure IP Phone 1120E and IP Phone 1140E 
Local Tools options” on page 463.

Key number assignments
The IP Phone 1120E has four soft-labeled, predefined soft keys that are used 
to provide up to ten features. Because they are pre-defined, the user cannot 
change the key number assignment. 

The Message key is numbered 16. Key numbers 17 to 26 are the four soft key 
labels below the display area. See Figure 48 on page 309.

Key numbers 17 to 31 support the features A03, A06, CFW, CHG, CPN, 
PRK, PRS, RGA, RNP, SCC, SCU, SSC, SSU and TRN, as listed in Table 32 
on page 324.

Key number mappings at the Call Server are aligned with that of the 
IP Phone 2002. 
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Table 32 describes the IP Phone feature assignment for each of the dedicated 
keys. Use LD 11 to program keys 16 to 26 on the IP Phone 1120E.

Note: If you attempt to configure anything other than the permitted 
response, the system generates an error code. 

Package components 
The approved Nortel AC adapter and a standard local power cord must be 
ordered separately if local power using the AC adapter is required. Refer to 

Table 32
IP Phone 1120E soft keys

Key Number  Response Description

Key 16 MWK Message Waiting key

Key 17 TRN Call Transfer key

Key 18 A06 Six-party conference key

Alternate: A03 (3-party conference)

Key 19 CFW Call Forward key

Key 20 RGA Ring Again key

Key 21 PRK Call Park key

Key 22 RNP Ringing Number Pickup key

Key 23 Reserved for speed dial Speed dial includes SCU, SCC, SSU, 
SSC

Key 24 PRS Privacy Release key

Key 25 CHG Charge Account key

Key 26 CPN Calling Party Number key

Keys 27 - 31 Reserved
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Table 33 on page 325 for the IP 1120E package components and product 
codes. 

The IP Phone 1120E includes integrated support for a number of power over 
LAN options, including support for IEEE 802.3af standard power.

Table 33 lists the IP Phone 1120E package components and product codes.

WARNING
Use your IP Phone 1120E with the approved Nortel AC adapter 
(model # N0023000) for this model of phone only.

Table 33
IP Phone 1120E components list (Part 1 of 3)

IP Phone 1120E package contents include:

• IP Phone 1120E 

• Handset

• Handset cord

• 2.3 m (7 ft.) CAT5 Ethernet cable

• Number plate and lens

• Getting Started Card 

IP Phone 1120E with icon key caps NTYS03AA

IP Phone 1120E with English key caps NTYS03BA

Replacement parts

Handset, Charcoal NTYS09AA70

Handset cord, Charcoal NTYS10AA70

Footstand kit, Charcoal NTYS11AA70

Phone number label and lens kit NTYS12AA

2.3 m (7 ft) CAT5 Ethernet cable NTYS13AA
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Power adapter

Global power supply (for local power) N0023000

AC cord 

1.8 m (5.9 ft), 10 amp, IEC320-C13 
North America

Note: Nortel recommends you use the thinner cord 
(NTYS14AA) as an alternative to NTTK14AB.

NTYS14AA

Table 33
IP Phone 1120E components list (Part 2 of 3)
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Before you begin
The following section provides a step-by-step guide through the 
IP Phone 1120E installation process. Before installing the IP Phone 1120E, 
complete the following pre-installation checklist.

IEC cables

3 m (9.9 ft),125 VAC 13 amp, NA power cord, NEMA 
North America, Middle East, Taiwan, Philippines, Thailand, and 
Japan

NTTK14AB

2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, 
Australia, New Zealand

NTTK15AA

250 VAC, Option 11C Standard European power cord, 
Other EMEA, Kenya, Korea, Thailand, Indonesia, Vietnam, 
India, Pakistan

NTTK16AB

3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord
Switzerland

NTTK17AB

240 VAC, Option 11C UK power cord
Hong Kong, Ireland, United Kingdom, Singapore, Malaysia, 
Bangladesh, Brunei, Sri Lanka

NTTK18AB

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord
Denmark

NTTK22AB

Table 33
IP Phone 1120E components list (Part 3 of 3)
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Procedure 58
Pre-installation checklist

1 Ensure there is one IP Phone 1120E boxed package for each 
IP Phone 1120E being installed. The package contains:

• IP Phone 1120E 

• Handset

• Handset cord

• 2.3 m (7 ft) CAT5 Ethernet cable

• Number plate and lens

• Getting Started Card

2 To install and configure an IP Phone 1120E, the host system must be 
equipped with the Voice Gateway Media Card, or a Signaling Server with 
the Line TPS application.

3 If an AC power adapter is required, ensure the approved Nortel AC 
adapter (model # N0023000) is used. Refer to Table 33 on page 325.

4 Understand the three configuration modes that you can choose as you 
proceed through the installation of the IP Phone 1120E. The three 
configuration modes are:

• Static IP address (see “Static IP address assignment” on page 329)

• Partial DHCP (see “Dynamic IP address assignment—Partial DHCP” 
on page 330)

• Full DHCP (see “Dynamic IP address assignment—Full DHCP” on 
page 330)

5 A DHCP server and DHCP relay agents, if required, must also be 
installed, configured, and running.

End of Procedure



 IP Phone 1120E  Page 329 of 508

IP Phones Description, Installation, and Operation

First-time installation

IP address assignments

During the first-time installation, the three IP address parameters that are 
entered either manually or automatically depending on the installation 
configuration are as follows:

• Static IP address assignment 

• Partial DHCP 

• Full DHCP

 As well, you are prompted to enable or disable 802.1Q. For more 
information, see “802.1Q VLAN description” on page 407. 

You can also use an enhanced network configuration menu to configure the 
IP Phone 1120E. The user can access the Local Tools menu at any time. 
Information is entered through the dialpad or an attached USB keyboard. For 
further information on using the Local Tools menu to configure the 
IP Phone 1120E, refer to “Configure IP Phone 1120E and IP Phone 1140E 
Local Tools options” on page 463.

Use Procedure 59, “Installing an IP Phone 1120E for the first time” on 
page 330.

Static IP address assignment

During the installation, the IP Phone 1120E parameters are entered manually 
using the key pad.

Enter the IP address, subnet mask, and default Gateway address. You must 
also enter the Connect Server parameters including IP address, port number, 
action, and retry count.
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Dynamic IP address assignment—Partial DHCP

For a partial DHCP installation, you must provide, through the 
IP Phone 1120E key pad, the Connect Server parameters including: IP 
address, port number, action, and retry count. Other parameters (IP Phone IP 
address, subnet mask and default Gateway) are obtained from the DHCP 
server.

The IP Phone 1120E password, node ID and TN must be entered manually 
using the telephone dial pad.

For more information about DHCP servers, see Converging the Data 
Network with VoIP (553-3001-160).

Dynamic IP address assignment—Full DHCP

For a full DHCP installation, all parameters (IP Phone IP address, subnet 
mask, default Gateway, Connect Server IP address, port number, action, and 
retry count) are obtained from the DHCP server to recognize the 
IP Phone 1120E.

The IP Phone 1120E password, node ID, and TN must be entered manually 
using the telephone dial pad.

For more information on how to set up DHCP servers for use with the IP 
Phones, refer to Converging the Data Network with VoIP (553-3001-160).

Procedure 59
Installing an IP Phone 1120E for the first time

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration (553-
3001-311).

2 Configure the IP Phone 1120E on the system as IP Phone 2002 using 
LD 11. At the prompt, enter the following:

REQ:chg
TYPE:i2002
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For more information, see Software Input/Output: Administration (553-
3001-311).

3 Remove the stand cover. Pull upward on the center catch and remove the 
stand cover. The cable routing tracks are now accessible. See Figure 50 
on page 331.

Figure 50
Stand cover removed

CAUTION
The IP Phone 1120E is shipped with the base locked in 
position. To avoid damaging the IP Phone, press the
wall-mount lever located under the Handsfree key to 
release the base and pull it away from the phone.

Tilt Lever
Button

Center
Catch

Handset
cord exit
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4 Connect the AC power adapter (optional). Connect the adapter to the AC 
adapter jack in the bottom of the phone. Form a small bend in the cable, 
and then thread the adapter cord through the channels in the stand.

Note 1: The IP Phone 1120E supports both AC power and Power over 
LAN options, including IEEE 802.3af standard power. To use local AC 
power, the optional AC adapter can be ordered separately. To use Power 
over Ethernet, where power is delivered over the CAT5 cable, the LAN 
must support Power over Ethernet, and an AC adapter is not required.

Note 2: You must use CAT5e (or later) cables if you want to use gigabit 
Ethernet. 

5 Install the handset. Connect the end of the handset cable with the short 
straight section into the handset. Connect the end of the handset cable 
with the long straight section to the back of the phone, using the RJ-9 
handset jack marked with the symbol +. Form a small bend in the cable, 
and then thread the handset cord through the channels in the stand so 
that it exits behind the handset on the right side, in the channel exit in the 
stand base marked with the symbol +. See Figure 51 on page 333. 

WARNING
Use your IP Phone 1120E with the approved Nortel AC adapter 
(model # N0023000) for this model of phone only.
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Figure 51
Cable routing tracks

6 Install the headset (optional). If you are installing a headset, plug the 
connector into the RJ-9 headset jack marked with the symbol) on the 
back of the phone, and thread the headset cord along with the handset 
cord through the channels in the stand, so that the headset cord exits the 
channel marked with the symbol).

7 Install the Ethernet cable. Connect one end of the supplied Ethernet cable 
to the back of your phone using the RJ-45 connect marked with the 
symbol%, and thread the network cable through the channel marked with 
the symbol%.

B

A
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8 Install the Ethernet cable connecting the PC to the phone (optional). If you 
are connecting your PC Ethernet through the phone, connect one end of 
the PD Ethernet cable to your phone using the RJ-45 connector marked 
with the symbol (, and thread it through the channel marked with the 
symbol (. Connect the other end to the LAN connector on the back of 
your PC. 

9 Install additional cables. If applicable, plug in optional USB devices. 
Connect the Ethernet cable to the LAN Ethernet connection. If you are 
using an AC power adapter, plug the adapter into an AC outlet.

Note: Complete steps 1-9, as needed, before wall-mounting the 
IP Phone.

10 Wall-mount your phone (optional). Use Method A or Method B to wall-
mount the IP Phone. See Method A—using the mounting holes on the 
bottom of the phone stand, or Method B—using the traditional-style wall-
mount box with a RJ-45 connector and a 15 cm (6 inch) RJ-45 cord (not 
provided).

• Method A: Press the wall-mount lever, and pull away from the stand. 
Using the stand cover (see step 3 on page 331), mark the wall-mount 
holes by pressing the bottom of the stand cover firmly against the wall 
in the location where you wish to install the phone. Four small pins on 
the bottom of the stand cover make the marks on the wall. Use the 
marks as a guideline for installing the wall-mount screws (not 
provided).

Install the screws so that they protrude 3 mm (1/8 inch) from the wall, 
and then install the phone stand mounting holes over the screw 
heads. You may need to remove the phone from the wall to adjust the 
lower screws. When the lower screws are snug, install the phone on 
the mounting screws, and then tighten the top screws.

• Method B: Attach the 15 cm (6 inch) CAT5e cable, position the stand 
over the mounting rivets, and slide the phone down the wall so that 
the rivets fit into the slots on the stand. 

11 Replace the stand cover. Ensure that all cables are neatly routed and 
press the stand cover into place until you hear a click.

CAUTION
Damage to Equipment
Do not plug your IP Phone 1120E into any other port 
but the PC Ethernet port. Severe damage can result. 
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12 Put the phone in the wall-mount position (optional). If you wall-mount the 
phone, put it in the wall-mount position by holding the Tilt Lever and press 
the phone towards the base until the phone is parallel with the base. 
Release the Tilt Lever and continue to push the phone towards the base 
until you hare an audible click. Ensure the phone is securely locked in to 
position. See Figure 52.

Figure 52
Rotate the phone into the wall mount position

Wall-mount leverTilt lever
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13 When the Nortel logo appears in the middle of the display, immediately 
press the four feature keys at the bottom of the display in sequence from 
left to right. The 3.Network Configuration menu opens. 

Note: You can press the Apply&Reset soft key to save the following 
settings and to reset the IP Phone. You can press the Exit soft key exit 
the menu to exit the menu without saving any changes and return to the 
3.Network Configuration menu.

When the 3. Network Configuration menu opens, the Enable 802.1x 
(EAP) check box is highlighted. 

14 Press the Enter key to toggle this item on and off. A check mark appears 
to indicate the item is active.

If you select the Enable 802.1x (EAP) check box, press the Enter key to 
start the edit mode. Use the keypad to fill in the following information:

• EAP Device ID

• EAP Password

For further information about EAP, refer to Appendix C: “802.1x Port-
based network access control” on page 415.

Note: If you select do not select the Enable 802.1x (EAP) combo box, 
you will not be prompted to enter Device ID and Password.

15 Use the Right navigation key to scroll and highlight DHCP combo box. 

16 Press the Enter key.

17 Press the Down navigation key to open list box.

IMPORTANT!

Timing information
There are only 4 seconds between plugging in the IP Phone 1120E 
power adapter and the appearance of the Nortel logo in the middle of 
the display. When you see the logo, you have 1 second to respond by 
pressing the 4 feature keys at the bottom of the display in sequence from 
left to right. If you miss the 1-second response time, the IP Phone 1120E 
attempts to locate the connect server. Wait until it is finished, and then 
begin the power-up sequence again.
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18 Use the Up/Down navigation keys to scroll and highlight one of the 
following DHCP options:

• No—enter the information in the boxes. 

• Partial—enter Server 1 IP address, Server 2 IP address, Port, Action, 
Retry, and PK numbers in the boxes.

• Full—all items are dimmed

Note: If Full is selected for DHCP in the list, all items are dimmed. If 
Partial or No is selected for DHCP in the list, all items are accessible. Use 
the navigation keys to scroll and highlight the items and use the keypad 
to enter the applicable information.

19 Press the Enter key. 

20 Use the Right navigation key to scroll and highlight SET IP. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.  

Set IP—a valid IP Phone 1120E IP address.

21 Use the Right navigation key to scroll and highlight NET MASK. Press 
the Enter key to start the edit mode. Use the keypad to fill in the 
information.

Net Mask—a subnet mask

22 Use the Right navigation key to scroll and highlight Gateway. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

Gateway—the default gateway for the IP Phone 1120E on the LAN 
segment to which it is connected

23 Use the Right navigation key to scroll and highlight S1 IP. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

S1 IP—the node IP address of the IP Phone 1120E
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24 Use the Right navigation key to scroll and highlight Port. 

S1 Port—a fixed value of 4100

25 Use the Right navigation key to scroll and highlight S1 Action. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

S1 Action—a fixed value of 1

26 Use the Right navigation key to scroll and highlight Retry. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

Retry—the number of times the IP Phone 1120E attempts to connect to 
the server

27 Use the Right navigation key to scroll and highlight S1 PK. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

28 Use the Right navigation key to scroll and highlight S2 IP. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

S2 IP—same as S1 in most cases 

Note: The IP Phone 1120E can support a primary (S1) and secondary 
(S1) connect server. If you require IP Phones to register on multiple 
nodes, refer to IP Line: Description, Installation, and Operation  (553-
3001-365).

29 Use the Right navigation key to scroll and highlight Port. Press the Enter 
key to start the edit mode. Use the keypad to fill in the information.

Port—same as S1 port

30 Use the Right navigation key to scroll and highlight S2 Action. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

S2 Action—same as S1

31 Use the Right navigation key to scroll and highlight Retry. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

Retry—same as S1

32 Use the Right navigation key to scroll and highlight S2 PK. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

S2 PK—same as S1

33 Use the Right navigation key to scroll and highlight VoiceVLAN combo 
box. Press the Enter key. Press the Down navigation key to open the list 
box.
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34 Use the Up/Down navigation keys to scroll and highlight one of the 
following options:

— No—default
802.1Q VLAN remains off until initialization continues.

— Auto

— value

The VoiceVLAN ID is entered as an integer. The VoiceVLAN ID is a 12-
bit value between 1 and 4095.

The IP Phone 1120E is configured with 802.1Q enabled, the VoiceVLAN 
ID is configured to the entered value and the VoiceVLAN priority is 6.

35 Press the Enter key. 

For more information about VLAN configuration, refer to Converging the 
Data Network with VoIP (553-3001-160). 

36 Use the Right navigation key to scroll and highlight VLAN Filter check 
box. Press the Enter key to toggle this item on and off.  

Note: The VLAN Filter check box will appear dimmed if you select No in 
the VoiceVLAN combo box.

37 Use the Right navigation key to scroll and highlight Disable PC Port 
check box. Press the Enter key to toggle this item on and off. 

38 Use the Right navigation key to scroll and highlight DataVLAN combo 
box. Press the Enter key. Press the Down navigation key to open the list 
box.

Use the Up/Down navigation keys to scroll and highlight one of the 
following options:

— No—default

— value

The DataVLAN is entered as an integer. The DATA VLAN ID is a 12-bit 
value between 0 and 4095, and should be different from the VoiceVLAN 
ID.

The IP Phone 1120E is configured with 802.1Q enabled, the Data VLAN 
ID is configured to the entered value, and the Data VLAN priority is 0.

39 Press the Enter key.

40 Use the Right navigation key to scroll and highlight PC-Port Untag All 
check box. Press the Enter key to toggle this item on and off. 
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41 Use the Right navigation key to scroll and highlight Duplex combo box. 
Press the Enter key. Press the Down navigation key to open the list box. 

Use the Up/Down navigation keys to scroll and highlight one of the 
following options:

— Auto

— 10BT Full

— 100BT Full

42 Press the Enter key.

43 Use the Right navigation key to scroll and highlight Ignore GARP check 
box. Press the Enter key to toggle this item on and off.

44 Use the Right navigation key to scroll and highlight XAS IP combo box. 
Press the Enter key to start the edit mode. Use the keypad to fill in the 
information.

45 Use the Right navigation key to scroll and highlight Graphical XAS check 
box. Press the Enter key to toggle this item on and off.

46 Use the Right navigation key to scroll and highlight Port combo box. 
Press the Enter key to start the edit mode. Use the keypad to fill in the 
information.

47 Use the Right navigation key to scroll and highlight TFTP IP combo box. 
Press the Enter key to start the edit mode. Use the keypad to fill in the 
information.

TFTP IP—TFTP Server IP address (for Succession Release 3.0 or 
CS 1000 Release 4.0

The TFTP Server is required to download the current firmware if you are 
using Succession Release 3.0 or CS 1000 Release 4.0. For further 
information about TFTP Server configuration, see Appendix E: “TFTP 
Server” on page 489. 

48 Use the Right navigation key to scroll and highlight Enable Bluetooth 
combo box. Press the Enter key. Press the Down navigation key to open 
the list box. 
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49 Use the Up/Down navigation keys to scroll and highlight one of the 
following options:

— Auto

— Yes

— No

50 Press the Enter key.

51 You can press the Apply/Reset soft key to save the settings and to reset 
the IP Phone. You can press the Exit soft key exit the menu to exit the 
menu without saving any changes and return to the main menu display.

The IP Phone 1120E searches for the connect server. 

The IP Phone 1120E registers with the Terminal Proxy Server (TPS) and, 
if needed, begins the firmware download. This takes several minutes. 
When download is complete, the IP Phone 1120E resets.

Note 1: The Enhanced UNIStim Firmware Download feature for 
IP Phones provides an improved method of delivering new firmware to 
IP Phones. For further information about Enhanced UNIStim Firmware 
Download, refer to “Features overview” on page 397.

Note 2: For Succession Release 3.0 and CS 1000 Release 4.0, the 
IP Phone 1120E searches for the TFTP Server for firmware upgrade. If 
the file name specified in 1120e.cfg is not the same as the current 
firmware, the IP Phone downloads the file and upgrades the firmware. 
This takes several minutes. When the upgrade is complete, the 
IP Phone 1120E reboots. 

The current system date and time appear on the top line of the display 
when the configuration is complete. Self-labeling keys also appear.

52 Check for dial tone and the correct DN on the display.

53 (Optional) Customize the feature keys as required. For more information, 
see IP Phone 1120E User Guide.

End of Procedure
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Startup sequence
When an IP Phone 1120E is connected to the network, it must perform a 
startup sequence. The elements of the startup sequence include:

• obtaining the IP parameters

• finding a default Gateway server

• authenticating the user

See Table 34 for a summary of the IP parameters and how they are obtained.

Full Duplex mode
In the Configuration menu, Auto Negotiate mode is the default setting for 
initial startup. Typically, the IP Phone is connected to a network that supports 
Auto Negotiate, and it selects the best speed and duplex mode available. 
There is no intervention required under normal operation.

If the IP Phone is connected to a network configured for Full Duplex mode 
only, cannot automatically negotiate the proper configuration. Therefore, in 

Table 34
IP Phone 1120E IP parameters

Parameter Method of acquisition

IP Address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Net Mask Manually entered or automatically retrieved through 
Partial or Full DHCP.

Default Gateway address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Connect Server (IP address, port, 
action and retry count—primary 
and secondary)

Manually entered or automatically retrieved through Full 
DHCP.

User ID (Node ID, Node Password 
and TN)

Manually entered for first-time configuration. Retrieved 
from local storage on subsequent power cycles.
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this instance, to allow the IP Phone to work at the optimum speed and duplex 
mode, Auto Negotiate must be disabled. Use the following procedure to 
disable Auto Negotiate and enable Full Duplex mode.

Procedure 60
Disabling Auto Negotiate and enabling Full Duplex 
mode

1 Double-press the Services key to open the Local Tools menu.

2 Press 3 on the dialpad to access the Network Configuration menu or 
use the Up/Down navigation keys to scroll and highlight the Network 
Configuration option.

3 Use the Right navigation key to scroll and highlight the Duplex combo 
box.

4 Press Enter to start the edit mode. 

5 Press the Down navigation key to open list box.

6 Use the Up/Down navigation keys to scroll and higlight one of the 
following options:

• 10BT Full—10 BT Full Duplex mode

• 100BT Full—100 BT Full Duplex mode

7 Press Enter to exit the edit mode.

8 Press the Apply&Reset soft key to save the changes and to restart the 
IP Phone 1120E.

End of Procedure

When the IP Phone 1120E is restarted, the firmware reads the setting for Full 
Duplex mode and sets both port 0, network interface port, and port 1, PC 
interface port, accordingly.
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Use the following procedure to confirm activation of Full Duplex mode.

Procedure 61
Checking Ethernet Statistics

1 Double-press the Services key. 

2 Press 2 to select Local Diagnostics, then press 3 to open the Ethernet 
Statistics menu.

If Full Duplex mode is active, the following is displayed:

• Link Status: UP

• Duplex Mode: Full

• Network Speed: 10 Mb, 100 Mb or 1G

• Auto Sense/Negotiate

— Auto-Nego Capability: No

— Auto-Nego Completed: No

End of Procedure

TFTP firmware upgrade 
When you enter Cfg TFTP = 1 (for yes), and enter an IP address, the phone 
searches for an upgrade file on the TFTP Server. 

Note: Users of CS 1000 Release 4.5 or later do not need to enter a TFTP 
IP address.

Gratuitous Address Resolution Protocol Protection
Gratuitous Address Resolution Protocol Protection (GARP) protects the 
1120E IP Phone from GARP Spoof attacks on the network. In a GARP Spoof 
attack, a malicious device on the network takes over an IP address (usually 
the default gateway) by sending unsolicited (or Gratuitous) ARP messages, 
thus manipulating the ARP table of the victim’s machine. This allows the 
malicious device to launch a variety of attacks on the network, resulting in 
undesired traffic routing. For example, a GARP attack can convince the 
victim machine that the malicious device is the default gateway. In this 
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scenario, all traffic from the victim’s machine flows through the malicious 
device.

To enable GARP Protection during configuration, refer to Procedure 59, 
“Installing an IP Phone 1120E for the first time” on page 330.

Extensible Authentication Protocol 
Extensible Authentication Protocol (EAP) is a general protocol that fulfills 
the protocol requirements defined by 802.1x. For further information on 
802.1x, refer to Appendix C: “802.1x Port-based network access control” on 
page 415.

Reinstalling an IP Phone 1120E
You can reinstall an existing previously configured IP Phone 1120E on the 
same system. For example, the IP Phone 1120E can be assigned to a new user 
(new TN) or to an existing user who moved to a new subnet by changing the 
TN of the IP Phone 1120E.

Procedure 62
Changing the TN of an existing IP Phone 1120E

1 Repower the IP Phone 1120E.

Note: During the reboot sequence of a previously configured IP Phone, 
the IP Phone 1120E displays the existing node number for approximately 
5 seconds.

2 If node password is enabled and NULL, choose one of the following:

a. Disable password.

b. Set password as non-NULL.
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3 Press OK when the node number displays.

4 Enter password at the password screen and press OK.

A TN screen displays.

5 Select the Clear soft key to clear the existing TN. 

End of Procedure

Replacing an IP Phone 1120E 

Procedure 63
Replacing an IP Phone 1120E 

1 Disconnect the IP Phone 1120E that you want to replace.

2 Follow  Procedure 59 on page 330 to install and configure the 
IP Phone 1120E.

3 Enter the same TN and Node Number as the IP Phone 1120E you 
replaced. The system associates the new IP Phone 1120E with the 
existing TN.

End of Procedure

If Then

node password is enabled and is 
not NULL

a password screen displays. Go to 
step 4.

node password is disabled a TN screen displays. Go to 
step 5.

IMPORTANT!

Two IP Phones cannot share the same TN. You must remove the 
IP Phone 1120E that is currently using the TN.
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Removing an IP Phone 1120E from service
Procedure 64
Removing an IP Phone 1120E from service

1 Disconnect the IP Phone 1120E from the network or turn off the power.

Note: The service to the PC is disconnected as well if the PC is 
connected to the IP Phone 1120E.

If the IP Phone 1120E was automatically configured, the DHCP lease 
expires and the IP address returns to the available pool.

2 In LD 11, OUT the TN.
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Introduction
This section explains how to install and maintain the IP Phone 1140E. For 
information on using the IP Phone 140E, see the IP Phone 1140E User Guide.

This section contains the following procedures:

• Procedure 65, “Pre-installation checklist” on page 372.

• Procedure 66, “Installing an IP Phone 1140E for the first time” on 
page 374.

• Procedure 67, “Disabling Auto Negotiate and enabling Full Duplex 
mode” on page 387.

• Procedure 68, “Checking Ethernet Statistics” on page 388.

• Procedure 69, “Enabling Bluetooth wireless technology on the IP Phone 
1140E” on page 390.

• Procedure 70, “Changing the TN of an existing IP Phone 1140E” on 
page 395.

• Procedure 71, “Replacing an IP Phone 1140E” on page 396.

• Procedure 72, “Removing an IP Phone 1140E from service” on 
page 396.

Note: After an IP Phone is has been installed and configured, if power to 
the phone is interrupted, it is not necessary to reenter IP parameters, 
Node Number, TN, nor firmware again. 

Description
The IP Phone 1140E brings voice and data to the desktop environment. It 
connects directly to the LAN through the Ethernet connection. 

The IP Phone 1140E translates voice into data packets for transport using 
Internet Protocol. A Dynamic Host Configuration Protocol (DHCP) server 
can be used to provide information that enables the IP Phone 1140E network 
connection, and connection to the Voice Gateway Media Card. The 
IP Phone 1140E uses the customer IP network to communicate with the 
Signaling Server. 
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Figure 53 shows the IP Phone 1140E.

Figure 53
IP Phone 1140E

Supported features
The 1140E Phone supports the following features:

• six user-defined feature keys with labels and indicators

• four soft keys providing access to a maximum of 10 features

Note: Functions for the soft keys are configured in LD 11.

Handsfree key

Handset

User-defined feature keys

High-resolution 
graphical display screen

Navigation keys

Services key
Copy key

Quit/Stop key

Message/Inbox key
Shift/Outbox key
Directory key

Hold key

Expand to PC key

Headset key

Goodbye key
Volume control

Dialpad

Soft keys

Speaker

Message waiting indicatorData message waiting indicator*

*Note: If supported by your server, the data message waiting indicator provides a data alert. 
Contact your system administrator to find out if this feature is available for you.

Mute key
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• graphical, high-resolution LCD display, backlit, with adjustable contrast

• high quality speaker phone

• volume control keys for adjusting ringer, speaker, handset, and headset 
volume

• six specialized feature keys: 

— Quit/Stop

— Directory

— Message/Inbox

— Shift/Outbox

— Services

— Copy

• six call-processing fixed keys:

— Mute

— Handsfree

— Goodbye

— Expand to PC

— Headset

— Hold

• gigabit Ethernet ports

• integrated gigabit Ethernet switch for shared PC access

• headset jack with On/Off key

• USB port, to support keyboard or mouse

Note: Powered downstream 1.1 compliant USB hubs are supported, 
including USB 2.0 hubs, if they offer USB 1.1 backwards compliancy.

• automatic network configuration

• hearing-aid compatibility



Page 354 of 508  IP Phone 1140E

553-3001-368 Standard 12.00 March 2006

• wireless headset support through Bluetooth® 1.2 compliant 
Audio Gateway Headset Profile, Power Classification 2

The IP Phone 1140E supports the following additional features:

• 802.1Q VLAN and 802.1p priority support, industry standards for 
managing bandwidth usage — full VLAN capability, including a 
manageable integrated switch in the IP Phone for VLAN and priority 
tagging for PC and IP Phone traffic

• 802.1x Port-based network access control, industry standard for passing 
Extensible Authentication Protocol (EAP) over a LAN

• integrated hardware to support power over Ethernet, for IEEE 802.3af 
standard power; also including support for PowerDsine Power over LAN 
Hub powering, and Cisco proprietary powering as tested with specific 
Cisco Ethernet switch equipment

• Gratuitous Address Resolution Protocol Protection (GARP) 

• VLAN filtering

• Call Duration Timer 

• ability to change the feature key labels

• Corporate Directory

• Personal Directory

• Redial List

• Callers List

• Password Administration

• Virtual office

• Branch Office

• Active Call Failover

• Enhanced UNIStim Firmware Download

• 10/100/1000 Mbps Full Duplex mode

• External Application Server (XAS)
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• language support: English, French, Swedish, Danish, Norwegian, 
German, Dutch, Portuguese, Czech, Finnish, Hungarian, Italian, Polish, 
Spanish, Russian, Latvian, Turkish, and Katakana

• In the case of the prompts locally generated by the phone for the Local 
Tools menu and in all local features, the language is controlled locally by 
the phone. Thus there are two language selection mechanisms on the 
phone: one for local features, which is selected in the Local Tools menu 
(press the Services key twice to access the Local Tools menu), and 
another for TPS features, which is selected in the Telephone Options 
menu (press the Services key, and select Telephone Options to access the 
Telephone Options menu). Refer to the appropriate telephone User 
Guide for more information.

Features not currently supported
The following features are not supported on the IP Phone 1140E:

• Live Dialpad

• Group Listening

• Set-to-Set messaging

• Context-sensitive soft keys

The three-port switch that is internal/external to the IP Phone 1140E is an 
unmanaged switch. It passes the packets (unmodified) and does not interpret 
the 802.1Q header. The three-port switch provides priority based on the port 
(that is, the IP Phone port traffic takes priority over the Ethernet).
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The IP Phone 1140E components are shown in Table 35.

Table 35
IP Phone 1140E components and functions (Part 1 of 6)

Component Function

Hold Press the Hold key to put an active call on 
hold. Press the line (DN) key beside the 
flashing LCD to return to the caller on hold.

Goodbye Press the Goodbye key to terminate an active 
call.

Message waiting 
indicator 

When a message is left for the user, the 
orange Message waiting indicator flashes. 
Also, this indicator flashes when the set ringer 
is set to On.

Data message waiting 
indicator

When a data-related message, such as an 
instant message, is received, the blue Data 
message waiting indicator flashes. Also, this 
indicator flashes when a contact has come 
on-line.

Note: This function requires server support 
and, therefore, is not available on all phones.

User-defined feature 
keys labels

User-defined feature key labels are configured 
for various features on the IP Phones.

A steady LCD light beside a line (DN) key 
indicates the feature or line is active. A 
flashing LCD indicates the line is on hold or 
the feature is being programmed.

Soft keys Soft keys are located below the display area. 
The LCD label above the key changes, based 
on the active feature.

Note: A triangle before a key label indicates 
that the key is active.
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Fixed feature keys Use these keys to access non-programmable 
standard features.

Expand to PC The Expand to PC key is used to access 
external server applications such as External 
Application Server.

Navigation keys Use the Navigation keys to scroll through 
menus and lists appearing on the LCD display 
screen. The outer part of this key cluster rocks 
for up, down, left, and right movements.

Send/Enter Press the Send/Enter key, at the center of the 
Navigation key cluster, to confirm menu 
selections. In many cases, you can use the 
Send/Enter key instead of the Select soft key.

Message/Inbox Press the Message/Inbox key to access your 
voicemail box.

Shift/Outbox The Shift/Outbox key is a fixed key that is 
reserved for future feature development.

Quit/Stop Press the Quit/Stop key to end an active 
application. 

Pressing the Quit/Stop key does not affect the 
status of the calls currently on your IP Phone.

Directory Press the Directory key to access Directory 
services.

Table 35
IP Phone 1140E components and functions (Part 2 of 6)

Component Function
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Mute Press the Mute key to listen to the receiving 
party without transmitting.

Press the Mute key again to return to a two 
way conversation.

The Mute key applies to Handsfree, Handset, 
and Headset microphones. 

The Mute LED flashes when the Mute option 
is in use.

Headset Press the Headset key to answer a call using 
the headset or to switch a call from the 
handset or Handsfree to the headset.

Press the Headset key twice to access 
Bluetooth Setup dialog.

Volume control keys Use the Volume control keys to adjust the 
volume of the handset, headset, speaker, 
ringer, and Handsfree feature. 

Press the volume key with the loudspeaker 
icon to increase volume; press the volume key 
without the loudspeaker icon to decrease 
volume.

Table 35
IP Phone 1140E components and functions (Part 3 of 6)

Component Function
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Services Press the Services key to access the 
following items:

• Telephone Options (see Notes 1 and 2):

— Volume Adjustment

— Contrast Adjustment

— Language

— Date/Time 

— Display diagnostics

— Local Dialpad Tone

— Set Info

— Diagnostics

— Call Log Options

— Ring type

— Call Timer

— OnHook Default Path

— Change Feature Key Label

— Name Display Format

• Virtual Office Login and Virtual Office 
Logout (if Virtual Office is configured)

• Test Local Mode and Resume Local Mode 
(if Branch Office is configured)

• Password Admin

• Display Network Diagnostics Utilities

Table 35
IP Phone 1140E components and functions (Part 4 of 6)

Component Function
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Press the Services key twice to access the 
Local Tools menu. The following items 
appear in the Local Tools menu:

1. Preferences

1. Display Settings

2. Languages…

3. Bluetooth Setup 

2. Local Diagnostics

1. IP Set&DHCP Information

2. Network Diagnostic Tools

3. Ethernet Statistics

4. IP Network Statistics

5. USB Devices

3. Network Configuration

4. Lock Menu

1. Manual Secure Local Menu

2. Manual Partial Secure Menu

3. Manual Disable Secure Menu

4. DHCP Secure Menu

5. Lock Now

To make a selection, press the number 
associated with the menu item, or use the 
navigation keys to scroll through the menu 
items. 

Press the Services key to exit from any menu 
or menu item.

Table 35
IP Phone 1140E components and functions (Part 5 of 6)

Component Function
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Display characteristics
An IP Phone 1140E has three major display areas: 

• user-defined feature key label

• soft key label

• information line

For information on configuring IP Phone 
1140E Local Tools menu, see “Configure IP 
Phone 1120E and IP Phone 1140E Local 
Tools options” on page 463.

Copy Press the Copy Key to copy entries to your 
Personal Directory from other lists, such as the 
Caller List, Redial List and Corporate 
Directory.

Speaker Press the Handsfree key to activate the 
speaker.

Handsfree key Press the Handsfree key to activate 
handsfree.

The LED lights to indicate when the handsfree 
feature is active.

Note 1: If a call is presented while the user is manipulating an option, the 
IP Phone 1140E rings and the DN key flashes. However, the screen 
display is not updated with Caller ID information. The programming text is 
not disturbed.

Note 2: The user can originate a call using Autodial or Last Number 
Redial while manipulating an option. However, the display is not updated 
with the dialed digits or the Caller ID, and Autodial and Last Number 
Redial intercept the dialpad.

Table 35
IP Phone 1140E components and functions (Part 6 of 6)

Component Function
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Figure 54 on page 362 shows these three display areas.

Figure 54
IP Phone 1140E display area

Cleaning the IP Phone display screen

Gently wipe the IP Phone display screen with a soft, dry cloth.

User-defined feature key label display

The feature key label area displays a 10-character string for each of the four 
feature keys. Each feature key includes the key label and an icon. The icon 
state can be on, off, or flashing. Key labels are left-aligned for keys on the left 
side of the screen, and right-aligned for keys on the right side of the screen.

CAUTION
Do not use any liquids or powders on the IP Phone. 
Using anything other than a soft, dry cloth can 
contaminate IP Phone components and cause premature 
failure.

Upper display area
User-defined 

feature key labels

Lower display area
Soft key labels

Middle display area
Date/time display

Call party information
Feature status information

Options information
Directories information

42888

47678

09/16     2:32pm

42597

44759

41798

49521

Trans Conf Forward More...
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Note: If a label is longer than ten characters, the last ten characters are 
displayed, and the excess characters are deleted from the beginning of the 
string.

Soft key label display

A maximum of ten functions can be assigned to the soft keys. Functions are 
assigned to the soft keys in layers in LD 11.

Use the More soft key to navigate through the layers of functions. If there are 
only four functions assigned to the soft keys, the More key does not appear 
and all four functions are displayed.

The soft key label has a maximum of seven characters. Each soft key includes 
the soft key label and an icon. When a soft key is in use, a flashing icon 
displays at the beginning of the soft key label, and the label shifts one 
character to the right. (If the label is six characters long, the last, or rightmost 
character is truncated.) If a feature is enabled, the icon state turns to On. It 
remains in the on state until the feature key is pressed again. This cancels the 
enabled feature and turns the icon off, returning the soft key label to its 
original state. 

Information line display

An IP Phone 1140E has a three-line information display area with the 
following information: 

• caller number

• caller name

• feature prompt strings

• user-entered digits

• date and time information (if the IP Phone is in an idle state) 

The information in the display area changes, according to the call processing 
state and active features.
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Password protection of the Tools menu
When password protection is enabled, the Tools menu is locked to prevent 
accidental or unwanted changes. The fixed password is required whenever the 
Services key is double-pressed or whenever the Local Diagnostics and 
Network Configuration sub menus are accessed. Use the dialpad to enter the 
fixed password 26567*738 (color*set). 

There are two ways to control the menu lock:

• DHCP Secure Menu option—IP Phone process the secure menu setting 
retrieved from the Full DHCP response

• 4. Lock Menu—manual user settings

– 1. Manual Secure Local Menu

– 2. Manual Partial Secure Menu

– 3. Manual Disable Secure Menu

– 4. DHCP Secure Menu

– 5. Lock Now

The settings configured in the Lock Menu sub menu override the settings 
received from the DHCP string.

For more information about 4. Lock Menu manual user settings, refer to 
“4. Lock Menu” on page 486.

DHCP Secure Menu 

Password protection is enabled during Full DHCP configuration if the 
SECUREMENU parameter, or the PARTSECUREMENU parameter are present 
at the end of the S4 part of the Full DHCP string. If neither the SECUREMENU 
parameter, nor the PARTSECUREMENU parameter is present, password 
protection is not enabled. 

The SECUREMENU/PARTSECURE item is an optional parameter. If it is 
present, then the full S4 string needs to be present, including the action and 
retries. The S4 string will already be present if the XAS support has been 
configured through the DHCP. If XAS is not configured, the password 
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protection can still be enabled by setting the S4 IP address to 0.0.0.0 and 
setting the other fields to anything, although it is recommended you use 0 for 
these settings.

The following examples show how to configure password protection through 
the DHCP string:

• Menu protection on, no XAS configured:

Nortel-i2004-A,147.19.11.70:4100,1,10;147.19.11.7:
4100,1,5;0.0.0.0:0,0,0,SECUREMENU

or

Nortel-i2004-A,147.19.11.70:4100,1,10;147.19.11.7:
4100,1,5;0.0.0.0:0,0,0,PARTSECUREMENU

• Menu protection off, GraphicalXAS configured:

Nortel-i2004-A,xxx.xxx.xxx.xxx:pppppp,aaa.rrr;
xxx.xxx.xxx.xxx:pppppp,aaa,rrr;xxx.xxx.xxx.xxx:
pppppp,aaa

Nortel-i2004-A,147.19.11.70:4100,1,10;147.19.11.7:
4100,1,5;37.165.238.90:4443,1
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• Menu protection on, GraphicalXAS configured:

Nortel-i2004-A,xxx.xxx.xxx.xxx:pppppp,aaa,rrr;
xxx.xxx.xxx.xxx:pppppp,aaa,rrr;xxx.xxx.xxx.xxx:
pppppp,aaa,rrr,SECUREMENU

Nortel-i2004-A,147.19.11.70:4100,1,10; 
147.19.11.70:4100,1,5;37.165.238.90:44443,1,5,
SECUREMENU

or

Nortel-i2004-A,xxx.xxx.xxx.xxx:pppppp,aaa,rrr;
xxx.xxx.xxx.xxx:pppppp,aaa,rrr;xxx.xxx.xxx.xxx:
pppppp,aaa,rrr,PARTSECUREMENU

Nortel-i2004-A,147.19.11.70:4100,1,10; 
147.19.11.70:4100,1,5;37.165.238.90:44443,1,5,
PARTSECUREMENU

For further information on configuring Full DHCP, refer to Converging the 
Data Network with VoIP (553-3001-160).

Accessing the Tools menu

If the SECUREMENU parameter was set during Full DHCP configuration, 
you are prompted to enter the fixed password (26567*738) whenever the 
Services key is double-pressed on the IP Phone 1140E. If the PARTSECURE 
parameter was set during Full DHCP configuration, you are prompted to enter 
the fixed password whenever you access 2. Local Diagnostics or 3. Network 
Configuration menu items from the Tools menu. You are always prompted to 
enter the fixed password whenever you access the 4. Lock Menu sub menu.

Once the password is entered, the Tools menu remains active for 5 minutes. 
You can freely navigate, exit and reenter the Tools menu without being 

IMPORTANT!

In Full DHCP mode, the server must be configured to respond to the 
request for vendor-specific encapsulated options.
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prompted to reenter the password. To reset the timer before the 5 minute time 
expires, double-press the Services key. 

You can also press the 5 key to select the Lock Now item from the Lock 
Menu. The Lock Now item immediately exits the Tools menu, closes any 
open Tools menu pages, and locks the Tools menu. Alternatively, when time 
expires, the Tools menu and any open submenus are closed. Double-press the 
Services key to open the password prompt window to reaccess the Tools 
menu.

If you enter an incorrect password, the Tools menu will not open. 
Double-press the Services key to open the password prompt window. Only 
three incorrect password entries are allowed. Any entry after the three 
attempts is ignored for 5 minutes. The password prompt window is visible 
and you can reenter the password but the password is not processed until the 
5 minute time expires.

Note: Some items appear dimmed depending on the current state of the 
menu lock and the mode of the IP Phone. The current selected mode is 
dimmed. Only configuration options which are enabled from the current 
state appear active.

For more information about configuring the Local Tools menu for the 
IP Phone 1120E, refer to “Configure IP Phone 1120E and IP Phone 1140E 
Local Tools options” on page 463.

Key number assignments
The IP Phone 1140E has four soft-labeled, predefined soft keys that are used 
to provide up to 10 features. Because they are predefined, the user cannot 
change the key number assignment. 

The Message key is numbered 16. Key numbers 17 to 31 are the four soft-key 
labels below the display area. See Figure 54 on page 362.

Key numbers 17 to 31 support the features A03, A06, CFW, CHG, CPN, 
PRK, PRS, RGA, RNP, SCC, SCU, SSC, SSU and TRN, as listed in Table 36 
on page 368.
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Key number mappings at the Call Server are aligned with that of the 
IP Phone 2004. 

Table 36 describes the IP Phone feature assignment for each of the dedicated 
keys. Use LD 11 to program keys 16 to 26 on the IP Phone 1140E.

Note: If you attempt to configure anything other than the permitted 
response, the system generates an error code.  

Table 36
IP Phone 1140E soft keys (Part 1 of 2)

Key number  Response Description

Key 16 MWK

NUL

Message Waiting key

Removes function or feature from key

Key 17 TRN

NUL

Call Transfer key

Removes function or feature from key

Key 18 A03

A06

NUL

Three-party conference key

Six-party conference key

Removes function or feature from key

Key 19 CFW

NUL

Call Forward key

Removes function or feature from key

Key 20 RGA

NUL

Ring Again key

Removes function or feature from key

Key 21 PRK

NUL

Call Park key

Removes function or feature from key

Key 22 RNP

NUL

Ringing Number Pickup key

Removes function or feature from key
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Package components
The approved Nortel AC adapter and a standard local power cord must be 
ordered separately if local power using the AC adapter is required. Refer to 
Table 37 on page 370.

The IP Phone 1140E includes integrated support for a number of power over 
LAN options, including support for IEEE 802.3af standard power.

Key 23 SCU

SSU

SCC

SSC

NUL

Speed Call User

System Speed Call User

Speed Call Controller

System Speed Call Controller

Removes function or feature from key

Key 24 PRS

NUL

Privacy Release key

Removes function or feature from key

Key 25 CHG

NUL

Charge Account key

Removes function or feature from key

Key 26 CPN

NUL

Calling Party Number key

Removes function or feature from key

WARNING
Use your IP Phone 1140E with the approved Nortel AC adapter 
(model # N0023000) for this model of phone only.

Table 36
IP Phone 1140E soft keys (Part 2 of 2)

Key number  Response Description
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Table 37 lists the IP Phone 1140E package components and product codes.

Table 37
IP Phone 1140E component list (Part 1 of 2)

IP Phone 1140E package contents includes

• IP Phone 1140E

• Handset

• Handset cord

• 2.3 m (7 ft) CAT5 Ethernet cable

• Number plate and lens

• Getting Started Card

IP Phone 1140E with icon keycaps NTYS05AA

IP Phone 1140E with English keycaps NTYS05BA

Replacement parts

Handset, Charcoal NTYS09AA70

Handset cord, Charcoal NTYS10AA70

Footstand kit, Charcoal NTYS11AA70

Phone number label and lens kit NTYS12AA

2.3 m (7 ft) CAT5 Ethernet cable NTYS13AA

Power adapter

Global power supply N0023000

AC cord 

1.8 m (5.9 ft), 10 amp, IEC320-C13 
North America

Note: Nortel recommends you use the thinner cord (NTYS14AA) as 
an alternative to NTTK14AB.

NTYS14AA
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Before you begin
The following section provides a step-by-step guide through the 
IP Phone 1140E installation process. Before installing the IP Phone 1140E, 
complete the following pre-installation checklist.

IEC cable

3 m (9.9 ft),125 VAC 13 amp, NA power cord, NEMA 
North America, Middle East, Taiwan, Philippines, Thailand, and 
Japan

NTTK14AB

2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, 
Australia, New Zealand

NTTK15AA

250 VAC, Option 11C Standard European power cord, 
Other EMEA, Kenya, Korea, Thailand, Indonesia, Vietnam, India, 
Pakistan

NTTK16AB

3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord
Switzerland

NTTK17AB

240 VAC, Option 11C UK power cord
Hong Kong, Ireland, United Kingdom, Singapore, Malaysia, 
Bangladesh, Brunei, Sri Lanka

NTTK18AB

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord
Denmark

NTTK22AB

Table 37
IP Phone 1140E component list (Part 2 of 2)
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Procedure 65
Pre-installation checklist

1 Ensure there is one IP Phone 1140E boxed package for each 
IP Phone 1140E being installed. The package contains:

• IP Phone 1140E

• Handset

• Handset cord

• 2.3 m (7 ft) CAT5 Ethernet cable

• Number plate and lens

• Getting Started Card

2 To install and configure an IP Phone 1140E, the host system must be 
equipped with the Voice Gateway Media Card, or a Signaling Server with 
the Line TPS application.

3 If an AC power adapter is required, ensure the approved Nortel AC 
adapter (model # N0023000) is used. Refer to Table 37 on page 370.

4 Understand the three configuration modes that you can choose from as 
you proceed through the installation of the IP Phone 1140E. The three 
configuration modes are:

• Static IP address–see “Static IP address assignment” on page 373.

• Partial DHCP–see “Dynamic IP address assignment—Partial DHCP” 
on page 374.

• Full DHCP–see “Dynamic IP address assignment—Full DHCP” on 
page 374.

5 A DHCP server and DHCP relay agents, if required, must also be 
installed, configured, and running.

End of Procedure
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First-time installation
To install and configure an IP Phone 1140E, you must first install a Voice 
Gateway Media Card in the system.

IP address assignments

During the first-time installation, the three IP address parameters that are 
entered either manually or automatically depending on the installation 
configuration are as follows:

• Static IP address assignment 

• Partial DHCP 

• Full DHCP

As well, you are prompted to enable or disable 802.1Q. For more information, 
see “802.1Q VLAN description” on page 407.

You can also use an enhanced network configuration menu to configure the 
IP Phone 1140E. The user can access the Local Tools menu at any time. 
Information is entered through the keypad or an attached USB keyboard. For 
further information on using the Local Tools menu to configure the 1140E 
Phone, refer to “Configure IP Phone 1120E and IP Phone 1140E Local Tools 
options” on page 463.

Use Procedure 66, “Installing an IP Phone 1140E for the first time” on 
page 374.

Static IP address assignment

During the installation, the IP Phone 1140E parameters are entered manually 
using the telephone key pad.

CAUTION
Damage to Equipment
Do not plug your IP Phone 1140E into an ISDN 
connection. Severe damage can result. 
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Enter the IP address, subnet mask, default Gateway, IP address, port number, 
action, and retry count.

Dynamic IP address assignment—Partial DHCP

For a partial DHCP installation, you must provide, through the IP Phone’s 
key pad, the Connect Server parameters including: IP address, port number, 
action, and retry count. Other parameters (IP Phone IP address, subnet mask, 
and default Gateway) are obtained from the DHCP server.

The IP Phone password, node ID and TN must be entered manually using the 
telephone key pad.

For more information about DHCP servers, see Converging the Data 
Network with VoIP (553-3001-160).

Dynamic IP address assignment—Full DHCP

For a full DHCP installation, all parameters (IP Phone IP address, subnet 
mask, default Gateway, Connect Server IP address, port number, action, and 
retry count) are retrieved from the DHCP server to recognize the 
IP Phone 1140E.

The IP Phone 1140E password, node ID and TN must be entered manually 
using the telephone key pad.

Procedure 66
Installing an IP Phone 1140E for the first time

1 Configure a virtual loop on the system using LD 97.

For more information, see Software Input/Output: Administration 
(553-3001-311).

2 Configure the IP Phone 1140E on the system as IP Phone 2004 using 
LD 11. At the prompt, enter the following:

REQ:chg
TYPE:i2004
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For more information, see Software Input/Output: Administration 
(553-3001-311). 

3 Remove the stand cover. Pull upward on the center catch and remove the 
stand cover. The cable routing tracks are now accessible. See Figure 55 
on page 375.

Figure 55
Stand cover removed

CAUTION
The IP Phone 1140E is shipped with the base locked in 
position. To avoid damaging the IP Phone, press the
wall-mount lever located under the Handsfree key to 
release the base and pull it away from the phone.

Tilt Lever
Button

Center
Catch

Handset
cord exit
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4 Connect the AC power adapter (optional). Connect the adapter to the AC 
adapter jack in the bottom of the phone. Form a small bend in the cable, 
and then thread the adapter cord through the channels in the stand.

Note 1: The IP Phone 1120E supports both AC power and Power over 
Ethernet options, including IEEE 802.3af standard power. To use local AC 
power, the optional AC adapter can be ordered separately. To use Power 
over Ethernet, where power is delivered over the CAT5 cable, the LAN 
must support Power over Ethernet, and an AC adapter is not required.

Note 2: You must use CAT5e (or later) cables if you want to use gigabit 
Ethernet. 

5 Install the handset. Connect the end of the handset cable with the short 
straight section into the handset. Connect the end of the handset cable 
with the long straight section to the back of the phone, using the RJ-9 
handset jack marked with the symbol +. Form a small bend in the cable, 
and then thread the handset cord through the channels in the stand so 
that it exits behind the handset on the right side, in the channel exit in the 
stand base marked with the symbol +. See Figure 56 on page 377. 

WARNING
Use your IP Phone 1140E with the approved Nortel AC adapter 
(model # N0023000) for this model of phone only.
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Figure 56
Cable routing tracks

6 Install the headset (optional). If you are installing a headset, plug the 
connector into the RJ-9 headset jack marked with the symbol) on the 
back of the phone, and thread the headset cord along with the handset 
cord through the channels in the stand, so that the headset cord exits the 
channel marked with the symbol).

7 Install the Ethernet cable. Connect one end of the supplied Ethernet cable 
to the back of your phone using the RJ-45 connect marked with the 
symbol%, and thread the network cable through the channel marked with

B

A
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8 Install the Ethernet cable connecting the PC to the phone (optional). If you 
are connecting your PC Ethernet through the phone, connect one end of 
the PC Ethernet cable to your phone using the RJ-45 connector marked 
with the symbol (, and thread it through the channel marked with the 
symbol (. Connect the other end to the LAN connector on the back of 
your PC. 

9 Install additional cables. If applicable, plug in optional USB devices. 
Connect the Ethernet cable to the LAN Ethernet connection. If you are 
using an AC power adapter, plug the adapter into an AC outlet.

Note: Complete steps 1-9, as needed, before wall-mounting the 
IP Phone.

10 Wall-mount your phone (optional). Use Method A or Method B to 
wall-mount the IP Phone. See Method A—using the mounting holes on 
the bottom of the phone stand, or Method B—using the traditional-style 
wall-mount box with a RJ-45 connector and a 15 cm (6 inch) RJ-45 cord 
(not provided).

• Method A: Press the wall-mount lever, and pull away from the stand. 
Using the stand cover (see step 3 on page 375), mark the wall-mount 
holes by pressing the bottom of the stand cover firmly against the wall 
in the location where you wish to install the phone. Four small pins on 
the bottom of the stand cover make the marks on the wall. Use the 
marks as a guideline for installing the wall-mount screws (not 
provided).

Install the screws so that they protrude 3 mm (1/8 inch) from the wall, 
and then install the phone stand mounting holes over the screw 
heads. You may need to remove the phone from the wall to adjust the 
lower screws. When the lower screws are snug, install the phone on 
the mounting screws, and then tighten the top screws.

• Method B: Attach the 15 cm (6 inch) CAT5e cable, position the stand 
over the mounting rivets, and slide the phone down the wall so that 
the rivets fit into the slots on the stand. 

11 Replace the stand cover. Ensure that all cables are neatly routed and 
press the stand cover into place until you hear a click.

CAUTION
Damage to Equipment
Do not plug your IP Phone 1140E into any other port 
but the PC Ethernet port. Severe damage can result. 
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12 Put the phone in the wall-mount position (optional). If you wall-mount the 
phone, put it in the wall-mount position by holding the Tilt Lever and press 
the phone towards the base until the phone is parallel with the base. 
Release the Tilt Lever and continue to push the phone towards the base 
until you hare an audible click. Ensure the phone is securely locked in to 
position.

Figure 57
Rotate the phone into the wall mount position

Wall-mount leverTilt lever
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13 When the Nortel logo appears in the middle of the display, immediately 
press the four feature keys at the bottom of the display in sequence from 
left to right. The 3.Network Configuration menu opens. 

Note: You can press the Apply&Reset soft key to save the following 
settings and to reset the IP Phone. You can press the Exit soft key exit 
the menu to exit the menu without saving any changes and return to the 
3.Network Configuration menu.

When the 3. Network Configuration menu opens, the Enable 802.1x 
(EAP) check box is highlighted. 

14 Press the Enter key to toggle this item on and off. A check mark appears 
to indicate the item is active.

If you select the Enable 802.1x (EAP) check box, press the Enter key to 
start the edit mode. Use the keypad to fill in the following information:

• EAP Device ID

• EAP Password

For further information about EAP, refer to Appendix C: “802.1x 
Port-based network access control” on page 415.

Note: If you select do not select the Enable 802.1x (EAP) combo box, 
you will not be prompted to enter Device ID and Password.

15 Use the Right navigation key to scroll and highlight DHCP combo box. 

16 Press the Enter key.

17 Press the Down navigation key to open list box.

IMPORTANT!

Timing information
There are only 4 seconds between plugging in the IP Phone 1140E 
power adapter and the appearance of the Nortel logo in the middle of 
the display. When you see the logo, you have 1 second to respond by 
pressing the 4 feature keys at the bottom of the display in sequence from 
left to right. If you miss the 1-second response time, the IP Phone 1140E 
attempts to locate the connect server. Wait until it is finished, and then 
begin the power-up sequence again.
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18 Use the Up/Down navigation keys to scroll and highlight one of the 
following DHCP options:

• No—enter the information in the boxes. 

• Partial—enter Server 1 IP address, Server 2 IP address, Port, Action, 
Retry, and PK numbers in the boxes.

• Full—all items are dimmed

Note: If Full is selected for DHCP in the list, all items are dimmed. If 
Partial or No is selected for DHCP in the list, all items are accessible. Use 
the navigation keys to scroll and highlight the items and use the keypad 
to enter the applicable information.

19 Press the Enter key. 

20 Use the Right navigation key to scroll and highlight SET IP. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.  

Set IP—a valid IP Phone 1140E IP address.

21 Use the Right navigation key to scroll and highlight NET MASK. Press 
the Enter key to start the edit mode. Use the keypad to fill in the 
information.

Net Mask—a subnet mask

22 Use the Right navigation key to scroll and highlight Gateway. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

Gateway—the default gateway for the IP Phone 1140E on the LAN 
segment to which it is connected

23 Use the Right navigation key to scroll and highlight S1 IP. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

S1 IP—the node IP address of the IP Phone 1140E



Page 382 of 508  IP Phone 1140E

553-3001-368 Standard 12.00 March 2006

24 Use the Right navigation key to scroll and highlight Port. 

S1 Port—a fixed value of 4100

25 Use the Right navigation key to scroll and highlight S1 Action. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

S1 Action—a fixed value of 1

26 Use the Right navigation key to scroll and highlight Retry. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

Retry—the number of times the IP Phone 1140E attempts to connect to 
the server

27 Use the Right navigation key to scroll and highlight S1 PK. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

28 Use the Right navigation key to scroll and highlight S2 IP. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

S2 IP—same as S1 in most cases 

Note: The IP Phone 1140E can support a primary (S1) and secondary 
(S1) connect server. If you require IP Phones to register on multiple 
nodes, refer to IP Line: Description, Installation, and Operation  
(553-3001-365).

29 Use the Right navigation key to scroll and highlight Port. Press the Enter 
key to start the edit mode. Use the keypad to fill in the information.

Port—same as S1 port

30 Use the Right navigation key to scroll and highlight S2 Action. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

S2 Action—same as S1

31 Use the Right navigation key to scroll and highlight Retry. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

Retry—same as S1

32 Use the Right navigation key to scroll and highlight S2 PK. Press the 
Enter key to start the edit mode. Use the keypad to fill in the information.

S2 PK—same as S1

33 Use the Right navigation key to scroll and highlight VoiceVLAN combo 
box. Press the Enter key. Press the Down navigation key to open the list 
box.
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34 Use the Up/Down navigation keys to scroll and highlight one of the 
following options:

— No—default
802.1Q VLAN remains off until initialization continues.

— Auto

— value

The VoiceVLAN ID is entered as an integer. The VoiceVLAN ID is a 12-bit 
value between 1 and 4095.

The IP Phone 1140E is configured with 802.1Q enabled, the VoiceVLAN 
ID is configured to the entered value and the VoiceVLAN priority is 6.

35 Press the Enter key. 

For more information about VLAN configuration, refer to Converging the 
Data Network with VoIP (553-3001-160). 

36 Use the Right navigation key to scroll and highlight VLAN Filter check 
box. Press the Enter key to toggle this item on and off.  

Note: The VLAN Filter check box will appear dimmed if you select No in 
the VoiceVLAN combo box.

37 Use the Right navigation key to scroll and highlight Disable PC Port 
check box. Press the Enter key to toggle this item on and off. 

38 Use the Right navigation key to scroll and highlight DataVLAN combo 
box. Press the Enter key. Press the Down navigation key to open the list 
box.

Use the Up/Down navigation keys to scroll and highlight one of the 
following options:

— No—default

— value

The DataVLAN is entered as an integer. The DATA VLAN ID is a 12-bit 
value between 0 and 4095, and should be different from the VoiceVLAN 
ID.

The IP Phone 1140E is configured with 802.1Q enabled, the Data VLAN 
ID is configured to the entered value, and the Data VLAN priority is 0.

39 Press the Enter key.

40 Use the Right navigation key to scroll and highlight PC-Port Untag All 
check box. Press the Enter key to toggle this item on and off. 
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41 Use the Right navigation key to scroll and highlight Duplex combo box. 
Press the Enter key. Press the Down navigation key to open the list box. 

Use the Up/Down navigation keys to scroll and highlight one of the 
following options:

— Auto

— 10BT Full

— 100BT Full

42 Press the Enter key.

43 Use the Right navigation key to scroll and highlight Ignore GARP check 
box. Press the Enter key to toggle this item on and off.

44 Use the Right navigation key to scroll and highlight XAS IP combo box. 
Press the Enter key to start the edit mode. Use the keypad to fill in the 
information.

45 Use the Right navigation key to scroll and highlight Graphical XAS check 
box. Press the Enter key to toggle this item on and off.

46 Use the Right navigation key to scroll and highlight Port combo box. 
Press the Enter key to start the edit mode. Use the keypad to fill in the 
information.

47 Use the Right navigation key to scroll and highlight TFTP IP combo box. 
Press the Enter key to start the edit mode. Use the keypad to fill in the 
information.

TFTP IP—TFTP Server IP address (for Succession Release 3.0 or 
CS 1000 Release 4.0

The TFTP Server is required to download the current firmware if you are 
using Succession Release 3.0 or CS 1000 Release 4.0. For further 
information about TFTP Server configuration, see Appendix E: “TFTP 
Server” on page 489. 

48 Use the Right navigation key to scroll and highlight Enable Bluetooth 
combo box. Press the Enter key. Press the Down navigation key to open 
the list box. 
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49 Use the Up/Down navigation keys to scroll and highlight one of the 
following options:

— Auto

— Yes

— No

50 Press the Enter key.

51 You can press the Apply/Reset soft key to save the settings and to reset 
the IP Phone. You can press the Exit soft key exit the menu to exit the 
menu without saving any changes and return to the main menu display.

The IP Phone 1140E searches for the connect server. 

The IP Phone 1140E registers with the Terminal Proxy Server (TPS) and, 
if needed, begins the firmware download. This takes several minutes. 
When download is complete, the IP Phone 1140E resets.

Note 1: The Enhanced UNIStim Firmware Download feature for 
IP Phones provides an improved method of delivering new firmware to 
IP Phones. For further information about Enhanced UNIStim Firmware 
Download, refer to “Features overview” on page 397.

Note 2: For Succession Release 3.0 and CS 1000 Release 4.0, the 
IP Phone 1140E searches for the TFTP Server for firmware upgrade. If 
the file name specified in 1140e.cfg is not the same as the current 
firmware, the IP Phone downloads the file and upgrades the firmware. 
This takes several minutes. When the upgrade is complete, the 
IP Phone 1140E reboots. 

The current system date and time appear on the top line of the display 
when the configuration is complete. Self-labeling keys also appear.

52 Check for dial tone and the correct DN on the display.

53 (Optional) Customize the feature keys as required. For more information, 
see For more information, see Software Input/Output: Administration 
(553-3001-311) and the IP Phone 1140E User Guide.

End of Procedure
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Startup sequence
When an IP Phone 1140E is connected to the network, it must perform a 
startup sequence. The elements of the startup sequence include:

• obtaining the IP parameters

• finding a default Gateway server

• authenticating the user

See Table 38 on page 386 for a summary of the IP parameters and how they 
are obtained.

Full Duplex mode
In the Configuration menu, Auto Negotiate mode is the default setting for 
initial startup. Typically, the IP Phone is connected to a network that supports 
Auto Negotiate, and it selects the best speed and duplex mode available. 
There is no intervention required under normal operation.

Table 38
IP Phone 1140E IP parameters

Parameter Method of Acquisition

IP Address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Net Mask Manually entered or automatically retrieved through 
Partial or Full DHCP.

Default Gateway address Manually entered or automatically retrieved through 
Partial or Full DHCP.

Connect Server (IP address, port, 
action and retry count—primary 
and secondary)

Manually entered or automatically retrieved through Full 
DHCP.

User ID (Node ID, Node Password 
and TN)

Manually entered for first-time configuration. Retrieved 
from local storage on subsequent power cycles.
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If the IP Phone is connected to a network configured for Full Duplex mode 
only, cannot automatically negotiate the proper configuration. Therefore, in 
this instance, to allow the IP Phone to work at the optimum speed and duplex 
mode, Auto Negotiate must be disabled. Use the following procedure to 
disable Auto Negotiate and enable Full Duplex mode.

Procedure 67
Disabling Auto Negotiate and enabling Full Duplex 
mode

1 Double-press the Services key to open the Local Tools menu.

2 Press 3 on the dialpad to access the Network Configuration menu or 
use the Up/Down navigation keys to scroll and highlight the Network 
Configuration option.

3 Use the Right navigation key to scroll and highlight the Duplex combo 
box.

4 Press Enter to start the edit mode. 

5 Press the Down navigation key to open list box.

6 Use the Up/Down navigation keys to scroll and higlight one of the 
following options:

• 10BT Full—10 BT Full Duplex mode

• 100BT Full—100 BT Full Duplex mode

7 Press Enter to exit the edit mode.

8 Press the Apply&Reset soft key to save the changes and to restart the 
IP Phone 1140E.

End of Procedure

When the IP Phone 1140E is restarted, the firmware reads the setting for 
Full Duplex mode and sets both port 0, network interface port, and port 1, 
PC interface port, accordingly.
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Use the following procedure to confirm activation of Full Duplex mode.

Procedure 68
Checking Ethernet Statistics

1 Double-press the Services key to open the Local Tools menu. 

2 Press 2 to select Local Diagnostics, then press 3 to open the Ethernet 
Statistics menu.

If Full Duplex mode is active, the following is displayed:

• Link Status: UP

• Duplex Mode: Full

• Network Speed: 10 Mb, 100 Mb or 1G

• Auto Sense/Negotiate

— Auto-Nego Capability: No

— Auto-Nego Completed: No

End of Procedure

TFTP firmware upgrade 
When you enter Cfg TFTP = 1 (for yes), and enter an IP address, the phone 
searches for an upgrade file on the TFTP Server. 

Note: Users of CS 1000 Release 4.5 or later do not need to enter a TFTP 
IP address.

Gratuitous Address Resolution Protocol Protection
Gratuitous Address Resolution Protocol Protection (GARP) protects the 
IP Phone 1140E from GARP Spoof attacks on the network. In a GARP Spoof 
attack, a malicious device on the network takes over an IP address (usually 
the default gateway) by sending unsolicited (or Gratuitous) ARP messages, 
thus manipulating the ARP table of the victim’s machine. This allows the 
malicious device to launch a variety of attacks on the network, resulting in 
undesired traffic routing. For example, a GARP attack can convince the 
victim machine that the malicious device is the default gateway. In this 
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scenario, all traffic from the victim’s machine flows through the malicious 
device.

To enable GARP Protection during configuration, refer to Procedure 66, 
“Installing an IP Phone 1140E for the first time” on page 374.

Extensible Authentication Protocol 
Extensible Authentication Protocol (EAP) is a general protocol that fulfills 
the protocol requirements defined by 802.1x. For further information on 
802.1x, refer to Appendix C: “802.1x Port-based network access control” on 
page 415.

Bluetooth wireless technology 
The IP Phone 1140E contains both hardware and software support for 
Bluetooth wireless technology enabled headsets. When the IP Phone 1140E 
powers up, Bluetooth wireless technology is disabled and it must be explicitly 
enabled. 

Note: The IP Phone 1120E does not support Bluetooth wireless 
technology.

The following methods are available to enable Bluetooth wireless technology 
the IP Phone 1140E: 

• Manual configuration— can be used to set the Bluetooth wireless 
technology mode on the IP Phone 1140E on a phone-by-phone basis. If 
manual configuration is used exclusively, a TFTP server is not required 
to configure Bluetooth wireless technology. 

Use Procedure 115 on page 485 to enable or disable Bluetooth wireless 
technology through manual configuration using the Local Tools > 
Network Configuration submenu.
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• TFTP configuration—can be used to initially set the Bluetooth wireless 
technology mode then the TFTP Server can be removed. The 
IP Phone 1140E will now retain the value and will use the last value 
received if no new value is received. 

Use Procedure 69 on page 390 to enable Bluetooth wireless technology 
on the IP Phone 1140E using the TFTP configuration file (1140e.cfg) 
retrieved during bootup.

Note: If Bluetooth wireless technology is enabled on your phone, and 
password-protection for the Local Tools menu has been enabled, you can 
still double-press the Headset key to access the 3. Bluetooth Setup 
menu.

Procedure 69
Enabling Bluetooth wireless technology 
on the IP Phone 1140E

Note: If the TFTP server is configured and is running, skip to step 5 on 
page 392 to configure the IP Phone 1140E with the TFTP Server IP 
address.

1 Add the [DEVICE_CONFIG] section to the 1140e.cfg file. 

2 Create the device configuration file. This file must have the same name 
as that specified for the FILENAME parameter in the [DEVICE_CONFIG] 
section of the 1140e.cfg file. See Figure 58.

Figure 58
Sample of the 1140eDEV.cfg file

3 The device configuration file (1140eDEV.cfg) enables Bluetooth wireless 
technology if ENABLE_BT 1 is present. If ENABLE_BT 0 is present, 
Bluetooth wireless technology is disabled. Figure 59 shows an example 
of the 1140e.cfg file with the FW and the ENABLE_BT line.

ENABLE_BT 1
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It is also possible to use the 1140e.cfg file with only the 
[DEVICE_CONFIG] section for the control of Bluetooth wireless 
technology. Figure 60 on page 391 shows an example of the 1140e.cfg 
file with only the [DEVICE_CONFIG] section.

Note: If only the [DEVICE_CONFIG] version is used, you must add the 
[FW] section before the BootC FW recovery is used. Otherwise, the 
BootC FW download fails and the IP Phone reverts to the BootC TPS 
download screen.

Figure 59
Sample of the 1140E.cfg file

Figure 60
Sample of the DEVICE_CONFIG file with only the [DEVICE_CONFIG] 
section

4 Start the TFTP Server. The TFTP Server must be running on the network 
when the IP Phone 1140E powers up to retrieve the Bluetooth wireless 
technology administrative control. After you put the 1140e.cfg and the 
device config file in the TFTP Server directory, ensure the TFTP Server is 
running then reboot the IP Phone 1140E. For information about TFTP 
Server configuration, refer to Appendix E: “TFTP Server” on page 489.

[FW]
DOWNLOAD_MODE AUTO
VERSION 0625Cxx
FILENAME 0625Cxx.bin
PROTOCOL TFTP
SERVER_IP 192.168.1.100
SECURITY_MODE 0

[DEVICE_CONFIG]
DOWNLOAD_MODE FORCED
VERSION 000001
FILENAME 1140eDEV.cfg
SERVER_IP 192.168.1.100

[DEVICE_CONFIG]
DOWNLOAD_MODE FORCED
VERSION 000001
FILENAME 1140eDEV.cfg
SERVER_IP 192.168.1.100
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Once the IP Phone 1140E retrieves the setting when the IP Phone 1140E 
restarts, it is saved in persistent memory. If the Enable BT setting is set to 
Auto, then the received value is acted on and Bluetooth wireless 
technology is either enabled or disabled on the IP Phone 1140E. If the 
Device Config file with the Enable BT setting is not received for any 
reason and the Enable Bluetooth mode is set to Auto, then the phone 
uses the last value received (retrieved from persistent memory).

If administrative control is not retrieved, the previously received value is 
used. If no value has ever been retrieved, then Bluetooth wireless 
technology is disabled by default. 

If the IP Phone 1140E successfully retrieves the administrative control 
and enables Bluetooth wireless technology, 3. Bluetooth Setup appears 
in the Preferences menu.

5 Configure the IP Phone 1140E with a TFTP Server IP address so the 
IP Phone can access the TFTP Server. 

6 Press the Services key twice.

7 Press 3 on the dialpad to access the Network Configuration menu or 
use the Up/Down navigation keys to scroll and highlight the Network 
Configuration option. Press Enter.

8 Enter the TFTP IP address in the TFTP IP field.

9 Press the Apply&Reset soft key. 

End of Procedure

Table 39 lists the 1140e.cfg field names and definitions. 

Table 39
1140e.cfg field name definitions (Part 1 of 2)

Field name Field value Definition

[FW] Section header for firmware download information

DOWNLOAD_MODE AUTO Recommended setting. FW is downloaded when 
the IP Phone’s FW version is older than the value 
in the 1140e.cfg file’s VERSION field.

VERSION 0625Cxx FW version
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Possible reasons Bluetooth wireless technology remains 
disabled on the IP Phone after bootup 

The following are possible reasons Bluetooth wireless technology remains 
disabled on the IP Phone 1140E after bootup:

• The TFTP Server is down or is no longer present on the network.

• Network failure. 

• The DEVICE_CONFIG section is missing from the 1140e.cfg file or is 
present but the specified device config file cannot be accessed, or it can 
be accessed but the ENABLE_BT line is either missing, or is present but 
the value of 1 is missing.

Create the DEVICE CONFIG section and file

The file pointed to by the [DEVICE CONFIG] section contains the 
parameter, ENABLE_BT. The parameter’s value is set to 1, which enables 
Bluetooth wireless technology.

The [DEVICE_CONFIG] section can point to a single file that enables or 
disables the Bluetooth wireless technology on all phones, or it can point to a 
device configuration file for specific phones using a wildcard file name to 
enable the Bluetooth wireless technology for select phones. The 
configuration files for the specific phones use the IP Phone MAC address as 
the file name with the .cfg file extension.

FILENAME 0625Cxx.bin image file name, must match the file name of the 
FW file

PROTOCOL TFTP Download protocol must be TFTP

SERVER_IP xxx.xxx.xxx.xxx IP address of the TFTP server that will download 
the FILENAME file.

SECURITY_MODE 0 For future use.

Table 39
1140e.cfg field name definitions (Part 2 of 2)

Field name Field value Definition
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Table 40 lists the [DEVICE_CONFIG] section field names and definitions.

Reinstalling an IP Phone 1140E
You can reinstall an existing previously configured IP Phone 1140E on the 
same system. For example, the IP Phone 1140E can be assigned to a new user 
(new TN) or to an existing user who moved to a new subnet by changing the 
TN of the IP Phone 1140E.

Table 40
[DEVICE_CONFIG] field name definitions

Field name Field value Definition

[DEVICE_CONFIG] Section header for device configuration file 
information

DOWNLOAD_MODE FORCED Recommended setting. The version is ignored and 
the DEVICE_CONFIG file is always read.

or

VERSION 000001 The version of the device config file

FILENAME 1140eDEV.cfg Device config filename. The file name can be 
anything. If a file name is specified, the file name is 
loaded to every IP Phone 1140e.

or

*.cfg A wildcard file name enables a different setting to 
be configured for every IP Phone. The IP Phone 
checks for a file with the MAC address as the file 
name (for example, 001365FEF1C6.cfg). 

SERVER_IP xxx.xxx.xxx.xxx The IP address of the TFTP Server that will 
download the FILENAME file.
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Procedure 70
Changing the TN of an existing 
IP Phone 1140E

1 Repower the IP Phone 1140E.

Note: During the reboot sequence of a previously configured IP Phone, 
the IP Phone 1140E displays the existing node number for approximately 
five seconds.

2 If node password is enabled and NULL, choose one of the following:

a. Disable password.

b. Set password as non-NULL.

3 Press OK when the node number displays.

4 Enter password at the password screen, and press OK.

A TN screen displays.

5 Select the Clear soft key to clear the existing TN. 

End of Procedure

If Then

node password is enabled and is 
not NULL

a password screen displays. Go to 
step 4.

node password is disabled a TN screen displays. Go to 
step 5.
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Replacing an IP Phone 1140E

Procedure 71
Replacing an IP Phone 1140E

1 Disconnect the IP Phone 1140E that you want to replace.

2 Follow Procedure 66 on page 374 to install and configure the 
IP Phone 1140E.

3 Enter the same TN and Node Number as the IP Phone 1140E you 
replaced. The system associates the new IP Phone 1140E with the 
existing TN.

End of Procedure

Removing an IP Phone 1140E from service

Procedure 72
Removing an IP Phone 1140E from service

1 Disconnect the IP Phone 1140E from the network or turn the power off.

Note: The service to the PC is disconnected as well if the PC is 
connected to the IP Phone 1140E.

If the IP Phone 1140E was automatically configured, the DHCP lease 
expires and the IP address returns to the available pool.

2 In LD 11, OUT the TN.

End of Procedure

IMPORTANT!

Two IP Phones cannot share the same TN. You must remove the 
IP Phone 1140E that is currently using the TN.
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Introduction
This chapter provides an overview of the following software features 
available for IP Phones. 

Personal Directory, Redial List, Callers List, Application Server 
Administration, Password Administration are software on the Signaling 
Server. An IP Phone must be registered to a Signaling Server to access these 
features.
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Corporate Directory
The Corporate Directory feature extends the use of a system database, created 
from Optivity Telephony Manager (OTM) information, to the IP Phones. 
This database is downloaded and stored on the system CPU platform. For 
information about using Corporate Directory from IP Phones, see the 
appropriate user guide. For details about Corporate Directory, see Features 
and Services (553-3001-306).

Personal Directory
Personal Directory allows an end user to create and control a personal 
directory. Up to 100 Personal Directory entries can be created, edited, copied 
from other sources, or deleted. (For information about using Personal 
Directory on IP Phones, see the appropriate user guide. For more information 
about the Personal Directory feature, see Features and Services 
(553-3001-306).) Personal Directory uses a separate central database, called 
the Application Server, to store directory data and end-user profile options.

Redial List
Redial List is a call log feature whose content is generated by the system 
during call processing. The list resides on the Application Server. An end user 
can scroll through a list of up to 20 entries of the most recent calls dialed from 
the IP Phone and redial a selected telephone number. For more information 
about using Redial List with IP Phones, see the appropriate user guide. For 
more information about the Redial List feature, see Features and Services 
(553-3001-306). 

Callers List
Callers List is a call log feature whose content is generated by the system 
during call processing. The list resides in the Application Server. An end user 
can scroll through a list of up to 100 entries of the most recent calls received 
by the IP Phone and call a selected telephone number. For more information 
about using Callers List with IP Phones, see the appropriate user guide. For 
more information about the Callers List feature, see Features and Services 
(553-3001-306). 
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Password Administration
Once the Station Control password (SCPW) has been set by the system 
administrator on the Call Server, end users can operate this feature from IP 
Phones to protect private directory information stored on the Application 
Server. For more information about using Password Administration from IP 
Phones, see the appropriate user guide. For information about the Password 
Administration feature, see Features and Services (553-3001-306). 

IP Call Recording
IP Call Recording enables an IP Call Recording Server to monitor the media 
stream for the active call and record it by providing the IP address and port 
information for an IP Phone on an active call. The following recording 
models are supported:

• bulk call recording — records all calls on an IP Phone

• quality monitor recording — records individual calls on an IP Phone

Note: If the network connection between the IP Call Recording Server 
and the IP Phone is lost, active calls cannot be recorded.

For more information about the IP Call Recording feature, see IP Line: 
Description, Installation, and Operation  (553-3001-365) and Automatic Call 
Distribution: Description (553-3001-351).

Virtual Office
The Virtual Office feature enables end users to log into any IP Phone using 
their own user ID and password This redirects the end-user’s telephone calls 
and other features to the Virtual Office logged-in IP Phone. For information 
about using Virtual Office on an IP Phone, see the appropriate user guide. For 
more information about the Virtual Office feature, see Features and Services 
(553-3001-306). 

Emergency Services for Virtual Office
The E911 for Virtual Office feature allows Virtual Office users to place an 
emergency call to the correct Public Safety Answering Point (PSAP) for their 



Page 400 of 508  Features overview

553-3001-368 Standard 12.00 March 2006

geographic location. For more information about the E911 for Virtual Office 
feature, see Emergency Services Access: Description and Administration 
(553-3001-313).

Active Call Failover
The Active Call Failover (ACF) feature enables an IP Phone to reregister in 
the ACF mode during a Signaling Server failure.

The ACF mode preserves the following:

• active media stream

• LED status of the Mute, Handsfree, and Headset keys

• DRAM content

Note: All other elements (feature keys, soft keys and text areas) are 
retained until the user presses a key or the connection with the Signaling 
Server is resumed. If the user presses a key during the failover, the 
display is cleared and a localized “Server Unreachable” message is 
displayed.

The IP Phone uses this new mode of reregistration only when the Signaling 
Server explicitly tells the IP Phone to do so. IP Phones clear all call 
information if they register to a Signaling Server or Line Terminal Proxy 
Server (LTPS) that does not support the ACF feature.

For more information on Active Call Failover, refer to IP Line: Description, 
Installation, and Operation  (553-3001-365). 

Enhanced UNIStim Firmware download
Enhanced UNIStim firmware download feature provides the following 
functionality for IP Phones:

• Enhanced firmware file header that includes the IT_TYPE and name 
string for each IP Phone type. 

• Revised definition of the IP Client’s IP Phone identification.
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• Maximum number of simultaneous firmware downloads from the 
Signaling Server’s UNIStim FTP (UFTP) server is 100.

• Maintenance Mode for the Signaling Server that allows more 
simultaneous firmware downloads.

Note: Maintenance Mode is not applicable to Voice Media Gateway 
Cards.

• Identification of the registered IP Phones using string names and detailed 
identification of IP Phones that register as emulations of the base 
IP Phone 2001, IP Phone 2002, and IP Phone 2004.

• UNIStim IP Phones are able to register with older versions of firmware 
when the UFTP servers are busy, and are periodically offered the option 
start the firmware upgrade to the IP Phone.

Enhanced UNIStim Firmware download feature requires a Signaling Server 
to be present on the node. Without a Signaling Server, the only firmware files 
available for downloading are the three available in CS Release 4.0 for the 
Phase 0/1/2 IP Phone 2001, IP Phone 2002, and IP Phone 2004.

For further information on Enhanced UNIStim Firmware download, refer to 
IP Line: Description, Installation, and Operation  (553-3001-365).
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Appendix A: Specifications

Contents
This section contains information on the following topics:

IP Phone power requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 403

Environmental specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 405

IP Phone power requirements

Phase II IP Phones have integrated hardware to support power over Ethernet 
for 802.3af standard power and other powering options, including ongoing 
support for PowerDsine Power over LAN Hub powering, and Cisco 
proprietary powering (as tested with specific Cisco Ethernet switch 
equipment). Nortel recommends Power over Ethernet deployment since it 
allows for power backup in case of power failures. Note that, with Phase II IP 
Phones, power splitters are no longer needed to support Power over Ethernet.

Phase II IP Phones also support connection to AC local power using the 
appropriate adapter. If local power using the AC adapter is required with a 
Phase II IP Phone, the AC adapter must be ordered separately. If the network 
LAN infrastructure supports Power over Ethernet, an AC adapter may not be 
required.

Note 1: You must order a country-specific power adapter. See the 
IP Phone components list table in the applicable IP Phone chapter for AC 
adapter descriptions and product codes.

Note 2: If you are using local power with the IP Phone 1120E and 
IP Phone 1140E, you must use the AC adapter (model # N0023000) only.
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Nortel does not advise connecting a local power adapter in addition to power 
over Ethernet.

Table 41 provides power requirements for Phase II IP Phones using Power 
over Ethernet Classification 2.

Table 42 provides power requirements for the IP Phone 2007, 
IP Phone 1120E, and IP Phone 1140E using Power over Ethernet 
Classification 3.

Table 42
Power requirements for IP Phone 2007 using Power over Ethernet Classification 3

Table 41
Power requirements for Phase II IP Phones using Power over Ethernet Classification 2

IP Phone Product Code Maximum Load Normal Load

2001 NTDU90BA 4.0 W 3.0 W

2002 NTDU91BA 4.5 W 3.0 W

2004 NTDU92BA 4.5 W 3.4 W

Note 1: Heavy load is defined as all LEDs on and 1 kHz tone on the speaker.

Note 2: Normal load is defined as set powered up.

IP Phone Product Code Maximum Load Normal Load

2007 NTDU96AB 10.0 W 7.0 W

1120E NTYS03AA
NTYS03BA

8.0 W 6.0 W

1140E NTYS05AA
NTYS05BA

8.0 W 6.0 W

Note 1: Heavy load is defined as all LEDs on and 1 kHz tone on the speaker.

Note 2: Normal load is defined as set powered up.
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Environmental specifications
Table 43 shows the environmental specifications of IP Phones.

Table 43
Environmental specifications

Parameter Specifications

Operating temperature +5° to +40°C, ambient

Operating humidity +5% to 95% RH (29 g/m3 mean absolute 
humidity)

Storage temperature –40° to +70° C
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Appendix B: 802.1Q VLAN description

Contents
This section contains information on the following topics:

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 407

Description  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 408

IP Phone support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 409

IP Softphone 2050 support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 409

Three-port switch support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 410

VLAN IDs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 410
Automatic VOICE VLAN ID configuration  . . . . . . . . . . . . . . . . . . 411
Enhanced VLAN Tagging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 412

Enhanced DATA VLAN. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 413

Introduction
The 802.1Q support is available for IP Phone 2001, IP Phone 2002, 
IP Phone 2004, IP Audio Conference Phone 2033, IP Phone 2007, 
IP Phone 1120E, IP Phone 1140E, the IP Softphone 2050 (through the PC 
operating system).

The 802.1Q support is configured from the user display interface of the IP 
Phone. Configure 802.1Q VLAN support when you initially configure an IP 
Phone. The switch ports for Voice Gateway Media Card TLAN network 
interfaces must be configured as untagged ports so the header is removed. 
While the IP Phone 2001 and the IP Audio Conference Phone 2033 provide 
VLAN support, they do not provide a port for a PC.
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The 802.1Q IEEE protocol standard allows virtual LANs (VLANs) to be 
defined within a single LAN. This improves bandwidth management and 
limits the impact of broadcast and multicast messages. A higher level of 
security between segments in a network can also be achieved.

Note: 802.1Q functionality is supported only on the IP Phone. The 
IP Line application IP stack does not provide 802.1Q support for the 
Voice Gateway Media Card.

Description
The p bits within the 802.1Q standard allow packet prioritization at Layer 2 
improving network throughput for VoIP data.

The 802.1Q standard specifies a new format of Ethernet frame. A standard 
Ethernet frame contains:

• a header consisting of a six-byte destination MAC address (following the 
header is a data area)

• a six-byte source MAC address

• a two-byte protocol identifier

The 802.1Q formatted frame is identical to a standard Ethernet frame, with 
the exception of the 4-byte 802.1Q tag that is inserted between the source 
MAC address and the protocol identifier. The first 16 bits of the 802.1Q tag 
field is the Tag Protocol Identifier containing 8100 (hex), allowing the 
Ethernet interface to distinguish it from standard Ethernet frames. The last 16 
bits of the 802.1Q tag contain the following information:

• a 3-bit Priority field (the 802.1p defined bits)

• a 1-bit Canonical Field Identifier (CFI)

• a 12-bit VLAN ID field
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IP Phone support
The IP Phone 2001, IP Phone 2002, IP Phone 2004, IP Phone 2007, IP Audio 
Conference Phone 2033, IP Phone 1120E, and IP Phone 1140E support 
802.1Q as follows:

• 802.1Q can be enabled or disabled at boot time using manual 
configuration or control downloaded from the TPS.

• If 802.1Q is disabled, standard Ethernet frames are transmitted.

• If 802.1Q is enabled, all frames transmitted by the Ethernet driver have 
the 802.1Q tag bytes inserted between the source MAC address and the 
protocol type field. The tag protocol identifier field contains 8100 (hex) 
and the CFI bit is set to 0.

• When 802.1Q is enabled, the configuration of separate voice and data 
VLANs is possible. Each VLAN has its own ID and priority on the IP 
Phone. Voice messages have the priority bits of all frames set to 6 (octal) 
and the VOICE VLAN ID is set to 000 (hex) by default. Data messages 
have the priority bits of all frames set to 0 and the DATA VLAN ID is 
set to 000 (hex) by default. The GUI and TPS configured values override 
these values.

• The IP Phone’s Ethernet driver receives any Ethernet frame destined for 
it, regardless of whether 802.1Q is enabled or whether the received frame 
is an 802.1Q tagged frame.

Note: The only exception is any 802.1Q tagged frame with the CFI = 1. 
In this case the frame is discarded.

• The IP Phone’s Ethernet driver strips the 802.1Q tag information from 
the frame prior to passing it on to the IP stack. 

• The IP Phone’s Ethernet driver filters packets by the VLAN tag and 
MAC address. Tagged traffic is prioritized and routed based on the 
priority bits.

IP Softphone 2050 support
The IP Softphone 2050 supports 802.1Q with Windows 2000. By default, 
when 802.1Q is enabled, the priority bits of all frames are set to 6 and the 
VLAN ID is set to 0 (a restriction of Windows 2000).
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For more information, see the “Nortel IP Softphone 2050” on page 193.

Three-port switch support
The IP Phone 2002, IP Phone 2004, IP Phone 2007, IP Phone 1120E, and 
IP Phone 1140E three-port switch does not interpret the 802.1Q header, but 
rather, allows the packets to pass through unmodified. Priority is achieved on 
a per port basis. The phone “port” traffic has higher priority over the Ethernet 
port to which the PC is connected. 

An IP Phone can receive Broadcast frames from a PC’s data VLAN. Any data 
network broadcast storm packets from the network are seen by the IP Phone. 
Significant broadcast storms occuring on the DATA VLAN can impact IP 
Phone performance. Refer to “Enhanced VLAN Tagging” on page 412 for 
configuration information to filter network activity from impacting IP Phone 
performance.

Enhanced 802.1P and 802.1Q support on the IP Phones improves voice 
quality by taking advantage of the VLAN filtering available on the three-port 
switch on the BCM 1100/1101. 

The following functions are available on the three-port switch:

• hardware VLAN filter 

• two TX (out) queues on each port —High Priority Queue (HPQ) and 
Low Priority Queue (LPQ)

Therefore, traffic other than Voice VLAN can be filtered by enabling the 
VLAN filtering feature and taking advantage of the hardware VLAN filter. 
Voice traffic is always queued to the HPQ thereby providing a higher quality 
of service.

VLAN IDs
The VOICE and DATA VLAN ID fields can be specified on a per interface 
basis. There is only one network interface on the IP Phone; however, the 
IP Phone has two internal IDs, one for voice and one for data traffic. The 
IP Phone firmware can detect and route the voice and data traffic. 
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The VLAN ID fields are global settings. That is, all voice packets transmitted 
by the IP Phone have the same VOICE VLAN ID. If DATA VLAN is 
enabled, the IP Phone will add the DATA VLAN ID to untagged traffic. 
However, if the traffic arriving on the PC port is already tagged, the frame 
will pass through unchanged. 

Each VLAN ID is specified as follows:

• The default VLAN ID is 000 (hex).

• The VOICE and DATA VLAN IDs can be specified in the manual 
configuration user interface.

• Or, in the case of the VOICE VLAN ID, the VOICE VLAN ID can also 
be configured by the DHCP parameter when using the Automatic VLAN 
discovery using DHCP approach.

Automatic VOICE VLAN ID configuration

As part of the 802.1Q feature, there is an option to automatically discover the 
VOICE VLAN ID using DHCP. This process reduces the configuration steps 
since entering data manually (the VOICE VLAN ID) is not required.

When the Automatic VOICE VLAN Discovery using DHCP approach is 
used, and the IP Phone has been configured as such, the following steps are 
automatically taken to obtain the VOICE VLAN ID:

1 The IP Phone 2001, IP Phone 2002, IP Phone 2004, IP Phone 2007, 
IP Audio Conference Phone 2033, IP Phone 1120E, and IP Phone 1140E 
perform an initial DHCP Discovery Request in the default VLAN.

2 The DHCP server returns a DHCP Ack message with an IP address in the 
data VLAN and one or more voice VLAN IDs in the vendor-specific 
field.

3 The telephone reads and saves the VOICE VLAN IDs. 

4 The telephone rejects the DHCP offer (accepts it but immediately gives 
up the lease).

5 The telephone reboots and sends a DHCP Discovery Request with the 
first VLAN ID from the saved list. This is repeated for each VLAN ID in 
the list until a response is received.
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This works because the Layer 2 switch discards every DHCP Discovery 
Request it receives from the IP Phone if the VLAN ID does not match the 
VLAN IDs configured on the port. When the IP Phone sends a DHCP 
Discovery Request with the port’s configured VLAN ID, the packet passes 
into the network and the DHCP server’s Ack message is passed back.

When a DHCP Ack message is received, the IP Phone accepts the offer and 
saves the IP address and Node IP address.

Enhanced VLAN Tagging

Enhanced VLAN has two main functions:

• Enhance the current Voice VLAN by implementing the hardware VLAN 
filter on the IP Phone port (SMP).

• Use TX High Priority Queue (HPQ) and 802.1P VLAN priority to 
enhance the traffic control on the IP Phone and PC network interface.

Enable/Disable menu is available to enable or disable telephony packets 
filtering based on a VLAN ID. The Enable/Disable menu is only available if 
tagging is enabled on the telephony port.

IMPORTANT!

VLAN filtering on the telephony port is disabled by default. If tagging is 
enabled on the telephony port, you can enable VLAN filtering on the 
telephony port. When VLAN filtering is enabled, packets destined for the 
IP Phone port are filtered based on the MAC address and the VLAN tag.

If VLAN filtering is not enabled on the telephony port, packets destined 
for the IP Phone port are filtered only on the MAC address. Filtering 
based on the VLAN tag does not occur. This makes the telephony port 
susceptible to broadcast storms and a Denial of Service (DOS) attack.
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Enhanced DATA VLAN 
Enhancements for DATA (PC Port) VLAN for the IP Phone 1120E and 
IP Phone 1140E include the following:

• DATA (PC Port) VLAN packet handling

– PC Port (Ingress direction)

– PC Port (Egress direction)

• DATA (PC Port) VLAN Tag Stripping

DATA (PC Port) VLAN packet handling

Packets processed to and from the PC port operate as follows:

PC Port (Ingress direction)

– DATA VLAN disabled—all traffic received on the PC port is 
switched based on MAC address. The packets are not modified 
in any way.

– DATA VLAN enabled—all untagged packets received on the 
PC port have the 802.1Q header appended and the VLAN ID is 
set to the value that was manually configured in the Data VLAN 
field. Any packet arriving on the PC port that is already tagged 
is dropped.

PC Port (Egress direction)

– DATA VLAN disabled—all traffic received on the PC port has 
the 802.1Q header appended and the VLAN ID is set to the 
value which was manually configured in the DATA VLAN 
field. Any packet arriving on the PC port which is already 
tagged is dropped.

– DATA VLAN enabled—all traffic is forwarded to the PC port 
based on a review of the MAC address and the 802.1Q value 
that was manually configured in the DATA VLAN field. Traffic 
is forwarded out the PC port only if the packets contain the 
DATA VLAN tag. Untagged traffic and traffic without the 
DATA VLAN tag is dropped.
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DATA (PC Port) VLAN Tag Stripping

DATA VLAN Tag Stripping can be configured in the Network Configuration 
menu. To enable DATA VLAN Tag Stripping, select the PC-Port Untag All 
check box, DATA VLAN Tag Stripping can be enabled or disabled 
independent of enabling VLAN support on the PC Port.

If the DATA VLAN Tag Stripping is disabled, the packet is sent to the PC 
Port unmodified. If the DATA VLAN Tag Stripping is enabled, the 802.1Q 
header if one exists, is removed from the packet before the packet is 
forwarded to the PC port.

During manual configuration, if DATA VLAN is enabled by configuring a 
VLAN ID, the PC-Port Untag All check box is selected and is enabled by 
default. By default, the egress tag is stripped. To manually override this 
setting and disable egress stripping, clear the PC-Port Untag All check box. 

If DATA VLAN is not enabled during manual configuration, the PC-Port 
Untag All check box is not selected. By default, the ingress tag is not stripped. 
To manually override this setting and enable ingress stripping, select the 
PC-Port Untag All check box.
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Appendix C: 802.1x Port-based network 
access control
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Introduction
The 802.1x support is available for IP Phone 2001, IP Phone 2002, and 
IP Phone 2004, IP Phone 2007, IP Phone 1120E, and IP Phone 1140E. 

Extensible Authentication Protocol
Extensible Authentication Protocol (EAP) supports multiple authentication 
methods, such as MD5, PEAP, TLS, and TTLS, and represents a technology 
framework that facilitates the adoption of Authentication, Authorization, and 
Accounting (AAA) schemes, such as Remote Authentication Dial In User 
Service (RADIUS). RADIUS is defined in RFC 2865.

802.1x defines the following three roles:

• Supplicant—an IP Phone which requires access to the network to use 
network services.
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•  Authenticator—the network entry point to which the supplicant 
physically connects (typically a Layer 2/3 switch). The authenticator acts 
as the proxy between the supplicant and the authentication server.
The authenticator controls access to the network based on the 
authentication status of the supplicant.

• Authentication server—performs authentication of the supplicant.

Authorization

If 802.1x is configured and the IP Phone is physically connected to the 
network, the IP Phone (supplicant) initiates 802.1x authentication by 
contacting the Layer 2/3 switch (authenticator). The IP Phone also initiates 
802.1x authentication after the Ethernet connection (network interface only) 
is restored following a network link failure.

However, if the phone resets, the IP Phone assumes the Layer 2 link has 
remained in service and is authenticated.

The IP Phone fails to authorize if the DeviceID and the IP Phone passwords 
do not match the DeviceID and IP Phone password provisioned on the 
RADIUS Server. The Layer 2 switch (authenticator) locks out the IP Phone 
and network access is denied. If this happens during reauthorization, all 
phone services are lost. The connected PC operates as normal. 

Enabling and disabling EAP

The following section provides steps to enable and disable EAP on the 
IP Phone.

Procedure 73
Enable the 802.1x supplicant

1 Reset the phone by disconnecting and reconnecting power.

2 When the Nortel logo appears, press each of the soft keys in sequence.

3 If no other configuration changes are required, press OK repeatedly until 
the 802.1x Options menu appears.

4 Press the Select soft key.

5 Enter 1 to enable EAP.
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6 Press the OK soft key to accept the setting and return to the 802.1x 
Options menu. 

Note: Press the Exit soft key at any time to return to the Configuration 
menu.

7 Use the Navigation keys to scroll through the list and select DeviceID.

The current DeviceID is shown between the brackets [ ]. This value is 
compared to the corresponding entry in the RADIUS Server for 
authentication.

Note: There is no default value when the IP Phone is shipped.

8 Enter the DeviceID.

• Enter text using the numeric key pad. See “Dialpad entry” on 
page 419 for information on entering text using the numeric keypad.

• Press the BkSpace soft key to delete a single character to the left of 
the insertion point.

• Press the Clear soft key to delete the entire DeviceID entry, and 
place the insertion point at the beginning of the string.

9 Press the OK soft key to accept the DeviceID and advance to the 
Password screen.

The current password, if one exists, is shown as a string of * * * *.

10 Enter the Password.

• Enter text using the numeric keypad. See “Dialpad entry” on 
page 419 for information on entering text using the numeric keypad.

When you enter a new password, the password is displayed in clear 
text.

• Press the BkSpace soft key to delete a single character to the left of 
the insertion point. 

• Press the Clear soft key to delete the entire DeviceID entry and place 
the insertion point at the beginning of the string.

11 Press the OK soft key to accept the password and exit the EAP menus.

Note: If the OK soft key is pressed before any changes are made, the 
current password is saved.

End of Procedure
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Procedure 74
Disabling 802.1x supplicant

1 Reset the IP Phone by disconnecting and reconnecting power.

2 When the Nortel logo appears, press each of the soft keys in sequence. 

3 If no other configuration changes are required, press OK repeatedly until 
the 802.1x Options menu appears.

4 Press the Select soft key.

5 Enter 0 to disable EAP.

6 Press the OK soft key to accept the change.

Note: Press the Cancel soft key at any time to exit the menu and discard 
any changes.

End of Procedure

Enabling and disabling EAP on the IP Phone 2007

The following section provides steps to enable and disable EAP on the 
IP Phone 2007. EAP is enabled or disabled in Network Configuration in the 
Tools menu.

Procedure 75
Enabling the 802.1x supplicant on 
the IP Phone 2007

1 Tap the Tools icon.

2 Enter the Tools menu password (if password protection is enabled). For 
information on password protection, refer to “Password Protection” on 
page 149.

3 Tap the Network Configuration menu entry.

The screen displays Apply & Reset and Exit soft keys, and the 
parameters used when configuring the IP Phone 2007. 

4  From the drop-down list, select Enable EAP.

5 Tap the screen to the right of the DeviceID prompt, then enter a Device. 

Use the dial pad to enter  digits only. To enter alpha characters, use either 
the IP Phone 2007 pop-up keyboard, or a USB keyboard. 
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6 Tap the Apply&Reset soft key to accept the DeviceID and advance to the 
Password screen.

7 Tap on the screen to the right of the Password prompt. Enter the 
password. Enter text using the numeric key pad. See Dialpad entry for 
information on entering text using the numeric keypad.

The password is shown as a string of * * * *.

8 Tap the screen to the right of the Re-type prompt. Reenter the password.

9 Tap the Apply&Reset soft key. 

End of Procedure

Dialpad entry

The following rules apply when you enter text and special characters using 
the key pad. 

• Press a key from 0 – 9 once to enter the corresponding number.

• Press a key from 2 – 9 repeatedly to cycle through the letters assigned to 
that key, first in lower case and then in upper case.

For example, if you press the 5 key repeatedly, the following characters 
are displayed, one at a time:

j -> k -> l -> J -> K -> L -> 5 ->

See Table 44 on page 420 for character key mappings.

• The insertion point remains in the its current position as long as you 
continue to press the same key.

• The entry is accepted if either a new key is pressed or if two seconds pass 
with no entry. The insertion point moves one space to the right.

For example, to enter the word “Nortel”, press the following key 
sequence:

6 [2 second delay] 6 7 8 3 5 
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Note: Although special characters are not required, key 1 generates 
commonly used special characters, such as the period (.), at symbol (@), 
and underscore (_).

Table 44:Character key mappings

Key Generates

1 _ - . ! @ $ % & + 1

2 a b c A B C 2

3 d e f D E F 3

4 g h i G H I 4

5 j k l J K L 5

6 m n o M N O 6

7 p q r s P Q R S 7

8 t u v T U V 8

9 w x y z W X Y Z 9
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Appendix D: IP Phone diagnostic utilities

Contents
This section contains information on the following topics:
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IP Phone diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 422
Network Diagnostic Utilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 422
Accessing Network Diagnostic Utilities from the IP Phone  . . . . . . 425
Network Diagnostic Utilities data display pages . . . . . . . . . . . . . . . 436
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Using CLI Commands. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 451
IDU commands. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 451

Configure IP Phone 2007 Local Options  . . . . . . . . . . . . . . . . . . . . . . . 454

Configure IP Phone 1120E and IP Phone 1140E Local Tools options. 463

Introduction
Two types of IP Phone diagnostic utility are described in this section: 
set-based, and call server console-based. These utilities provide testing and 
verification of end-to-end connectivity, verification of statistics and settings, 
and retrieval of set information.
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IP Phone diagnostics

Network Diagnostic Utilities

Network Diagnostic Utilities are accessible on IP Phone 2001, 
IP Phone 2002, IP Phone 2004, and the IP Audio Conference Phone 2033 to 
isolate voice quality and network performance problems. For information on 
network diagnostics from the IP Phone 2007, refer to Table 15 page 152. For 
information on IP Phone 1120E and 1006 Network Diagnostic Utilities, see 
“Configure IP Phone 1120E and IP Phone 1140E Local Tools options” on 
page 463.

The diagnostic utilities are available on the IP Phone itself, or from the 
Command Line Interface (CLI). For further information about CLI, see “IDU 
commands” on page 451. 

The Network Diagnostic Utilities include Network Diagnostic Tools (Ping 
and traceRoute), Ethernet Statistics, IP Networking Statistics, DHCP 
Information Process, RUDP Statistics, and Network QoS Process. 

IP Phone-based Network Diagnostic Utilities are available for Phase II Nortel 
IP Phone 2001, IP Phone 2002, IP Phone 2004, and the IP Audio Conference 
Phone 2033. See Table 45 for a description of diagnostic utilities availability 
for each phone state. 

For detailed information on Quality of Service (QoS) and Proactive Voice 
Quality Management (PVQM), refer to Converging the Data Network with 
VoIP (553-3001-160).
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Table 45 lists the Network Diagnostic Utilities available on the IP Phone in 
different states.

Ping and TraceRoute

The system administrator can use the local diagnostic tools, Ping or 
Traceroute command, from a specific endpoint with any arbitrary destination, 
typically another endpoint or Signaling Server. Ping and TraceRoute are 
available in Local or Remote mode.

Table 45
Network Diagnostic Utilities availability

Function module
Before IP 
Address 
assignment

After IP 
Address 
assignment, 
unregistered - 
Local Mode

Registered 
(TPS) - Remote 
Mode

Call in 
progress 
(TPS)

Local diagnostic tools 
(Ping & TraceRoute)

N/A Yes Yes Yes

Ethernet statistics Yes Yes Yes Yes

IP Networking statistics N/A Yes Yes Yes

DHCP information 
process

N/A Yes, part of 
information

Yes Yes

UNIStim/RUDP 
statistics

N/A N/A Yes Yes

RTP/RTCP statistics N/A N/A Yes Yes

Network QoS process N/A N/A Yes, last call Yes, renew

Supplicant Status N/A N/A Yes Yes

Supplicant 
Authentication Status

N/A N/A Yes Yes

Supplicant Device ID N/A N/A Yes Yes

Supplicant 
Authenticator ID

N/A N/A Yes Yes
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Ethernet statistics

In Local or Remote Mode, the system administrator can view ethernet 
statistics (for example, number of collisions, VLAN ID, speed and duplex) 
for the IP Phone on a particular endpoint. The exact statistics will depend on 
what is available from the IP Phone for the specific endpoint. The user may 
select either the Network Port (NIport) or PC port (PCport).

IP Networking statistics

In Local or Remote Mode, the system administrator can view information on 
the packets sent, packets received, broadcast packets received, multicast 
packets received, incoming packets discarded, and outgoing packets 
discarded.

DHCP information process

In Remote Mode, the system administrator can view DHCP settings (for 
example, IP address, S1, S2, and S4 addresses) for each IP Phone. In Local 
Mode partial information is available.

UNIStim/RUDP statistics

In Remote Mode, the system administrator can view RUDP statistics (for 
example, number of messages sent, received, retries, resets, and uptime) for 
the IP Phones.

RTP/RTCP statistics

In Remote Mode, the system administrator can view RTP/RTCP QoS metrics 
(for example, packet loss and jitter) while a call is in progress.

Network QoS Process

In Remote Mode, the system administrator can view QoS statistics (for 
example, packets sent, packets received, packet loss, jitter average and jitter 
maximum, and round trip delay).

Supplicant Status

The system administrator uses this option to determine whether 802.1x is 
enabled or disabled 802.1x.
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Authentication State

The system administrator uses this option to determine whether the IP Phone 
is currently authenticated with the 802.1x system. The following are valid 
state values:

• LogOff

• Disconnected

• Connected

• Acquired 

• Authorizing

• Held

• Authorized

• Dbl Authd

DeviceID

The system administrator uses this option to check the user name configured 
for the device that is sent to the switch for authentication. This should match 
the corresponding entry in the RADIUS Server.

Authenticator ID

The system administrator uses this option to check the MAC address of the 
Authenticator (switch).

Accessing Network Diagnostic Utilities from the IP Phone

Local diagnostics are available from the IP Phone for either Local or Remote 
mode. 

Note: Diagnostics prompts are presented in English.

Local Mode

When the IP Phone is not registered with the signaling server, the Network 
Diagnostic Tools menu is available from the IP Phone in Local Mode (see 
Table 45 on page 423). This menu is controlled by the firmware on the IP 
phone.
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Use Procedure 76 on page 426 to access the Network Diagnostic Tools in 
Local mode.

Procedure 76
Accessing the Network Diagnostic Tools 
menu in Local mode

1 Double-click the Services key. The Local Main Menu, Network 
Diagnostic Tools, appears. 

2 Press Cancel to quit, or use the Navigation keys to scroll through the 
menu and select one of the following:

• Ping

• TraceRoute

• Ethernet Statistics

• IP Network Statistics

• IP Set & DHCP Information

End of Procedure

Procedure 77
Executing Ping

1 Select Ping from the Network Diagnostic Tools submenu.

2 Press the IP soft key and enter the IP address to Ping.

Tip: Use the dialpad to enter the IP address. The * key is used for dots 
and the # key produces a space.

3 Press the Ping soft key. The results of the Ping appear on the display. 

4 Use the Navigation keys to browse the data. See Figure 61 on page 437.

Tip: Press the Ping soft key again to stop the pinging. 

5 Press one of the following soft keys:

• Reset — to clear the data

• Exit — to return to the Network Diagnostic Tools menu.

End of Procedure
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Procedure 78
Executing TraceRoute

1 Select TraceRoute from the Network Diagnostic Tools submenu.

2 Press the IP soft key and enter the IP address to trace.

3 Press the Tracert soft key. The results of the TraceRoute appear on the 
display. 

4 Use the Navigation keys to browse the data. See Figure 62 on page 438.

Tip: Press the Tracert soft key again to stop the route tracing.

5 Press one of the following soft keys:

• Reset — to clear the data

• Exit — to return to the Network Diagnostic Tools menu

End of Procedure

Procedure 79
Accessing Ethernet Statistics

1 Select Ethernet Statistics from the Network Diagnostic Tools menu. 
The Ethernet statistics appear on the display. 

2 Use the Navigation keys to browse the data. See Figure 63 on page 439.

3 Press one of the following soft keys:

• Reset— to clear the data and reset the statistic counter

• Exit — to return to the Network Diagnostic Tools menu

End of Procedure

Procedure 80
Accessing IP Network Statistics

1 Select IP Network Statistics from the Network Diagnostic Tools menu. 
The IP Network Statistics appear on the display. 

2 Use the Navigation keys to browse the data. See Figure 64 on page 440.

3 Press one of the following soft keys:

• Reset — to clear the data and reset the statistic counter

• Exit — to return to the Network Diagnostic Tools menu
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Procedure 81
Accessing IP Set & DHCP Information

1 Select IP Set & DHCP Information from the Network Diagnostic Tools 
menu. The IP Set and DHCP information appears on the display. 

2 Use the Navigation keys to browse the data. See Figure 65 on page 441. 

Note: In Local Mode, Exit is the only soft-key available in this submenu.

End of Procedure

Remote Mode

When the IP Phone is registered to the signaling server, diagnostics are 
available through the Telephone Options menu in Remote Mode. This menu 
is controlled by the TPS.

Note: When the user selects Diagnostics from the Telephone Options 
menu, if an IP Phone Installer Password is enabled in the Signaling 
Server, the Diagnostics menu is locked and the message “Access 
denied” displays on the IP Phone display.

Use Procedure 82 to access the Diagnostics submenu in Remote Mode:

Procedure 82
Accessing the Diagnostics submenu 
in Remote Mode

1 Press the Services key. 

2 Select Telephone Options.

3 Select Diagnostics.

4 Do one of the following:

• Press the Cancel soft key to quit the Diagnostics submenu and 
return to the Telephone Options menu. 

• Use the Navigation keys to scroll through the Diagnostics 
submenu. 

• Press Select to select one of the diagnostics.

The following items are available on the Diagnostics submenu:

• Diag Tools (Diagnostic Tools: Ping and TraceRoute)
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• EtherStats (Ethernet Statistics)

• IP Stats (IP Statistics)

• RUDP Stats (RUDP Statistics)

• QoS Stats (Quality of Service Statistics)

End of Procedure

Procedure 83
Accessing Diagnostic Tools in Remote mode

1 Select Diagnostic Tools from the Diagnostics submenu.

2 Do one of the following:

• Press the Cancel soft key to return to the Diagnostics submenu.

• Use the Navigation keys to scroll to the DiagnosticTools selection.

3 Press the Select soft key to choose one of the following:

• Ping (see Figure 68 on page 444)

• TraceRoute (see Figure 69 on page 445)

End of Procedure

Ping

The following items are available on the Ping submenu in Remote mode:

• IP Addr

• Nr of Pings

• Ping!

• Last ping

Procedure 84
Entering an IP address

1 Scroll through the Ping submenu to the IP Addr menu item. An IP 
address appears if previously entered. Example 47.249.48.20.

2 Press the Select soft key.

3 Use the Navigation keys to scroll to the destination IP address. 
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— If the destination IP address is in the list, press the Select soft 
key to select the IP address. Press the Select soft key again to 
return to the Ping submenu. 

— If the destination IP address is not in the list, continue scrolling 
through the available IP address list until the IP address 0.0.0.0 
appears. Press the Select soft key. 

Tip: To edit the IP address, use the keypad and the Delete soft key 
and the Cancel soft key. Use the * key for dots. 

4 Press the Select soft key to save the new IP address or press the Cancel 
soft key to return to the Ping submenu.

End of Procedure

Procedure 85
Changing the number of Pings

1 From the Ping submenu, use the Navigation keys to scroll to the Nr of 
Pings submenu item.

2 Press the Select soft key. 

Tip: Use the Delete and Clear soft keys to enter the number of pings.

3 Do one of the following:

• Press the Select soft key to accept the change and return to the Ping 
submenu.

• Press the Cancel soft key to return to the Ping submenu.

End of Procedure

Procedure 86
Pinging an IP address

1 From the Ping submenu, use the Navigation keys to scroll to the Ping! 
submenu item.

2 Press the Select soft key. Pinging starts. 

Tip: Press the Stop soft key to stop pinging.

3 Press the OK soft key to return to the Ping submenu.
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Procedure 87
Reviewing the results of the Ping:

1 Use the Navigation keys to scroll to the Last Ping submenu item. 

2 Press the Select soft key.

3 Use the Navigation keys to scroll through the results.

4 Press the Cancel soft key to return to the Ping submenu.

End of Procedure

TraceRoute

The following items are available on the TraceRoute submenu in Remote 
mode:

• IP Addr

• Max Nr of Hops

• TraceRt!

• Last TraceRt

Procedure 88
Entering an IP address

1 Scroll through the TraceRoute submenu to the IP Addr menu item. An IP 
address appears if previously entered. Example 47.249.48.20.

2 Press the Select soft key.

3 Use the Navigation keys to scroll to the destination IP address. 

— If the destination IP address is in the list, press the Select soft 
key to select the IP address. Press the Select soft key again to 
return to the TraceRoute submenu. 

— If the destination IP address is not in the list, continue scrolling 
through the available IP address list until the IP address 0.0.0.0 
appears. Press the Select soft key. 

Tip: To edit the IP address, use the Delete soft key and the Cancel 
soft key. Use the * key for dots. 
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4 Press the Select soft key to save the new IP address, or press the Cancel 
soft key to return to the TraceRoute submenu.

End of Procedure

Procedure 89
Changing the number of Hops

1 From the TraceRoute submenu, use the Navigation keys to scroll to the 
Max Nr of Hops submenu item.

2 Press the Select soft key. 

Tip: Use the keypad and the Delete and Clear soft keys to enter the 
number of Hops.

3 Do one of the following:

• Press the Select soft key to accept the change and return to the 
TraceRoute submenu.

• Press the Cancel soft key to return to the TraceRoute submenu.

End of Procedure

Procedure 90
Tracing a route

1 From the TraceRoute submenu, use the Navigation keys to scroll to the 
TraceRoute! submenu item.

2 Press the Select soft key. Route tracing starts. 

Tip: Press the Stop soft key to stop the trace.

3 Press the OK soft key to return to the TraceRoute submenu.

End of Procedure

Procedure 91
Reviewing the results of the trace

1 From the TraceRoute submenu, use the Navigation keys to scroll to the 
Last TraceRt submenu item. 

2 Press the Select soft key.



Appendix D: IP Phone diagnostic utilities  Page 433 of 508

IP Phones Description, Installation, and Operation

3 Use the Navigation keys to scroll through the results.

4 Press the Cancel soft key to return to the TraceRoute submenu.

End of Procedure

Ethernet Statistics

Use Procedure 92 to access the EtherStats submenu item in Remote mode.

Procedure 92
Browsing Ethernet Statistics

1 Select EtherStats from the Diagnostics submenu. The Ethernet 
statistics appear on the display. 

2 Do one of the following:

• Press the OK soft key to return to the Diagnostics submenu.

• Use the Navigation keys to browse the data. See Figure 70 on 
page 446. 

• Press the Cancel soft key to return to the Diagnostics submenu.

End of Procedure

Procedure 93
Checking 802.1x Supplicant status

1 Select EtherStats from the Diagnostics submenu. 

2 Scroll through the EtherStats menu and select Supplicant Status.

3 Press the Select soft key.

4 Do one of the following:

• Press the OK soft key to return to the EtherStats submenu.

• Use the Navigation keys to browse the data. 

5 Press the Cancel softkey to return to the EtherStats submenu.

End of Procedure
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Procedure 94
Checking 802.1x Supplicant Authentication state

1 Select EtherStats from the Diagnostics submenu. 

2 Scroll through the EtherStats menu and select Authentication State.

3 Press the Select soft key.

4 Do one of the following:

5 Press the OK soft key to return to the EtherStats submenu.

• Use the Navigation keys to browse the data. 

6 Press the Cancel softkey to return to the EtherStats submenu.

End of Procedure

Procedure 95
Checking Device ID

1 Select EtherStats from the Diagnostics submenu. 

1 Scroll through the EtherStats menu and select Device ID.

2 Press the Select soft key.

1 Do one of the following:

• Press the OK soft key to return to the EtherStats submenu.

• Use the Navigation keys to browse the data. 

2 Press the Cancel soft key to return to the EtherStats submenu.

End of Procedure

Procedure 96
Checking Authenticator ID

1 Select EtherStats from the Diagnostics submenu. 

1 Scroll through the EtherStats menu and select Authenticator ID.

2 Press the Select soft key.

3 Do one of the following:
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4 Press the OK soft key to return to the EtherStats submenu.

• Use the Navigation keys to browse the data. 

5 Press the Cancel soft key to return to the EtherStats submenu.

End of Procedure

IP Statistics

Use Procedure 97 to access the IP Stats submenu item in Remote mode.

Procedure 97
Browsing IP Statistics

1 Select IP Stats from the Diagnostics submenu. The IP Statistics appear 
on the display. 

2 Do one of the following:

• Press the OK soft key to return to the Diagnostics submenu.

• Use the Navigation keys to scroll through the data display results. 
See Figure 71 on page 447. 

• Press the Cancel soft key to return to the Diagnostics submenu.

End of Procedure

RUDP Statistics

Use Procedure 98 to access the RUDP Stats submenu item in Remote mode.
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Procedure 98
Browsing RUDP Statistics

1 Select RUDP Stats from the Diagnostics submenu. The RUDP statistics 
appear on the display. 

2 Do one of the following:

• Press the OK soft key to return to the Diagnostics submenu.

• Use the Navigation keys to scroll through the data display results. 
See Figure 72 on page 448. 

• Press the Cancel soft key to return to the Diagnostics submenu.

End of Procedure

QoS Statistics

Use Procedure 99 to access the QoS Stats submenu item in Remote mode.

Procedure 99
Browsing Quality of Service Statistics

1 Select QoS Stats from the Diagnostics submenu. The Quality of Service 
statistics appear on the display.

2 Do one of the following:

• Press the OK soft key to return to the Diagnostics submenu.

• Use the Navigation keys to scroll through the results. See Figure 73 
on page 448.

• Press the Cancel soft key to return to the Diagnostics submenu.

Note: The IP Phone screen display returns to an idle state after 5 minutes 
if the user does not interact with menu items.

End of Procedure

Network Diagnostic Utilities data display pages

Data from the diagnostic utilities is displayed on the IP Phone screen display. 
One line of data at a time is displayed on IP Phone 2001 and IP Phone 2002 
and 3 lines of data are displayed at a time on IP Phone 2004. Each line of data 
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is up to 24 characters long. Use the Navigation keys to scroll through the 
lines of data.

Local Mode data display pages

The following figures illustrate the Network Diagnostic Utilities data display 
pages in Local Mode.

Ping 

Figure 61 illustrates the data displayed from the Ping diagnostic tool.

Figure 61
PING data display page

In Figure 61,

• PacketTx = packets sent

• PacketRx = packets received

TraceRoute

Figure 62 on page 438 illustrates the data displayed from the TraceRoute 
diagnostic tool. Browse through the last 30 items by pressing the Navigation 
keys.

Pinging xxx.xxx.xxx.xxx
Ping Statistics:
Packet Tx: xxxxxxxxxx
Packet Rx: xxxxxxxxxx
Packet Loss - xx %
Round Trip Times (ms)
Min-xxxxx Max=xxxxx
Avg-xxxxx
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Figure 62
TraceRoute data display screen

In Figure 62,

• xxx: = Time To Live (TTL):Round Trip Time1, Round Trip Time2, 
Round Trip Time3

• IP: = IP address

Ethernet Statistics

Figure 63 on page 439 illustrates the data displayed from the Ethernet 
Statistics submenu item.

xxx: xxxxx xxxxx xxxxx
IP: xxx.xxx.xxx.xxx
xxx: xxxxx xxxxx xxxxx
IP: xxx.xxx.xxx.xxx
xxx: xxxxx xxxxx xxxxx
IP: xxx.xxx.xxx.xxx
xxx: xxxxx xxxxx xxxxx
IP: xxx.xxx.xxx.xxx
xxx: xxxxx xxxxx xxxxx
IP: xxx.xxx.xxx.xxx
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Figure 63
Ethernet Statistics data display page

In Figure 63,

• Duplex = duplex mode

• Speed = network speed 10MB/100MB

• Auto Sense/Negotiate = Auto Negotiate Protocol Received or Not 
(Y – Yes, N – No)

Note: In the IP Phone Configuration menu, Auto Negotiate mode is 
the default setting for initial startup. If the telephone is connected to a 
network that supports Auto Negotiate, it selects the best speed and 
duplex mode available. For more information, see “Full Duplex mode” 
on page 61, on page 96, and on page 131.

• VLANPriority = IP Phone VLAN priority

• VLANID = IP Phone VLAN ID

• PCollision = network packet collision peg counts

• CRCErrors = network CRC errors peg counts

• FrameErrors = network Framing errors peg counts

1.Link: UP/Down
2.Duplex:Full/Half
3.Speed: xxx (MB)
4.Auto Sense/Negotiate
Auto-Nego Capability:Y/N
Auto-Nego Completed:Y/N
5.VLANPriority:xxx
6.VLANID:xxxx
7.PktColl:xxxxxxxxxx
8.CRCErrors:xxxxxxxxxx
9.FrameErrors:xxxxxxxxxx
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IP Networking Statistics

Figure 64 illustrates the data displayed from the IP Networking Statistics 
submenu item.

Figure 64
IP Networking Statistics data display screen

In Figure 64,

• PacketTx = IP Phone packets sent

• PacketRx = IP Phone packets received

• BcastPktRx = broadcast packets received

• McastPktRx = multicast packets received

• InPktDisc = incoming packets discarded

• OutPktDisc = outgoing packets discarded

• UnknownPkts = unknown protocol packets discarded

• ICMPType-Code = the last ICMP message: XXX-XXX

DHCP Statistics

Figure 65 on page 441 illustrates the data displayed from the DHCP 
Statistics submenu item.

1. Packet Tx: xxxxxxxxxx
2. PacketRx: xxxxxxxxxx
3. BcastPktRx: xxxxxxxxxx
4. McastPktRx: xxxxxxxxxx
5. InPktDisc: xxxxxxxxxx
6. OutPktDisc: xxxxxxxxxx
7. UnknownPkts: xxxxxxxxxx
8. ICMPType—Code: xxx—xxx
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Figure 65
DHCP information data display page

1.Configuration:
NetworkDataValided:Yes/No
MACAddressStored:Yes/No
PerformDHCP:Full/Partial
VLANEnable:Yes/No
VLANConfig:Manual/Auto
VLANIDsDiscovered:Yes/No
PrimaryServer:S1/S2
2.FWVersion:xxxxxxx
3.HWIDxxxxxxxxxxxxxxxxxx
4.SetIP:xxx.xxx.xxx.xxx
5.SbMask:xxx.xxx.xxx.xxx
6.GtWay:xxx.xxx.xxx.xxx
7.PROMS1:xxx.xxx.xxx.xxx

Port:xxxx Act:xxx
Retries:xxx

8.PROMS2:xxx.xxx.xxx.xxx
Port:xxxx Act:xxx
Retries:xxx

9.VLANPriority:xxx
10.VLANID:xxxx
11.DHCPRespondString:
xxxxxxxxxxxxxxxxxxxxxxxx
xxxxx......
12.Servers’Information:

SN:xxx.xxx.xxx.xxx
Port:xxxx Act:xxx

Retries:xxx FailOver:xxx



Page 442 of 508 Appendix D: IP Phone diagnostic utilities

553-3001-368 Standard 12.00 March 2006

In Figure 65,

• NetworkDataValided = is EEPROM Network Data valided?

• MACAddressStored = is MAC Address stored in EEPROM?

• FWVersion = IP Phone firmware version

• HWID = IP Phone hardware ID

• SbMask = subnet mask

• GtWay = Gateway

• PROMS1 = EEPROM Server1 information

• PROMS2 = EEPROM Server2 information

• Sn = S: Server n is from 1 to 16

UNIStim/RUDP statistics

Figure 66 illustrates the data displayed from the UNIStim/RUDP statistics 
submenu item.

Figure 66
UNIStim/RUDP statistics data display screen (TPS)

In Figure 66,

• MessageTx = messages sent

• MessageRx = messages received

• Retries = number of retries

• UpTime = up-time of current TPS registration 
(days/hours/minutes/seconds)

1.MessageTx:xxxxxxxxxxxx
2.MessageRX:xxxxxxxxxxxx
3.Retries:xxxxxxxxxxxx
4.UpTime:xxx/xx/xx/xx
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RTP/RTCP statistics

Figure 67 illustrates the data displayed from the RTP/RTCP statistics 
submenu item.

Figure 67
RTP/RTCP statistics data display page 

In Figure 67,

• EndIP = endpoint IP address

• PortID = port ID

• PacketTx = RTP packets sent

• PacketRx = RTP packets received

• DPacketRx = BTR Disorder packets received

• PacketLossRx = packet loss received xxx%

• JittAveRx = jitter average received xxxxxx

• JittMaxRx = jitter maximum received xxxxxx

• RdTripDelay = round trip delay

Note: Each new call resets the counters.

1.EndIP:xxx.xxx.xxx.xxx
2.PortID:xxxx
3.PacketTX:xxxxxxxxxx
4.PacketRx:xxxxxxxxxx
5.DiscPktRx:xxxxxxxxxx
6.PacketLossRx:xxx%
7.JittAveRx:xxxxxxxxxx
8.JittMaxRx:xxxxxxxxxx
9.RdTripDelay:xxxxx ms
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Remote Mode data display pages

The following figures illustrate the Network Diagnostic Utilities data 
display pages in Remote Mode.

PING

Figure 68 illustrates the data displayed from the Ping Diagnostic Tool.

Figure 68
Ping data display page

In Figure 68,

• Packet TX = packets sent

• Packet Rx = packets received

• RTT - Round Trip Time (for Min RTT, Avg RTT, and Max RTT)

Rx 64 bytes time xx ms
Rx 64 bytes time xx ms
Rx 64 bytes time xx ms
For xxx.xxx.xxx.xxx
PacketTx:xxx
Packet Loss = xx%
Min RTT: xxx ms
Avg RTT: xxx ms
Max RTT: xxx ms
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TraceRoute

Figure 69 illustrates the data displayed from the Tracert Diagnostic tool.

Figure 69
Tracert data display screen

In Figure 69,

• Hopxxx = the Hop number

• xxx = Round Trip Time1, Round Trip Time2, Round Trip Time3

• IP: = IP address

Hopxxx: RTT = xxx xxx xxx
IP: xxx.xxx.xxx.xxx
Hopxxx: RTT = xxx xxx xxx
IP: xx.xxx.xxx.xxx
Hopxxx: RTT = xxx xxx xxx
IP: xxx.xxx.xxx.xxx
Hopxxx: RTT = xxx xxx xxx
IP: xxx.xxx.xxx.xxx
Hopxxx: RTT = xxx xxx xxx

IP
IP: xxx.xxx.xxx.xxx
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Ethernet Statistics

Figure 70 illustrates the data displayed from the EtherStats submenu item.

Figure 70
Ethernet statistics data display screen

In Figure 70,

• Duplex - duplex mode

• Speed - network speed 10MB/100MB

• Auto Sense/Negotiate = Auto Negotiate Protocol Received or Not (Y - 
Yes, N - No)

• VLANPriority = IP Phone VLAN priority

• VLANID = IP Phone VLAN ID

• PCollision = network packet collision peg counts

• CRCErrors = network CRC errors peg counts

• FrameErrors = network Framing errors peg counts

Note: In the IP Phone Configuration menu, Auto Negotiate mode is 
the default setting for initial startup. If the telephone is connected to a 
network that supports Auto Negotiate, it selects the best speed and 
duplex mode available. For more information, see “Full Duplex mode” 
on page 61, on page 96, and on page 131. 

1.Link: UP/Down
2.Duplex:Full/Half
3.Speed: xxx (MB)
4.Auto Sense/Negotiate
Auto-Nego Capability: Y/N
Auto-Nego Completed: Y/N
5.VLANPriority:xxx
6.VLANID:xxxx
7.PktColl:xxxxxxxxxx
8.CRCErrors:xxxxxxxxxx
9.FrameErrors:xxxxxxxxxx
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IP Networking Statistics

Figure 71 illustrates the data displayed from the IP Stats submenu item.

Figure 71
IP Networking statistics data display screen

In Figure 71,

• PacketTx = IP Phone packets sent

• PacketRX = IP Phone packets received

• BcastPktRx = broadcast packets received

• McastPkeRx = multicast packets received

• InPktDisc = incoming packets discarded

• OutPktDisc = outgoing packets discarded

• UnknownPkts = unknown protocol packets discarded

• ICMPTypeCode = the last ICMP message: xxx-xxx

1. Packet TX: xxxxxxxxxx
2. Packet Rx: xxxxxxxxxx
3. BcastPktRx: xxxxxxxxxx
4. McastPktRx: xxxxxxxxxx
5. InPktDisc: xxxxxxxxxx
6. OutPktDisc: xxxxxxxxxx
7. UnknownPkts: xxxxxxxxxx
8. ICMPTypeCode: xxx-xxx
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RUDP statistics data display screen (TPS)

Figure 72 illustrates the data displayed from the RUDP Stats submenu item.

Figure 72
RUDP statistics data display page

In Figure 72, 

• MessageTx = messages sent

• MessageRx = messages received

• Retries = number of retries

• UpTime = up-time of current TPS registration (days/hours/minutes/
seconds)

Quality of Service statistics

Figure 73 illustrates the data displayed from the QoS Stats menu item.

Figure 73
QoS statistics data display page

1.MessageTx:xxxxxxxxxxxx
2.MessageRx:xxxxxxxxxxxx
3.Retries:xxxxxxxxxxxx
4.UpTime:xxx/xx/xx/xx

FarEndIP:xxx.xxx.xxx.xxx
PortEndPortID:xxxx
LocPktLossRx:xxxxxxxxxxx
LocJittAvgRx:xxx
LocLatAvg:xxx
LocPktTx:xxx
LocPktRx:xxx
LocOutOrdRx:xxx
LocListR:xxx
RmtPktLossRx:xxx
RmtJittAvgRx:xxx
RmtLatAvg>xxx
RmtListR:xxx
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In Figure 73,

• EndIP = endpoint IP address

• PortID = port ID

• PacketTx = RTP packets sent

• Packet Rx = RTP packets received

• DPacketRx = BTR Disorder packets received

• PacketLossRx = packet loss received xxx%

• JittAveRx = jitter average received xxxxxx

• JittMaxRx = jitter maximum received xxxxxx

• RdTripDelay = round trip delay

Note: Each new call resets the counters.

Network Address Translation Traversal

This section describes the Network Address Translation (NAT) Traversal 
feature as it effects IP Phones. NAT Traversal is required to permit IP Phones 
working behind a NAT box to connect and maintain signaling and media 
paths. 

NAT Traversal is applicable to all UNIStim IP Phone clients and is 
one-ended. That is, it does not require the other end of a call to support any 
special protocol, and it is interoperable with any other media termination. 

In this document NAT refers to both IP port address mapping and IP address 
mapping (also known as NAPT). A NAT can be used with or without a 
Virtual Private Network (VPN).

The NAT Traversal feature supports only IP clients behind cone NAT types. 
There are three types of cone NAT—the full cone, restricted cone, and the 
port restricted cone. NAT traversal is not compatible with symmetric NATs. 
If the IP Phone is behind a Symmetric NAT, the LTPS unregisters the phone 
from the call server (while remaining registered on the LTPS), and displays 
the following message on the IP Phone display: “Error! Symmetric NAT”.
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For detailed information about the NAT Traversal feature, refer to IP Line: 
Description, Installation, and Operation  (553-3001-365).

Network Address Translation information accessible from the IP Phones 
includes:

— Public Set IP 

– SIG

— Public Set IP 

– RTP

— Private Set IP 

– SIG

— Private Set IP 

– RTP

— type of NAT

Procedure 100
Accessing NAT information

1 Press the Services key.

2 Press the Navigation keys to scroll and highlight Telephone Options.

3 Press the Select soft key.

4 Press the Navigation keys to scroll and highlight Set Info.

5 Press the Select soft key.

6 Press the Navigation keys to scroll and highlight Set IP Info.

7 Press the Select soft key
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8 Press the Navigation keys to scroll through the NAT information.

Using CLI Commands

IDU commands

The system-based IDU command in LD 32 can be used to test the end-to-end 
IP connectivity of the IP Phone from the call server console instead of using 
set-based diagnostics.

The IDU command provides the following information:

• TN

• TN ID

• MAC address

• IP address

• LTPS IP address

• Manufacturer code

• Model

• NT code

• Color code

• Release code

• Serial number

• Firmware/Software version

IMPORTANT!

Nortel recommends partial DHCP configuration for IP Phones residing 
behind a NAT router unless the NAT router supports special 
configuration of the DHCP server. For more information, refer to IP Line: 
Description, Installation, and Operation  (553-3001-365).
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Note: For an IP Phone behind a NAT, the IP address is composed of the 
public address followed by the private address in parentheses (see 
Table 46 on page 453). For an IP Phone without a NAT, the IP address 
is the signaling IP address of the IP Phone as seen by the LTPS (see 
Table 47 on page 453).

For detailed information, see Software Input/Output: Maintenance 
(553-3001-511).

Table 46 and Table 47 on page 453 provide the output format of the IDU 
commands in LD 32.
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Table 46 provides the output format of the IDU commands in LD 32 for an 
IP Phone with a NAT.

Table 47 provides the output format of the IDU commands in LD 32 for an 
IP Phone without a NAT. 

Table 46
IDU command printout in LD 32 for IP Phone with a NAT

Item Description

ISET TN: l s c u

TN ID CODE: i2001, i2002, i2004, or i2050

ISET MAC ADR xx.xx.xx.xx.xx.xx

ISET IP ADR xx.x.x.xxx:xxxx(xxx.xxx.x.xx)

LTPS IP ADR xx.xx.xxx.xx

MANUFACTURER CODE [NAME]

MODEL

NT CODE: xxxxxxxx

COLOR CODE: xx

RLS CODE: x

SER NUM: xxxxxx

FW/SW VERSION xxxxxxx

Table 47
IDU command printout in LD 32 for IP Phone without a NAT (Part 1 of 2)

Item Description

ISET TN: l s c u

TN ID CODE: i2001, i2002, i2004, or i2050

ISET MAC ADR xx.xx.xx.xx.xx.xx
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• If the IDU command cannot retrieve the information shown in Table 46 
or Table 47, it responds with one of the following:

• prints the IP Phone IP address and the Voice Gateway Media Card 
address, and generates an NPR0503 message

• the IP Phone is not registered with the Call Server and generates an 
NPR0048 message

• the IP Phone is registered, but the Call Server is not responding, and 
generates an NPR0503 message.

Configure IP Phone 2007 Local Options
The IP Phone 2007 has both local and server-based options. The local options 
cover the following entries in the Tools menu:

• Network Configuration

• Local Diagnostics

• Touch Panel Setup

• Contrast and Brightness

ISET IP ADR xx.x.x.xxx:xxxx

LTPS IP ADR xx.xx.xxx.xx

MANUFACTURER CODE [NAME]

MODEL

NT CODE: xxxxxxxx

COLOR CODE: xx

RLS CODE: x

SER NUM: xxxxxx

FW/SW VERSION xxxxxxx

Table 47
IDU command printout in LD 32 for IP Phone without a NAT (Part 2 of 2)

Item Description
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• USB devices

• TFTP Upgrade

• Preferences

Note: Entering Text in the Tools menu items is easier with a USB 
keyboard.

Network Configuration

The Network Configuration displays the information that was configured 
when the IP Phone 2007 was installed.

Procedure 101
Displaying Network Configuration information

1 Tap the Tools icon.

2 Enter the Tools menu password (if password protection is enabled). For 
information about password protection, refer to “Password Protection” on 
page 149.

3 Tap the Network Configuration menu entry.

The screen displays Apply & Reset and Exit soft keys, and the 
parameters used when configuring the IP Phone 2007:

• DHCP status

– To change the setting, choose an entry in the drop-down list.

• Telephone Set IP address

• Network Mask (NET MASK)

• Gateway IP address

• Server 1 IP address, Port, Action, Retry, and PK numbers

• Server 2 IP address, Port, Action, Retry, and PK numbers

• XAS (S4) IP address, Port, Action, Retry

• Voice VLAN

– To change the setting, choose an entry in the drop-down list.

• VLAN Filter
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– To change the setting, choose an entry in the drop-down list.

• DATA VLAN

– To change the setting, choose an entry in the drop-down list.

• Duplex setting

– To change the setting, choose an entry in the drop-down list.

• EAP

– To change the setting, choose an entry in the drop-down list.

4 Tap the arrow keys on the scroll bar to view all the data.

5 Tap the Apply & Reset soft key to save the changes.

6 Tap the Exit key to return to the main display.

See Table 15 on page 152 for further information.

End of Procedure

Local Diagnostics

The Local Diagnostics menu contains the following menu items:

• Network Diagnostic Tools

• Ethernet Statistics

• IP Network Statistics 

• IP Set&DHCP Information

You can press the Return soft key in any submenu item screen to return to the 
Local Diagnostics submenu. Therefore, you can gather information and run 
tests without exiting and reentering the Local Diagnostics menu. 

Procedure 102
Using Network Diagnostic Tools

1 Tap the Tools icon.

2 Tap the Local Diagnostics menu entry.

3 Tap the Network Diagnostic Tools soft key.
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The screen displays Ping, Tracert, and EXIT soft keys, presents a 
pull-down list for IP addresses, and displays the Ping and Hop 
parameters.

4 Scroll down through the IP addresses and tap an address.

5 The number of repetitions of the Ping command are shown in the top bar 
of the screen. The default is 4.

To change the number of repetitions, tap on the number and enter a new 
value using the USB keyboard.

6 The number of hops for the Tracert command are shown in the top bar of 
the screen. The default is 30.

To change the number of hops, tap on the number and enter a new value 
using the USB keyboard.

7 Tap the Ping soft key to have the telephone attempt to access the IP 
address up to the number of times shown on the top of the screen.

The IP Phone displays the following:

Pinging x.x.x.x with 64 bytes
(where x.x.x.x is the IP address chosen in step 4 on page 457)

The Exit soft key changes to Stop and the other soft keys become blank.

The IP Phone will attempt to contact (ping) the address the number of 
configured times, displaying the results of each attempt.

8 To stop the ping before completing, tap the Stop soft key.

The Stop key becomes the Exit soft key. The results of ping are displayed 
as follows:

• Packets transmitted (Tx)

• Packets received (Rx)

• Packets lost (Lost)

• Minimum round trip time (Min)

• Maximum round trip time (Max)

• Average round trip time (Avg)

9 Tap the Tracert soft key to request the IP Phone to trace the route to the 
entered IP address, up to MaxHop nodes.

The IP Phone displays the following:
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Tracing route to: (x.x.x.x) over a maximum of y hops
(where x.x.x.x is the IP address chosen in step 4 on page 457 and y 
is the number of hops displayed at the top of the screen)

The Exit soft key changes to Stop and the other soft keys become blank.

The IP Phone will trace the route to the address for the configured number 
of server hopes, displaying the hop number (starting at 0), the time in 
milliseconds, and the IP address.

When the trace is complete, the screen displays the following:

Trace complete.

10 To stop Tracert before it completes, tap the Stop soft key.

The Stop soft key becomes the Exit soft key when Tracert stops.

11 Tap the Exit soft key to return to the Local Diagnostics menu.

End of Procedure

Procedure 103
Using Ethernet Statistics tool

1 Tap the Tools icon.

2 Tap the Local Diagnostics menu entry.

3 Tap the Ethernet Statistics soft key.

The tool displays Reset, NIPort, and EXIT soft keys, and the statistics for the 
Network Interface Port (NIPort).
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The following statistics are displayed:

• Link Status

• Duplex Mode

• Network Speed

• AutoSense/Negotiate Capability

• AutoSense/Negotiate Completed

• Port VLAN Priority

• Port VLAN ID

• Packet Collision

• CRC Error count

• Frame Error count

4 To reset the NIPort counters to 0, tap the Reset soft key.

5 Tap the NIPort soft key.

The NIPort soft key changes to the PCPort soft key and the tool displays 
the statistics for the Personal Computer port (PCPort). The following 
statistics are displayed:

• Link Status

• Duplex Mode

• Network Speed

• AutoSense/Negotiate Capability

• AutoSense/Negotiate Completed

• Port VLAN Priority

• Port VLAN ID

• Packet Collision

• CRC Error count

• Frame Error count

6 To reset the PCPort statistics to 0, tap the Reset soft key.

End of Procedure
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Procedure 104
Using the IP Network Statistics tool

1 Tap the Tools icon.

2 Tap the Local Diagnostics soft key.

3 Tap the IP Network Statistics soft key. 

The tool displays the Reset, NIPort, and Exit soft keys, and the statistics 
for the Network Interface Port (NIPort). 

The following statistics are displayed:

• Packets sent

• Packets received

• Broadcast Packets received (Rx)

• Multicast Packets received (Rx)

• Incoming Packets discarded 

• Outgoing Packets discarded

• Unknown protocols (Unknown protos

• Last Internet Control Message Protocol (ICMP) message type and 
code (ICMP Type/Code)

4 To reset the NIPort counters to 0, tap the Reset soft key.

5 Tap the NIPort soft key.

The NIPort soft key becomes the PCPort soft key, and the statistics for 
the Personal Computer Port (PCPort) are displayed.



Appendix D: IP Phone diagnostic utilities  Page 461 of 508

IP Phones Description, Installation, and Operation

The following statistics are displayed:

• Packets sent

• Packets received

• Broadcast Packets received (Rx)

• Multicast Packets received (Rx)

• Incoming Packets discarded 

• Outgoing Packets discarded

• Unknown protocols (Unknown protos

• Last Internet Control Message Protocol (ICMP) message type and 
code (ICMP Type/Code)

6 To reset the PCPort counters to 0, tap the Reset soft key.

7 Tap the Exit soft key to return to the Local Diagnostics menu.

End of Procedure

Procedure 105
Using the IPSet&DHCP Information tool

1 Tap the Tools icon.

2 Tap the Local Diagnostics soft key.

3 Tap the IPSet&DHCP Information soft key.

The tool displays the Exit soft key at the bottom of the display and the 
following information:

• Configuration

— Network data validated, MAC address stored, DHCP setting
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— Voice VLAN status, type of configuration and discovery status

— Primary Server identification

• Firmware version and Hardware Identification number

• Telephone Set IP address

• Network subnet mask

• Gateway IP address

• EPROM Server S1 and S2 IP addresses, ports, actions, and number 
of retries

• Voice VLAN priority and VLAN ID

• DHCP Respond String

• Server Information for S01, S02, S03, and S04, including IP 
addresses, ports, actions, number of retries, and failover values

4 Use the scroll bar to display all the information.

5 Tap the Exit soft key to return to the Local Diagnostics menu.

End of Procedure
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Configure IP Phone 1120E and 
IP Phone 1140E Local Tools options

To make a menu selection, you can press the number associated with the 
menu item (for example, press 21 to show the IP Set&DHCP Information 
menu) or you can use the navigation keys to scroll through the list of menu 
items.

Figure 74 shows the options in the Local Tools menu.

Figure 74
Local Tools menu options

 1. Preferences

1. Display Settings

2. Languages…

3. Bluetooth Setup (IP Phone 1140E only)

2. Local Diagnostics

1. IP Set&DHCP Information

2. Network Diagnostic Tools

3. Ethernet Statistics

4. IP Network Statistics

5. USB Devices

3. Network Configuration

4. Lock Menu 

1. Manual Secure Local Menu

2. Manual Partial Secure Menu

3. Manual Disable Secure Menu

4. DHCP Secure Menu

5. Lock Now
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Note: Bluetooth wireless technology (IP Phone 1140E only) is optional 
and is dimmed if it is not enabled. 

1. Preferences

The Preferences submenu offers the following choices:

• 1. Display Settings

• 2. Languages…

• 3. Bluetooth Setup (IP Phone 1140E only)

1. Display Settings

The Display Settings menu provides access to the Contrast and Screen Saver 
tools. Contrast adjusts the viewing angle of the display. Screen Saver controls 
how long the display remains lit if the phone is inactive.

Note: Nortel recommends you use the Telephone Options menu to 
adjust the contrast.

2. Languages…

This item is used to select the language in the local menus of the IP Phone. 

3. Bluetooth Setup

You can access the Bluetooth Setup options using either of the following two 
methods:

• Double press the Headset key to open the 3. Bluetooth Setup dialog box. 

• Double press the Services key to open the Local Tools menu, press 1 on 
the dialpad to select 1. Preferences and press 3 on the dialpad to open 
the 3. Bluetooth Setup dialog box.

The 3. Bluetooth Setup item is not available on all phones. If the 3. Bluetooth 
Setup menu item appears dimmed, or fails to open when you double press the 
Headset key, Bluetooth wireless technology is not enabled on your phone. To 
configure the administration setting for Bluetooth wireless technology, see 
“Bluetooth wireless technology manual configuration” on page 484. 
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Use Procedure 106 to pair the Bluetooth wireless technology headset with 
your IP Phone 1140E. 

Procedure 106
Pairing the Bluetooth wireless technology headset 
with your IP Phone 1140E 

1 Restart your IP Phone 1140E using one of the following methods:

• If you are using an AC power adapter, unplug it, wait ten seconds, 
and reinsert it.

• If you are using POE, unplug the LAN Ethernet cable, wait ten 
seconds, and reinsert it.

2 Double-press the Headset key to open the 3. Bluetooth Setup dialog box.

The Enable Bluetooth check box is highlighted.

Note: If the 3. Bluetooth Setup menu fails to open when you double press 
the Headset key, Bluetooth wireless technology is not enabled on your 
phone.

3 Press the Enter key to activate Bluetooth wireless technology.

A check mark is displayed to indicate that Bluetooth wireless technology 
is activated. The message BT Enabled appears at the bottom of the 
display.

4 Put your wireless headset in its pairing or search mode. The procedure 
for doing this can be different for each wireless headset. Refer to the 
documentation that accompanied your headset. 

For example, if you are using the GN Netcom GN 6210, do the following:

a. Turn the headset off by pressing and holding the headset telephone 
button for 3 to 4 seconds until a high to low tone is heard through the 
headset. The headset blue LED turns off.

b. Press and hold the headset telephone button for about 8 seconds 
until the blue LED flashes and then lights steadily.

5 Search for the headset.

a. Press the Right navigation key twice to highlight the Search button, 
displayed next to the Search Devices item.

b. Press the Enter key. 
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The message Searching… is displayed. 

c. If the search is successful, a list of Bluetooth wireless technology 
headsets appears in the Found: combo box.

d. Choose one of the following:

— If the search is successful, proceed to step 6.

— If the search is not successful, the message Search completed. 
No device found is displayed. Power off the wireless technology, 
and repeat step 4 and step 5.

6 Wait for the search to finish or press the Stop soft key to end the search.

7 Choose one of the following:

• If your headset is displayed as the first item in the Found combo box, 
proceed to step 8. 

• If your headset is not displayed as the first item in the Found combo 
box, select your headset from the list, as follows:

a. Press the Right navigation key one or more times to highlight the 
Found: combo box. Press the Enter key to start the edit mode.

b. Press the Down navigation key to open the list. Press the Up/Down 
navigation keys to scroll and highlight your headset. 

c. Press the Enter key to select the headset and close the list. Press 
the Enter key to exit edit mode.

8 Press the Right navigation key one or more times to highlight the Pair 
button (next to the Pair Device item) and press the Enter key. 

a. A dialog box appears, with the prompt Enter PIN#. 

b. Use the telephone dialpad to enter the Bluetooth wireless technology 
headset PIN and press the Enter key.

Check your headset's documentation to find its PIN (sometimes called a 
passkey). Typically this value is 0000.

9 Choose one of the following:

• If the headset is successfully paired with your phone, proceed to 
step 10. To verify that the pairing was successful, ensure that the 
headset appears in the list next to the Paired: item. If pairing is 
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successful, the message Pair completed also appears at the bottom 
of the screen. 

• If the headset is not successfully paired with your phone, an error 
message appears at the bottom of the screen. If an error message 
appears:

— Confirm that the wireless headset is still in search/pair mode. 
For example, on the GN Netcom GN 6210 headset the blue LED 
should still be lighted when the pairing operation starts. 

— If the headset timed out and exited search/pairing mode, put the 
headset in pairing mode, as discussed in step 4, and repeat 
step 8.

— Check that you are using the correct PIN and repeat step 8.

10 Choose one of the following:

• If your headset is displayed as the first item in the Paired combo box, 
proceed to step 11. 

• If more than one device is paired, you may need to navigate to the 
one you want, as follows:

— Press the Right navigation key one or more times to highlight 
the item in the Paired combo box. Press the Enter key to start 
the edit mode.

— Press the Up/Down navigation keys to open the list. Press the 
Up/Down navigations key to scroll in the list and highlight your 
headset. 

— Press the Enter key to select the headset and close the list. 
Press the Enter key to exit edit mode.

11 Choose one of the following:

• If only one headset is paired, proceed to step 12.

• If more than one wireless headset is paired, the first headset paired 
is automatically made the active device. 

To make a different headset active, press the Right navigation key 
one or more times to highlight the Set button (next to the Set Active 
Device item). Press the Enter key. 
The message Set active: <device name> appears. This means the 
headset named is now the active wireless headset and is used when 
you press the headset key.
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12 Press the Exit soft key to exit to the main display. Changes are saved 
automatically. 

Note 1: Paired headset information is saved and restored when a reboot 
of the IP Phone 1140E occurs; therefore, the active wireless headset will 
remain paired and active. 

Note 2: It is not recommended to pair more than one headset of the 
same model because they will have identical names in the Paired list. 

End of Procedure

Dual Pairing Headsets

Take special care when using a dual pairing type of Bluetooth wireless 
technology headset, for example the GN Netcom GN6210. This headset can 
be paired to its base as well as to the IP Phone 1140E.

If the headset is paired to both, the IP Phone 1140E is the second device. 
When you press the headset telephone key and you hear a single tone, the 
headset is active for a call from the desktop telephone base. 

To use the headset with the IP Phone 1140E, press and hold the headset’s 
telephone key for 1 second. You will hear a double beep. The headset is active 
with the IP Phone 1140E.

If the desktop telephone base is powered off, then the headset is only paired 
to the IP Phone 1140E. Press the headset’s telephone key to connect to the 
IP Phone 1140E.

Note: Unless there is a need to dual pair the GN6210 headset, the 
headset’s operation with the IP Phone 1140E is simpler if it is only used 
with its charging-only base. The desktop telephone base should be 
powered off when not in use.
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Using a wired headset

If you connect a wireless headset and a wired handset to the same 
IP Phone 1104E, the wireless headset interacts with the wired headset as 
follows: 

• If no wireless headset is paired, the wired headset works as normal. 
Likewise, if a wireless headset is paired with a set but is not in range, the 
wired headset works as normal.

• When the Use BT Headset check box is selected, the Bluetooth wireless 
technology headset is used as the phone’s headset.

The Bluetooth wireless technology headset can work only within range of the 
IP Phone 1140E; as a wireless headset approaches the edge of its radio range, 
the audio quality degrades and radio interference noise increases. When the 
wireless headset is in connecting range, the Headset key controls the headset, 
even if a wired headset is attached. 

If a Bluetooth wireless technology headset moves out of connecting range, a 
special beep sounds in the headset indicating the connection was lost. For 
example, on the GN6210, a series of tones from high to low sounds when the 
connection is lost and when a call ends. 

When you do not want to use Bluetooth wireless technology

If a Bluetooth wireless technology headset is connected, and you want to use 
the wired headset, you can switch between the wireless headset and the wired 
headset. It is not necessary to unpair or disable Bluetooth wireless 
technology.

Use Procedure 107 to switch between a wired headset and a wireless headset.

Procedure 107
Switching between a wired headset 
and wireless headset

1 Double-press the Headset key to open the 3. Bluetooth Setup dialog 
box.

2 Press the Left/Right navigation key to select the Use BT headset item. 

A check mark indicates that the wireless headset is used. This option is 
on (o) by default.
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3 To switch between a wired headset and a wireless headset, do one of the 
following: 

• Press the Enter key to clear the check box and to use the wired 
headset.

• Press the Enter key to select the check box and to use the wireless 
headset.

4 Press the Exit soft key to exit to the main display.

End of Procedure

Use Procedure 108 to unpair the Bluetooth wireless technology headset.

Procedure 108
Unpairing a wireless headset

1 Double-press the Headset key to open the 3. Bluetooth Setup dialog 
box.

2 Press the Right navigation key to select the Paired: item.

3 Choose one of the following:

• If your headset is displayed in the Paired combo box, proceed to 
step 4.

• If more than one device is paired, and your headset is not already 
displayed in the Paired combo box, do the following:

— Press the Right navigation key one or more times to highlight 
the Paired: combo box. Press the Enter key to open edit mode.

— Press the Up/Down navigation keys to open the list. Press the 
Up/Down navigations key to scroll in the list and highlight your 
headset. 

— Press the Enter key to select the headset and close the box. 
Press the Enter key to exit edit mode.

4 Press the Right navigation key one or more times to highlight the UnPair 
button (next to the UnPair Device item).

5 Press the Enter key. 

Your Bluetooth wireless technology headset is unpaired and removed 
from the Paired: item list.



Appendix D: IP Phone diagnostic utilities  Page 471 of 508

IP Phones Description, Installation, and Operation

6 Press the Exit soft key to exit to the main display.

Note: Your Bluetooth wireless technology headset is no longer paired 
with your phone, and the wired headset can be used. To use the 
Bluetooth wireless technology headset again, you must perform the 
pairing and activation procedure.

End of Procedure

2. Local Diagnostics

Figure 75
Local Diagnostics menu

The Local Diagnostics submenu offers the following choices:

• 1. IP Set&DHCP Information

• 2. Network Diagnostic Tools

• 3. Ethernet Statistics

• 4. IP Network Statistics

• 5. USB Devices

Trans ForwardConf More...

4001

4. IP Network Statistics

3. Ethernet Statistics

2. Network Diagnostic Tools

5. USB Devices

1. IP Set&DHCP Information
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1. IP Set&DHCP Information

Use Procedure 109 to use the IP Set&DHCP Information tool.

Procedure 109
Using the IP Set&DHCP Information tool

1 Press the Services key twice.

2 Press 2 1 on the dialpad to access the IP Set&DHCP Information menu 
or use the Up/Down navigation keys to scroll and highlight the IP Set & 
DHCP Information option.

3 Press the Select soft key.

You can press the Return soft key to exit the menu and return to Local 
Diagnostics submenu. 

The tool displays the following information:

• Configuration

— Network data validated, MAC address stored, DHCP setting

— Voice VLAN status, type of configuration and discovery status

— Primary Server identification, PC Port enabled status

• Firmware version and Hardware Identification number

• Telephone Set IP address

• Network subnet mask

• Gateway IP address

• EPROM Server S1 and S2 IP addresses, ports, actions, and number 
of retries

• Voice VLAN priority and VLAN ID

• DHCP Response String

• Server information for S01, S02, S03, and S04, including IP 
addresses, ports, actions, number of retries, and failover values

• TFTP Server IP address

Figure 76 on page 473 shows IP Set & DHCP Information screen.
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Figure 76
IP Set & DHCP Information screen

4 Use the scroll bar to display all the information.

5 Press the Return soft key to return to the Local Tools menu or the Stop 
key to exit the menu and return to the telephone display.

End of Procedure

2. Network Diagnostic Tools

The Network Diagnostic Tools menu contains the following menu items:

• IP/MaxPing/MaxHop

• Ping

• Tracert

• Exit

Use Procedure 110 on page 474 to use Network Diagnostic Tools.

Return

1. Configuration:
Network Data Validated:       Yes
MAC Address Stored: Yes
Perform DHCP:       Partial
Voice VLAN Enable: No
Voice VLAN Config: Manual
Voice VLAN Discovered: No
Primary Server: S1
PC Port is ON
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Procedure 110
Using Network Diagnostic Tools

1 Press the Services key twice.

2 Press 2 2 on the dialpad to access the Network Diagnostic Tools menu 
or use the Up/Down navigation keys to scroll and highlight the IP Set & 
DHCP Information option.

3 Press the Select soft key.

You can press the Return soft key exit the menu to return to the Local 
Diagnostics submenu.

The screen displays IP/MaxPing/MaxHop, Ping, Tracert, and Return 
soft keys. 

Figure 77 on page 474 shows the Network Diagnostic Tools screen.

Figure 77
Network Diagnostic Tools screen

4 Enter an IP address or use the Up/Down navigation keys to scroll down 
through the IP addresses.

ReturnTracertPing

IP  192.167.101.  3    Ping 4 Hop 30
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5 The number of repetitions of the Ping command is shown in the top bar 
of the screen. The default is 4.

To change the number of repetitions, use the arrow keys to select the 
number and enter a new value using the keypad.

6 The number of hops for the Tracert command is shown in the top bar of 
the screen. The default is 30.

To change the number of hops, use the arrow keys to select the number 
and enter a new value using the keypad.

7 Press the Ping soft key to have the telephone attempt to access the IP 
address, up to the number of times shown on the top of the screen.

The IP Phone displays the following:

Pinging x.x.x.x with 64 bytes
(where x.x.x.x is the IP address chosen in step 4 on page 457)

The Return soft key changes to Stop and the other soft keys become 
blank.

The IP Phone attempts to contact (ping) the address the number of 
configured times, and displays the results of each attempt.

8 To stop the ping before completing, tap the Stop soft key.

The Stop soft key becomes the Return soft key. The results of ping are 
displayed as follows:

• Packets transmitted (Tx)

• Packets received (Rx)

• Percentage of Packets Lost (Lost)

• Minimum round trip time (Min)

• Maximum round trip time (Max)

• Average round trip time (Avg)

9 Press the Tracert soft key to request the IP Phone to trace the route to 
the entered IP address, up to MaxHop nodes.

The IP Phone displays the following:

Tracing route to: (x.x.x.x) over a maximum of y hops
(where x.x.x.x is the IP address chosen in step 4 on page 457 and y 
is the number of hops displayed at the top of the screen)
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The Return soft key changes to Stop and the other soft keys become 
blank.

The IP Phone traces the route to the address for the configured number 
of server hops, displaying the hop number (starting at 0), the time in 
milliseconds, and the IP address.

When the trace is complete, the screen displays the following:

Trace complete.

10 To stop Tracert before it completes, tap the Stop soft key.

The Stop soft key becomes the Return soft key when Tracert stops.

11 Tap the Return soft key to return to Local Tools menu or the Stop key 
to exit the menu and return to the telephone display.

End of Procedure

3. Ethernet Statistics

Use Procedure 111 on page 476 to use the Ethernet Statistics menu.

Procedure 111
Using Ethernet Statistics tool

1 Press the Services key twice.

2 Press 2 3 on the dialpad to access the Ethernet Statistics menu or use 
the Up/Down navigation keys to scroll and highlight the Ethernet 
Statistics option.

3 Press the Select soft key.

You can press the Return soft key exit the menu to return to the Local 
Diagnostics submenu.

The screen displays Reset, NIport/PCport, and Return soft keys. The 
NIport/PCport soft key is used to select the Network (NI) Port or the PC 
(PC) Port. The soft key label indicates the current display page. For 
example, when NIport appears on the soft key label, the information 
showing on the display is for the network interface port.



Appendix D: IP Phone diagnostic utilities  Page 477 of 508

IP Phones Description, Installation, and Operation

When NIport appears on the second soft key label, the following statistics 
are displayed:

• Link Status

• Duplex Mode

• Network Speed (10 Mb, 100 Mb, or 1G)

• AutoSense/Negotiate

— AutoSense/Negotiate Capability

— AutoSense/Negotiate Completed

• Port VLAN Priority

• Port VLAN ID

• Packet Collision

• CRC Error count

• Frame Error count

• Unicast Packets Sent

• Unicast Packets Received

• Broadcast Packets Received

• Multicast Packets Received

• 802.1x Status (EAP Status)

4 To reset the NIPort counters to 0, press the Reset soft key.

5 Press the NIPort soft key.
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The NIPort soft key changes to the PCPort soft key and the tool displays 
the statistics for the Personal Computer port (PCPort). The following 
PCPort statistics are displayed:

• Link Status

• Duplex Mode

• Network Speed

• AutoSense/Negotiate Capability

• AutoSense/Negotiate Completed

• Port VLAN Priority

• Port VLAN ID

• Packet Collision

• CRC Error count

• Frame Error count

• Unicast Packets Sent

• Unicast Packets Received

• Broadcast Packets Received

• Multicast Packets Received

Figure 78 on page 479 shows Ethernet Statistics display screen.
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Figure 78
Ethernet Statistics display screen

6 To reset the PCPort statistics to 0, tap the Reset soft key.

End of Procedure

4. IP Network Statistics

Use Procedure 112 to use the Network Statistics tool.

Procedure 112
Using the IP Network Statistics tool

1 Press the Services key twice.

2 Press 2 4 on the dialpad to access the IP Network Statistics menu or use 
the Up/Down navigation keys to scroll and highlight the IP Network 
Statistics option.

3 Press the Select soft key.

ReturnNIportReset

1. Link Status:   UP
2. Duplex Mode:   Full
3. Network Speed:   100Mb
4. Auto Sense/Negotiate
    Auto-Negotiate Capability:   NO
    Auto Negotiate Completed:   NO
5. Port VLAN Priority:   0
6. Port VLAN ID:   1
7. Packet Collision:   0
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You can press the Return soft key exit the menu to return to the Local 
Diagnostics submenu.

4 The screen displays Reset, Refresh, and Return soft keys. The Refresh 
soft key (second soft key on the display) refreshes the counts on the 
display. This display shows the Network statistics for the IP Phone’s port 
of the 3 port switch. 

The following statistics are displayed:

• Packets sent

• Packets received

• Incoming Packet errors

• Outgoing Packet errors

• Incoming Packets discarded 

• Outgoing Packets discarded

• Unknown protocols (Unknown protos)

• Last Internet Control Message Protocol (ICMP) message type and 
code ( The Last ICMP Type/Code)

Figure 79 on page 481 shows IP Networks Statistics screen.



Appendix D: IP Phone diagnostic utilities  Page 481 of 508

IP Phones Description, Installation, and Operation

Figure 79
IP Networks Statistics screen

5 To reset the NIPort counters to 0, press the Reset soft key.

6 The display counter values are a snapshot and the displayed counter 
values will not change while the display is shown. To refresh them as you 
view the counter display, press the Refresh soft key. 

7 You can press the Return soft key exit the menu to return to the Local 
Diagnostics submenu, or you can press the Stop key to close the menu 
and return to the telephone display.

End of Procedure

5. USB Devices

The USB Devices tool provides information about an Universal Serial Bus 
(USB) devices that connect to your IP Phone. The IP Phone automatically 
detects USB devices when they are connected to the USB port in the back of 
the IP Phone. The IP Phone will enumerate and list any USB device, but only 

ReturnRefreshReset

1. Packets Sent:   1740
2. Packets Received:   1913
3. Incoming Packets Error:   0
4. Outgoing Packets Error:   0
5. Incoming Pkts Discarded:   0
6. Outgoing Pkts Discarded:   0
7. Unknown Protos:   0
8. The last ICMP Type/Code:   1
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USB mice and USB keyboards can be used. The display shows the descriptive 
text string received from the USB device.

Procedure 113
Using the USB Devices tool

1 Press the Services key twice.

2 Press 2 5 on the dialpad to access the USB Devices menu or use the Up/
Down navigation keys to scroll and highlight the USB Devices option.

3 Press the Select soft key. 

You can press the Return soft key exit the menu to return to the Local 
Diagnostics submenu.

3. Network Configuration

The Network Configuration displays the information that was configured 
when the IP Phone was installed. Items that are not active appear dimmed. 

Use Procedure 114 to display Network Configuration information.

Procedure 114
Displaying Network Configuration information

1 Press the Services key twice.

2 Press 3 on the dialpad to access the Network Configuration menu or 
use the Up/Down navigation keys to scroll and highlight the Network 
Configuration option.

3 Press the Select soft key.

You can press the Apply/Reset soft key to save the settings and to reset 
the IP Phone. You can press the Exit soft key exit the menu to exit the 
menu without saving any changes and return to the Local Diagnostics 
submenu.

The screen displays Select, Next and Exit soft keys, and the following 
parameters used when configuring the IP Phone:

• EAP enable/disable check box

If you select the EAP enable/disable check box, use the keypad to fill in 
the following boxes:

— EAP Device ID
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— EAP Password

• DHCP mode (Full, Partial, No) list

Note: If Full is selected for DHCP in the list, all items are dimmed. If 
Partial or No is selected for DHCP in the list, all items are accessible. You 
can use the keypad to enter the information.

— If Full is selected from the list, all items are dimmed.

— If No is selected from the list, use the keypad to fill in the 
information in the boxes.

— If Partial is selected from the list, use the keypad to enter 
Server 1 IP address, Server 2 IP address, Port, Action, Retry, 
and PK numbers in the boxes.

• Voice VLAN (No, Auto, value) list 

— VLAN filter enable/disable check box

• Disable PC Port check box

To disable the PC Port, select the Disable PC Port check box.

• Data VLAN (No, value) list 

• PC-Port Untag All check box

To enable VLAN Tag stripping, select the PC-Port Untag All check box.

• Duplex setting (Auto, 10 MB Full, 100 MB Full) list

To change this setting, use the keypad to fill in the box.

• Ignore Gratuitous ARP (GARP) check box

To disable GARP, select the Ignore Gratuitous ARP (GARP) check box.

• XAS IP address

• GXAS selection check box

— GXAS port number

• TFTP IP address

• Enable Bluetooth combo box (Auto, Yes, No)

4 Press the Select soft key to save the changes.
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You can press the Apply/Reset soft key to save the settings and to reset 
the IP Phone. You can press the Exit soft key exit the menu to return 
without saving any changes and return to the Local Diagnostics 
submenu.

Figure 80 shows Network Configuration information.

Figure 80
Network Configuration information

End of Procedure

Bluetooth wireless technology manual configuration

You can also enable or disable Bluetooth wireless technology through the 
Network Configuration menu. The Enable Bluetooth option provides 
adminstration control over Bluetooth wireless technology. The following 
values are available:

• Auto—(default) Bluetooth wireless technology setting received through 
TFTP configuration

ExitApply&Reset

Enable 802.1x (EAP):

Device ID:

Password:

DHCP   :     Partial

Set IP  : 207.179.167.136

NET MASK: 255.255.225.136
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• Yes—Bluetooth wireless technology is enabled on the IP Phone 1140E

• No—Bluetooth wireless technology is disabled on the IP Phone 1140E

When the IP Phone 1140E firmware is upgraded, or when the IP Phone 1140E 
is received from the manufacturer with the latest firmware, the default power 
up setting is Auto. When the setting is Auto, the setting received from the 
TFTP Device Config file controls whether Bluetooth wireless technology is 
enabled. For more information about enabling Bluetooth wireless technology 
using TFTP configuration, see Procedure 69, “Enabling Bluetooth wireless 
technology on the IP Phone 1140E” on page 390.

When the Bluetooth wireless technology setting is Yes or No, the value 
received from the TFTP Device Config file is saved but is not used. The 
Bluetooth wireless technology adminstration setting is forced enabled, or 
disabled respectively regardless of the value received in the TFTP Device 
Config file. If the setting is then changed back to Auto, the saved value will 
take effect if no further setting is received through the TFTP server.

Use Procedure 115 to configure the Bluetooth wireless technology 
administration setting through the Local Tools > Network Configuration 
submenu.

Procedure 115
Configure the Bluetooth wireless technology 
administration setting

1 Double-press the Services key.

2 Press 3 on the dialpad to access the Network Configuration menu or 
use the Up/Down navigation keys to scroll and highlight the Network 
Configuration option.

3 Use the Right navigation key to navigate to the Enable Bluetooth combo 
box. The current setting is displayed. 

4 Press Enter to start the edit mode.

5 Use the Down navigation key to open the list. 

6 Use the Up/Down navigation keys to scroll and highlight the desired 
Bluetooth wireless technology mode.

7 Press Enter to select the mode and to close the list.
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8 Press Enter to exit the edit mode.

9 Press the Apply&Reset soft key to save the change and to restart the 
phone.

End of Procedure

The new mode takes affect when the IP Phone 1140E restarts. If the 
adminstrative control enabled Bluetooth wireless technology on the phone, 
the item 3. Bluetooth Setup appears in 1. Preferences submenu.

After setting administrative control, it is recommended that the Partial Menu 
Lock feature be activated to prevent users from changing the adminstration 
setting. For further information about the Partial Menu Lock feature, see “2. 
Manual Partial Secure Menu” on page 487. 

4. Lock Menu

You must enter the fixed password whenever the Lock Menu sub menu is 
accessed. Use the dialpad and enter the fixed password 26567*738 
(color*set). 

Note: The settings configured in the Lock Menu sub menu override the 
settings received from the DHCP string.

The Lock Menu offers the following choices:

• 1. Manual Secure Lock Menu 

• 2. Manual Partial Secure Menu

• 3. Manual Disable Secure Menu

• 4. DHCP Secure Menu

• 5. LockNow

1. Manual Secure Local Menu

When this option is selected, you are prompted to enter the fixed password 
whenever the Services key is double-pressed. 
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2. Manual Partial Secure Menu

When this option is selected, you are prompted to enter the fixed password 
whenever you access the Local Diagnostics and the Network Configuration 
sub menus.

3. Manual Disable Secure Menu

When this option is selected, the Lock Menu is disabled. 

4. DHCP Secure Mode

The IP Phone follows the menu lock configuration received from the Full 
DHCP string:

• if SECUREMENU is present, you are prompted to enter a password after 
you double-press the Services key

• if PARTSECUREMENU is present, you are prompted to enter a 
password whenever you select Local Diagnostics and Network 
Configuration

• if neither SECUREMENU nor PARTSECUREMENU is present, then 
the menu is not locked

For information about Password Protection, see “IP Phone 1120E” on 
page 307, or “IP Phone 1140E” on page 349

5. Lock Now

The Lock Now item immediately exits the Tools menu, closes any open Tools 
menu pages, and locks the Tools menu. 
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500

Appendix E: TFTP Server

Introduction
A Trivial File Transfer Protocol (TFTP) Server may be required in an 
IP Telephony system to distribute firmware to IP Phones. The TFTP Server 
can reside on a subnet other than the Call Server and can be located on either 
side of the firewall. 

TFTP Server planning

The TFTP Server holds the firmware for updating the IP Phones. Assuming 
the IP address for the TFTP Server has been configured on the IP Phone, each 
time the IP Phone is powered on, rebooted, or is manually reset, the IP Phone 
checks the version of firmware against the version of firmware on the TFTP 
Server. If the versions are different, the IP Phone downloads the new 
firmware from the TFTP Server. 

The following information must be considered when planning for a TFTP 
Server:

• The process for the IP Phone to check the version of firmware against the 
firmware on the TFTP Server takes a few seconds for a quiet network.

CAUTION
TFTP firmware download does not work when the 
IP Audio Conference Phone 2033 is behind a NAT Server.
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• The IP Phone attempts to connect to the TFTP Server. If the TFTP Server 
is offline, unreachable, or no connection is made, the IP Phone uses its 
existing version.

• The firmware downloading process takes about 30 seconds.

• The TFTP Server must be capable of supporting multiple TFTP sessions.

• When the IP Phone makes a TFTP request, it uses filenames without a 
full path name. Therefore, firmware updates for the IP Phones must be 
installed on the root directory of the TFTP Server.

When the firmware is uploaded to the TFTP Server, the files must be 
unzipped. Allow time for the TFTP Server to refresh. Monitor the TFTP 
Server for any errors. The TFTP Server can be located anywhere on the 
network if the IP Phones have the subnet mask and default IP gateway 
configured correctly. However, the IP Phone expects a response within two 
seconds to any TFTP Server request. Therefore, the TFTP Server should not 
be located, for example, at the other end of a slow WAN link.

If too many IP Phones attempt to download new software simultaneously, it 
can cause the downloads to slow down or return error messages. To reduce 
the number of retries and error messages, manage the download process by 
staggering the times the IP Phones download the firmware.

Nortel has tested the following TFTP Servers. They are listed in order of 
preference:

• Nortel TFTP Server (ONMS application)

• 3COM TFTP Server

• Pumpkin TFTP Server

Pre-download checklist

Ensure the following requirements are met before downloading firmware:

• A LAN must be properly configured and operational.

• The Nortel Telephony system must be connected to the network and 
completely operational.
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• A TFTP Server must be available on the network in order to load the 
appropriate firmware in the IP Phones.

Downloading the firmware for IP Audio Conference 
Phone 2033

Procedure 116
Downloading the IP Audio Conference Phone 2033 firmware

Note: Nortel recommends that the user ends an active call before 
performing firmware upgrade. Otherwise results may be unpredictable.

1 Download the latest IP Phones firmware from the Nortel web site.

2 Load the latest version of the IP Phones firmware and place it on the 
TFTP Server. Ensure the TFTP Server is started. 

The files required are:

— i2033.cfg

— firmware binary file (2310S10.bin, for instance)

3 If you statically assign IP addresses, ensure that the IP address, TFTP 
Server IP Address, Subnet Mask, and Default Gateway information are 
accurate. If you are using a DHCP Server, ensure the DHCP options are 
configured. 

4 Enter the TFTP Server IP address in the configuration menu, and reboot 
the IP Audio Conference Phone 2033. 

Downloading the firmware for IP Phone 2007

The IP Phone 2007 can perform TFTP firmware upgrade from within the 
Tools menu. This method requires the TFTP Server to store the following 
files in the root directory:

• i2007.cfg – downloading script file
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• i2007.img – firmware image file

Note: i2007.img is the name of the firmware file by default, but the 
location and the name of the firmware image file being downloaded is 
specified in the i2007.cfg file and can be any name. The name of the 
firmware image file can be specified in relative path name notation (for 
example, /subfolder/name.ext or name.ext).

Procedure 117
Downloading the firmware for the IP Phone 2007

Note: Nortel recommends that the user ends an active call before 
performing firmware upgrade otherwise results may be unpredictable.

1 Select the TFTP Upgrade option in the Service > Option > Tools menu.

See Figure 81 on page 492.

Figure 81
TFTP Upgrade menu option
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2 Enter the IP address for the TFTP Server in the TFTP IP: edit box. The 
keypad can be used to enter the IP address by substituting star (*) as dot 
(.). See Figure 82 on page 493.

Figure 82
TFTP Server IP address screen

3 Tap on the Read_Configuration button.

The IP Phone reads the configuration file information from the TFTP 
Server and displays the image information in the dialog box. Check your 
network connection if the phone cannot read the configuration file. See 
Figure 83 on page 494.
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Figure 83
Configuration file information

4 Press the Download button to start the TFTP Server. 

The phone will go blank briefly. Then the message “Starting TFTP 
download” appears on the screen. Then the firmware is downloaded. The 
message “Writing firmware to Flash ROM” appears on the screen while 
the firmware is written to Flash memory. The IP Phone 2007 resets and 
the application starts.

End of Procedure

For future firmware upgrades, update the firmware file which is stored on the 
TFTP Server. Each time the IP Phone is powered on, it checks with the TFTP 
Server to ensure it has the proper firmware version, and it downloads the new 
software if necessary.
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Downloading the firmware for 
IP Phone 1120E and IP Phone 1140E

Automatic TFTP download at bootup

If a TFTP IP address has been configured and a firmware upgrade is available 
on the server when the phone restarts, the phone executes the automatic TFTP 
download. This method requires the TFTP Server to store the .cfg and .img 
files for the IP Phone in the root directory. 

For example, the IP Phone 1120E and IP Phone 1140E require the following 
files:

• 1120e.cfg
1120e.img 

• 1140e.cfg
1140e.img

Note: 1120e.img, or 1140e.img is the name of the firmware file by 
default, but the location and the name of the firmware image file being 
downloaded is specified in 1120e.cfg, or 1140e.cfg and can be any name. 
The name of the firmware image file can be specified in relative path 
name notation (for example, /subfolder/name.ext or name.ext).

Table 48 describes the fields in the configuration file on the TFTP Server. 
The download mode can be set to AUTO or FORCED. It is recommended 
that you set DOWNLOAD_MODE to AUTO.

Table 48
Fields in the TFTP configuration file (Part 1 of 2)

Field Name Field Value Descriptions

[FW] Section header for firmware download info

DOWNLOAD_MODE AUTO Recommended setting. The application looks at 
the version and downloads the FW if it is a newer 
version than what is on the phone.

FORCED The version of firmware is ignored. The firmware 
is always downloaded.
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Use Procedure 118 on page 497 to upgrade the firmware for the 
IP Phone 1120E and IP 1140E using automatic TFTP download during 
bootup.

VERSION 0625Cxx The version string compared to what is on the 
phone.

FILENAME 0625Cxx.bin Image file name. Must match the file name of the 
actual IP Phone FW file.

PROTOCOL TFTP Download protocol. Must be TFTP.

SERVER_IP xxx.xxx.xxx.xxx IP Address of the TFTP server in decimal.

SECURITY_MODE 0 For future use.

Table 48
Fields in the TFTP configuration file (Part 2 of 2)

Field Name Field Value Descriptions
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Procedure 118
Upgrading the firmware for IP Phone 1120E
and IP Phone 1140E using automatic
TFTP download at bootup

1 Use one of the three methods to configure the TFTP Server address:

• Access the Network Configuration menu. Enter the address at the 
TFTP IP prompt. Press the ApplyandReset soft key to save the 
change.

• Enter the address in the BootC menu. See “Manual TFTP Download 
from BootC Procedure” on page 497.

• Enter the IP address in the TFTP IP address field retrieved by the 
DHCP Server.

2 Restart the phone.

After the phone starts and begins to run the latest version of firmware, the 
1120e.cfg or 1140e.cfg files are downloaded from the TFTP Server. After 
the .cfg file is retrieved, the DOWNLOAD_MODE and VERSION fields are 
checked. If necessary, the firmware file is transferred to the phone using 
TFTP. The display shows the message "[FW] reading…". If successful, 
the display shows "[FW] writing…" and the blue LED starts to flash. After 
the FW image is written to the phone, the message "[FW] finished" is 
displayed, the blue LED stops flashing, and the phone resets. The phone 
registers to the TPS with the new FW version.

End of Procedure

Manual TFTP Download from BootC Procedure

This method of upgrading the firmware is normally used only when you need 
to force the phone to restore an older firmware version. To use this method, 
the FW must be placed on the TFTP server, and you must manually configure 
the phone to point to that TFTP server. The BootC firmware carries out the 
upgrade. To initiate the FW download task, BootC must be triggered to run. 
The following steps explain the procedure.



Page 498 of 508 Appendix E: TFTP Server

553-3001-368 Standard 12.00 March 2006

Note: You can create the configuration file with a default file name, such 
as"1140E.img" so you do not have to change the file name each time a 
new IP Phone 1140E FW load is released. However, if you take this 
approach, be sure to rename the released FW file (for example, 
0625Cxx.bin) to the default file name when the new FW file is copied 
into the TFTP server's directory and to update the VERSION string in the 
configuration file.

After the configuration file is in the TFTP server's home directory together 
with the image file, the firmware can be upgraded using the following 
procedure.

Procedure 119
Upgrading the firmware for IP Phone 1120E
and IP Phone 1140E using BootC

1 Hold down the [Up] and [2] keys, and while doing so, repower the phone. 
When the phone restarts, it will load and run BootC instead of the 
application. When the Msg Waiting LEDs go off, you can release the [Up] 
and [2] keys.

2 The following text menu on a white background appears:

Note: If you do not see this message, you are in the wrong menu. Repeat 
step 1. If BootC is damaged from a power reset, hold down the [Up] and 
[3] keys to use the backup BootC.

3 When Nortel appears on the screen, press the soft keys 1,2,3,4 in 
sequence (left to right). BootC goes to manual configuration. If you miss 
this step, and the phone begins to register to the TPS, repeat step 1.   

4 Follow the prompts to configure DHCP and other IP parameters or, if 
DHCP and other parameters are already configured, just keep pressing 
the 1 soft key or OK. The soft keys functions are listed below:

• soft key 1 (below the LCD) is OK

• soft key 2 is BackSpace

• soft key 3 is Clear

• soft key 4 is Cancel

11x0 IP Phone
Manual Configuration

Nortel 
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5 When prompted: "TFTP Dwnld? (0-No, 1-Yes):0",

• Press soft key 2 (BKSpace) to clear the 0 (No).

• Press 1 on the dialpad, then press soft key 1 (OK).

6 When prompted: "TFTP IP xxx.xxx.xxx.xxx",

• If the IP address is correct for the TFTP server, press soft key 1 (OK). 
After the TFTP address is entered the first time, it is presented the 
next time you enter the menu.

• If the IP address is incorrect, press soft key 2 (Clear) to erase the 
address shown and enter a new address. Press the asterisk (*) key 
to enter a period (.) in the IP address. You can also use backspace 
key to erase part of the address or correct errors by pressing soft key 
1 (BKSpace). When the address is correct, press soft key 1 (OK).

7 The phone reads the configuration file from the TFTP server, extracts the 
Server_IP and Filename fields, and attempts to download the file. The 
display shows the message "[FW] reading…"

8 The display shows "[FW] writing…" and the blue LED starts to flash.

9 After the FW image is written to the phone, the message "[FW] finished" 
is displayed, the blue LED stops flashing, and the phone resets.

The phone registers to the TPS with the new FW version.

Note: If the TFTP Server, specified by the TFTP IP address entered 
during configuration, is unreachable or down, the IP Phone attempts to 
register to the TPS to perform a firmware download. If the IP Phone does 
not register to the TPS, the IP Phone will not work. Check the TFTP IP 
address and the state of the TFTP Server, then reboot the IP Phone.

10 If the IP Phone remains in this condition because no TPS FW download 
occurs, check the TFTP IP address and the state of the TFTP Server, 
then restart the IP Phone.

End of Procedure
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Figure 84:
TFTP Server on a network
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Index

Numerics
12-button dialpad, 225, 228

3-port switch
and 802.1Q header, 74, 312, 410

802.11b
wireless ethernet networking, 267

802.1Q, 407
Ethernet frame, 408
p bits, 408

802.1Q support, 408

802.3af, 403

A
AC adapter, 403

Accessory Expansion Module (AEM), 187

Ack message, 411

Active Call Failover, 400

ActiveSync, 268
deactivate, 268
uses PPP, 268

Advanced Audio settings, 261

Advanced Audio tab, 225, 260

Answer, 226

AP
distance from, 267

Application menu
language selection, 197

audible notification
connection, disconnection, 222

audio buffers, 260

audio clarity, 260
reduced, 260

audio delay, 260

audio quality, 224, 260, 264, 267
maintain, 246

Audio quality slider tab, 260

Audio screen, 260

Audio selection tab, 225

audio stream
receive, 260

audio streams, 260

Auto-Create button, 256

Auto-discovery
VLAN ID, 411

B
Bluetooth, 224, 267

buffers, 260

build number, 256

C
Callers List, 398

call features, 226
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Call forward key
IP Phone 2004, 44, 78, 112, 154, 280, 324, 368
IP Softphone 2050, 208

Call Handling screen, 226, 232, 246
dialpad, 230

Call park key
IP Phone 2004, 44, 78, 112, 154, 280, 324, 368
IP Softphone 2050, 209

Call transfer key
IP Phone 2004, 44, 78, 112, 154, 280, 324, 368
IP Softphone 2050, 208

Charge account key
IP Softphone 2050, 209

Checking Ethernet Statistics IP Phone 2001, 62

Clear Type, 226

Closet power, 120, 126, 161, 167

codec
G.711, 264

Codecs
and jitter buffer, 206
IP Softphone 2050, 207

communication server, 254, 256

compensation, 261, 264

compression, 225, 264

Conference key
IP Softphone 2050, 208

configuration information
About, 250

conflicts, 254

connection history, 253

Connections settings, 231, 251

Connect server, 131, 174, 386

contact a server, 251

Contacts, 231
dialog box, 231

Contacts application, 223, 231

Contacts list, 226

contention, 267

Contivity, 245

Controls, 181

Corporate Directory, 398

cursor control, 226

D
Default gateway, 117, 158, 374

IP Phone 2002, 51, 85, 289

def gw See Default gateway

delay
reduce, 260
too large, 260

Desk-mount bracket, 186

DHCP, 223
Ack message, 411
Discovery request, 411
VLAN ID discovery, 411

Diagnostics from the IP Phone, 422

Diagnostic Utilities
Network diagnostic utilities availability, 423
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Diagnostic utilities
Authentication State, 425
Authenticator ID, 425
call server console-based, 421
Command Line Interface (CLI), 422
data display pages, 436
DeviceID, 425
DHCP information process, 424
Ethernet statistics, 424
IDU command printout in LD 32 for IP Phone 

with a NAT, 453
IDU command printout in LD 32 for IP Phone 

without a NAT, 453
IP Networking statistics, 424
Network Address Translation (NAT) 

Traversal, 449
Network QoS Process, 424
Ping and TraceRoute, 423
RTP/RTCP statistics, 424
set-based, 421
UNIStim/RUDP statistics, 424
Using CLI Commands, 451

diagnostic utilities, 421

Diagnotic utilities
Supplicant Status, 424

dialpad, 226, 244

display, 228, 242

Display area
IP Softphone 2050, 202

Display label, 181

Driver software
headset adapter, 213

Dynamic Host Configuration Protocol
DHCP, 226

E
Early Packet Resync, 263

echo cancellation, 263

Echo cancellers, 205

Emergency Services for Virtual Office, 399

Enabling Full Duplex mode IP Phone 2001, 62, 299

enclosed spaces, 267

enter data
MVC 2050, 243

Ethernet, 256
hardware addresses, 256

Ethernet frame, 408

Exit, 231

extranet client, 256

F
Feature keys

IP Softphone 2050, 207

Features
Callers List, 398
Corporate Directory, 398
Emergency Services for Virtual Office, 399
IP Call Recording, 399
Password Administration, 399
Personal Directory, 398
Redial List, 398
Virtual Office, 399

Features menu
default, 233

File menu, 229

Firmware Version, 256

flexible interface, 225, 250

Frame size
IP Softphone 2050, 207

frame sizes, 264

Full Duplex mode IP Phone 2001, 61, 298

G
G.711-64 A-law and U-law, 225, 264

G.711 codec, 225, 226

Gateway
default, 51, 85, 289
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GIPS NetEQ
active, 261
Global IP Sound NetEQ, 261

Global IP Sound NetEQ, 223, 225, 236, 250

Goodbye icon, 233

graphical images, 236

H
hard reset, 254

Hardware ID
box., 256
unique, 254

Hardware ID screen, 254

headphones, 224

Headset adapter
driver software, 213

Headset/Answer icon, 226, 232

headsets, 223, 224

Help, 235
About, 236
About copyright indication, 236
About Global IP Sound name, 236
About manufacturer’s name, 236
About product name, 236
About version number, 236
Contents, 235
menu, 235

Highwater mark, 263

Hold icon, 233

I
incoming call, 232

installation
MVC 2050, 248

Installer password, 54, 88, 292

integrated switch, 403

Interactive Voice Response
(IVR), 223

interface keys, 233

interference, 267

IP, 37

IP address, 61, 96, 131, 174, 298, 342, 386

IP Call Recording, 399

IP Line IP stack, 408

IP Phone
diagnostic utilities, 421
password, 117, 159, 213, 374

IP Phone 2001
Changing TN, 64, 300
components and functions, 37
Description, 36
features not supported, 40
Introduction, 35
Reinstalling, 63, 98, 133, 176, 299, 300, 344, 

388
Removing, 65, 302
Replacing, 65, 301
Supported features, 40

IP Phone 2002, 186
user ID, 61, 96, 298, 342

IP Phone 2002 keys
reserved, 44, 78, 209, 281, 324

IP Phone 2004, 186
user ID, 131, 174, 386

IP Phone controls, 181

IP Phone Installer Password, 54, 88, 292

IP Phone KEM, 179, 186

IP Phone Key Expansion Module (KEM), 179

IP Phones
environmental specifications, 405

IP Softphone 2050
codecs, 207
loss plan, 205
registration, 204
software version, 210
TN, 210
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isetShow command
IP Softphone 2050 software version, 210

iTask settings, 231, 251

J
Jitter buffer

setting, 206

jitter buffer, 263, 264

K
keyboard, 243

Key expansion module
configuration, 182
connection, 187
Description, 179
display, 181
features, 180
initialization, 188
installation, 186
key number assignments, 181
operating parameters, 189
package components, 181

Key expansion module (KEM), 179

Keys menu, 226, 231, 233
Features, 233
Features tab, 233
Goodbye, 233
Headset, 232
Hold, 233
Macros, 234

L
Language

IP Softphone 2050 Application menu, 197
Terminal Proxy Server, 197

Late Packet Resync, 263

Line/feature keys, 181

Listener IP screen, 265

Local power, 120, 126, 161, 167

local power, 403

loss concealment, 261, 264

Loss Plan
IP Softphone 2050, 205

M
MAC address, 254, 256

unique, 254

Macro, 223, 226, 234

memory, 231, 251

Menu Bar
icons, 242

Message waiting key, 112, 154, 368
IP Softphone 2050, 208

MVC 2050
components, 225
requires Windows Mobile 2003, 245
software, 222, 225
supports, 225
supports English, 245
supports Windows Mobile 2003, 245

N
navigation

buttons, 226

Net mask (net msk), 61, 96, 131, 174, 298, 342, 386

network connection
loss, 254

Network Interface Card (NIC), 254

network interface cards, 265

Node ID, 117, 159, 213, 374

Nortel Contivity Extranet Switch, 256

O
Online help, 223, 226

operating parameters
MVC 2050, 245
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P
packet loss, 264

packet loss concealment, 236, 250, 263

packets, 263

Party conference key
IP Phone 2004, 44, 78, 112, 154, 280, 324, 368

Password
installer, 54, 88, 292

Password Administration, 399

pauses in transmission and reception
gaps, 268

p bits, 408

PDA, 226
battery life, 247
battery life, call duration, 247
battery types, 247
compatible, 223
CPU type, 245
extended-life battery, 247
memory recommendation, 245
processing resources, 231
processor speed adverse affects, 246
recommended hardware, 245

Personal Digital Assistant
PDA, 222

Personal Directory, 398

Personal settings, 231, 251

place a call, 230

power, 231, 251

Power over Ethernet (PoE), 403

Power over LAN, 120, 126, 161, 167

Power requirements
Phase II Phones, power over Ethernet, 404

power splitters, 403

Power supply, 46, 80
IP Phone 2004, 120, 126, 161, 167

Power up
IP Phone 2002, 51, 56, 84, 90, 288, 294, 336, 

380
IP Phone 2004, 120, 125, 161, 167

Privacy release key
IP Softphone 2050, 209

Profiles, 225, 236, 258
create, delete, modify, change, export, import, 

257
exporting, 236
importing, 236
selected or removed, 257

Profiles screen, 257

programmable line/feature keys, 225, 229

Q
QoS, 206

802.1Q, 207
DiffSERV, 206
voice quality on IP Softphone 2050, 206

quality slider, 225

R
random hardware IDs, 256

Reboot
IP Phone 2002, 64, 98, 133, 177, 300, 345, 395

recovering server unreachable, 254

Redial List, 398

regional settings, 231, 251

Registration
error messages, 454
IP Softphone 2050, 204

registry key, 253

remove programs, 231, 251

removing
MVC 2050, 249

Reserved keys
IP Phone 2002, 44, 78, 209, 281, 324
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Ring again key
IP Phone 2004, 44, 78, 112, 154, 280, 324, 368
IP Softphone 2050, 208

Ringing number pickup key
IP Phone 2004, 44, 78, 112, 154, 280, 324, 368
IP Softphone 2050, 209

roaming/handover, 268

Router address, 61, 96, 131, 342, 386

Run-in-background, 226, 230

S
screen, 231, 251

screen font, 226

self test, 231, 251

Settings, 231
menu, 233
Select a skin, 236

Settings screen
Server tab, 251

Setup
MVC 2050, 249

SIP, 303
Converged Desktop Service (CDS), 304
installation and configuration, 306
redirect server, 304
registrar, 304
SIP Gateway, 304
SIP Phone features, 305

SIP Phone, 303
SIP-network components, 304

skin
current, 226

skins, 225, 226, 236, 242

soft keys, 225, 229

soft restart, 249

sound
files, 258
settings, 258

Sounds
audible notification connection, disconnection, 

258
Server connected, 259
Server unreachable, 259
Server unresponsive, 259

specific address, 265

specific port
IP port 5000, 265

speech path, 223

Speed dial
IP Phone 2002, 44, 78, 281, 324
IP Phone 2004, 112, 154, 369
IP Softphone 2050, 209

speed-dials, 234

Start up
IP Phone 2002, 51, 56, 84, 90, 288, 294, 336, 

380
IP Phone 2004, 120, 125, 161, 167
IP Softphone 2050, 215, 216

Structural baseplate, 186

Switch
3-port, 74, 312

synchronize
Outlook, 231

System Input Panel, 243
Block Recognizer, 243
default, 243
icon, 243
Keyboard, 243, 244
Letter Recognizer, 243
Transcriber, 243

System settings, 231, 251

T
Terminal Proxy Server

language selection, 197

text menu equivalents, 242
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Timing sequence, 51, 56, 84, 90, 120, 125, 161, 167, 
288, 294, 336, 380

TN, 117, 159, 213, 374
IP Softphone 2050, 210
sharing, 65, 99, 134, 178, 301, 346, 396

Toolbar, 225, 242
retractable, 242
retracted, 242
toggle icon, 242

transcriber, 243

Transfer key
IP Phone 2002, 44, 78, 280, 324
IP Phone 2004, 44, 78, 112, 154, 280, 324, 368

Trivial File Transfer Protocol, 489

troubleshooting, 236

U
User ID

IP Phone 2002, 61, 96, 298, 342
IP Phone 2004, 131, 174, 386

V
version number, 256

Virtual Office, 399

VLAN
802.1Q, 407
priority, 58, 295

VLAN ID
discover using DHCP, 411
values, 58, 291, 295

voice frames, 263
arriving, 263

Voice Gateway Media Card, 263

voicemail, 223, 226, 234

Voice quality
IP Softphone 2050, 206

VPN, 254
certicom movianVPN client, 245
movian, 222

W
watchdog timer, 254

wireless network, 268

WLAN, 225

WLAN 802.11b, 222, 224, 226

WLAN Access Point
WAP, 222

WLAN Handset
2210, 269
2211, 269
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